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Copyrights
Copyright ©1987-2001 Electric Image Inc. All rights reserved.

The ElectricImage Universe software and documentation are Copyright ©1987-2001 Elec-
tric Image Inc. All rights reserved. This document may not, in whole or in any part, be cop-
ied, photocopied, reproduced, translated, or reduced to any electronic medium or machine 
readable format without prior consent, in writing, from Electric Image Inc. 

Trademarks
Electric Image Universe, Universe Modeler, Universe Animator and their logos are trade-
marks of Electric Image Inc. Windows is a trademark of Microsoft Corporation. Macintosh 
is a trademark of Apple Computer, Inc. Solaris is a trademark of Sun Microsystems. All 
other trademarks are the property of their respective holders.    

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND 

CONDITIONS BEFORE INSTALLING THE ELECTRICIMAGE UNIVERSE 

SOFTWARE. THE OPENING OF THE SOFTWARE PACKAGES AND/OR 

INSTALLATION OF THE SOFTWARE INDICATES YOUR ACCEPTANCE 

OF THESE TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH 

THEM, YOU SHOULD RETURN THE ENTIRE PRODUCT IN NEW CON-

DITION TO THE PLACE OF PURCHASE, AND YOUR MONEY WILL BE 

REFUNDED.

Except as otherwise specifically provided, Electric Image Inc. is the “Licen-

sor” of the ElectricImage Universe software and accompanying documen-

tation. The ElectricImage Universe software program is referred to in this 

License Agreement as the “Program”. The Licensor grants to you, the origi-

nal end user licensee, a nonexclusive license to use the Program for your 

own personal use and not for sublicense, subject to the terms and condi-



       
tions stated in this License Agreement. You assume responsibility for the 

selection of the Program to achieve your intended results.

LICENSE
You may: (i) use the Program on a single machine; (ii) copy the Program into any machine-
readable form only for necessary backup or modification purposes in support of your use of 
the Program on a single machine; and (iii) transfer the Program and license to another party 
if the other party agrees to accept all terms and conditions of this Agreement. If you transfer 
the Program, You must at the same time either transfer all copies, whether in printed or 
machine-readable form, to the same party or destroy any copies not transferred. You may not 
sublicense or lease the Program or accompanying documentation. You may not assign or 
transfer the license to the Program or accompanying documentation except as expressly pro-
vided in this Agreement. Except as expressly permitted above, any attempt to lease, subli-
cense, assign or transfer any of the rights, duties or obligations hereunder is void.

Upgrades and Updates

If this Software is being licensed to you as an upgrade or update to soft-

ware previously licensed to you, you must destroy the software previously 

licensed to you, including all copies resident on your hard-disk drive, 

within sixty (60) days of the purchase of the license to use the upgrade or 

update.

RESTRICTIONS 

You may not distribute copies of the Program to others or electronically 

transfer the Program or accompanying documentation from one computer 

to another over a network. The Program contains trade secrets, and in 

order to protect them, You may not decompile, reverse engineer or disas-

semble the Program, or otherwise reduce the Program to a human perceiv-

able form. You may not modify, adapt, translate, rent, lease, loan, resell for 

profit, distribute, network or create derivative works based on all or any 

part of the Program or accompanying documentation. You may not circum-



     
vent operation of the accompanying hardware key device or “dongle” or 

any other form of copy protection employed by the Program. You may not 

copy, clone or emulate or otherwise duplicate the functions of the hardware 

key in any manner, or allow the Program or hardware key to be so copied.

Disclaimer

Computer-Aided Design Software and other technical software are not 

substitutes for your professional judgement. Computer-Aided Design Soft-

ware and other technical software are intended to assist with product 

design and are not substitutes for independent testing of product stress, 

safety, and utility. due to the large variety of potential applications for the 

software, the software has not been tested in all situations under which it 

may be used. Electric Image Inc. shall not be liable in any manner whatso-

ever for the results obtained through the use of the software. Persons using 

the software are responsible for the supervision, management, and control 

of the software. This responsibility includes, but is not limited to, the deter-

mination of appropriate uses for the software and the selection of the soft-

ware and other programs to achieve intended results. Persons using the 

software are also responsible for establishing the adequacy of independent 

procedures for testing the reliability and accuracy of any program output, 

including all items designed by using the software.

TITLE 

The original and any copies of the Program and accompanying documenta-

tion, in whole and in part, including translations, compilations, partial cop-

ies, modifications, and updates are the property of Licensor or its suppliers. 

You have only the limited rights granted by this license. You are not an 

owner of a copy of the Program, and therefore 17 U.S.C. Section 117 does 



       
not apply. You must reproduce and include the proprietary rights notices 

on any copy of the Program and accompanying documentation.

LIMITATIONS

This license does not include any rights to reproduce, copy, commercialize 

or otherwise use or make use of the sounds, music, pictures, effects or other 

content contained in the Program except in connection with your personal 

use of the Program as permitted hereunder.

TERMINATION 

You may terminate your license to the Program at any time by destroying 

the Program and accompanying documentation together with all copies, 

modifications and merged portions in any form. The license also will termi-

nate as set forth elsewhere in this Agreement if you fail to comply with any 

term or condition of this Agreement. You agree upon such termination to 

destroy the Program and accompanying documentation, together with all 

copies, modifications and merged portions, in any form.

LIMITED WARRANTY.
Electric Image Inc. (“Licensor”) warrants to the purchaser of ElectricImage Universe from 
an authorized dealer(“End User”) that the CD-ROM(s) media on which the ElectricImage 
Universe software program (“Program”) are furnished are free from defects in materials and 
workmanship under normal use for a period of ninety (90) days from the date of delivery to 
End User as evidenced by a copy of End User’s receipt (“Program Warranty”). Licensor 
does not warrant that the documentation or the functions contained in the Program will meet 
End User’s requirements or that the operation of the Program will be uninterrupted or error 
free. Licensor’s entire liability and End User’s exclusive remedy with respect to breach of 
the Program Warranty will be the replacement of any CD-ROM media not meeting the Pro-
gram Warranty if returned to the Licensor for the particular nonconforming Program within 
the Program’s Warranty period with a copy of the applicable receipt(s). End User is respon-
sible for any costs, expenses, customs, duties, taxes, and other similar charges arising with 



       
regard to return shipment of the Program to the place of purchase and Licensor’s return of 
the Program under the Software Warranty. End user must pay all such costs upon invoice.

NO OTHER WARRANTY.   
EXCEPT FOR THE LIMITED WARRANTY STATED ABOVE, THE ELECTRICIMAGE 
UNIVERSE PROGRAM AND ACCOMPANYING DOCUMENTATION ARE PROVIDED 
“AS IS” WITHOUT WARRANTY OR CONDITION OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED AND THE IMPLIED WARRANTIES AND CONDITIONS 
OF MERCHANTABILITY, TITLE AND FITNESS FOR A PARTICULAR PURPOSE 
ARE SPECIFICALLY DISCLAIMED. THE ENTIRE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE ELECTRICIMAGE UNIVERSE PROGRAM AND ACCOM-
PANYING DOCUMENTATION IS WITH END USER. SHOULD THE PROGRAM 
PROVE DEFECTIVE, END USER (AND NOT THE LICENSOR OR ANY AUTHO-
RIZED DEALER) ASSUMES THE ENTIRE COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION. No oral or written information or advice given by Licensor, 
its dealers, distributors, agents or employees will create a warranty or in any way increase 
the scope of the limited warranties set forth herein, and End User may not rely on any such 
information or advice. SOME STATES MAY NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY. THIS 
WARRANTY PROVIDES SPECIFIC LEGAL RIGHTS AND THE END USER MAY 
ALSO HAVE OTHER RIGHTS THAT VARY FROM STATE TO STATE. 

Remedies

The entire liability of Electric Image Inc. and your exclusive remedy under 

the warranty provided herein will be, at the option of Electric Image Inc. to 

attempt to correct or work around errors, to replace the media, or to refund 

the purchase price and terminate this Agreement. This remedy is subject to 

return of the Software to Electric Image Inc. or to the Authorized Electric 

Image Inc. Dealer from whom it was obtained with a copy of your receipt.

LIMITATION OF LIABILITY.
IN NO EVENT WILL LICENSOR OR ANYONE ELSE WHO HAS BEEN INVOLVED IN 
THE CREATION, PRODUCTION OR DELIVERY OF THE PROGRAM, OR ANY OR 
ALL OF THE ELECTRICIMAGE UNIVERSE CONTENT BE LIABLE TO YOU FOR 
ANY CONSEQUENTIAL, INCIDENTAL, INDIRECT OR SPECIAL DAMAGES, 



   
INCLUDING ANY LOST PROFITS OR LOST SAVINGS ARISING OUT OF THE USE 
OR INABILITY TO USE THE PROGRAM, ACCOMPANYING DOCUMENTATION OR 
CONTENT, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. The foregoing limitations of liability shall apply notwithstanding any 
failure of essential purpose of any limited remedy or any claim by any other party. Licen-
sor’s liability to the End User or any third party arising out of or related to this Agreement 
however caused and on any theory of liability, whether in contract, tort (including negli-
gence), or otherwise will not exceed the fee paid by the End User for the Program, as appli-
cable. The Program was not developed and is not licensed for use in any nuclear, aviation, 
mass transit, life support or medical application, or any other inherently dangerous applica-
tions. SOME STATES MAY NOT ALLOW THE LIMITATION OR EXCLUSION OF LIA-
BILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO ALL OR A 
PORTION OF THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY.

General

This Agreement shall not be governed by the UN Convention on Contracts 

for the Sale of Goods; rather this Agreement shall be governed by the laws 

of the State of California, including its Uniform Commercial Code without 

reference to conflict-of-laws principles. This Agreement is the entire agree-

ment between us and supersedes any other communications or advertising 

with respect to the Software and Documentation. If you have any ques-

tions, please contact in writing: Electric Image Inc., Customer Service, 3 

Imperial Promenade, Suite 400, Santa Ana, California, 92707.
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Chapter 1  ElectricImage™ Universe Concepts — Introduction

          
ElectricImage™ Universe Concepts

Universe Animator is a powerful suite of programs that you can use to cre-

ate fully rendered, motion picture quality computer generated 3D ani-

mated movies. It consists of three applications, Universe Modeler for object 

creation, Universe Animator for animation and surfacing, and Universe 

Camera for rendering and raytracing. Universe Animator also includes the 

Renderama™ network rendering utility.

Universe Animator is a multi-platform application suite. You can operate 

just as easily on Macintosh, Windows NT and 2000, and Sun Solaris com-

puters. You can animate on a Macintosh and render on a Sun network, if 

you so choose.

1.0 Universe Animator Introduction

Universe is a suite of applications which you use to create models, animate 

them, and finally render them into pictures or movies. The applications 

included within Universe Animator are:

Universe Modeler

Unless you already have created your models, or purchased some pre-

made models, you are going to have to build your own. The place to start is 

Universe Modeler. It is a solids and surface modeling system, allowing you 

to model with NURBS and solids together in the same program, and even 

with the same basic shapes! Universe Modeler also includes subdivision 

surfaces, the best tools for character modeling.
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Universe Animator

Once you have created your models in Universe Modeler, you can use Uni-

verse Animator to apply surface materials and textures, set up scene lights, 

and then animate your models. Universe Animator has been used in most 

of the Hollywood summer blockbusters since 1991, when it was first intro-

duced as ElectricImage Animation System. Universe Animator is the next 

level animator from Electric Image, Inc.

Universe Camera

Rendering is the process of converting your animation, model and surface 

data into finished pictures and movies. The rendering process is effectively 

a standalone process: once you assign a rendering job, you take a break 

until its complete. Depending upon how many frames are in your anima-

tion, and what rendering levels you have chosen, your job could take a few 

minutes to many hours.

Universe Camera is the rendering component of Universe Animator. Long 

known as the “world’s fastest renderer,” Universe Camera is capable of 

rendering over 30,000,000 polygons, and an effectively unlimited amount 

of lights, texture maps, procedural shaders, and so on. The image quality 

and rendering speed of Universe Camera are unsurpassed, as demon-

strated by its continuos use in Hollywood’s biggest effects films. 

Renderama

Universe Camera can be controlled by Renderama, the network rendering 

server utility that ships with Universe Animator. With Renderama, you can 

render to a local network, or across the internet! Renderama is a very sim-

ple utility, with very few bells and whistles.
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1.1 Terms and Definitions

Before reading any further, it is necessary for you to understand the 

nomenclature of Universe Animator. These terms will become important in 

the following sections:

Project. The project file is the main work file used by Universe Animator. it 

stores all references to objects, materials, maps, procedural shaders, and 

any other files used in the scene.

Scene. A rendered sequence, like a scene in a movie. 

Object. Any of several object types: camera, light, model, plugin, effector, 

and smoke object.

Camera (Scene Object). The camera is a scene object which is used to 
record the events of the scene over a period of time, just like a real camera. 

Light (Scene Object). A scene object that can be any of several sub-types 

which is used to illuminate a scene.

Model File. A model is an object type that contains a geometric description 

of the shape of the object. A model is made up of collection of “groups.”

Group. A member of a model file, a group is a single container of point, 

line and/or polygon data that is used to describe the shape of an object. A 

model file can have but a single group, but it must have at least one. 

Groups can be linked to one another or other scene objects hierarchically, 

can be animated, and can contain shading information.

Polygon. A polygon is an enclosed, flat shape that, as part of a mesh of 

other polygons, defines a more complex shape.

Vertices. Points which define the corners of a polygon.
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Attribute. An aspect of an object which can be set to a value or animated. 

Objects typically have many attributes.

Map. Refers to attribute maps, such as bump, clip, diffuse, transparency 

and so on, and projection maps.

1.2 Starting Up Universe Animator

When you first start Universe Animator, you will be asked to create a 

project. A project is the main file that Universe Animator uses to store and 

organize animated scenes.

After you create your project, you will be asked to choose a model to 

import into the scene. If you cancel, an empty scene containing a single 

camera and light will be created. You can import objects and create 3D text 

at any time.

A new project will always start with four windows, a camera, a radial light, 

any models that you may have imported, and the main menu bar. Three of 

the windows represent your working space, or “world space.” They are 

titled “top view,” “front view,” and “side view.” The fourth window is your 

camera view. The camera’s start position is on the Z axis, looking towards 

the origin (0,0,0 in world space coordinates.) The origin is the center of the 

world, and of your project.

1.3 Moving in Space

We all exist in space. We organize our space with units of measurement, 

such as feet or meters. 3D programs need to work within a space just like 

we do. Fortunately, a 3D program is not limited to just one space, and it can 

easily work at the atomic or astronomic level. 
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3D space is represented as a cube, and divided into three “axes” called X, Y 

and Z. Remember in school when a geometry exercise required you to plot 

a curve on graph paper? Chances are, the graph paper grid was divided up 

into X and Y space. Now, imagine three pieces of graph paper, running 

through the centers of the other in a perpendicular direction. Each of the 

sheets of paper would be labeled XY, XZ and YZ. 3D space is described in 

the exact same fashion. Three coordinate pairs are used to describe the loca-

tion of an object in 3D space, such as 20,10,0. In this example, the object is 

located 20 units on the X axis, up 10 units on the Y axis, with no change on 

the Z axis, putting the object on the XY plane of the 3D space. Values for 3D 

space can be both positive and negative. The direction that you travel will 

dictate whether or not your are in the positive or negative coordinates of a 

spatial region. The meeting point of all three planes is referred to as the 

“origin,” and located at coordinates 0,0,0.

Different 3D packages use different ways to look at the coordinates of the 

3D cube space. Although it doesn’t really matter how a particular package 

may view 3D space, it can be a concern if you are interchanging data from 

one program to another program from a different manufacturer. The most 

important thing to note in your program of choice is “which end is up?”

In Universe Animator, world space is “Y up,” that is, the positive Y axis is 

pointing up. The positive X axis points to the right, and the positive Z axis 

points to the rear. This is called the “left-handed coordinate system.” All 

objects in a Universe Animator scene will move within this coordinate sys-

tem. Another kind of space in Universe Animator is “object space” or “local 

space.” Object space is localized to each object in the scene, and refers to the 

rotation or orientation components of an object, as well as material proper-

ties such as texture maps. This sounds more complicated than it is, really. 
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As you work with Universe Animator, you will be exposed to these con-

cepts in more detail.

Depending upon how your model was made, you may see its rear end fac-

ing you in the front view, or you might see the front pointing at you in the 

top view. This is easy to correct with object axis editor (Hierarchy>Axis 

Editor). If you created your model in Universe Modeler, the up axis will be 

correct, and assuming that you created your model pointing towards nega-

tive z, the front of your model will be oriented correctly as well.

1.4 Looking at Your World

Universe Animator offers you a set of tools for you to communicate what 

you want the program to do. The most basic tool is the window. Windows 

in Universe Animator present you with information and allow you to edit 

and manipulate that information so that you can animate. There are several 

types of windows in Universe Animator:

• 3D Windows
• Information Windows
• Editing Windows
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Each of these types of windows offers different methods for animating 

your objects. In the 3D windows, you interact with objects directly: you 

select them, move them, rotate them, and so on. You can also control the 

level of drawing and shading, choosing the method which offers you the 

best compromise of performance and presentation.

The information windows provide you with data that is current to the time 

in which your scene is currently residing. You can control all of the 

attributes available to an object with its information window, and you can 

even animate these attributes by changing the values at the current time.

The editing windows offer a more detailed view of your scene and the 

objects inside of it. The project window presents this data numerically, and 

is also used to control hierarchy and other functions. The function curve 

editor presents its data in curve form, allowing you change the shape of 

Figure 1.1 — Default Universe Animator interface (four view windows.)
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data as it progresses through time. This in turn translates to actual motion 

or attribute behavior. Once you get the hang of the function curve editor, it 

is likely that you will favor this editor as you animate. The morph editor 

offers a slider-based method of animating morph targets. Morph targets are 

most commonly used for facial animation, but can be used for a variety of 

other animated tricks as well. The joint editor is used to set up the orienta-

tion of joints in your hierarchies and skeletons. The axis editor lets you eas-

ily change the orientation of your model, without having to resort to 

rotating the model into place. The deformation editor is used to bend, twist 

and otherwise distort your objects into the performance that you require.

3D Environment Windows

3D environment windows are used to draw your scene in 3D. You interact 

within 3D space in these windows only. Other windows allow you to inter-

act with your project in data or curve form. The 3D environment in Uni-

verse consist of the following windows:

• World Windows
• Camera Window
• Light Windows
• Texture Map Alignment Windows
• Morph Editor
• Joint Editor
• Model Information Window 

Projects in Universe Animator can often get very complex, and it is not 

unusual to have model counts of a million or more polygons in a scene. You 

can imagine that constantly drawing and redrawing this much information 

can be difficult for your computer, and it is. Universe Animator uses Open 

GL for drawing by default (you can also switch to a software drawing 
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engine). Open GL is an open drawing architecture used by 3D cards to 

speed up the drawing of 3D scenes and objects.

In addition to Open GL, Universe Animator also uses a variety of drawing 

modes that you choose, so that you can tailor the amount of drawing with 

the performance that you want to work with when you animate.

Drawing Modes

Drawing modes allow you to control detail vs. performance. You choose 

which one works the best for you and your setup. Drawing modes are set 

with the Window Display menu. This menu is located in the little blue ball 

at the bottom of each 3D window. The available drawing modes are:

• None
• Point
• Outline
• Wireframe
• Point Shaded
• Outline Shaded
• Wireframe Shaded
• Flat Shaded
• Gouraud Shaded
• Phong Shaded

Display None. This mode will draw nothing in the view. Hey, you never 

know.

Point. This mode draws points for each corner of every polygon in the 

scene. It can give you a fast volumetric feedback.
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Outline. This mode draws a “cartoon-style” outline for each group in the 

scene, including silhouettes and contours. It offers more clarity than wire-

frame drawing, and is much faster, as it has to draw much less. Outline 

mode provides very good feedback and response time. 

Wireframe. This traditional mode draws all of the polygons in the scene as 

wires that you can see through. This is the most clichéd drawing mode ever 

used in computer graphics. It is also slow when large numbers of polygons 

are present in the scene.

Point Shaded. This mode is the same as the point mode, except that the 

points are shaded by the lights within the scene. This mode can actually 

provide a combination of good speed and good feedback, as the shading of 

the points can remove the abstract curse of Point only drawing.

Outline Shaded. This mode is the same as Outline mode, except that the 

outlines are shaded by the lights within the scene. It is tempting to use this 

mode, but if you have objects with complex geometries, it can start to bog 

down when shading. You might find that you prefer Outline mode overall.

Wireframe Shaded. This mode is the same as Wireframe mode, except that 

the wireframes are shaded by the lights within the scene. It is very sexy to 

look at, but there is a time penalty to shade all of those wires.

Flat Shaded. This mode will shade each polygon in the scene giving a fac-

eted or jeweled appearance. It is a very fast shading mode, but does not 

adequately show spotlights, highlights, or texture maps.

Gouraud Shaded. This mode will smooth shade across each polygon in the 

scene, although spotlights and highlights will not look as good as they do 

when the Phong Shaded mode is active. Texture Maps will be visible when 
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this mode is on, and the Display Textures option is set in the group info 

window, on an object-by-object basis.

Phong Shaded. This mode is the superior shading method, and the results 

will match the results when you are rendering with the ElectricImage ren-

dering engine, Camera. Spotlights, highlights and texture maps will all dis-

play correctly. 

To view textures require that the Display Textures option is set in the group info 

window.

Underneath the drawing mode list in the menu is the Engine pop out 

menu. This menu allows you to select Open GL (hardware) or the Universe 

drawing engine (software.) It is rare that you would want to choose the 

software engine over Open GL, and it is offered as a choice primarily out of 

convenience. If you notice that the performance that you are getting from 

Open GL is less than what you would expect, try switching to the software 

engine and see if you notice any improvement. If you do, please call tech 

support.

Note If you are using Open GL, you should not be using the ruler bars feature. Ruler 

bar drawing significantly negates Open GL performance and should be avoided 

unless absolutely necessary. If you need the ruler bars, use them just to determine 

the measurements you need, and then deactivate them.

Following the Engine menu item are two other menu items:

• Show Extents
• Cull Back Faces

Show Extents. Selecting this mode draws the historically familiar cubic 

extent for each group. This is the fastest setting, but offers the least in feed-

back.
Electric Image Universe 3.0        11



Chapter 1  ElectricImage™ Universe Concepts — Looking At Your World
Cull Back Faces. This mode will speed up drawing by as much as two 

times, as the polygons which do not face the viewer are removed 

(“culled”.)

Interaction Sub Menu (Texture Window)

The following menu items appear only when in the texture window. The 

Interaction sub menu allows you to fine tune the performance of the inter-

face drawing engine for maximum results and throughput. 

There are four items in the Interaction Sub Menu:

• Update Time…
• Full Monty
• Drop Data
• Drop Quality

Update Time… This option brings forth a dialog which will allow you to 

set the amount of time that the Drop Data and Drop Quality modes use as 

their threshold values.

Full Monty. This mode will draw everything, regardless of the setting 

found in the Update Time value. Hey, what you see is what you get.

Drop Data. This mode will skip parts of the object in order to keep up with 

your interaction with the program. Depending on the speed of your com-

puter, you may not notice this too much.

Drop Quality. This mode will continue to drop the drawing quality of the 

model, until it can keep up with you. This mode can be somewhat discon-

certing to start with, but you get used to it. 
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Options Sub Menu (Texture Window)

The options sub menu allows you to select aides which can help in the 

application of your texture maps. 

There are four items listed in the Options sub menu:

• Cull Back Faces
• Use Lights
• Show Normals
• Texture Shading

Cull Back Faces. This mode will speed up drawing by as much as two 

times, as the polygons which do not face the viewer are removed 

(“culled”.)

Use Lights. This mode is active only when the Shaded options are selected. 

This mode allows you to view the texture with normal scene lighting.

Show Normals. This mode will draw lines along the direction that each 

polygon is pointing. If there is a problem with the normals of a particular 

polygon, it will be evident when examined with this feature, and appear as 

a normal pointing in a direction opposite that of the neighboring polygons.

Texture Shading. The default presentation of the texture map on the sur-

face of the model is “fully lit,” as if you were viewing the texture in a paint 

program. The default method can hide detail at times, so we created this 

option for you to use when you need to see some surface definition when 

you are applying your texture map.

In addition to the items covered in the Texture Window version of these 

menus, there are three other options that are found in the World and Cam-

era View versions of these menus. These options are:
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• Display None
• Display Lights
• Display Paths

Display None. This mode will draw nothing in the view. Hey, you never 

know.

Display Lights. This mode will draw the lights in the view. You can turn 

off the lights to hide the clutter, or speed up the shading performance of the 

view.

Display Paths. This option will toggle the display of motion paths in the 

view.

1.5 The Camera Scene Object

The camera is what records the scene. It is actually three connected pieces, 

as shown in Figure 1.2: the body, which is the focal plane; the view vector, 

which is a line indicating the view direction; and the reference point, which 

determines the actual point at which the camera is looking.

• Dragging on the body changes the position of the camera, but not 
where it is looking.

• Dragging the reference point changes where the camera is looking but 
not its position.

• Dragging the view vector keeps the orientation of the camera the same, 
but changes the camera’s position and where it is looking.
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One of the most common mistakes of new Universe Animator users is employing 

too much camera motion. This is due to the fact that the camera is so easy to ani-

mate. Camera moves should be slow and deliberate. Otherwise, a “digital whip-

lash” effect occurs, the main result being that all your friends and associates will 

know that you are not a professional camera operator.

Aspect Ratio

The aspect ratio is the shape of the rendered image, expressed as width 

over height. The clear rectangle represents the area of the image which will 

be rendered; the grayed out portion of the view is just outside the camera’s 

rendering area (which is how motion picture and television cameras actu-

ally operate).

In the movie industry, there are many different aspect ratios in use. Uni-

verse Animator has menu items for the most popular aspect ratios used for 

production. You can also enter your own.

Figure 1.2 — The camera icon
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Focal Length and Field of View

Directly influenced by the aspect ratio is the focal length, also known as the 

field of view. The focal length works the same in Universe Animator as it 

does for an actual camera. It can represent any lens type. There are two dif-

ferences between Universe Animator and a real camera: You do not have 

keystone problems (which are vertical line distortions due to the spherical 

nature of the real lens), and you do not have fisheye distortion problems at 

extremely wide focal lengths.

You may also use the field of view feature if that suits your needs. The field 

of view is expressed as an angle. For instance, a 35˚ field of view with the 

aspect ratio set to 35mm slide would equate to a 60mm lens on your slide 

camera.

Yaw, Pitch and Roll

As mentioned previously, all objects in Universe Animator have an orienta-

tion. When referring to the camera, this orientation is called yaw, pitch and 

roll, which work the same for the camera as they do for the rest of the object 

classes in Universe Animator. Yaw equates to the Y axis, pitch equates to 

the X axis, and roll equates to the Z axis.

1.6 Light Objects

Lights are the class of objects which illuminate a scene. Universe Animator 

always adds a 100% white light with an intensity of 1.00 to your project as a 

default every time you create a new project, and any new light that you 

add has these same values. Lights have no physical properties as a model 

would have.
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It is important to remember that the use of too many bright lights can overexpose 

the scene, in the same manner as when photographing a scene for film or video. If 

you experience this, you can drop the intensity of some of the lights. It is a common 

practice for only one or two lights (called the “keylights” in the production indus-

try) to be near full brightness. The other lights are usually adjusted to set a mood 

in the scene.

Lights in Universe Animator can be set to any one of 16.8 million colors. 

You can also animate the color of a light, and, depending on the particular 

type of light, you can even adjust the effective range of the light, called the 

“dropoff,” and the inner and outer cone angles of the light. Wherever lights 

overlap each other, their colors will add together, producing a different 

color, just as with their real world counterparts.

There are six light types in Universe Animator:

• Radial
• Parallel
• Spot
• Tube
• Ambient
• Camera

These light types can be mixed and matched together in order to achieve 

dramatic lighting effects.

Radial Lights. Radial lights cast light rays out from their centers in all 

directions. These rays act like the spokes of a bicycle wheel, but in a spheri-

cal area. Radial lights most closely resemble artificial lights, like those 

found in your home.
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Parallel Lights. Parallel lights cast parallel rays. Parallel lights are analo-

gous to stars (such as the sun). There is no real beginning to a parallel light. 

Objects lit by parallel lights will be evenly lit, unlike the other light types.

Spot Lights. Spot lights work just like real spotlights. You can adjust the 

inner and outer cone of the spotlight, as well as the dropoff distance. You 

can also animate these attributes. Spot lights are great mood enhancers for 

a scene and offer the greatest amount of control.

Tube Lights. Tube lights are basically elongated radial lights. You can 

adjust the length of the tube and, by enabling fog or glow special effects (as 

explained on the next page), create such visual elements as fluorescent 

bulbs, laser beams, etc.

Ambient Lights. Ambient lights add an overall brightness to a scene 

regardless of the orientation of the surface relative to the other lights. 

Experimenting with ambient lights will give you the best indication of their 

usefulness to you. 

Camera Lights. Camera lights are radial lights which are attached to the 

front of the camera, always illuminating the area in front of the camera.
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Animating in Universe

To successfully create 3D animation in Universe Animator, you must learn 

a few basic concepts about how 3D animation works, about the animation 

tools included with Universe Animator and the Universe workflow 

between Universe Modeler, Universe Animator and Universe Camera. 

Universe allows you to animate objects over time: model object files (and 

their groups or layers), cameras and lights. The following discussion 

applies to all of these object types.

1.7 What is an Object?

An object is any item which is an independent entity in the scene. An object 

can be a model file that you import, a scene camera and a scene light. 

Model files consist of a collection of sub-objects called groups in Universe 

Animator (some programs refer to them as layers).

Scene cameras and scene lights are system objects. They exist in 3D space, 

but contain no real volume, with some lighting effects as exceptions to this.

Model files and groups are a collection of points, lines and polygons, and 

are combined with shading and material information at render time. These 

points, lines and polygons make up the overall shape that you perceive the 

model to have.

Note Objects created in Universe Modeler are actually solids, surfaces or subdivision 

surfaces. You must convert them to the FACT polygon format in order for them to 

be used by Universe Animator.
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1.8 What Can You Do with Objects?

Objects are what you animate in Universe. The type of animation allowed 

depends upon the particular object, but here is a general list of ways to 

interact with (and animate) objects: 

• Import Model Files into the project
• Select (implicitly)
• Move (translate)
• Rotate
• Scale (models only)
• Animate
• Create Hierarchies
• Deform (models only)
• Morph (models only)

1.9 Importing Models into Universe Animator

A “model” is an object file on disk which uses polygons to describe its 

shape. Models can be created in Universe Modeler, or other 3D programs 

(Universe Animator does not create models directly, with the exception of 

3D text). Universe Animator requires that all of its models be imported into 

the FACT format, which is the ElectricImage model format. If you model in 

Universe Modeler, you will need to export your model in FACT format 

from that application, as it uses a different internal format than Universe 

Animator. Universe Animator can import the following model types:

• Lightwave (.lwo I & II)
• 3-D Studio (.3ds)
• Autocad (.dxf)
• Maya (.obj)
• ElectricImage (fact)
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To import a model into Universe Animator:

1. Choose Object>Import Object from the main menu bar
2. Pick the file you wish to import from the file list

The file will be imported into the scene. Once that is complete, the 

import dialog will appear again, prompting you for any additional 

model files to import.

3. Choose any additional models, or press the Done button to close the 
dialog

3D Text Models

Although you cannot create models in Universe Animator, you can create 

3D text from PostScript type one and True Type fonts, which is the type of 

font that you use with a laser printer or typesetter. You can create text with 

depth, bevels and separate face groups for material mapping.

1.10 Selecting Objects Implicitly

In Universe Animator, objects are selected by the particular tool that you 

have chosen. In other words, you pick the tool, and then you pick the 

object.

1.11 Moving (Translating) Objects

The translate tool is the default animation tool in Universe Animator. When 

you select an object to translate with the translation tool, the translate 

manipulator will be activated.

Translate Manipulator. The translate manipulator is used move objects in 

the world. The manipulator can limit motion to just one axis, or all axes at a 
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time. The manipulator is constructed of a yellow wireframe box at the ori-

gin of the manipulator (which is placed at the pivot point of the object) and 

three axis lines, radiating from the center outwards, each capped by a cone. 

The X axis is drawn as a red line. The Y axis is drawn as a green line. The Z 

axis is drawn as a blue line. Selecting any of these axes will cause motion to 

be limited to that axis. The selected axis will be drawn in yellow to indicate 

that it has been selected. 

1.12 Rotating Objects

To rotate objects in Universe Animator, select the rotate tool. Then, select 

the object to rotate. If you select the parent object of a hierarchy, then all of 

the objects will rotate along with the parent (assuming the objects have 

their inherit rotate attributes active, which is the default). If you select mul-

tiple, separate objects (that do not share a hierarchical relationship), each 

object will rotate about its own center.

Rotate Manipulator. The rotate manipulator is used to rotate objects. Rota-

tions for objects always occur in the local space of the object. The rotate 

manipulator is an “arc ball” and drawn as a series of offset spheres or arcs, 

each axis a different color. Unlike the translate and scale manipulators 

which have only three axes, the rotate manipulator has four. The X axis is 

drawn as a red arc. The Y axis is drawn as a green arc. The Z axis is drawn 

as a blue arc. The view planar axis is drawn as a cyan circle. Selecting any 

of these axes will cause rotations to be limited to that axis. The view planar 

axis will always rotate the selected objects along the depth axis of the win-

dow plane. The selected axis will be drawn in yellow to indicate that it has 

been selected.
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1.13 Scaling Objects

To scale objects in Universe Animator, select the scale tool. Then, select the 

object to scale. If you select the parent object of a hierarchy, then all of the 

objects will be scaled along with the parent (assuming the objects have 

their inherit scale attributes active), maintaining the scaled distance 

between children. If you select multiple, separate objects (that do not share 

a hierarchical relationship), each object will scale to its own center point.

Scale Manipulators. The scale manipulator is used scale objects in the 

world. The manipulator can limit scale to just one axis (non-uniform scal-

ing), or all axes at a time (uniform scale). The manipulator is constructed of 

a yellow wireframe box at the origin of the manipulator (which is placed at 

the pivot point of the object) and three axis lines, radiating from the center 

outwards, each capped with shaded balls. The X axis is drawn as a red line. 

The Y axis is drawn as a green line. The Z axis is drawn as a blue line. 

Selecting any of these axes will cause motion to be limited to that axis. The 

selected axis will be drawn in yellow to indicate that it has been selected. 

1.14 Configuring Manipulators

The size of the manipulator is not related to the size of the object which is 

using it. This allows you to scale the manipulator to the working size that 

you prefer. All manipulators use the same size value, so when you change 

the size of the translate manipulator, you are also changing the size of the 

rotate and scale manipulators.

The manipulator’s display can be controlled from the Edit>Display>Con-

troller menu item in the main menu bar. You can control the size of the ele-

ments that control the origin (yellow wireframe box) and the end caps 

(shaded cones for translate, and shaded balls for scale). You can also control 
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the line thickness of all line elements (vectors for translate and scale, and 

arcs for rotate).

1.15 Animating Objects

Animation is what Universe Animator is all about. You can choose to do 

simple little animations, or complex creations that rival blockbuster movie 

effects. What you get out of it is based on what you decide to put into it. 

Universe operates under some important core concepts. These core con-

cepts, when understood, will help you to apply the best approach to the 

animation that you are creating. 

Remember, you are always animating objects. Animation is a record of the 

changes to an object that occurs over a period of time. These objects have 

attributes that can be animated. Objects can be joined together to form 

more complex assemblies. Objects can be modified by deformations and 

morphs. Once you understand these basic concepts, animating in Universe 

will become easier:

• Time is used to control when something happens
• Keyframe events are used to control where something happens
• Animation channels are used to control the rate at which something 

happens
• Object hierarchies are used to control how many objects will be ani-

mated, and what attributes may be animated
• Deformations are used to control other aspects of how something hap-

pens
• Morphing is used to blend different model files of the same basic data
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Time Line

To create an animation, you use the tools Universe Animator supplies tools 

to move, rotate, scale, deform, or otherwise move or change an object over 

time. Universe Animator uses a combination of time and events to animate 

your objects. Universe Animator uses the time line to sample “snapshots” 

in time called “frames” and then uses these frames to render final images 

and movies. 

The time line is a scale of time that you set for the duration of your project. 

The time line is available in either the project window, or the time palette. 

Within the time line is the time slider. To change the scene time, you just 

drag the slider to the desired time. You can go forward or backward at any 

time.

You are in control of the amount of frames that are sampled over a period 

of time. This control is called “frames per second.” You can think of this as 

sort of a “level of detail,” as you can resample the time line into a different 

amount of frames per second as needed. As you create events, you advance 

the time slider to the next moment in time that you want something to hap-

pen. You then create the next event.

Key Frames

These events are called “key frames.” Universe Animator then “interpo-

lates” these key frames, adding extra information between each key frame 

that you set. When you playback your animation, you see a combination of 

your key frames and interpolated frames. Key frame events are the rough 

points of a motion or attribute change. You do not need to set a key frame 

for every frame in your scene, nor should you. Instead, you want to “rough 
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in” your performance, refining keyframes and adding new ones as neces-

sary to get what you want.

Creating

Keyframes

Key frames can be created automatically whenever you change something 

that hasn’t been changed before, or you can create them yourself by hand.

To create automatic key frames in Universe Animator:

1. Select the object you wish to animate
2. Choose Animation>Enable Animation from the menu bar

This will activate the animation channel for the object (see the follow-

ing section for an explanation of animation channels.)

3. Drag the time slider to a different time
4. Move the object (or rotate, scale or otherwise change an attribute of the 

object)

A key frame will be created. 

5. Advance the time again
6. Move the object again

Additional key frames will be added to the project.

To check your work, press the preview button, or open the project window 

and note that a new keyframe has been placed in the data panel of the win-

dow.

Animation Channels

If you don’t set a key frame, you will not see any change in motion. If you 

change an object’s attributes without activating the animation channel for 

the object, you will not see any change in motion. Instead, the last change 

you made on the object will be all that you see.
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Animation channels are used to hold the information that you create when 

you animate. They are effectively “motion containers.” To save space and 

speed the performance of a project, animation channels are typically turned 

off. You can easily turn them on, just by selecting the object you wish to ani-

mate, and then choosing Animation>Enable Animation in the main menu 

bar.

1.16 Motion Path Curves

When you animate the position of objects in Universe Animator, you will 

see a motion path curve appear. This is the path of motion that the object 

will follow. There are two classes of motion paths, implicit and explicit.

Implicit Keyframe Paths

If your object is set to animate its position with an implicit curve, the curve 

will run through each position key frame that you have set for the object. If 

you click on any keyframe point along the motion path, the scene time will 

be set to the time of the keyframe that you selected, and you will be editing 

that keyframe.

There are four different spline types available for implicit motion paths: lin-

ear, natural cubic, Hermite and Bezier.

Linear Splines. These are not actually splines, but rather a simple line. All 

motion using linear interpolation results in a very mechanical (sometimes 

awkward) motion.

Natural Cubic. These splines give a very fluid motion, and are the best to 

use if you do not care about the precision of object placement, since editing 

one keyframe along the spline will change the whole curvature of the 

spline.
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Hermite Splines. These splines are more versatile to use but require 

greater effort to control. Unlike the natural cubic spline, editing one key-

frame along the spline will not change the whole curvature of the spline, 

and thus the curve can be manipulated with greater precision.

Bezier Splines. These splines are the same splines used by popular Macin-

tosh drawing programs such as Adobe Illustrator®, however Universe Ani-

mator Bezier splines are 3-dimensional.

Spline paths can be edited at any time. You can also edit the tension, bias, and con-

tinuity attributes of Hermite splines.

Explicit Motion Curves

Explicit motion curves are different than implicit curves. These curves are 

combined plots of separate X, Y and Z position data curves. There is no 

provision to edit the shape of the curve in the 3D views. Instead, you must 

edit explicit curves in the function curve editor.

To set an object to use explicit translation curves:

1. Select the object
2. Choose Object>Group Info (command or control “i”) from the main 

menu bar

The object information window will appear

3. Choose the X-form tab in the window if it is not already visible
4. Under the position heading, choose “Explicit” from the key popup 

menu

The curve is now changed to an explicit motion curve. The path curve will 

be drawn without any form of keyframe markers.
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Note Explicit path curve shapes are harder to control than implicit path curves, as you 

can edit those directly. If the shape of the path is important, try using implicit 

curves set to bezier, and make adjustments as needed. Then, you can convert to an 

explicit curve and finish the editing in the function curve editor.

1.17 Object Hierarchies

Object hierarchies are used to control what objects are connected together, 

and what objects are animated within that relationship. The hierarchical 

relationship between objects is often expressed as parent/child. To under-

stand what a hierarchy is, just examine you own hand. Each finger joint is 

attached to the next one, as the chain that is a single finger heads toward 

the wrist. Each finger travels through the palm area and forms a nexus with 

the other fingers at the wrist. The root of the hierarchy, forming the base, is 

the wrist/palm. The root, or parent, has the fingers attached to it, joint by 

joint. The fingers are said to be the children, grandchildren, and so on for 

each joint, down to the finger tips. This is a basic hierarchy.

Object hierarchies can be animated directly, using what is called “forward 

kinematics” or they can be attached to skeletons and animated in a fashion 

more like human motion, using what is called “inverse kinematics,” which 

is covered in the following section.

Forward Kinematics

Using the typical swing arm lamp as an example of a hierarchy containing 

five joints (base, arm 1, arm 2, lamp shade), animating this hierarchy one 

joint at a time to make the arm swing around is how forward kinematics is 

applied. You are responsible for animating each joint to get the perfor-

mance you require. Forward kinematics are great for straightforward ani-

mation of fairly simple hierarchies.
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1.18 Inverse Kinematics

Using the swing arm lamp example again, you can imagine the same hier-

archy as a simple “IK chain,” which is just a fancy way of controlling the 

hierarchy as a single unit. With an IK chain, you merely adjust the end of 

the chain, in this case, the lamp shade, and the rest of the joints will move 

accordingly. Of course, IK chains can be applied to more complex hierar-

chies, such as organic characters like animals, humans and even aliens!

IK chains are actually a series of bones or skeleton joints, with an IK handle 

applied to control them. An IK handle is a special controller that manages 

the motion of the chain to which it is attached. You move and animate the 

IK handle, not the bones or skeleton joints directly. 

IK handles are scene objects, as such they do not render. IK handles have 

their own information window, which is activated in the following ways:

• Selecting the IK handle and then choosing Object>IK Handle info

• Double-clicking on the IK handle

Figure 1.3 — IK Handle Information window, Properties tab
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The IK Handle information window has three tabs:

• X-form
• Properties
• Chain

X-form tab. The x-form tab contains all of the transform information for the 

IK handle. You can use this tab to reset the position of the IK handle during 

an animation, especially if you “parked” the IK handle prior to animating.

Note You can only apply object parking (Hierarchy>Park) to objects that are con-

tained within a hierarchy. If you attempt to apply the Park command to 

objects outside of a hierarchy, strange things can happen...

The x-form tab contains numeric entry edit boxes for translation, rotation, 

and scale. The translation and rotation edit boxes are applied in a manner 

similar to all other objects. 

Tip The scale attribute is applied to the size of the selection handle for the IK 

handle. If you are having trouble selecting the IK handle, change the scale 

value to suit your needs.

Properties Tab. The properties tab controls the attributes of the IK handle. 

You can choose what type of IK solver is applied to the handle; set the pre-

ferred angle, pole vector location and twist of the handle; and choose 

which type of goal will be used by the IK solver.

There are three types of IK solvers in Universe Animator:

• Pseudo
• Minimizer
• 2 Bone
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In a character set up, your skeleton rig will have many separate chains. In a 

human, for example, you will have chains for each arm and leg, each finger 

and the spine. You can also add chains for the head and mouth, and the 

feet. These chains are typically (although not always) controlled by an IK 

handle, and that IK handle will use a solver to produce a result.

An IK solver is a method to determine how the IK solution will be calcu-

lated for the specific chain that you are working with. Which solver works 

the best is a matter of choice on your part. A solver works by finding the 

best IK solution to apply to a chain within the parameters that you specify. 

Typically, most of the chains used for a human character would be planar; 

that is, the motion of the bones in the chain would tend to lie on a plane. 

For example, the human arm consists of several bones: the humerus, which 

extends from the shoulder to the elbow and comprises the “upper arm”; 

and the ulna and radius bones, which extend from the elbow to the wrist, 

comprising the “fore arm.” The direction of travel for the arm is led by the 

wrist/palm. If you were to “connect the dots” from the tip of the humerus 

through the elbow, on to the end of the ulna/radius, and back to the tip of 

the humerus at any point of motion for the arm, you would have a planar 

triangle. The IK solvers know that, and can limit the amount of work that 

they have to do to allow only planar solutions for the motion generated by 

the IK handle.

Each solver attempts to find a solution in a slightly different way. The 

pseudo solver uses linear approximation to quickly find an IK solution. The 

minimizer solver will minimize the amount of unacceptable solutions pos-

sible, and then pick a result. The 2 bone solver with apply geometric analy-

sis to find a solution. It only works with chains of two bones in length, and 

will lock any additional joints.
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You will find that you have the best results with either the pseudo or 2 bone 

solvers (any chains consisting of only 2 bones will automatically use the 2 

bone solver). The minimizer solver can sometimes cause the end effector to 

be in a position other than the explicit endpoint defined by the IK handle.

Preferred

Angle

The preferred angle indicates the desired direction preference of the IK 

chain. This value will help the solver to find an accurate solution quickly. 

To improve the results, the preferred angle should be clear and non-ambig-

uous. This is accomplished by creating or manipulating the shape of the 

chain to clearly show an angle, such as an elbow or knee bend. To set the 

preferred angle for the IK handle, click the Preferred Angle button.

Chain. The chain tab contains a list of all of the joints and bones under the 

control of the IK handle. You can access the bone or joint directly by double 

clicking on the name of the joint in the chain list.

To apply an IK handle to a bone or joint chain:

1. Select the end of the chain (if you want to apply an IK handle to the 
entire chain) or choose the beginning and end joint to be controlled by 
the IK handle (if you want to apply the handle to a subset of the chain)

2. Choose Character>Add IK Handle from the main menu bar

The IK handle will be added from the end of the chain to the beginning 

of the chain (called the “root.”) The handle will be listed as an object at 

the end of the object/channel list in the project window.

Once you have create an IK handle, you can use that handle to manipulate 

the chain underneath. If you happen to make any change to the chain that 

would affect the rotation axes (used by the IK handle) directly to the bone 

or joint, those changes will be lost the next time you use the IK handle.
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In order to animate the IK handle, you must select the handle and choose 

Animation>Enable Animation from the main menu bar. Once you enable 

the animation record for an IK handle, the handle will maintain its position 

in space, as opposed to moving with the rest of the hierarchy. That is 

because the handles are located in global space by default. If you require a 

handle to move with the rest of the skeleton, you can imbed the handle into 

the hierarchy at the appropriate location. 

Pole Vector and Twist Disc

The pole vector controls the direction in which the IK reference plane is ori-

ented, and is used to keep the IK chain from flipping 180˚ on its axis. This 

happens when the pole vector has crossed the IK handle vector, or is point-

ing in the opposite direction (which can happen frequently). To control axis 

flip, you must activate the pole vector (enable the Show Pole Vector check 

box), and make sure that it doesn’t cross the IK handle vector, or point in 

the opposite direction of the IK handle vector. To change the position of the 

pole vector, click and drag on the box at then end of the vector.

Figure 1.4 — Bone chain, with IK handle parts illustrated

Pole Vector

IK Handle Vector

Twist Disc
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The twist disc control is used to control the orientation of the IK joint plane, 

which is separate from the reference plane controlled by the pole vector, 

even though the end result appears to be the same. While the pole vector is 

used to keep the IK solution under control, the twist control is used for the 

purposes of performance. To keep things simple, use the pole vector to con-

trol axis flip, use the twist disc for everything else that requires orientation 

of the IK joint plane.

Hierarchies or No Hierarchies?

Do you need to create hierarchies to animate? Of course not. Whether or 

not you need a hierarchy depends entirely on what you are trying to ani-

mate. However, as you gain more experience in animation, you will likely 

apply a hierarchy to almost anything you animate with more than one 

component.

1.19 Deformations

Hierarchical animation will allow you to create complex assemblies and 

animate them easily, but you are limited to “rigid bodies” with hierarchical 

animation alone. You could not have a single arm model bend at the elbow 

without some additional help. That’s where deformations come in.

Deformations are volumetric regions attached to objects which allow you 

to distort the shape of an object in a variety of ways. They can be applied, 

singly or in combination, to specific regions within a group, individual 

groups within a model, and can optionally affect other groups within the 

model. Deformations can also be animated. For example, you could take a 

model rectangle and ripple it like a flag in the wind. Or you could make a 

figure’s body parts bend and twist to simulate natural arm, leg and head 

movement.
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Deformations can be used with inverse kinematics to automatically create 

deformable skins. Using what is called a “bone deformation,” the skins that 

are parented to the same root as the bone skeleton can bend the skin along 

with the bone skeleton as the skeleton is animated (this works with inverse 

or forward kinematics.)

In Universe Animator, deformations can be applied in layers, in a hierarchi-

cal, cascading fashion. The order in which a deformation is applied to an 

animation is important, and Universe Animator will let you adjust the 

order of deformations to get the proper effect.

Deformations are a group-based tool. They are applied as a group attribute, 

although they can affect children groups if the children of the parent to 

which the deformation is applied are set to inherit deformations. 

Deformation Regions

Deformations are applied to groups and are bound by regions. Regions are 

boxes which surround the group. The group portions within the region will 

be affected by the deformation. Those portions outside of the region will 

not be. This behavior will allow you to put a small-radius bend into a cylin-

der, or bend the entire cylinder.

Regions can be animated, and then can be attached to null effectors as well 

as geometry. This allows for some very powerful effects. For example, if 

you create a null effector (a placeholder object that does not show up in 

rendered imagery) and attach a deformation region to it, parent a cylinder 

object to the null and set inherit deformation for the cylinder, then drag the 

cylinder through the null effector, you will see the cylinder deform as it 

passes through the null. As the cylinder passes outside of the null’s influ-

ence, its normal shape will return. 
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Types of Deformations

There are twelve different deformation types available. Each of these defor-

mations is suited to a particular task. In order, they are:

• Scale
• Shear
• Twist
• Taper
• Bend
• Bulge
• Linear wave
• Circular Wave
• Stretch
• Bezier
• Bezier II
• Bones

To apply a deformation to a group:

1. Select the group, by either clicking on it in the world views or selecting 
its name in the Project window.

2. Choose Animation>Deformation Editor from the main menu bar

The Deformation Editor opens.

3. In the Region section, click on the Add button

A new deformation region will be added to the group.

4. In the Deformation section, click on the Add button
5. Choose the type of deformation from the Type menu.

The deformation will be added to the group.
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Different deformations have different controls. Some deformations have 

special options, which are available in via the Options... button. All defor-

mations require that you set the direction axis (or axes) and the deforma-

tion axis (or axes). You can interactively set the strength of the deformation 

in the 3D views, or you can enter a value for the deformation strength in 

the amount edit box.

You can limit the effective area of deformations by enabling the check 

boxes in the minimum and maximum sections. This controls the deforma-

tion region to which the deformation is applied. You can choose to limit just 

a few axes, or all axes, based upon which check boxes you enable. If no 

check boxes are enabled, the deformation will not be constrained.

Note While the deformation editor is active, no other functions will be available. 

In order to set a new rotation or translation on the group, you will need to 

close the editor before you proceed (placing the editor in the background 

will have no effect). Deformation editing can be accomplished only when 

the editor is open.

1.19 Morphing Model Poses

Deformations change the actual geometry of the model, but morphing uses 

model poses to create new, in-between poses. What technique to use is 

based largely upon the task at hand. For facial animation, it is hard to beat 

morphing. In fact, it has been the favored method of facial animation for 

some time now. The upside to morphing is that it is very easy to under-

stand and learn to use. The downside is that you must create different vari-

ations of the model, typically called poses, in order to use morphing. 

Depending upon your modeling skills and your patience, you will have 

more or less success with morphing.
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Morphing models is very similar to “replacement animation,” a technique 

often used by claymation animators (and a technique offered by Universe 

Animator). These models must have the same amount of polygons in order 

for the process to work properly. Morph models are actually separate disk-

based model files. These model files are loaded into the morph editor. From 

there, you use slider bars that has the morph editor blends the different 

model poses together, creating a new pose altogether. 

Facial animation is the most common use for morphing, but you can use it 

for any model that you wish to morph. For example, you could animate a 

bird flapping its wings, or perhaps a pair or “rabbit ears” (an old fashion 

set top TV antenna) reacting with anthropomorphic character. Whatever 

you choose to morph, make sure that you have enough in between poses 

created. Unlike deformations, a morph target will tend to progress in a lin-

ear fashion. You can control the timing of the morph with a spline curve, 

but the morph itself will be direct (that is, linear.) So, it you are morphing 

things other than facial features, be sure to include an additional pose or 

two for extreme motion, to help make the motion appear more realistic.

1.20 Modifying Values in Edit Boxes and Cells

When animating in Universe, you can interact with the program numeri-

cally or directly in 3D. Working numerically, which you will do from time 

to time, Universe Animator allows you to enter relative values and percent-

age changes based upon the existing value in an edit box or cell.

Edit boxes support two types of value changes: relative offset and percent-

age. 
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Relative Offset Value Changes

Relative offset value changes alter each selected item by adding, subtract-

ing, multiplying, dividing or taking to a power. A change of +25 would add 

25 to the current value in the edit box or cell.

Percentage Value Changes

Percentage value changes alter the selected item by computing a specified 

percentage to each value individually. A percentage change of 150% would 

make the value 1.5 times its current value.

Applying Value Modification

Relative offset and percentage changes are applied by entering simple for-

mulas in data cells or edit boxes. The syntax of the formula is:

@ symbol amount

where @ means the current value of the cell, and symbol indicates an opera-

tion to be performed, and amount is the numeric offset or percentage. For 

example, @*7.6 results in the cell’s current value being multiplied by seven 

point six.

The formulas you enter are not retained by Universe Animator. They are immedi-

ately processed, and the result is placed in the edit box or data cell.

The following symbols are supported:+,-, *, /,^and%. In addition, two 

other symbols,! (for negating the value of the edit box) and # (to set the 

absolute value).
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1.21 Surface Attributes

Surface attributes (which apply only to models) define the color, diffuse, 

specular, reflectivity, transparency, luminosity, and edge density of the 

model’s groups. Surface attributes, taken together with texture, reflection, 

bump, and transparency maps, make up the overall appearance of the ren-

dered model. The Material Editor is used to set the surface attributes of 

your models. 

1.22 Sound Synchronization

Universe Animator allows you to import an unlimited number of sound 

tracks from the many different popular sound editing programs, or record 

directly from the microphone. Sound frequency import range is from 5KHz 

to 64KHz, and sound track wave forms are displayed directly in the Project 

window. The sound tracks are automatically parsed and sounds are 

assigned to every frame. Synced animations can be previewed in real time 

and saved in Quicktime format. Universe will add sound only to the 

Quicktime format.

1.23 Tool Palette

The tool palette contains a collection of tools that give you access to most of 

the object manipulation functions in Universe Animator, as well as motion 

path and grid control. All of the selections in the tool palette are available in 

the main menu bar, as well as several other locations.

1.24 The Project Window

Recognizing that different animators work in different ways, Universe Ani-

mator allows you to animate in an event-based time system and/or by an 
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explicit frame-based system. Both approaches use the keyframe paradigm, 

which harkens back to the days of traditional cel-based 2D animation. You 

can animate in either system or both, and each has its strengths and weak-

nesses. Taken as a combined whole, however, this approach provides you 

with the most powerful and flexible tools available in any animation sys-

tem.

The Project window is where you set the animation modes (e.g., Time, Key-

frame, etc.), and where you can observe and animate all of the attributes 

within the project file. In Time mode it provides a graphic time scale on 

which to set events.

Events can also be synchronized to sound tracks, which are represented in 

graphic form.

In the other modes, such as Keyframe mode, it provides a complete over-

view of the project in a format resembling a spreadsheet, and you could 

specify and animate virtually all attributes of the scene from this one win-

dow if you wished to.

Because there can be a very large amount of information in a project file, 

the Project window is programmable. It is broken down into several sec-

tions and each section can be collapsed to shrink the size of the window for 

convenience.

Groups and lights can be renamed in the Project window and frame data 

can be edited by directly keying in values.

The Project window also contains a palette with tools and pop-up menus 

for performing various operations on frame data such as cycling a range of 

frames and creating a blend between two frames (many options are avail-

able).
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The Joint Editor

This window is where you can assign joint types for a model’s groups’ hier-

archy (controlling how the model’s groups move in relation to each other).

There are many options for setting how a group can move (i.e., rotate, 

swivel, etc.), by itself and in relation to other groups in the same model. 

The data contained in the edit boxes are in local coordinate space.

The Render Information Window

This window is where you specify how your animation or image is to be 

rendered, such as how many and which frames to render, how large your 

rendering should be, and the level of quality you wish your rendering to 

have.

The window’s check boxes are used to selectively enable or disable render-

ing effects for controlling the efficiency of the rendering process (i.e., it may 

not be necessary to perform a full rendering if you are testing a single ele-

ment of a scene).
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1.25 File Management

Universe Animator and you are responsible for managing the many differ-

ent kinds of files that you will use to create your work. The types of files 

that Universe uses are:

• Project Files
• Model Files
• Material Files
• Texture Files
• Sound Files
• Channel Envelope Files
• Plug-in Files

Universe Animator maintains a directory structure for the most common 

files that it uses. After you install Universe Animator, several directories are 

placed within the directory that Universe Animator has been installed into. 

These directories are:

• EI Material
• EI Resources
• EI Shaders
• EI Snapshots
• EI Sockets
• Renderama Jobs

EI Material. This folder contains material descriptions that you create, save 

and load.

EI Resources. This folder contains resources that Universe Animator needs 

in order to operate. Do not remove this folder, or change its location.

EI Shaders. This folder contains all of the shaders that you have installed. 

Place any third party shaders into this directory.
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EI Snapshots. This folder is used to hold any snapshot renderings that you 

create during a session with the program. Once you exit the program, the 

snapshots in this folder will be deleted, freeing up disk space. If you wish 

to keep your snapshot renderings, you will need to set the preference. 

Choose Edit>Preferences>Preview & Render tab, snapshot section, and 

enable the Make Image Permanent check box. If this check box is enabled, 

snapshot images are then placed within the home directory of Universe 

Animator, and not within the EI Snapshots directory.

EI Sockets. This folder contains all of the plug-ins that you have installed. 

Any plug-in not installed into this folder will not be available to the pro-

gram.

Renderama Jobs. This folder contains the job information for any network 

rendering that you have initiated.

Any other files not covered by these categories can be placed anywhere, 

although it is recommended that you follow a logical structure. You may 

wish to keep all of your bitmaps in the same directory, or you may wish to 

place them within directories that are specific to the project you are work-

ing on. The same holds true for model files.

Note Should you need to gather files used by a project together, you can use 

File>Collect Files... from the main menu bar. This command will collect all 

files that your project is referencing, and place them where you direct.
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Rendering and Raytracing

1.26 Introduction

Rendering and raytracing creates two dimensional pictures from the 3D 

information contained in the project file. When you set up your models, 

lights, and the camera, you are supplying the rendering engine with a three 

dimensional data set. That data set is fed to the rendering engine to be ren-

dered and raytraced as you have determined. The output of the rendering 

engine is either a single picture or a movie file.

Rendering and raytracing perform imaging tasks in different ways. Ren-

dering is like an artist or illustrator, capturing an impression of a composi-

tion. Rendering can easily produce photorealistic results, but you may be 

able to see that reflections and transparencies are not the same as those you 

would see in the real world. The benefit that rendering gives you is speed 

and image quality (in terms of anti-aliasing—see below.) The detriment to 

rendering is the setup time for simple things such as shadows, and the 

requirement that you plan ahead in order to optimize your speed benefits 

even further.

Raytracing is more like photography, in the sense that the raytracing engine 

will take a more accurate approach to imaging the scene, actually following 

beams of light as they exit the camera and voyage into the world (which is 

the exact opposite of what happens in the real world.) The images pro-

duced by raytracing can be nearly perfect, in terms of reflections, transpar-

encies and refraction, and more accurate (and easier to use) shadows. 

Unfortunately, as you can imagine, raytracing is a slow process, and can get 

much, much slower when dealing with very large scenes (in terms of poly-

gon counts.) Also, anti-aliasing can suffer, as a lower quality of filtering 
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must be used in order to keep imaging times within the realm of practical-

ity.

Hybrid Imaging

Universe Camera is a hybrid renderer/raytracer. Depending upon the 

material and shadow settings that you specify, either the renderer or the 

raytracer will be used. This test is applied on a channel-by-channel basis, so 

that raytracing is used only where it is needed. As raytracing is very time 

consuming, this discretion is mandatory to make it practical for legitimate 

production.

The raytracer inside of Universe Camera benefits from the legendary 

speed, efficiency and image quality of the renderer that preceded it. In the 

same amount of time as other raytracers, it can produce a higher quality 

image. It can also produce higher quality images is less time as other ray-

tracers, and you may find this result is typical for your use.

1.27 Shading

Renderers and raytracers produce images by a process called shading. 

Shading determines what color a particular pixel in an image will be.

Before a pixel can be shaded, it must first be mapped to a polygon. And 

before the pixel is mapped to the polygon, the polygons must be tested to 

determine which part of the polygon is visible (if at all). Shading only the 

visible portions of polygons reduces actual rendering times quite a bit, 

since the renderer is not shading what is not visible and is not wasting any 

time.

Each polygon contains at least one shading normal (a normal is a line or 

vector which indicates the direction that a polygon or vertex is oriented 
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towards). Vertexes which border polygons can also contain normals. These 

normals are used by the rendering and raytracing engines to properly 

shade the object. Without these normals, the objects would not be recogniz-

able.

Polygons can be shaded in several different manners, called algorithms. 

Universe Animator offers a choice of flat (also called “constant”), Gouraud, 

Phong and raytracing.

Flat Shading

Flat shading creates evenly filled polygons. It uses the single normal in the 

center of the polygon to determine a shade for the whole polygon. There 

would be no change of colors across the surface of a flat shaded polygon.

Gouraud Shading

Gouraud shading creates a graduated shade across the surface of the poly-

gon. It uses the normals located at the corners, or vertices of the polygon 

with which to shade.

This results in a very fast, smooth shade, but the highlights (reflections of 

the lights illuminating the polygon) look awful, so Gouraud is usually not 

used when rendering shiny objects.

Phong Shading

Phong shading also graduates the shading across the surface of the poly-

gon, but in a superior manner to Gouraud. It uses the normals at the verti-

ces of the polygon, but creates new normals in between the existing 

normals, creating a much more precise shade across the surface of the poly-

gon.
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Raytracing

Raytracing is a very precise shading algorithm. It uses polygon normals as 

do the other methods, but it precisely tracks rays from the viewer to the 

object (and any reflections), and ultimately to the light source. As a result, 

raytracing takes much longer to image a scene than Phong or any of the 

other methods. It will give you accurate reflections, refractions and shad-

ows, and should be used when you need those things. If not, use Phong.

1.28 Resolution

Universe Animator will let you render your images in resolutions up to 

32,000 pixels by 32,000 lines. You can even adjust the aspect ratio of the pix-

els in the image so that they better conform to video systems, or older 

graphics systems. The default resolution is set to the resolution of the mon-

itor on which you start up Universe Animator.

1.29 Color Depth

Universe Animator renders in 48-bit color space and then reduces it down 

to 32 bit color space. That means that every image you render can have any 

one of 16.8 million colors per pixel, plus any one of 256 values of transpar-

ency per pixel. This is often referred to as true color. There are also some 

black and white rendering modes available, which resemble the old black 

and white paint programs from the early days of computer graphics.

1.30 Anti-Aliasing

Anti-aliasing creates an image which appears to be a much higher resolu-

tion image than was actually rendered. It does this by creating “in-

between” colors for every pixel, by rendering the image at a higher resolu-
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tion and then shrinking it. Instead of throwing away pixels which don’t fit 

in the smaller space, these pixels are sampled together, and a new single 

pixel is derived. It may sound complicated, but all you need to know is that 

it significantly improves image quality, especially in animations. Universe 

has superior anti-aliasing, and produces higher quality results without the 

time penalty of other programs. 

Universe Animator offers scene and object anti-aliasing, and can be adjust 

to whatever sampling levels are required. Universe can anti-alias with an 

oversample method, which produces images that are better suited to 

motion and film, and an adaptive method, which offers more clarity and 

detail at lower resolutions than oversample.

1.31 Motion Blur

Motion blur occurs whenever the subject or the camera moves faster than 

film can record an image. Since motion blur does not occur in computer 

graphics, computer animation often lacks an element of reality (we expect 

to see motion blur). Universe Animator allows you to add motion blur so 

that the final image looks more like the real world.

Universe Animator offers two different types of motion blur which can be 

intermixed for maximum benefit: 2D motion blur (motion vector) and 3D 

motion blur (multi-frame.) Electric Image developed 2D motion vector blur 

in the early ‘90’s as an answer to the less that appropriate look of 3D blur. 

As both methods have their uses, Universe Animator offers both. In fact, 

you can have 3D blur set, and use 2D blur to smooth the results a bit (with 

just a little extra rendering time!)
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Main Menu Bar

This section will give a brief overview of each of the menus in the main 

menu bar, and their options.

File Menu

The file menu is used to open, save and create new projects, merge project 

files together, view images and animation files, collect files together that are 

used by the current project (so that they can be transferred to another 

machine or animator), view project statistics, launch Universe Modeler, 

and quit the Universe Animator application. The menu items are:

• New
• Open
• Merge
• Close Project
• View Image
• Save
• Save Project As
• Save Copy of Project As
• Collect Files
• Project Statistics
• (Launch) Modeler
• Quit

New. Creates a new project. 

(Cmd + N Mac, Ctrl + N PC)

Open. Opens an existing project. 

(Cmd + O Mac, Ctrl + O PC)
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Merge. Project... Merges another project into the current project.

Close Project. Closes the current project.

View Image. Displays image or animation in a separate window. 

(Cmd + B Mac, Ctrl + B PC)

Save. Saves the current project under the same name. 

(Cmd + S Mac, Ctrl + S PC)

Save Project As... Saves the current project under a different name and 

switches the working project to the one that was just saved.

Save Copy of Project As... Saves a copy of the current project under a dif-

ferent name. The current project is retained.

Collect Files... Collects all of the referenced files together in one location, 

and saves the project file to that location as well. Options include the ability 

to create separate folders for project elements. The project file is remapped 

so that it can be easily opened once a directory location is established.

Project Statistics. Brings forward a dialog box which provides all of the 

statistics for the project file.

Modeler... Launches the Universe Modeler. Will shot down the animator 

by default. If the control key is depressed when this option is selected, the 

Animator will remain open.

Quit. Quits the Universe Animator. 

(Cmd + Q Mac, Ctrl + Q PC)
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Edit Menu

The edit menu is used for undos, cutting, copying and pasting, clearing 

selections from the project, duplicating items, accessing Universe Animator 

preferences and setting the display attributes of controllers, manipulators 

and so forth. The menu items are:

• Undo
• Cut
• Copy
• Paste
• Clear
• Duplicate
• Preferences
• Display
• Default Preferences

Undo. Undoes the previous action. Only one level of undo is supported. If 

Undo is not supported for that action, Undo will be greyed out. 

(Cmd + Z Mac, Ctrl + Z PC)

Cut. Removes the selection and places it in the clipboard. It can then be 

pasted if desired into a target location. 

(Cmd + X Mac, Ctrl + X PC)

Copy. Copies the selected item for pasting purposes. 

(Cmd + C Mac, Ctrl + C PC)

Paste. Pastes the item in the clipboard to the selected destination. 

(Cmd + V Mac, Ctrl + V PC)
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Clear. Clears the selection from the project.

Duplicate. Duplicates the selected items. To have copies of objects or 

groups in the project window, this command is used. 

(Cmd + D Mac, Ctrl + D PC)

Preferences... Brings forward the preferences dialog.

Display. Brings forward separate dialog boxes for each menu item. Con-

trols the various display preferences for these items (Controllers, Lights, 

Cameras, Effectors, and IK Handles).

Default Preferences. Resets all preferences to their factory settings
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Object Menu

The object menu is used for any function that deals with objects as disk files 

(such as importing and exporting objects to and from the project), adding 

system objects (such as cameras, lights and nulls), adding 3D text, import-

ing and recording sound files, locking and unlocking objects, hiding and 

showing objects, and accessing the object info window for the selected 

object or group. The menu items are:

• Import Object
• Export Object
• Export Parked FACT Object
• Add Camera
• Add Light
• Add Null
• Add Smoke
• Add 3D Text
• Import Sound
• Record Sound
• Lock Selected
• Unlock Selected
• Hide Selected
• Show Selected
• Group Info

Import Object... Imports a model file into the scene. FACT format is 

default, but Universe does import a variety of other formats.

Export Object. Exports an object to a desired format. FACT format is 

default, but Universe does export a multitude of other formats.

Export Parked FACT Object. This export option will zero out rotation, 

position and scale data for a FACT file, and then saves it to disk.
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Add Camera. Adds a camera into the scene.

Add Light. Adds a light to the scene.

Add Null. Adds a null object to the scene. Nulls are drawn as three stroked 

objects like the IK handle goals.

Add Smoke. Places a smoke object in the scene

Add 3D Text. Creates a 3D font from a PostScript or TrueType font file.

Import Sound... Imports a sound file into the project.

Record Sound... Records a sound into the project.

Lock Selected. Locks object from the selection. It also sets the object lock 

flag to on in the project window.

Unlock Selected. Makes object selectable, sets object lock flag to off in the 

project window.

Hide Selected. Makes object invisible. This also makes it unselectable in 

the world views.

Show Selected. Makes object visible in the world views, selection depends 

upon the lock flag.

Group Info. Brings the info window up for the group selected 

(Cmd + I Mac, Ctrl + I PC)
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Plugin Menu

This menu lists all the plugins that are installed for Universe. Many 3rd 

Party developers have created Plugins and shaders to extend the capabili-

ties of Universe. Some plugins such as “Light Flare” are special interface 

plugins, which are accessible in other areas of the program. As a result, 

they are not listed in the plug-ins menu. 

Note All Universe Animator plugins listed are cross-platform, and will operate 

consistently. You can use these plugins, and the aforementioned lens flare 

plugins (Lens Flare and Light Flare) when rendering across the network on 

various machine types (Macs, PCs and Suns). Be sure not to rename these 

plugins.

The following menu items are contained in the plugin menu, though the 

contents of the menu will change depending upon the 3rd party plugins 

you may have installed:

• Dicer.plm
• Flag.plm
• Mesh.plm
• Mr. Blobby.plm
• Mr. Nitro.plm
• Power Particles Basic.plm
• Pixel Grains.plm
• UberShape.plm

Dicer. Adds the Dicer polygon decimator plugin to the project.

Flag. Adds the flag generator plugin to the project.

Mesh. Adds the mesh generator plugin to the project.

Mr. Blobby. Adds the Mr. Blobby metaballs plugin to the project.
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Mr. Nitro. Adds the Mr. Nitro polygon-based explosion plugin to the 

project.

Power Particles Basic. Adds the Power Particles particle generator plugin 

to the project.

Pixel Grains. Adds the Pixel Grains plugin to the project.

UberShape. Adds the UberShape shape generator plugin to the project.
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Material Menu

The material menu is used to add master materials and master lights to a 

project, to assign and remove master materials and master lights, and to 

access the material editor. The menu items are:

• Add Master Material
• Add Master Light
• Assign Master Material
• Remove from Master Material
• Assign Master Light
• Remove from Master Light
• Reload Material from File
• Material Editor

Add Master Material. Adds a Master Material to the project window list. 

Note this only adds the material to the project, it does not assign the mate-

rial to any objects; use Material>Assign Master Material to do that.

Add Master Light. Adds a light to the scene. The light can be used as a 

standard light, or as a master light. This option will not assign subscriber 

lights; use Material>Assign Master Light to do that.

Assign Master Material. Assigns a master material to a selected object, 

group or series of objects or groups.

Remove from Master Material. Removes the selected object or group from 

the master material subscription list.

Assign Master Light. Assigns a master light to a selected light or series of 

lights.

Remove from Master Light. Removes the selected light or series of lights 

from the master light subscription list.
Electric Image Universe 3.0        59



Chapter 2  Main Menu Bar — Material Menu
Reload Material from File. Reloads the original material settings from the 

object file on disk. If you want to restore the original settings after you have 

experimented and start over, use this menu option.

Material Editor. Activates the material editor for the selected group or 

master material.
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Hierarchy Menu

The hierarchy menu is used to add and remove objects and groups from a 

hierarchy, freeze transformations to an object, and call up the joint and axis 

editor. The menu items are:

• Parent
• Remove Parent
• Park
• Joint Editor
• Axis Editor

Parent. This option prompts you to choose a parent for the object or group 

that you have selected.

Remove Parent. This option removes the selected object from the hierar-

chy, and place it at the root level. Note that if you select children as well as 

parents, all objects will be placed at the root level, regardless of their previ-

ous standing in the hierarchy. If you wish to keep a portion of the hierarchy 

intact, then select only the parent object at the level you wish to maintain, 

and then choose Remove Parent.

Park. This option will freeze all transformations applied to an object at the 

current values, and then reset those values to zero (the position, rotation 

and scale operations you applied previously will be maintained, but their 

values will bet set to zero). This is referred to as “baking” in other pro-

grams.

Joint Editor. Brings up the Joint Editor window for the selected object.

Axis Editor. Brings up the Modify Axis window for the selected object.
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Character Menu

The Character menu is used to create skeleton hierarchies, bones deforma-

tions and to add IK handles to either bone or skeleton hierarchies. The 

menu items are:

• Create Skeleton
• Create Bones
• Add IK Handle

Create Skeleton. This option will enable the creation of hierarchical skele-

ton joints in any 3D view window. 

Note Skeleton joints do not deform models. If you need your models to deform, 

use Create Bones instead.

To terminate the operation, press the Cancel button in the floating alert dia-

log, or the keyboard shortcut.

Cmd “.” (Mac) | Cntrl “.” PC and Sun

Create Bones. This option will enable the creation of hierarchical bones in 

any 3D view window. To terminate the operation, press the Cancel button 

in the floating alert dialog, or the keyboard shortcut.

Cmd “.” (Mac) | Cntrl “.” PC and Sun

Add IK Handle. This option will add an IK handle to a skeleton or bones 

chain. If you select the end effector of the chain only, an IK handle will be 

automatically applied from the root on down. If you select to joints, and 

then choose Add IK Handle, the IK handle will be applied only to those 

joints; the rest of the chain will be unaffected.
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Animation Menu

The Animation menu is used to control all of the animation options that 

any object can have. You use the menu to: enable animation channels; 

import and export animation channel envelopes; import and export motion 

capture files; add, delete and clear key frames; manage motion paths of 

objects; recalculate custom frames; fit frames and objects to curves; and 

access the offset editor, function curve editor, morph editor and deforma-

tion editor. The menu items are:

• Enable Animation
• Import Envelope
• Import Motion
• Export Envelope
• Export Motion
• Add Keyframe
• Delete Keyframe
• Clear All Key frames
• Make Path Explicit
• Make Path Implicit
• Set Path to (Linear, Natural Cubic, Hermite and F-Curve)
• Recalculate Selected Frames
• Recalculate All Object Frames
• Calculate Auto Frames
• Fit Selected Frames to Curve
• Fit Selected Objects to Curve
• Offset Editor
• Function Curve Editor
• Morph Editor
• Deformation Editor
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Enable Animation. Enables the animation channel for the selected object, 

group or series of objects or groups. The animation channel must be 

enabled in order to animate the group.

Import Envelope. Imports a motion envelope into the motion channel that 

is selected in the function curve editor.

Import Motion. Imports a motion capture file into the project. A skeleton 

will be automatically created, with the motion mapped to it from the 

motion capture file. 

Export Envelope. Exports a disk file that contains the animation data for a 

specific channel selected in the function curve editor.

Export Motion. Exports a Biovision-format motion file, in either flat or 

hierarchical form. Also exports an ElectricImage format motion file, which 

can be imported into another Universe Animator project.

Add Keyframe. Adds a keyframe to all channels of the selected object at 

the current scene time. This command will create key frames for all chan-

nels, which is not efficient or necessarily desirable. Automatic keyframe 

generation will likely be preferable to you.

Delete Keyframe. Deletes the current keyframe from the selected object. If 

more than one keyframe is present for the object at the current time, all will 

be deleted.

Clear All Key frames. Clears all key frames for the selected object. The cur-

rent position and orientation will be set as the beginning state of the object.

Make Path Explicit. Sets the motion path of the selected object to explicit 

(applies only to translation channels). The motion path curve will not be 

editable in the interface beyond setting a new position for the keyframe. 
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Three curves, for X, Y and Z, will be placed in the function curve editor on 

demand, for editing purposes. While this choice limits the path shape edit-

ing in the 3D views, it adds much more control within the function curve 

editor. Most professional animators prefer to animate in the function curve 

editor because of this.

Make Path Implicit. Sets the motion path of the selected object to implicit 

(applies only to translation channels.) The motion path will be fully edit-

able in the 3D views, in any of four formats (linear, natural cubic, hermite 

and bezier). The motion channel data will not be editable as three separate 

curves in the function curve editor. Instead, only the velocity channel can 

be edited in the editor when the motion path is set to implicit.

Set Path to (Linear, Natural Cubic, Hermite and F-Curve). Sets the motion 

path type to any of the four choices listed. This applies only to motion 

paths that are implicit.

Recalculate Selected Frames. Recalculates frames that are selected in any 

of the spreadsheet-based project window views (keyframe, frame, index). 

This feature is available only when the data in the frames deviates from the 

selected motion path curve type (custom frame data, indicated in under-

lined text.)

Recalculate All Object Frames. Recalculates frames for any selected object 

in the project. This feature is available only when the data in the frames 

deviates from the selected motion path curve type (custom frame data, 

indicated in underlined text.)

Calculate Auto Frames. This feature will force the update of any auto 

frames to reflect the current scene time. Auto frame updates are disabled by 

default, as they can interfere with user interface performance. 
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Fit Selected Frames to Curve. This feature will fit imported motion cap-

ture data frames that are selected in the project window to a curve (motion 

capture data is frame based, and custom frames are created when motion 

capture data is imported.) This feature effectively lets you convert the 

motion capture frame data to curve data.

Fit Selected Objects to Curve. This feature will fit imported motion cap-

ture data frames for a selected object to a curve (motion capture data is 

frame based, and custom frames are created when motion capture data is 

imported.) This feature effectively lets you convert the motion capture 

frame data to curve data

Offset Editor. The Offset Key frames editor is activated by this menu item. 

The Offset Key frames editor enables you to offset or scale the time values 

of selected key frames, or the values of selected key frames.

Function Curve Editor. The Function Curve Editor is activated by this 

menu item. The function curve editor allows you to edit animation channel 

data in curve form, relative to other curves displayed in the graph. Profes-

sional animators prefer to animate with this tool over others, as this tool 

offers the most control of the animation data overall.

Morph Editor. The morph editor is activated by this menu item. The 

morph editor allows you to create animation by blending together different 

model files of similar complexity. This technique is used most often for 

facial animation, although it can be used for any animation where the 

shapes of one object can be effectively blended with another (they have the 

same polygon and vertex count.)

Deformation Editor. The deformation editor is activated for the selected 

object by this menu item. Deformations are used to physically warp and 

distort object geometry, and operate on the group level.
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Constraint Menu

The constraint menu is used to apply basic constraints to groups. Con-

straints are applied at the group level only. Any object can have one of the 

three constraints applied to it (if the object supports such motion.) If the 

applied constraint does not seem to behave as expected, use the joint editor 

and check to see if the joint type is set to allow such motion. For example, if 

a look at constraint is added to a group which is set to be a locked joint, the 

look at constraint will not be functional, as the joint type overrides the look 

at constraint. To rectify this, you would want to choose a more appropriate 

joint type. In the case of a look at constraint, a better joint type would be 

“socket.” The menu items are:

• Add Look At
• Remove Look At
• Add Attach
• Remove Attach
• Add Auto Bank
• Remove Auto Bank

Add Look At. The look at constraint allows one object to constantly target 

another, with the rotations of the source object being used to track the tar-

get. Joint types have priority, so you can use joints to lock out certain axes, 

or to limit the motion of certain axes if you choose to. For example, if you 

are using a look at constraint for a character’s eyes, you may wish to limit 

the rotations of the eyes so that the eyes are not allowed to point to the back 

of the head of the character.

This item adds a look at constraint to the selected object at the current time. 

The program will prompt you to pick the look at target. Once the target is 

picked, frames preceding the current frame will blend in the look at con-

straint automatically.
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Remove Look At. This item removes the look at constraint at the current 

time. The constraint will be blended away over a series of frames automati-

cally.

Add Attach. The attach constraint will create a spatial relationship between 

the source and target objects or groups. The spatial relationship that exists 

between the objects at the time the constraint is applied will be maintained 

until Remove Attach is applied. 

This item adds an attach constraint to the selected object at the current 

time. The program will prompt you to pick the target. Once the target is 

picked, the frames preceding the current frame will blend in the attach con-

straint automatically.

Remove Attach. This item removes the attach constraint at the current 

time. The constraint will be blended away over a series of frames automati-

cally.

Add Auto Bank. The auto bank constraint modifies an object so that it 

points in the direction of the tanget vector of the motion path. The auto 

bank constraint will remain in place until Remove Auto Bank is applied.

This item adds an auto bank constraint to the selected object at the current 

time. The program will prompt you to pick the target. Once the target is 

picked, the frames preceding the current frame will blend in the auto bank 

constraint automatically.

Remove Auto Bank. This item removes the auto bank constraint at the cur-

rent time. The constraint will be blended away over a series of frames auto-

matically.
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Render Menu

The render menu is used to control render settings, edit any cropping that 

has been applied, and to send off rendering jobs. The menu items are:

• Render Settings
• Render Flags Off
• Render Flags On
• Edit Cropping
• Render Project
• Render Window
• Render Frame
• Render Window Selection
• Render Frame Selection

Render Settings. This option activates the render information window.

Cmd “r” (Mac) or Cntl “r” (PC and Sun)

Render Flags Off. This option sets all of the render flags in the Render tab 

of the render information window to off. Use this item if you intend to acti-

vate just a few flags, instead of turning off the undesired flags manually.

Render Flags On. This option sets all of the render flags in the Render tab 

of the render information window to on. Use this item to quickly activate 

all of the render flags.

Edit Cropping. This option will allow you to interactively edit the crop-

ping rectangle in the camera view window. You must first activate cropped 

rendering by enabling the Enable Cropped check box in the Resolution tab 

of the render information window. 

Render Project. This option will render the project, using the current set-

tings in the render information window. An image or animation save dia-
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log will appear, prompting you to name the file. A save project dialog will 

follow. Universe Animator will then launch the rendering job, and shut 

down to allow more system resources to be allocated to the rendering.

Render Window. This option will render a “snapshot” image the size of the 

camera view window. Only the current frame will be rendered, regardless 

of the settings in the render control window. After rendering, the image 

will be automatically displayed in an image view window.

Render Frame. This option will render a full sized image of the scene. Only 

the current frame will be rendered, regardless of the settings in the render 

control window. After rendering, the image will be automatically displayed 

in an image view window.

Render Window Selection. This option will render the contents of a mar-

quee selection that you are prompted to make, in “snapshot” resolution. 

Only the current frame will be rendered, regardless of the settings in the 

render control window. After rendering, the image will be automatically 

displayed in an image view window.

Render Frame Selection. This option will render the contents of a marquee 

selection that you are prompted to make, in full frame resolution. Only the 

current frame will be rendered, regardless of the settings in the render con-

trol window. After rendering, the image will be automatically displayed in 

an image view window.
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Select Menu

The select menu is used to make selections in a scene, set filters which 

allow you to select certain types of objects only, and select objects by 

attribute, type, model file, hierarchy, label or selection set. The menu items 

are:

• Groups Only
• Cameras Only
• Lights Only
• IK Handles Only
• All
• None
• Inverse
• Find
• Find Again
• Find All
• By Attribute
• By Type
• By Model
• By Hierarchy
• By Label
• By Set

Groups Only. This option sets the selection filter to allow the selection of 

groups only. No other items can be selected. If you have difficulty selection 

other objects, make sure you check the selection filter settings.

Cameras Only. This option sets the selection filter to allow the selection of 

camera scene objects only. No other items can be selected. If you have diffi-

culty selection other objects, make sure you check the selection filter set-

tings.
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Lights Only. This option sets the selection filter to allow the selection of 

light scene objects only. No other items can be selected. If you have diffi-

culty selection other objects, make sure you check the selection filter set-

tings.

IK Handles Only. This option sets the selection filter to allow the selection 

of IK Handles only. No other items can be selected. If you have difficulty 

selection other objects, make sure you check the selection filter settings.

All. This option will select all objects in the scene that are not filtered from 

selection.

None. This option will deselect any selected objects.

Inverse. This option will invert the selection, releasing the selected objects 

and selecting those that were previously unselected.

Find. This option will search the project for any object by name, and fitting 

the criteria that you specify.

Find Again. This option will continue to find the next object that meets the 

criteria specified by the find command.

Find All. This option will find all objects in the project that meet the criteria 

that you specify.

By Attribute. This option will select all objects that are not filtered, and that 

fulfill the selected attribute: Visible, locked or hidden. 

By Type. This option will select all objects that are not filtered, and that are 

of the type you specify: Camera, light, group, effector, sound, world, mate-

rial model file, IK handle, smoke object.
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By Model. This option will select all groups contained within the specified 

model file, regardless of the filter settings.

By Hierarchy. This option is used to select a hierarchy, or portions of a hier-

archy, based upon the following criteria that you specify: root of selected, 

parent of selected, children of selected.

By Label. This option is used to select any object with a specific label 

attached to it. Labels are assigned to objects in the project window. You can 

also use Select>By Label>Edit... to change the label names.

By Set. This option is used to select any previously created selection set. 

Whatever is contained within the selection set will be selectable by this 

item. You can also use Select>By Set> Edit... to create new selection sets, 

and manage existing selection sets.
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Window Menu

The window menu is used to open the tool palette, time palette and loca-

tion palette; manage the 3D view windows; access the project window; 

close and reset windows; show and hide rulers, scene grid and motion 

paths. The menu items are:

• Tool Palette
• Location Palette
• Time Palette
• Top View
• Front View
• Side View
• Camera View
• Project Window
• Close Window
• Reset Windows
• Show/Hide Rulers
• Show/Hide Grid
• Show/Hide Path

Tool Palette. This option activates the tool palette. The tool palette contains 

tools for: translating, rotating and scaling objects; panning the 3D views; 

showing and hiding the grid; activating and deactivating the snapping 

grid; editing the cropping rectangle; activating deformations, morph editor, 

joint editor or axis editor for the selected object; showing or hiding the 

motion path for the selected object; parenting and unparenting the selected 

object; assigning constraints, master materials and master lights; and park-

ing the selected object (freezing its transforms.) The tool palette is a floating 

palette, and can be oriented horizontally or vertically.
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Location Palette. This option activates the location palette. The location 

palette displays the location of the selected object in coordinate space read-

outs, specific to each window.

Time Palette. This option activates the time palette. The time palette is a 

simple timeline, which you can use to set the new scene time. Key frames 

are not displayed in the time palette.

Top View. This option toggles the display of the top view window.

Front View. This option toggles the display of the front view window.

Side View. This option toggles the display of the side view window.

Camera View. This option toggles the display of the camera view window.

Project Window. This option toggles the display of the project window.

Close Window. This option will close the currently selected window.

Reset Windows. This option will reset all windows, placing them in their 

factory determined locations and sizes.

Show/Hide Rulers. This option will toggle the display of the ruler bars.

Show/Hide Grid. This option will toggle the display of the scene grid.

Show/Hide Path. This option will toggle the display of all object motion 

paths.
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Assigning and Using Cameras

3.0 Introduction

There are two basic points of view in Universe Animator, world views and 

camera views. The world views present the project environment from a 

“creator’s” perspective. You see everything in the project through these 

views. They assist you in the creative process, allowing you a variety of 

perspectives in which to view and work within your project. Camera views 

are used to actually record the results of your animation. It is the camera 

through which your audience sees your work.

3.1 Camera Anatomy

Cameras in Universe Animator follow the “source/target” metaphor. Cam-

eras do not have a “yaw, pitch and roll” but instead use the target control as 

a pointing mechanism.

Figure 3.1 — Camera control with field of view (FOV) active

Camera Body

View Vector

Reference
Point
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Figure 3.1 shows an illustration of the camera control. It has three separate 

components that you can manipulate:

• Camera Body (source)
• View Vector
• Reference Point (target)

Camera Body. Camera controls are actually drawn as a real motion picture 

camera. Looking at the control as illustrated below, note the film magazine 

on top of the camera, and the matte box to the front where the lens is. The 

actual focal (nodal) point of the camera exists where the view vector inter-

sects with the camera body. All of the position data for the camera body ref-

erences this location.

View Vector. The view vector is the line drawn between the camera and the 

reference point. You can drag the entire camera control by this vector, leav-

ing the orientation of the camera intact (a great time saver!) The distance 

between the camera body and the reference point, as represented by the 

view vector, is pertinent only when depth of field rendering settings are 

used.

Reference Point. Also called the target in other programs, the reference 

point is the actual point of interest for the camera body. You can easily see 

and control the direction in which the camera is pointing by dragging the 

reference point to the desired position.

Adding Cameras to Scenes

You can have as many cameras as you want in Universe Animator. Each of 

the cameras can have independent settings, although the resolution and 
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image filtering settings are global for all cameras, as covered in the Render 

Information Window chapter. 

There are two ways to add cameras into your projects:

• Choose Object>Add Camera

• Duplicate an existing camera by selecting it and choosing Edit>Dupli-

cate from the menu bar

Translating Cameras

Moving cameras in Universe Animator is very easy. Cameras can be moved 

either by the camera body, view vector or by the reference point. There are 

actually two ways to move the camera body:

• Move
• Rotate

Both of these methods use manipulators.

To move the camera body:

1. Choose Tool>Translate from the menu bar
2. Select the desired camera

The translate manipulator will appear.

3. Drag the camera to the desired location

The camera reference point will stay fixed on its target as you drag the cam-

era. If you wish to move the camera along a particular axis, click on the 

desired axis of the translate manipulator and drag. The target will move 

with the camera when the camera is moved along a specific axis.
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To move the reference point of the camera:

1. Select the camera
2. Click on the reference point and drag

You can move the reference point at any time, regardless of manipulator selected for 

the camera. The reference point cannot be rotated, it can only be translated, there-

fore, only that motion is passed along to the reference point.

Both the camera body and the reference point have their own motion paths, 

and can be animated independently. This might cause you to “over-ani-

mate” the camera, resulting in “digital whiplash.” The best way to animate 

the camera is either to animate only one of the controls, camera body or ref-

erence point (not always practical) or insure that the motion paths for each 

point roughly match, both in keyframe times, velocity, and path shape. You 

can use the function curve editor to further adjust these factors (see the 

Project Window/Function Curve chapter for more information.) Of course, there 

are far more controls for cameras than just the control icon. Like all objects 

in Universe Animator, cameras have their own “info windows.” 

Looking through the Camera

The camera view window shows the view from a camera that you select. 

You can also look through shadow casting lights in this view.

To look through a camera:

1. Depress the control key
2. Click in the title bar of the camera view window

A pop-up menu will appear, listing any available cameras and lights that 

can be used to view the scene.
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3. Choose the desired camera to view through

The camera view will now be switched to the camera that you selected. If 

that camera has any images attached to it, such as rotoscope or camera map 

images, they can now appear in the window.

3.2 Camera Information Window Overview

The camera info window contains all of the settings required to manipulate 

a camera in Universe Animator, as well as view its current attributes. Each 

camera in a project maintains a separate set of parameters, found in its 

camera info window. There are two ways to access the Camera Info Win-

dow:

• Select the Camera and choose Object>Camera Info (command or con-
trol “i”)

• Double Click on the Camera Icon in either the world views or project 
window

Figure 3.2 — Camera Info Window
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General Camera Settings

In Universe Animator the camera window is divided into 5 folder tabs. On 

the left side are check boxes used for enabling additional camera options in 

the view windows. The X-form tab displays the position of the camera and 

it’s reference point, as well as its current angle. The FOV tab is used for set-

ting the focal length and field of view of the camera, as well as its shutter, 

and depth of field settings. The Roto/Comp tab is used for adding 

rotoscoping and compositing layers. The stereo tab allows for the render-

ing of stereoscopic images. Finally, the Projection Map tab is where camera 

maps are applied, allowing for the projection of custom images onto geom-

etry from a camera’s perspective.

Camera Display Options

On the left side of the camera window info are additional display options 

for the camera will be seen in the world view windows. These options are:

• Show Angle
• Show Fog
• Show Stereo
• Show Roto
• Show Map

Show Angle. This check box toggles the display of the camera’s field of 

view (FOV) angle in the world views. When enabled, it will project a pyra-

mid outward from the center of the camera to the reference point, as illus-

trated in Figure 3.1. The area inside these lines represents the field of view 

of the camera. This is what will be “seen” by the camera and rendered. The 

size of this area is changed by altering either the Focal Length in the FOV 
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window, or by changing the aspect ratio in the Render window. Refer to the 

Focal Length section that follows for more information on changing the 

camera’s field of view.

This display mode is very helpful for determining exactly which objects are within 

the field of view as you move the camera through the world view windows. 

Show Fog. This check box displays a projection of the fog radius used by 

the camera. The fog region is an attribute the World object, which is listed 

in the project window. If the fog region has not been activated, this check 

box will have no effect. The fog region is a spherical volume which ema-

nates from the center of any camera in the scene.

Show Stereo. When the Stereo rendering option is enabled, this check box 

provides a graphic display of the stereo separation parameters. Stereo-

scopic rendering creates two images for each frame in an animation, one for 

the left eye, and one for the right.

Show Roto. This check box will cause any loaded background or fore-

ground images to be drawn in the camera view window. These images are 

added to a camera via the Roto/Comp tab.

Show Map. This checkbox will cause any foreground image to be dis-

played in the camera view window.

Camera X-Form Tab

This tab is broken down into four sections:

• Camera Section
• Reference Section
• Roll, Pitch and Yaw Angles Section
• Roll Control
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Camera Section. The camera section contains the Key popup menu (for 

controlling motion interpolation) and three position edit boxes. These edit 

boxes list the current position of the camera, in X, Y, and Z coordinates, 

which can be changed by you at any time.

Reference Section. The reference section contains the Key popup menu 

(for controlling reference point interpolation) and three position edit boxes. 

These edit boxes list the current position of the reference point, in X, Y, and 

Z coordinates. You can also expressly set the camera to reference distance 

in the edit box.

Roll, Pitch, and Yaw Angles Section. The camera can also be controlled 

through more traditional roll, pitch and yaw edit boxes, and are expressed 

in degrees. The order of the boxes is actually presented as Yaw (X), Pitch (Y) 

and Roll (Z), and equates directly to X, Y, and Z.

Roll Control. The roll control is interactive, and can be dragged to create 

roll angles. Its presentation is reminiscent of the roll indicator found in air-

craft avionics.
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All of the numeric values presented in the edit boxes are dependent upon 

the editing mode set in the project window, and if the animate flag has been 

set for the camera object or a particular channel for the camera object.

In Index mode, changing the values updates the value for the current key-

frame you are editing. Index mode only allows for the editing of previously 

generated key frames, rather than for creating new ones, so it is only possi-

ble to alter an existing keyframe while in index mode.

In Frame mode, changing the values in the x-form window creates a cus-

tom frame with those new values. Custom frames have an underline mark 

below their values in the project window. Custom frames are not affected 

by the interpolation and velocity of the frames around them. They are fixed 

values which will be implemented without regard to any other key frames. 

If you can picture a smooth curve, custom frames are like spikes jutting out 

from the curve. They have no regard for the curve itself, or its shape (veloc-

ity). They simply pop to their value, and then return back to the curve 

when done. 

Figure 3.3 — Camera X-Form Tab
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In Keyframe and Time modes, changing the values in the x-form window 

either creates a new keyframe (if none exists at the current frame), or 

updates the values of an existing keyframe.

Universe Animator can display keyframe values in either Implicit, or 

Explicit values. Implicit is the way that Universe Animator has always dis-

played vectorized quantities. When the camera is set to implicit, dragging 

the camera in a window controls two of its positional measurements. The 

velocity is computed as a composite of these two vectors. For instance, by 

dragging a camera in the top view window, the X & Z coordinates will 

change, in the Front View the Y&X, and the Side View the Y&Z coordinates. 

Implicit controls always function on all axes simultaneously.

When a camera or object is set to explicit positioning, it is possible to con-

trol the values and velocity for all 3 components of motion (X,Y,Z) indepen-

dently in the function curve editor.

FOV Tab

This tab controls the camera focal length, shutter angle, and depth of field 

options. It is divided into three sections:

• Focal Length Section
• Shutter Section
• Depth of Field
86       Electric Image Universe 3.0    



Chapter 3  Assigning and Using Cameras — Camera:Camera Information Win-
Focal Length Section

In photography, an image is exposed onto film or captured on video. Light 

is collected through the camera’s lens, and projected onto the focal plane. In 

film cameras, the focal plane is actually inscribed on the camera body, typi-

cally denoted by a circle with a slash running down the middle.   The dis-

tance between the first lens element in the lens body to the focal plane is 

referred to as focal length.  

Universe Animator provides many controls to manage the lens characteris-

tics of a camera. These controls are affected by the aspect ratio settings in 

the Render Information Window. The focal length section consists of the 

following three items:

• Focal Length Edit Box
• Field of View Edit Box
• Focal Mode Popup Menu

Figure 3.4 — Camera FOV Tab
Electric Image Universe 3.0        87



Chapter 3  Assigning and Using Cameras — Camera:Camera Information Win-
Focal Length Edit box. This edit box allows you to explicitly define the 

camera lens focal length. The number will change depending upon the 

aspect ratio setting in the Render Info Window. The default for that setting 

is “computer,” so the number that you are most likely to see is a floating 

point number, such as “1.0.” Changing the aspect ratio setting will result in 

a conversion of the number in the edit box to a new number. With the 

exception of the custom and computer aspect ratio settings, the number in 

this box will be expressed in millimeters. This allows you to match real 

world lens types to real world photography formats. 

Note that if you do change the aspect ratio, the focal length will be adjusted to the 

new number, but the image in the viewing rectangle will appear relatively 

unchanged. Only the cropping areas will be affected, the image distortion will not.

The smaller the focal length, the wider the field of view. The larger the focal 

length, the narrower the field of view. Lenses with small focal lengths 

(6mm to 12mm) are called wide angle lenses, lenses with large focal lengths 

(75mm to 135mm) are called narrow or telephoto lenses, and those in 

between (16mm to 50mm) are considered normal lenses. Focal length is 

directly proportional to the size any object will appear in the frame. If the 

distance to the object remains constant, and the focal length is doubled, the 

object will appear twice as large in the frame.

Field of View Edit Box. Field of View (FOV) determines how much of the 

scene when viewed through the camera lens is visible to the lens. This 

value is expressed in degrees. The FOV is directly related to the focal length 

of the lens, the focal mode popup menu (discussed following) and the 

selected aspect ratio. 

Many single lens reflex cameras (SLRs) include a 50mm lens. This lens most 

closely mimics the human eye for this 8 perf 35mm format (8 perf is also called 
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“Vista - Vision” format when applied to motion picture cameras.) The field of view 

for this lens is approximately 40˚ in the real world (depending upon differing spec-

ifications by camera and lens manufacturers.) It should be noted that Universe 

Animator presents these values in true mathematical space, while real world cam-

eras and lenses are incapable of meeting these tolerances, and will often vary by one 

or two degrees.

Perspective distortion is also driven by both the focal length and Field of 

View. The smaller the FOV, the more distortion will appear, creating a wide 

angle effect. The larger the FOV, the less distortion will appear creating a 

telephoto effect. You can use extremely large focal lengths if you wish to 

negate the effects of perspective altogether. For example, you may wish to 

render a view with no perspective in order to create the basis for a texture 

map the closely conforms to the shape of the group.

Focal Mode Popup Menu

This menu determines how the focal length and field of view calculations 

are performed. There are three choices:

• Horizontal
• Vertical
• Diagonal

Horizontal Focal Mode. This mode uses the sides of the frame to calculate 

the focal length and field of view. This is the default mode, and is the typi-

cal method for making such calculations in most motion picture camera 

systems.

Vertical Focal Mode. This mode uses the top and bottom of the frame as a 

basis to calculate focal length and field of view. Some computer imaging 

systems use this mode, but it is unlikely that you would need to.
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Diagonal Focal Mode. This mode uses the frame diagonal as a basis to cal-

culate the focal length and field of view. Many SLR cameras use this 

method.

Shutter Angle Section. All real world cameras have a shutter system. Film 

cameras have a physical shutter, and video cameras have electronic shut-

ters. A shutter is used to create discreet frames, otherwise all we would see 

would be smearings of color. Discreet frames are necessary for our percep-

tion of imagery in motion, made possible by a phenomenon called “persis-

tence of vision.” It is this phenomenon that enables us to see the discreet 

frames on film (or video fields) as a continuous motion. 

Shutters actually keep parts of the film from exposing, rendering them 

black. A shutter is typically very fast, covering the focal plane for about half 

of the total exposure time. For example, in a 24 frames per second shot, the 

shutter will be closed for about 1/48 of a second, and open for the same 

amount. During the time that the shutter is closed, the world is still mov-

ing. When the next frame is exposed, the subject matter will not necessarily 

be in the same place, and thus, its motion is imparted to the film.

This section contains two controls:

• Enable Shutter Check Box
• Shutter Angle Edit Box

Enable Shutter Check Box. Use this check box to override the global shut-

ter settings in the Render Info Window. If this box is enabled, the value in 

the Shutter Angle Edit Box for this camera will be used instead of the global 

value.

Shutter Angle Edit Box. Use this edit box to set the angle of the open shut-

ter in degrees. In the real world, the shutter angle would max out at far less 
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than 360˚, otherwise the images recorded would not make any sense to us. 

However, Universe Animator provides a “virtual shutter” that can be far 

greater than 360˚. You can still view an image, because Universe Animator 

does not actually use a shutter to render the discreet frames, it does so 

automatically (one of the benefits of a synthetic camera!) As such, the shut-

ter angle can be used for some really cool effects, such as ultra high speed 

motion (like a space warp drive.)

Instead, shutter angle is a major component of the motion blur effect. The 

size of the shutter angle will dictate the amount of perceived motion blur 

along the following rules:

• Larger shutter angles produce longer blur streaks
• Shorter shutter angles produce shorter blur streaks

Note that shutter angle has no apparent effect on the Depth of Field function. It is 

included in this section as an animatable control for motion blur only.

Depth of Field Section

3D programs like Universe Animator are all designed to mimic real world 

cameras, up to a certain point. The focal length section is used to approxi-

mate what a real world camera would see if the scene existed in our world. 

The basic physics are the same, with some added bonuses (such as, every-

thing is always in focus.) Sometimes, however, that’s not what you want. 

Universe Animator is capable of performing depth of field rendering. 

Depth of field mimics a real camera, whereby images are blurred according 

to the focal settings of the camera. Depth of field is defined as the distance 

from the nearest object in sharp focus to the farthest object in sharp focus.   

Depth of field rendering is a multi-frame technique that requires the multi-frame 

button to be set in the Motion Blur tab of the Render window. For best results the 
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number of Blur Frames should be set to 5 or higher. Do not use raytracing with 

depth of field, the render times will be prohibitive.

The Depth of Field section contains five items used to control the options 

for this feature:

• Enable Focus Check Box
• F-Stop Edit box
• Focus Distance Edit box
• Distance Popup Menu
• Multi-frame Pixel Offset

Enable Focus Check Box. This check box enables the depth of field feature. 

It must be selected in order for the effect to be created.

F-Stop Edit Box. Use this edit box to set the f-stop for the camera lens. In 

real world terms, the light gathering power of a lens is called the speed of 

the lens. The more light that is available to a lens, the larger the area it is 

able to keep in focus (the depth of field). This is expressed as an f-number, 

or f-stop. This number is the ratio between the focal length of the lens and 

its diameter (the aperture):

As the lens diameter increases, so does the amount of light that passes 

through. As the focal length increases, the light is dispersed over a greater 

area and the amount of light available decreases. This is often expressed as 

a faster lens allowing more light through, and a slower lens allowing less 

light. Lenses of about f/2 and lower are considered fast. 

f-stop=
focal length

lens diameter
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Additionally, inside the lens is an iris diaphragm which can open or close 

to change the amount of available light. Thus, the actual term, f-stop, is 

determined by a series of “stops” along the lens aperture:

The standard series of stops is: 1, 1.4, 2, 2.8, 4, 5.6, 8, 11, 16, 22, 32. Each stop 

represents the halving (or doubling) of the amount of light that the lens 

passes. At low f-numbers, the diaphragm is open wider and more light 

enters the lens.

As in actual photography, smaller f-stops result in a shorter depth of field. 

Objects outside of the focus distance will appear soft and out of focus. 

Larger f-stops will result in a longer depth of field. Objects outside of the 

focus distance will be in sharper focus. Unlike real world cameras, the 

actual amount of light required to illuminate the scene will not change. 

Only the depth of field will be affected, not exposure.

Focus Distance Edit Box. This edit box determines the distance from the 

camera in which the object will be in sharp focus. Objects not in the area of 

the focus distance will appear out of focus, depending upon the f-stop set-

ting. The focus distance can also be set to use the reference point of the 

camera. This is controlled by the distance popup menu, covered below. If 

the reference point method is used, the value in the Focus Distance Edit 

Box is ignored.

Distance Popup Menu. The two options in this popup menu selects the 

method for calculating the depth of field:

• By Channel
• By Reference

f-stop=
focal length

diameter of lens aperture
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By Channel. When setting the focus distance by channel, the focal target is 

determined by the value entered in the Focus Distance edit box. This value 

emanates from the center of the camera, and is expressed in world units. 

For instance, a number of 50 would focus the lens on an object 50 units 

from the focal plane of the camera.

By Reference. When setting the focus distance by reference, the focal target 

is the end point of the reference vector. This provides an easy way to deter-

mine exactly what the focal object is. Just drag the reference vector out or in 

until it is sitting over your target object. This is the default method.

Multi-frame Pixel Offset. This value represents what is known as the cir-

cle of confusion. The point at which the focus distance is set, is said to be 

the area of critical focus. Everything on this plane is in focus. Objects that 

are nearer and farther from this point are said to be in the circle of confu-

sion. Depending on the f-stop and focal length, many of these objects will 

also be in variable states of focus even though they aren’t located at the 

exact focus distance. 

For example, when the focus distance is set at 15 units, we might find that 

the depth of field where objects remain in focus ranges from 12 units to 20 

units. Thus, the total depth of field here would be 8 units. Since “being in 

focus” is a subjective judgment, in order to determine what is defined as in 

focus, a permissible circle of confusion must be set; the circle of least confu-

sion. In Universe Animator, this value is the multi-frame pixel offset, and it 

uses this number to determine the acceptable range of sharpness when per-

forming depth of field calculations. 
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The following rules apply:

• Smaller offset values produce sharper images
• Larger offset values produce blurrier images

Effectively, the offset is an additional control to determine how blurry the 

objects in the scene will appear.

Roto/Comp Tab

Rotoscoping (“roto”) is a term used to describe the process of incorporating 

information from previously exposed (or rendered) footage into a shot. 

One might wish to match the camera movements or other objects from live 

action footage, or have a rendered model follow the movements of an actor. 

Compositing (“comp”) is a process of including foreground or background 

images or movies into your rendered scene. Composite layers are added 

above the 3D action you create in Universe Animator, and background lay-

ers appear behind your renderings in the final image or movie. In order for 

compositing to work properly, the images or movies that you use will need 

to contain an alpha channel mask. 

Your roto and comp footage can be any resolution, but it is best to match 

the final resolution to which you are rendering. If your background or fore-

ground maps are smaller than your target render resolution, then they will 

be enlarged. This will reduce the quality of the images used for composit-

ing. If the footage is a greater resolution, then the footage will be down 

sampled to fit in the image rectangle. This will not decrease the quality of 

the imagery used for compositing, but will add somewhat to the render 

time.
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The Roto/Comp tab contains controls which allow for background and 

foreground image compositing within a rendering, and display of these 

images in the camera view window. There are several items in this tab:

• Render Rotoscope/Composite Check Box
• Background Map List
• Foreground Map List
• X-Form Tab
• Properties Tab
• Info Tab
• Crop Tab

Render Rotoscope/Composite Check Box. This check box enables the 

images in the background and foreground map lists to be rendered and/or 

composited into the final image. (Maps can also be individually enabled or 

disabled within the map lists.)

Background Map List. This list contains all of the images used as back-

grounds for the active camera. Each camera renders its own map lists sepa-

rately — what appears in the background list for one camera will not be 

present for another, unless you insure that the lists are the same for each 

Figure 3.5 — Camera Roto/Comp Tab
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camera. Each image can be enabled or disabled by clicking the active icon 

next to the name of the map. The background maps will appear in the final 

rendered image only if the active icon next to the image name in the list is 

present, and the Render Rotoscope/Composite check box is enabled. Back-

ground images can be animated and scaled in XY screen space with the X-

form tab next to the map list.

To add a background image to the list:

1. Click the Add button
2. Choose an image or movie from the file list
3. Click the Open button

The background image you selected will now appear in the list.

To delete a background image from the list:

1. Select the image
2. Click the Delete button

The image will be removed from the list.

You can reorder the maps in the list by dragging the map to its desired loca-

tion. You can Edit>Copy (command or control “c”) and paste maps 

between lists by selecting the map and choosing copy, then selecting the 

destination map list, and choosing Edit>Paste (command or control “v”). 

Maps will be layered by the order in which they appear in the list. If the 

maps do not have alpha channel masks, then the top-most map will be the 

only map that will appear as a background image for this camera. 

Foreground Map List. This list contains all of the images used as fore-

grounds for the active camera. Each camera renders its own map lists sepa-

rately — what appears in the foreground list for one camera will not be 
Electric Image Universe 3.0        97



Chapter 3  Assigning and Using Cameras — Roto/Comp Tab
present for another, unless you insure that the lists are the same for each 

camera. Each image can be enabled or disabled by clicking the active icon 

next to the name of the map. The foreground maps will appear in the final 

rendered image only if the active icon next to the image name in the list is 

present, and the Render Rotoscope/Composite check box is enabled. Fore-

ground images can be animated and scaled in XY screen space with the X-

form tab next to the map list.

To add a foreground image to the list:

1. Click the Add button
2. Choose an image or movie from the file list
3. Click the Open button

The foreground image you selected will now appear in the list.

To delete a foreground image from the list:

1. Select the image
2. Click the Delete button

The image will be removed from the list.

You can reorder the maps in the list by dragging the map to its desired loca-

tion. You can Edit>Copy (command or control “c”) and paste maps 

between lists by selecting the map and choosing copy, then selecting the 

destination map list, and choosing Edit>Paste (command or control “v”). 

Maps will be layered by the order in which they appear in the list. If the 

maps do not have alpha channel masks, then the top-most map will be the 

only map that will appear as a rendered image for this camera, hiding any 

3D objects that you intended to render. 
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Note To view any image in the background of the Camera window, the option to show 

the image must be on (found in the Roto/Comp Properties Tab, Show in Camera 

View check box) and the Paint Image button must be set to the image name desired.

The following illustration indicates the roto/comp controls that are dis-

played in the camera view window. These controls are visible only when 

the option to display an image in the camera view is active.

Paint Image Icon. This icon will draw the foreground/background image 

in the camera view. To use click on the button. A popup menu will appear, 

with the names of the loaded images listed. Choose the image that you 

wish to view. You cannot preview composites in this window. You must 

perform a window size rendering or full size rendering to do so.

Paint Image Icon Frame Number Scroll Bar

Figure 3.6 — Camera View Roto/Comp View Tools indicated
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Frame Number. This box displays the current frame number. If the Sync 

with Time option is selected in the Roto/Comp Properties Tab, then this 

number will match the current frame number of the project.

Scroll Bar. The scroll bar allows you to scroll through the movie file to find 

the appropriate frame for use. This bar will have no effect on a single frame 

image.

Roto/Comp X-form Tab

This tab provides position, scale and alignment information used by the 

currently selected map in either list. Each map in each list can be posi-

tioned, scaled and aligned independently from the others. These functions 

are presented in 3 areas in the X-form tab:

• Position Edit Boxes
• Scale Edit Boxes
• Alignment Popup Menu

Figure 3.7 — Roto/Comp Tab Foreground/Background Image X-form Tab
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Position Edit Boxes. These boxes control the position of the selected image 

in either of the foreground or background map lists. Maps can be posi-

tioned in X and Y space only (acting as flat layers.) The default value of 0.0 

will place the map in the center of the frame. X and Y values of 1.0 or 

greater for each position attribute will place the map offscreen (Values may 

may vary depending upon the aspect ratio of the map as it relates to the 

rendered image.)

Scale Edit Boxes. These boxes control the scale of the selected image in 

either the foreground or background map lists. The default scale of 1.0 fits 

the map to the extents of the rendered image rectangle. The alignment 

popup, covered below, governs which axis is used as the “fit” axis, that is, 

which axis is used to fit correctly into the frame at a scale of 1.0. Values of 

less than 1.0 in will reduce the size and values greater than 1.0 will increase 

the size of the image.

Align Popup Menu. This menu is used to determine how the map will fit 

into the rectangle of the rendered image. There are three choices:

• Both
• Horizontal only
• Vertical only

Both. This option will fit both axes of the image into the aspect ratio of the 

rendered image rectangle. If the aspect ratio of the image does not match 

the aspect ratio of the rendered image rectangle, the image will appear 

stretched or squeezed.

Figure 3.8 — Align Pop Up Menu
Electric Image Universe 3.0        101



Chapter 3  Assigning and Using Cameras — Roto/Comp Tab
Horizontal Only. This option will fit just the horizontal axis of the back-

ground or foreground image into the rendered image rectangle. The verti-

cal axis may extend past the rendered image extents or end within view of 

the frame if the aspect ratios of the foreground/background image doesn’t 

match the rendered image rectangle.

Vertical Only. This option will fit just the vertical axis of the background or 

foreground image into the rendered image rectangle. The horizontal axis 

may extend past the rendered image extents or end within view of the 

frame if the aspect ratios of the foreground/background image doesn’t 

match the rendered image rectangle.

Roto/Comp Properties Tab

This tab is used to control the foreground/background image rendering 

and display properties. This tab is comprised of several items:

• Camera View Section
• Image Tiling Section
• Anti-Alias Check Box
• Invert RGB Check box
• Invert Alpha Check Box
• Samples Edit box
• Blur Edit Box
• Opacity Edit Box
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Camera View Section

This section contains controls which govern the display of the foreground/

background image in the camera view window. There are three sub items 

listed in this section:

• Show In Camera View Check Box
• Synchronize with Time Check Box
• Display Mode Popup Menu

Show in Camera View Check Box. This control enables the display of the 

image in the camera view window.

Synchronize with Time Check Box. This control insures that the fore-

ground/background images will match the time reference of the project 

scene time.

Display Mode Popup Menu. This popup menu determines which chan-

nels of the image will be displayed in the camera view window. This fea-

ture does not affect the rendering quality of the foreground/background 

images. There are four choices:

Figure 3.9 — Roto/Comp Properties Tab
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• RGB Only
• Alpha Only
• RGB + Alpha
• RGB + Color

RGB Only. Displays only the RGB channel of the foreground/background 

image in the camera view window. If the image has an alpha channel, then 

the display of the image in this mode will appear to have ragged edges (the 

anti-aliasing information is in the alpha channel).

Alpha Only. Displays only the Alpha (mask) channel of the foreground/

background image in the camera view window.

RGB + Alpha. Displays a properly anti-aliased foreground/background 

image in the camera view window. (Uses the alpha channel information to 

mask in the RGB channel.)

RGB + Color. Displays the RGB channel of the image with the selected 

background color (set in the World Info Window).

Image Tiling Section

This section contains two popup menus which control the way the fore-

ground/background images are tiled when viewed or rendered (one for 

the X axis and one for the Y axis). There are four choices:

• None
• Hold
• Repeat
• Mirror

None. Disables mirroring of the image on the specified map axis. Choosing 

None for both axes will cause the image to be displayed only where you 

positioned it, nowhere else.
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Hold. Applies the colors found at the image edges outside of the actual 

image rectangle. (The image will appear once as positioned, with the bor-

der colors of the image extending beyond the image rectangle, covering the 

frame.)

Repeat. Repeats the image along the specified axis. Choosing Repeat for 

both axes will cause the image to repeat continuously.

Mirror. Mirrors the image along the specified axis. Choosing Mirror for 

both axes will cause the image to flip flop about both axes.

Anti-Alias Check Box. This check box enables foreground/background fil-

tering. If you are not scaling your foreground/background images, and if 

they match the aspect ratio of the rendered image rectangle, then this set-

ting can be disabled.

Invert RGB Check Box. This option will negate the RGB color space of the 

image.

Invert Alpha Check Box. This option will negate the alpha channel of the 

image. This is useful if you decide that you need to mask the area opposite 

of that represented by the alpha channel.

Samples Edit Box. This edit box lets you determine the sampling quality of 

the image. The default is 5.0. Numbers greater than 5 will cause the image 

to be sampled more often, slowing down render time, but increasing the 

quality of the image. Numbers less than 5 will cause the image to be sam-

pled less often, speeding up render time, but decreasing the quality of the 

image. Numbers greater than 10 might be prohibitively slow. 5 is a good 

default, and you will likely not need to deviate from that amount.

Blur Edit Box. This edit box lets you blur the image. The default is 1.0. This 

value will present the image as is. Values of greater than 1.0 will blur the 
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image. For example, a value of 2.0 will produce a blur of two pixels for 

every one encountered in the image. Values less than 1.0 will sharpen the 

image, although it will also introduce aliasing (jagginess) into the image.

Opacity Edit Box. This edit box controls the opacity of the foreground/

background image. The default is 1.0, where the image is completely 

opaque. Values of less than 1.0 will make the image more transparent, end-

ing at 0.0 where the image will be invisible. Values of greater than 1.0 are 

ignored.

Stereo Tab

The stereo tab is used to set up stereo image rendering in Universe Anima-

tor. This technique lets you create true “3D” images, when properly assem-

bled and viewed through polarized glasses. (Universe Animator does not 

support the anaglyph (red/blue) stereo effect, just “right eye/left eye” ste-

reo.) To accomplish this, Universe Animator creates separate image files for 

each eye. You will need a third party program to assemble the images into 

viewable 3D imagery or movies.

The stereo tab consists of a few simple controls to accomplish the stereo 

effect:

• Enable Check Box
• Stereo Separation Edit Box
• Stereo Convergence Edit Box
• Convergence Popup Menu
• Render Popup Menu
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Enable Check Box. This box enables the stereo effect. You can play with 

settings without actually rendering them by disabling this check box.

Stereo Separation Edit Box. This edit box controls the distance between 

the two cameras. (If you would like to see the distance indicated on the 

camera, enable the “Show Stereo” check box in the Camera Info Window’s 

Camera display control area to the left of the window.) The default value is 

1.0. This may or may not be appropriate for your needs. Essentially this 

control is attempting to duplicate the distance between the human eyes. 

How much scale you want something to have will depend upon the size of 

this value. Unfortunately, the relevance of this number is directly related to 

the scale of the objects in your scene, so we can offer little guidance here.

Figure 3.10 — Stereo Tab
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Stereo Convergence Edit Box. This edit box controls to focus point of the 

stereo effect. Beyond this point, no depth will be perceived. This value is 

used only if the Convergence Popup Menu is set to “By Channel.”

Convergence Popup Menu. This menu controls the type of convergence 

that will be used when the scene is rendered. There are three choices:

• By Channel
• By Reference
• In Infinity

By Channel. Causes the stereo effect to use the value found in the Stereo 

Convergence Edit Box.

By Reference. Causes the stereo effect to use the reference point as the 

point of convergence.

In Infinity. The perception of depth will extend into infinity.

Render Popup Menu

This menu controls what image files are created at render time (if any) for 

the stereo effect. There are four choices:

• Normal
• Left Only
• Right Only
• Left & Right

Figure 3.11 — Convergence Popup Menu
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Normal. This option will render the scene normally, producing only one, 

“flat” image file.

Left Only. This option will render an image file for the left eye position 

only.

Right Only. This option will render an image file for the right eye position 

only.

Left & Right. This option will render two image files, one for each eye. In 

this instance, render times will be twice as long, as complete scenes for each 

eye must be rendered.

Projection Tab

This tab is used to control map projections from the camera position. A pro-

jection map is a texture than can be projected onto many groups at once 

from the same location in space. Both lights and cameras can project maps. 

Lights project maps exactly like a slide or movie projector. Camera projec-

tion maps work a little differently. These maps are typically projected onto 

objects which are fully self-illuminated (meaning that the objects are 

always at full brightness, as are any maps applied to them.

Here’s a real world analogy to this process — imagine that you have a pho-

tograph of a building. The camera is inside of an alcove, with walls on the 

sides, and an arch to the rear. Now, imagine that you have a model that is 

Figure 3.12 — Stereo Render Popup Menu
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roughly scaled to the objects in the photograph. In essence, you have walls 

and then an arch at the end of the walls. The model is painted white to 

accept the slide of the photo. Now, setup a slide projector that can project 

the photo onto the model. Position the projector so that it approximates the 

position of the camera that took the original photograph. As you bend 

down and look at the model from the same point as the slide projector (or 

as close as you can get to the lens) what you would see would appear to be 

very close to the original photo. However, the farther away from the projec-

tor that you move — either side to side, up or down, or in and out — you 

would notice that what you are seeing is almost a true 3D representation of 

the original photo! This is a special effects technique that has been used for 

many years.

The first known use of this technique on a computer was performed by Mr. 

Yusei Usegi, an extremely talented matte painter, on the film “Hook.” He 

painted an overhead view of the Neverland Island, and had the computer 

department create a rough model of the island and ocean. As the map was 

project from his point of view created in the painting, as soon as the record-

ing camera moved off axis, the painting suddenly appeared to have a three 

dimensional feel. Since then Mr. Usegi and a variety of very talented arti-

sans have used this technique to great effect in such films as “Spawn,” 

“Star Wars Trilogy Special Edition,” “101 Dalamations,” and so on.

The true benefit of camera projection maps is that in many cases what 

would have required complex models before can now use rather simple 

models. The complexity instead is found within the details of the painting 

— a process many find easier than modeling.
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Projection Map Process

Camera projection maps are applied to either all groups in a scene or 

groups within selection sets. (See the Selection Sets chapter for more informa-

tion on selection sets.) Each map in the list can be set to project in different 

manners (“applied as”), and each map can be set to project to a different 

selection set (“applied to”). Typically, camera projection maps are applied 

as “luminance” maps (the default), so that the map appears at full bright-

ness. This method allows the scene that is rendered and the original map 

image to have the same brightness levels. In other words, the rendered 

scene would look like the photograph of the map. It is not uncommon to 

also use clip and transparency map methods to isolate elements in the map 

image, such as people, trees, or other details.

After applying a camera map and aligning the projecting camera, you 

should lock the projecting camera, so that registration is maintained.
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The Projection Map tab consists of three items:

• Camera Map List and Controls
• Camera Map Applied As pop up menu
• Camera Map Applied To pop up menu

Camera Map List and Controls. The camera maps list is where you add 

camera projection maps. You can put as many maps as you like in this list. 

Maps can be single frames or movie files, and can be any bit depth desired.

To add a camera projection map to the list:

1. Click the Add button next to the Camera Map list
2. Select a map from the file list
3. Double click the map, or press the Open button

The camera map will be added to the list. To configure the map, double 

click on the map name in the list. To reorder the map in the list, just drag it 

to its new location. 

Figure 3.13 — Camera Info Window Projection Map Tab
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To delete a camera projection map from the list:

1. Select the map from the file list
2. Click the Delete button next to the Camera Map list

The map will be removed from the list.

Camera Map Apply As Pop Up Menu

This menu allows you to set the method in which the map will be applied 

to items in the selection set. All map channel methods described in the 

Materials and Textures chapter are found here. You can use any of the 

methods that you wish, although in practice you may find just the few 

described above to be of any real use in the map projection process. 

There are eleven methods in the list in which the map can be applied. 

Applying camera maps to any of these channels acts as if the map has been 

applied to that group’s corresponding material channel:

Figure 3.14 — Camera Map Apply As Pop Up Menu
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• Bump/Displace
• Clip
• Diffuse
• Specular
• Ambient
• Reflection
• Reflectivity
• Transparency
• Luminance
• Glow
• Transmission

Bump/Displace. The projected map will act as a bump/displacement map 

for the items listed in the Applied To pop up menu. This option is not typi-

cally used as a camera projection map.

Clip. The projected map will act as a clip map for the items listed in the 

Applied To pop up menu. This is option is great for isolating elements eas-

ily by masks.

Diffuse. The projected map will act as a diffuse map for the items listed in 

the Applied To pop up menu. This option is not typically used as a camera 

projection map, as the groups receiving a camera map from this method 

would shade normally, without self-illumination. (in other words, requir-

ing standard scene lighting) 

Specular. The projected map will act as a specular map for the items listed 

in the Applied To pop up menu. This option is not typically used as a cam-

era projection map.

Ambient. The projected map will act as a ambient map for the items listed 

in the Applied To pop up menu. This option is not typically used as a cam-

era projection map.
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Reflection. The projected map will act as a reflection map for the items 

listed in the Applied To pop up menu. This option is not typically used as a 

camera projection map.

Reflectivity. The projected map will act as a reflectivity map for the items 

listed in the Applied To pop up menu. This option is not typically used as a 

camera projection map.

Transparency. The projected map will act as a transparency map for the 

items listed in the Applied To pop up menu. This option might be useful 

for some effects, or to isolate some elements of target groups.

Luminance. The projected map will act as a luminance map for the items 

listed in the Applied To pop up menu. This is the default setting, as it 

allows for the projection map and the original image to have the same 

brightness (in other words, the rendered image will appear virtually identi-

cal to the original map image in terms of brightness). 

Note The groups receiving maps from this method do not accept shadows when this set-

ting is used. Self-illumination means that the groups are effectively not shaded, 

rather presented at full brightness levels. If you wish to cast shadows from other 

scene groups upon a projection mapped group with this method, you will be 

required to render an additional image, with the same groups, but with the map 

projections disabled, and the group shadow settings for the projection mapped 

groups (found in the group info window, shadow tab) set to “generate shadow 

mask.” You would then need to composite the two images together, using the pro-

jection mapped image as the background, and the shadow mask image as the fore-

ground.

Glow. The projected map will act as a glow map for the items listed in the 

Applied To pop up menu. This option is not typically used as a camera pro-

jection map.
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Transmission. The projected map will act as a transmission map for the 

items listed in the Applied To pop up menu. This option is not typically 

used as a camera projection map.

Camera Map Applied To Pop Up Menu

This menu determines which groups in the scene will receive the selected 

camera projection map. There are three choices for this menu:

• None
• All
• “Set List”

None. No groups in the scene will receive the selected camera projection 

map.

All. All groups in the scene will receive the camera projection map. This 

option should be used if you will not be introducing items that are not 

intended to be components of the map, as every group in the scene will 

receive the map projection.

“Set List” . Actually, after the All menu item, you will see the entire list of 

selection sets that exist within the project. If no selection sets exist, then 

there will be no items presented after the All menu item. Selection sets are 

the most controllable way of using camera projection maps. By use of a set 

or series of sets, you can determine exactly which groups will receive the 

selected camera projection map. Using sets, you can mix and match groups 

which do and do not receive projection map effects.

All of the maps can be further adjusted using the standard set of texture mapping 

tools.
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Lights in Universe Animator

4.0 Introduction

As with real world photography, 3D computer graphics programs need 

light to properly render an image. It is in lighting that one truly sets the 

mood of the composition. Universe Animator offers a variety of different 

light types and lighting effects to help you set the mood you envision. You 

can animate all of a light’s characteristics — there are over 450 channels to 

work with for a single light (including all of the special effects). The inter-

face is very straightforward, to the point that you don’t realize just how 

much control you have over the light.

Like groups, lights can exist individually or as part of a hierarchy, although 

they are best placed at the end of a chain or strange results will occur. 

Sometimes you will want to add lights into a hierarchy for scene illumina-

tion, other times you may wish to add them for visual effects. Some of the 

many visual lighting effects available are lens flares, visible lights and light 

rays, and light projections (where you load an image or movie and it is then 

“projected” into a scene.) You can also tell lights to include or ignore 

groups in a scene with selection sets. And you can even tell a light to remove 

light from a scene, by setting its intensity to a negative value.
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4.1 Light Types

By default, all projects in Universe Animator start out with one radial light 

so that you won’t be left in the dark. There are six types of lights available 

in Universe Animator:

• Camera
• Parallel
• Radial
• Ambient
• Spot
• Tube

Camera. This type of light simulates a point light that is attached to the 

camera itself. It is radial in nature (in that all beams of light from this source 

emanate from it’s center).

Parallel. This type of light simulates a light placed an infinite distance 

away. The light rays are parallel, providing an even illumination. Use this 

type for sunlight, stars, etc. This is the best light source for illuminating flat 

shaded scenes.

Radial. This type of light (the default) simulates artificial lights, by nature 

of the way the rays emanate radially, like the spokes of a wheel, from the 

center of the light. The light has no sense of direction, just location and 

dropoff.

Radial lights can also be set to be dark lights. When a dropoff other than zero is 

specified in the Dropoff edit box (see below), a negative intensity can be used in the 

intensity box to create a subtractive lighting effect. Whatever color is specified in 

the Color Button (see below) will be subtracted from the scene.
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Ambient. This type of light simulates a non-directional, overall illumina-

tion, much like you would see on a cloudy day. It is normally used so that 

objects don’t shade to absolute black.

An ambient light, as with all lights (except for dark lights), adds more light to the 

scene. This can result in images appearing to be overexposed. To compensate for a 

strong ambient light, drop the intensity value of your other lights accordingly. It 

takes some practice, but the ambient light can add tremendous realism to a scene 

when used properly.

Spot. This type of light simulates a directional, limited area light, placing a 

pool of light over a specified area. The pool is circular in nature, and the 

lights contain several different variables, such as an inner and outer cone 

size (note that the inner cone is always smaller than the outer cone), which 

controls the umbra and penumbra of the light. The dropoff distance of the 

spotlight can also be set, as well as whether or not the effective drop-offs 

are calculated linearly or logarithmically.

Spotlights can also be set to be dark lights. When a dropoff other than zero is speci-

fied in the Dropoff edit box (see below), a negative intensity can be used in the 

intensity box to create a subtractive lighting effect. Whatever color is specified in 

the Color Button (see below) will be subtracted from the scene.

Tube. This type of light simulates artificial lights from a tube-like source. A 

tube light is basically an elongated radial light (its length can be adjusted) 

which, when used as a fog or glow light, can create visual effects such as 

fluorescent bulbs or laser beams.

Adding Lights

Typically you will use many lights in a scene to achieve a desired effect. 

There are two ways to create new lights in a project:
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• Lights can be added by choosing Object>Add Light

• Existing lights in a scene can be duplicated

To add a light to a project from the Object menu:

1. Choose Object>Add Light 
2. Click and place the light into the scene
3. Drag the light into the desired position

To duplicate an existing light:

1. Select the light to be duplicated in either the project window or world 
windows

2. Choose Edit>Duplicate (command-D)
3. Drag the duplicate to the desired position

4.2 Light Information Window Anatomy

Like all Info windows in Universe Animator, the Light Info Window can be 

accessed using any of the following methods:

• Double click on the light in the World View or Camera Windows
• Double click on the light name in the Project Window
• Choose “Light Info” from the Object menu, with the light previously 

selected

Figure 4.1 shows an illustration of the Light Info Window. To the left of the 

Light Info Window is the Light Type pulldown menu and a series of check 

boxes. To the right are a series of named configuration tabs, each containing 

the controls and functions indicated by the name of the tab. To select a tab, 

just click on it to bring it forward.
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The Light Type popup menu allows you to select the type of light you want 

this light to be, and the eight check boxes activate interface representations 

of specific attributes within the world view and camera view windows. The 

checkboxes allow the user to have quick visual feedback regarding the 

parameters of the lights sources without having to render out scenes. You 

can use the checkboxes while setting up a scene but only activate those 

attributes needed, as turning on too many at the same time can clutter up 

your view windows.

Figure 4.1 — Light Info Window

Light Interface Attributes

Light Type Pop-up Menu Configuration Tabs

Tab Control Area
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Light Display Options

The following light interface attributes are available:

• SHOW ANGLE

• SHOW DROPOFF

• SHOW FOG RADIUS

• SHOW GLOW RADIUS

• SHOW FLARE

• SHOW LIGHT SIZE

• SHOW FLARE DROPOFF

• SHOW VOLUME DROPOFF

Show Angle. This check box option enables the display of the light’s spot-

light and/or shadow cone angle in the World View windows. The cone 

angle projection emanates from the center of the light toward the direction 

indicated by the reference point of the light. It will project four lines which 

define the maximum area of the cone as indicated in the Inner Cone and 

Outer Cone edit boxes, discussed below.

Show Dropoff. This check box option enables the display of the light’s 

dropoff value when the light is selected. A simple wireframe sphere primi-

tive will be used to represent the area of the dropoff of radial lights. Spot-

lights will show a clipped disc primitive inside the area of the spotlight 

cone, regardless if the SHOW ANGLE checkbox is active. Tube lights will 

show a tube-shaped primitive surrounding the light controls. Parallel 

lights do not support dropoff. Dropoff will not be shown for camera lights.

Show Fog Radius and Show Glow Radius. These check boxes enable the 

display of the light’s fog and glow radii when the light is selected. The dis-

play primitive is the same as for SHOW DROPOFF.
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Show Flare. This check box option enables the display of the light’s flare in 

the Camera View window if the lens flare is active for the light. Display of 

the flare in the interface is not affected by the FLARE DROPOFF value.

Show Light Size. This check box option enables the display of the light’s 

size when the light is selected. The same primitives will be used as SHOW 

DROPOFF.

Show Flare Dropoff. This checkbox draws the Flare dropoff primitive in 

the world view and camera view windows when the light is selected, and 

represents the furthest distance from the light that the lens flare effect will 

be visible. You can access installed lens flares through the Flare tab in the 

Light Info Window.

Show Volume Dropoff. This checkbox draws the volume dropoff primi-

tive in the world view and camera view windows when selected. The vol-

ume dropoff compensation will occur inside of the dropoff extent. The 

volume drop off setting is an edit box located in the properties tab of the 

Light Info Window.

Light X-Form Tab

The light x-form tab contains transform information for the light. This tab is 

broken down into four sections:

• Light Section
• Reference Section
• Roll, Pitch and Yaw Angles Section
• Roll Control
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Light Section. The light section contains the Key popup menu (for control-

ling motion interpolation) and three position edit boxes. These edit boxes 

list the current position of the light, in X, Y, and Z coordinates, which can be 

changed by you at any time.

Reference Section. The reference section contains the Key popup menu 

(for controlling reference point interpolation) and three position edit boxes. 

These edit boxes list the current position of the reference point, in X, Y, and 

Z coordinates. You can also expressly set the camera to reference distance 

in the edit box.

Roll, Pitch, and Yaw Angles Section. The light can also be controlled 

through more traditional roll, pitch and yaw edit boxes, and are expressed 

in degrees. The order of the boxes is actually presented as Yaw (X), Pitch (Y) 

and Roll (Z), and equates directly to X, Y, and Z.

Roll Control. The roll control is interactive, and can be dragged to create 

roll angles. Its presentation is reminiscent of the roll indicator found in air-

craft avionics.

Figure 4.2 — X-Form Tab
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All of the numeric values presented in the edit boxes are dependent upon 

the editing mode set in the project window, and if the animate flag has been 

set for the camera object or a particular channel for the camera object.

In Index mode, changing the values updates the value for the current key-

frame you are editing. Index mode only allows for the editing of previously 

generated key frames, rather than for creating new ones, so it is only possi-

ble to alter an existing keyframe while in index mode.

In Frame mode, changing the values in the x-form window creates a cus-

tom frame with those new values. Custom frames have an underline mark 

below their values in the project window. Custom frames are not affected 

by the interpolation and velocity of the frames around them. They are fixed 

values which will be implemented without regard to any other key frames. 

If you can picture a smooth curve, custom frames are like spikes jutting out 

from the curve. They have no regard for the curve itself, or its shape (veloc-

ity). They simply pop to their value, and then return back to the curve 

when done. 

In Keyframe and Time modes, changing the values in the x-form window 

either creates a new keyframe (if none exists at the current frame), or 

updates the values of an existing keyframe.

Universe Animator can display keyframe values in either Implicit, or 

Explicit values. Implicit is the way that Universe Animator has always dis-

played vectorized quantities. When the camera is set to implicit, dragging 

the light in a window controls two of its positional measurements. The 

velocity is computed as a composite of these two vectors. For instance, by 

dragging a camera in the top view window, the X & Z coordinates will 

change, in the Front View the Y&X, and the Side View the Y&Z coordinates. 

Implicit controls always function on all axes simultaneously.
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When a light is set to explicit positioning, it is possible to control the values 

and velocity for all 3 components of motion (X,Y,Z) independently in the 

function curve editor. 

Properties Tab

The Properties tab contains the basic illumination features of the light. This 

tab is broken down into a variety of sections, depending upon which light 

type is selected.

Common Attributes to All Lights:

• Light Color Swatch
• Intensity Edit Box
• Size Edit Box
• Volume Dropoff Edit Box
• Enable Highlight Check Box
• Enable Illumination Check Box
• Illumination List

Light Color Swatch. This swatch selects the color of the light at the current 

keyframe, frame or point in time (depending on the editing mode in effect). 

When the color button is clicked, the Color Picker comes forward for color 

selection. The color button will then change to the color of the light, and the 

light icon will change to the new color in the world view windows.

Intensity Edit Box. This edit box contains a value for the brightness of the 

light at the current keyframe, frame or point in time (depending on the 

editing mode in effect). The default intensity is 1. If it is necessary to 

increase the brightness of the light, then the Intensity value should be 
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greater than 1. If a “dark light” effect is required (where light is subtractive 

rather than additive), then a negative value should be entered into the box.

Size Edit Box. This edit box contains the value for the size of the light (in 

world units) at the current keyframe, frame or point in time (depending on 

the editing mode in effect). The default is 0.0, which means that the light is 

infinitely small (effectively, a point.) The size value can be used by lens 

flares for scale control, and for soft ray-traced area shadows, where the size 

of the light is used for the area shadow calculation.

Volume Dropoff Edit Box. The Volume Dropoff setting is used to improve 

the look of both glow and fog lights. The purpose of this feature is to pre-

vent spotlight beams from washing out surfaces which they intersect. The 

illustration below clearly shows the benefits of using volume dropoff. Most 

would argue that the image on the right appears more natural than the one 

on the left. With the exception of enabling the volume dropoff feature for 

the image on the right, both images use identical values. There is no signif-

icant render time penalty to use the volume dropoff feature.

Figure 4.3 — To the left, Volume Dropoff is disabled, to the right image Volume 
Dropoff is enabled. All other values are the same.
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Smaller values set the dropoff towards the light source, larger values set the 

dropoff closer to the illuminated object. The Volume Dropoff value repre-

sent distance in scene units. Using the ruler bars (command-m) will help to 

choose the best distances.

Dropoff values visible inside of the glow or fog regions will appear as a 

parabolic mach band within the region. This effect is similar to seeing a 

spotlight beam focused in smoke. If this effect is undesirable, increase the 

dropoff value beyond the range of the glow or fog region. The effect will no 

longer be visible.

Enable Highlight Check Box. This check box will enable the light to cast a 

highlight reflection, or specular on any object in the scene, unless the object 

is on the exclude illumination list, or not present on the include illumina-

tion list.

Enable Illumination Check Box. This check box will enable the light to 

illuminate any object in the scene, unless the object is on the exclude illumi-

nation list, or not present on the include illumination list.

Figure 4.4 — Properties Tab
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Additional attributes of Camera, Radial, Spot and Tube Lights:

• Dropoff Edit Box
• Dropoff Enable Check Box

Dropoff Edit Box. This edit box contains a value for the dropoff distance of 

a light at the current keyframe, frame or point in time (depending on the 

editing mode in effect). Dropoff is not available for parallel lights or ambi-

ent lights. You can use the rulers (command or control “m”) to see the 

actual scale of your scene, and to determine the dropoff distance you 

would like to use. To view the dropoff in the world view windows, click the 

Show Dropoff check box in the Light Interface Attributes section.

Dropoff Enable Check Box. This check box will enable the dropoff shad-

ing feature for the light. If this checkbox is off, but the show dropoff check 

box in the interface attributes section is on, no dropoff will be shown in the 

interface.

Additional attributes of Spotlights:

• Inner Cone is Offset Check Box
• Factor Edit Box
• Outer Cone Edit Box
• Inner Cone Edit Box

Inner Cone is Offset Check Box. This check box lets you create a great 

looking spot light cone by typing in just one value instead of two. When 

you enable this option, an edit box will appear to set the offset distance. 5 ˚ 

is a good value for starters, but feel free to experiment. Once enabled, 

whenever you set the outer cone of the spotlight, the inner cone will adjust 

to its new value based upon the offset that you provide.
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Factor Edit Box. This edit box contains a value for the rate at which the 

spot light falls off between the inner and outer cones. The default is 1.0, 

which provides an even transition. A higher number creates a sharper tran-

sition.

Outer Cone Edit Box. This edit box contains a value for the outermost 

diameter of the area illuminated by the spot light. The area outside the 

outer cone will not be illuminated by the light. The area between the outer 

and inner cones is a transition area between full illumination and none.

Inner Cone Edit Box. This edit box contains a value for the diameter of the 

area receiving the full illumination of the spot light. The light falls off 

between the inner and outer cones.

4.3 Illumination Lists

Illumination lists provide a way to control which objects receive light from 

a particular light source. They are common to all light types. Which objects 

receive or are excluded from the illumination of a particular light source 

are determined by selection sets. 

Adding Illumination Lists
To add an illumination list to the light, use the following method:

1. Click the Add button
2. Select the set from the list window that appears
3. Click the Add button in the list window

You will now see the name of this selection set listed in the Illumination 

List window.
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Enabling/Disabling Illumination Lists

Sets in the Illumination lists are enabled or disabled by clicking on the solid 

circles to the left of their names (defaults to enabled.) Once clicked, the cir-

cle becomes hollow, indicating that the set member will be ignored. This 

feature works in the same manner as the checkboxes to the left of each 

group name in the project window.

Illumination Lists and Light Behavior

Once you assign an illumination list to a light, the light “sees” only those 

items contained within the selection sets listed for the specified behavior. If 

the Illumination List is set to be excluding, then those selection sets in the 

illumination list are not lit by the lightsource. All other objects in the scene 

will be lit normally. If the Illumination List is set to be including, then only 

those items contained within the selection sets will receive illumination 

Figure 4.5 — Light exclusion example

Normal Render Object Excluded from illumination
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from the lightsource. All other objects in the scene will be ignored by the 

light.

Lights can only offer include or exclude behavior, regardless of the number 

of selection sets within the illumination list. Behaviors cannot be mixed and 

matched. If such is desired, you would need to create a new light with the 

corresponding selection sets and settings.

Flare Tab

The flare tab contains all of the parameters to control lens flares for the 

lightsource. Installed lens flares are available from the popup Flare menu 

(flares are plug ins and need to be installed into the EI Sockets folder to be 

available to a project.) 

There are several options which relate to all lens flare plug-ins, regardless 

of the manufacturer:

• Flare Selection Pop-up Menu
• Plug-in Options Button

Figure 4.6 — Flare Tab
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• Enable Object Obscuration
• Enable Cone Obscuration
• Enable Offscreen
• Enable Distance
• Enable Background
• Enable Fog
• Enable Intensity
• Flare Dropoff Edit Box

Flare Selection Pop-up Menu. This menu allows you to choose the desired 

lens flare plug-in for the light. Only one lens flare per light is allowed. 

Lens flare plug-ins will be available only when properly installed in the EI Sockets 

directory.

Plug-in Options Button. This button will activate the configuration dialog 

for the selected lens flare.

Enable Object Obscuration. Causes flare to dim as the light is covered by a 

group. Light size is determined by the Size: edit box in the Light Info win-

dow.

Enable Cone Obscuration. Causes the flare brightness to change as the 

spotlight cone moves through the camera’s view. Takes into account the 

brighness of the inner and outer cone of the spotlight.

Enable Offscreen. This checkbox enables the flare to gradually diminish as 

the origin of the flare moves off screen. With this option on the flare 

behaves as the real photographic artifact behaves. The lightsize setting in 

the Properties tab is used to control the effect.

Enable Distance. This checkbox enables the flare to diminish over distance. 

The lightsize setting in the Properties tab is used to control the effect.
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Enable Background. Allows the lens flare to “glow behind” all objects in 

the shot. As such, this feature ignores the Enable Obscuration setting. You 

can add some dramatic backlighting effects to your scene with this feature.

Enable Fog. Causes the flare intensity to diminish as the flare moves into 

the fog (the fog feature is available in the World Info Window.)

Enable Intensity. Uses the Light intensity setting to calculate the flare 

intensity. The Light intensity setting is available in the Properties tab. The 

Dropoff setting for the light will effect the lensflare if this setting is active.

4.4 Shadows

The shadow tab is used to control the shadow properties for the light. All 

lights can cast shadows. There are two different types of shadows offered 

in Universe Animator:

• Depth Buffer Shadows
• Raytraced Shadows

Depth Buffer Shadows

Depth buffer shadows are very fast to calculate and render. They are soft 

and less defined along the edges than raytraced shadows. Depth buffer 

shadows required much more setup effort than raytraced shadows, and are 

also less accurate. As such, numerous controls are implemented to allow 

you to “fine tune” the depth buffer shadows for better results.

Raytraced Shadows

Raytraced shadows are very slow to calculate and render. They are very 

sharp along the edges, unless the soft shadow option is enabled (which 
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adds even more render time.) Raytraced shadows are very accurate, and 

are very easy to setup and use. Essentially, there is no setup involved, with 

the exception of activating them. For soft raytraced shadows, just a little 

more effort involved, as will be discussed in a following section.

Note Neither shadow type will motion blur with the motion vector blur setting enabled. 

If you need your shadows to be properly blurred, you will need to use the multi-

frame blur setting, or a combination of multi-frame and motion vector.

Depth Buffer Shadow Tab

The shadow tab contents will change depending upon the setting of the 

shadow type pop-up menu. This section will cover depth buffer shadow 

settings. The following attributes are available to depth buffer shadows:

• Enable Shadow
• Outside Buffer Area in Shadow
• Calculate Shadow Only Once
• Buffer X Resolution
• Buffer Y Resolution
• Shadow Color
• Gap
• Softness
• Samples
• Transition
• Smoothing
• Darkness
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Enable Shadow. This check box option enables the light to cast shadows.

Outside Buffer Area in Shadow. This check box option, when enabled, 

causes the entire area of the image outside the outer cone angle (specified 

in the Outer Cone edit box) to be rendered in shadow (simulating the effect 

of a real spotlight).

Calculate Shadow Only Once. This check box option, when enabled, 

causes the shadow image to be calculated only once, as it appears in the ini-

tial frame of an animation. This feature saves rendering time when the 

shadow image does not change during an animation (such as when only 

the camera is moved).

Buffer X Resolution. This edit box contains a value for the shadow buffer 

X resolution. The larger the buffer size, the greater the rendering detail for 

the shadow, however greater memory is required to render the shadow. 

The default is set to 1280 pixels square, which creates good looking shad-

ows. This setting uses 6.5 mb of RAM.

Figure 4.7 — Shadow Tab showing depth buffer shadow attributes
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Buffer Y Resolution. This edit box contains the Y buffer resolution for the 

depth buffer shadow. You can create non-square shadow buffers to suit 

your needs. Often, too much space is wasted in a shadow buffer. By allow-

ing a non-square shadow buffer, you can orient the light position to maxi-

mize the buffer usage.

Shadow Color. This swatch allows you to use the color picker to set the 

color of the shadow. Shadows on earth are rarely black, unless induced by 

artificial lighting.

Gap. This edit box contains a value for the minimum distance between a 

surface casting a shadow and the point at which a shadow first appears.

Softness. This edit box contains a value affecting how the shadow’s edge 

appears. The larger the value, the softer or fuzzier the shadow’s edge will 

appear. A value of 1 creates fairly crisp shadows.

Samples. This edit box contains a value for the number of shadow samples 

per pixel. A larger value reduces the noise around the edge of a shadow but 

takes longer to render.

Transition. This edit box contains a value for the fade-in distance between 

a surface casting a shadow and the surface upon which the shadow 

appears.

Smoothing. This edit box contains a value for the softness of shadow edges 

when viewed up close. Longer values can reduce the stair step of shadow 

edges, but can also cause shadows to appear further away from the sur-

faces which cast them.
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Raytraced Shadow Tab

The shadow tab contents will change depending upon the setting of the 

shadow type pop-up menu. This section will cover depth buffer shadow 

settings. The following attributes are available to depth buffer shadows:

• Enable Shadow
• Dropoff Section
• Soft Shadow Section
• Optimize Shadow Generation

Enable Shadow. This check box option enables the light to cast shadows.

Dropoff Section. This section contains controls to enable the dropoff value 

of the raytraced shadow. There are two controls, the Enable check box, and 

the distance edit box. To activate dropoff, click in the enable check box. Add 

a dropoff distance in scene units.

Soft Shadow Section. This section contains controls to enable the soft area 

shadow effect. To enable soft shadows, click in the enable box. The samples 

Figure 4.8 — Shadow Tab showing raytraced shadow attributes
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edit box allows you to set the number of samples that will be applied to the 

shadow. Higher numbers in this edit box will result in significantly longer 

raytrace times, as the number of samples is then squared and scattered over 

the area of the light (as determined by the light size attribute in the Proper-

ties tab.) 

There is a direct relationship between the Lightsize attribute and the samples edit 

box in this section. Larger lights may require higher samples for accurate shadows. 

Smaller sample values may produce artifacts such as noise, and can be especially 

noticeable around the edges of the shadow boundary.

Optimize Shadow Generation. This check box enables soft, raytraced 

shadows to calculate sixteen times faster while producing indentical visual 

results. However, using this feature may produce artifacts such as small 

squares which are different than the surrounding pixels in the image. If you 

encounter artifacts, then disable this feature.

Soft shadows are very effective, but they extract a tremendous time penalty, espe-

cially when you consider just how fast the rendering engine really is. Should you 

need soft shadows, depth buffer shadows may be a better choice, especially if you 

are creating a long animation sequence.

4.5 Special Lighting Effects

Universe Animator offers an impressive array of special lighting effects. 

These lighting effects can be used to convey a variety of different moods in 

your scenes. They can also be used for specific effects such as laser beams 

or streak effects. Available special lighting effects are:

• Glows
• Fog
• Volume Shadows
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• Light Rays
• Smoke Effects
• Projector Light Effects

Glows. Effectively, the glow properties enable your light to be visible in the 

scene. With this feature, you are not required to create a model of your 

light, as you are creating an actual glowing light, When combined with lens 

flares, this effect is especially powerful. 

Important

Rendering

Note

The glow property of a light is not compatible with transparent objects, or 

material attributes which use the transparency pipeline, such as clip maps. 

Do not use effects which rely on the glow light, such as those effects in this 

section (except for projector lights without light rays) when the scene also 

includes transparent object or material effects.

Fog. Fog is essentially the glow feature, but instead of the light being added 

to the scene, it is averaged into the scene instead. Light-based fog is differ-

ent from the environmental fog found in the World object. Environmental 

fog is global, and does not produce volume shadow effects.

Important

Rendering

Note

The fog property of a light is not compatible with transparent objects, or 

material attributes which use the transparency pipeline, such as clip maps. 

Do not use effects which rely on the fog light, such as those effects in this 

section (except for projector lights without light rays) when the scene also 

includes transparent object or material effects.

Volume Shadows. Volume shadows are shadows that are cast through a 

glow or fog light region, or through a smoke object. Volume shadows 

resemble beams of sunlight shining through the clouds. 
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Volume shadows rely on the glow and fog properties of lights to produce results. 

Transparent objects, and material attributes which use the transparency pipeline 

(such as clip maps) may not be compatible with volume shadows.

Light Rays. Light rays are like volume shadows, except that instead of cast-

ing shadows, light is cast instead. This makes the object appear to be gener-

ating shafts of light.

Light rays, like volume shadows, rely on the glow and fog properties of lights to 

produce results. Transparent objects, and material attributes which use the trans-

parency pipeline (such as clip maps) may not be compatible with light rays.

Smoke Effects. Smoke effects take advantage of a smoke object volume. 

Smoke effects are best used if you need to see smoke billows and tendrils. If 

you prefer more of a blanket of smoke, to where the amount of smoke is 

even and you do not see definition to the smoke, then stick with glow or 

fog lights alone, as they will render significantly faster. 

Smoke effects are visible only inside the cone of a spotlight with the glow or fog 

properties enabled.

Projector Light Effects. Projector lights are similar to volume shadows, 

except that instead of a streaked volume shadow, the image loaded into the 

projector light is substituted. This is great for simulating a movie projector 

in a theatre, or stain glass windows in a cathedral. Simpler effects can also 

be accomplished, such as the pattern of a flashlight beam.

Projector lights which are set up to use volume shadows or light rays rely on the 

glow and fog properties of lights to produce results. Transparent objects, and mate-

rial attributes which use the transparency pipeline (such as clip maps) may not be 

compatible with projector lights using volume shadows.
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Important Glow and Fog Rendering Note

All of the visible lighting effects, that is, effects which rely on glow or 

fog properties of lights to produce their results, should not be used with 

transparent or clip mapped objects. Volumetric glow effects and transpar-

ency materials and effects (clip maps use the transparency pipeline in the 

rendering engine) are not compatible for a variety of technical reasons, and 

can cause strange artifacts to occur. 

Some alternatives to these limitations are:

• Render your scene in layers, inserting the glow effects on a layer other 
than transparent objects and objects with transparency or clip maps

• Use material glow effects (which is an image processing effect) instead 
of glow lights, which are volumetric. Material glow effects are applied 
after the image is rendered, and thus bypass the incompatibility 
(although these glows will not be visible in raytraced reflections or mir-
ror maps)

• Use lens flare effects (which is an image processing effect) instead. 
These effects are also applied after the image is rendered, and like 
material glow effects are not visible in ray traced reflections or mirror 
maps

• Use geometry and transparency edge settings, along with luminance 
channel settings, to simulate glows with actual models in the shape of 
the desired glow. This method is a bit “old fashioned” but works well.

Glow Tab

This tab contains all the information to control the glow properties of your 

light source. 
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The following attributes are available on the light glow tab:

• Enable Glow
• Volume Falloff
• Invert Glow & Fog
• Interpolate RGB
• Enable Glow Blend
• Enable Ray
• Outside Glow Color
• Inside Glow Color
• Inner Radius
• Outer Radius
• Factor
• Intensity
• Ray Factor
• Ray Sample
• Smoke Volume Selector

Figure 4.9 — Glow Tab
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Enable Glow. This check box option enables the glow effects for the light.

Volume Falloff. The Volume Falloff checkbox enables the volume dropoff 

value in the Properties tab to be used when shading the glow region. For 

more information, see “Additional attributes of Camera, Radial, Spot and Tube 

Lights:” on page 129.

Invert Glow & Fog. This feature will invert your light rays and other glow 

and fog light effects. For example, instead of your logo casting shadows 

within your light beam, you can have the logo actually cast the light beam 

for streak effects.

Interpolate RGB. The default color interpolation method for the glow 

attribute is HSV color space (hue, saturation and value.) This option will 

allow you to change the interpolation method to RGB color space (red, 

green and blue). HSV is a more natural form of interpolation, and will 

maintain the brightness of the colors in the glow region as the glow is ren-

dered. RGB is a more linear form of interpolation. When a glow region is 

calculated with RGB interpolation, the color values will dim and get 

muddy, and the brightness factor will decrease in this space. HSV bright-

ness values will remain constant throughout the region.

Enable Glow Blend. As glows are an additive process, when one glow 

region intrudes into another, the area of intersection will be brighter than 

the areas of glow outside of the intersection. While physically accurate, this 

look may not be what you are after. The Enable Glow Blend feature will not 

brighten the area of intersection, but rather just blend them together (as 

would occur in an averaged process.)

Enable Ray. This check box activates the light ray feature.
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Outside Glow Color. This swatch opens the color editor to select the color 

at the edge of the glow. If the outside color is different than the inside color, 

a blend will occur between the two.

Inside Glow Color. This swatch opens the color editor to select the color at 

the center of the glow. If the inside color is different than the outside color, 

a blend will occur between the two.

Inner and Outer Radius. These edit boxes contain values for the size of the 

effect. Within the inner radius it is opaque; the outer radius is where it 

becomes clear. To see these radii in the World View windows, enable the 

Show Glow Radius check box in the interface attributes section of the light 

info window.

Factor. This edit box indicates the rate (default is 1) at which the glow will 

drop off between opacity at the inner radius and transparency at the outer 

radius. It is an exponential function, and the higher the value, the greater 

the rate of drop off to the outer glow radius. 

Intensity. Intensity controls the density of the inner glow radius. A value of 

0.5 in this edit box will result in a glow of 50%.

Ray Factor. To decrease the darkness of the rays, enter a value between 

0 and 1 in theRay Factor edit box—the smaller the number, the lighter (or 

with less contrast) the rays. The Ray Factor value defaults to 1.0, which pro-

duces very dark (high contrast) rays.

Ray Sample. This attribute controls the grain present in the rays, enter a 

value in theRay Sample edit box. The value in this edit box determines how 

many samples are taken to calculate the streak intensity through the cross-

section of the spotlight cone. Increasing the value reduces grain in the rays 

(at the expense of processing speed, however).
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Smoke Volume Selector Pop-up Menu. The Smoke pop-up menu is used 

to assign a smoke object to the light for creating smoke within the cone of 

the spotlight. It will list all smoke objects in the scene, from which you can 

choose one.

Creating Glow Effects

Glow lights must be configured before they can be used. The following 

steps represent the typical steps involved in configuring glow attributes for 

a light.

To configure a glow attribute for a light:

1. Select the desired light to add the glow effect
2. Open the Light Info Window for the selected light (command or con-

trol “i”)

The light info window will now open.

3. Click on the Show Glow Radius check box. This will allow you to see 
the area occupied by the glow region once you have entered the sizes 
for the inner and outer glow areas

4. Choose the Glow tab
5. Click on Enable Glow to activate the glow feature
6. Set the size of the outer glow region by typing in the desired size in 

scene units
7. Set the inner glow region by entering the desired size in scene units
8. Click on the outer glow color swatch

The color picker will appear.

9. Select the desired color for the outer glow. Click the OK button to 
accept the color

10. Do the same for the inner glow
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11. Set the glow intensity. For subtle glow effects, try numbers that are less 
than 0.25 intensity. Numbers greater than 0.50 will appear more styl-
ized or cartoon-like

12. Set the ray factor to determine the look of the glow transition from 
inner to outer radius (optional). 

Once the glow attribute for a light is configured, it is ready to be used in the 

scene and rendered. 

Creating a Volume Shadow with a Glow Light

Once you have created and configured a glow light, you can add a volume 

shadow or light ray to the light effect. Glow or fog attributes for a light 

must be enabled in order for the ray effect to be visible.

Volume shadows can be used to create natural shafts of light when applied 

to a glow or fog effect on a spotlight. When light rays are applied, the shaft 

of light will be partially blocked when it is interrupted by groups in your 

project. Since the shaft can be partially blocked, you can place cut-outs in 

front of the shaft to create shaped shadows and spots. In theatrical lighting 

terms, you can create gobos, cucoloris, and dingles.

Light rays do not pass through transparent groups or groups with transparency 

maps. This can be used to some advantage, however. A transparent (invisible) 

plane may be animated to cause the end point of the rays to move through space, 

creating exciting effects for logo work.

To create volume shadows:

1. Select the light and open the Light Info window.
2. Choose Spotlight from the Light Type pop-up menu.

This sets the light type to spotlight.
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Because the light streak effect uses the shadow buffer of spotlights to function, the 

light mode must be set to Spot and shadows must be enabled.

3. Follow the previous steps to configure the light for a glow effect
4. Click the Enable Ray check box to enable the volume shadow effect
5. Choose a smoke object from the Smoke pop-up menu (optional)

Volume shadows will now be rendered for any object which passes 

through the shadow cone of the light. If you choose a smoke object, you 

will notice significantly longer render times.

Creating Light Rays

Light rays are volume shadows with the invert Glow & Fog checkbox 

enabled. When enabled, this checkbox will convert the shadow into a lumi-

nous volume, as if streaks were emanating from the object (instead of a 

shadow.)
148       Electric Image Universe 3.0    



Chapter 4  Lights in Universe Animator — Fog Tab
Fog Tab

This tab contains all the information to set the fog properties of your light 

source.

The following attributes are available on the light fog tab:

• Enable Fog
• Volume Falloff
• Invert Glow & Fog
• Interpolate RGB
• Enable Ray
• Outside Glow Color
• Inside Fog Color
• Inner Radius
• Outer Radius
• Factor
• Intensity
• Ray Factor
• Ray Sample
• Smoke Volume Selector

Figure 4.10 —  Fog Tab
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Enable Fog. This check box option enables the fog effects for the light.

Volume Falloff. The Volume Falloff checkbox enables the volume dropoff 

value in the Properties tab to be used when shading the fog region. For more 

information, see “Additional attributes of Camera, Radial, Spot and Tube Lights:” 

on page 129.

Invert Glow & Fog. This feature will invert your light rays and other glow 

and fog light effects. For example, instead of your logo casting shadows 

within your light beam, you can have the logo actually cast the light beam 

for streak effects.

Interpolate RGB. The default color interpolation method for the glow 

attribute is HSV color space (hue, saturation and value.) This option will 

allow you to change the interpolation method to RGB color space (red, 

green and blue). HSV is a more natural form of interpolation, and will 

maintain the brightness of the colors in the glow region as the glow is ren-

dered. RGB is a more linear form of interpolation. When a glow region is 

calculated with RGB interpolation, the color values will dim and get 

muddy, and the brightness factor will decrease in this space. HSV bright-

ness values will remain constant throughout the region.

Enable Ray. This check box activates the light ray feature.

Outside Fog Color. This swatch opens the color editor to select the color at 

the edge of the fog. If the outside color is different than the inside color, a 

blend will occur between the two.

Inside Fog Color. This swatch opens the color editor to select the color at 

the center of the fog. If the inside color is different than the outside color, a 

blend will occur between the two.
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Inner and Outer Radius. These edit boxes contain values for the size of the 

effect. Within the inner radius it is opaque; the outer radius is where it 

becomes clear. To see these radii in the World View windows, enable the 

Show Fog Radius check box in the interface attributes section of the light 

info window.

Factor. This edit box indicates the rate (default is 1) at which the fog will 

drop off between opacity at the inner radius and transparency at the outer 

radius. The higher the value, the greater the rate of drop off.

Intensity. Intensity controls the density of the inner glow radius. A value of 

0.5 in this edit box will result in a glow of 50%.

Ray Factor. To decrease the darkness of the rays, enter a value between 

0 and 1 in the ray Factor edit box—the smaller the number, the lighter (or 

with less contrast) the rays. The Ray Factor value defaults to 1.0, which pro-

duces very dark (high contrast) rays.

Ray Sample. This attribute controls the grain present in the rays, enter a 

value in the Ray Sample edit box. The value in this edit box determines 

how many samples are taken to calculate the streak intensity through the 

cross-section of the spotlight cone. Increasing the value reduces grain in the 

rays (at the expense of processing speed, however).

Smoke Volume Selector Pop-up Menu. The Smoke pop-up menu is used 

to assign a smoke object to the light for creating smoke within the cone of 

the spotlight. 
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Creating a Volume Shadow with a Fog Light

The procedure to creating volume shadow effects with fog lights is exactly 

the same with glow lights, with the exception that you are working in the 

fog tab. Please see the discussion topic in the Glow section.

Projection (Map) Tab

Projection maps are controlled from this tab. Projection maps are single or 

multiple frame image files, which are projected along the a light’s direction 

vector. Any light that can cast a shadow can cast a projection map. Each 

shadow casting light is allowed one projection map only.

Light projection maps are simpler than camera projection maps. Light pro-

jection maps can be used to simulate movie or slide projectors, bulb pat-

terns that are common with flashlights, and so on. In fact, you can think of 

them as texture maps for lights. Some of the texture map controls are also 

used in the projection map sub-tabs, covered below.   

This tab contains buttons to add and delete projection maps, and small 

thumbnail representation of the RGB and Alpha channels of the loaded 

map. This tab also contains several sub tabs:

• X-form
• Properties
• Info
• Crop

Projection Map: X-Form Tab

The Projection Map X-Form (Transformation) tab is used to control the 

position of the map in the light’s local space. The position edit boxes con-
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trol the X and Y position of the map. The scale edit boxes control the X and 

Y scale of the map. The Align popup menu (shown extended in the figure 

below) eases map alignment and fitting. They are discussed below.

• Fit Outer Cone (Default)
• Fit Within Inner Cone
• Fit Without Inner Cone
• Fit Within Outer Cone
• Fit Within Outer Cone

Fit Outer Cone (Default). This option distorts the projection map to fit 

inside of the outer cone of the spotlight. Do not use this option if you wish 

to maintain the map’s aspect ratio.

Fit Within Inner Cone. This option fits the rectangular extent of the projec-

tion map to the inside of the inner cone of the spotlight. The map’s aspect 

ratio is presented without distortion.

Figure 4.11 — Projection (Map) Tab: X-Form Tab
Electric Image Universe 3.0        153



Chapter 4  Lights in Universe Animator — Projection Map: Properties Tab
Fit Without Inner Cone. This option fits the rectangular extent of the pro-

jection map to the outside of the inner cone of the spotlight. The map’s 

aspect ratio is presented without distortion.

Fit Within Outer Cone

This option fits the rectangular extent of the projection map to the inside of 

the outer cone of the spotlight. The map’s aspect ratio is presented without 

distortion.

Fit Without Outer Cone. This option fits the rectangular extent of the pro-

jection map to the outside of the outer cone of the spotlight. The map’s 

aspect ratio is presented without distortion.

Projection Map: Properties Tab

The Projection Map: Properties tab is used to control the properties of the 

projection map. Illustrated below, the tab is divided up into several compo-

nents: Tiling popup menus; Samples edit box; Blur edit box; and a series of 

checkboxes. 

Figure 4.12 — Projection (Map) Tab: Properties Tab
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Tiling Popup Menus. The tiling section controls the repeat functions of the 

map if it is scaled at less than 1.0 (scale functions are found in the Projection 

Map: X-Form tab.) There are four options for each popup menu: 

• None
• Hold
• Repeat
• Mirror

None. Disables mirroring of the map on the specified map axis. Choosing 

None for both axes will cause the map to be displayed only where you 

positioned it, nowhere else.

Hold. Applies the colors found at the map edges outside of the actual 

image rectangle. (The map will appear once as positioned, with the border 

colors of the image extending beyond the image rectangle, covering the 

frame.)

Repeat. Repeats the map along the specified axis. Choosing Repeat for both 

axes will cause the map to repeat continuously within the cone of the light, 

depending upon the scale of the map.

Mirror. Mirrors the map along the specified axis. Choosing Mirror for both 

axes will cause the map to flip flop about both axes.

Samples Edit box. This edit box lets you determine the sampling quality of 

the map. The default is 5.0. Numbers greater than 5 will cause the map to 

be sampled more often, slowing down render time, but increasing the qual-

ity of the map. Numbers less than 5 will cause the map to be sampled less 

often, speeding up render time, but decreasing the quality of the map. 
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Numbers greater than 10 might be prohibitively slow. 5 is a good default, 

and you will likely not need to deviate from that amount.

Blur Edit Box. This edit box lets you blur the map. The default is 1.0. This 

value will present the map as is. Values of greater than 1.0 will blur the 

map. For example, a value of 2.0 will produce a blur of two pixels for every 

one encountered in the map. Values less than 1.0 will sharpen the map, 

although it will also introduce aliasing (jagginess) into the map.

Quality Control Check Boxes

There are four check boxes which let you control the quality of the map:

• Interpolate
• Anti-Alias
• Invert RGB
• Invert Alpha

Interpolate. Enables map filtering. Necessary to avoid moire patterns in 

the map as it rotates off axis.

Anti-Alias. An additional level of filtering for image quality. Not always 

necessary, and can soften the look of the map.

Invert RGB. Negates the RGB channels of the map for special effects.

Invert Alpha. Negates the Alpha channel of the map. This feature comes in 

handy when you aren’t sure how to design the alpha channel of the map.
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Projection (Map): Info Tab

The info tab contains information about the projection map, as well as any 

cropping that you may have performed on the map.

Projection (Map): Crop Tab

The crop tab displays a reduced version of the map and allows you to crop 

within it, so you can use just a section of the map. To crop, click anywhere 

on the “crawling ants” border around the edge of the map in the rectangle. 

Clicking on the edges of the map will drag the entire side of the map. Click-

ing on the corners of the map drags the corner inward. To reset the map, 

drag the borders to the extents of the image. 

Adding Projection Maps

The process of adding projection maps to a light is straightforward. There 

are two different looks that you may wish to achieve, as illustrated:

Figure 4.13 — Projector (Map): Info Tab
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• Projection maps with no additional effects
• Projection maps with volume shadows or light rays

To add a projector map with no additional effects:

1. Click on the Add button
2. Select an image file
3. Double click the file or click on the Open button

The map is now ready for use. The light will now project the loaded image, 

as you have configured in the previous sections.

To add a projection map with volume shadows or light rays:

1. Follow the previous steps to add an image to a light for projection
2. Configure the glow or fog sections as described in previous steps, mak-

ing sure that shadows are enabled
3. Determine the effect type to use (volume shadow or streaks) and set 

the Invert Glow & Fog check box accordingly

These settings will allow the projected map to generate colored streaks 

across the scene.

4.6 Master Lights

Master lights are lights which control the illumination properties of other 

lights. Think of a master light as a light switch. Turn on the master lights, 

and the other lights in the “circuit” are also turned on. Dim the master 

light, and the other lights in the circuit dim by the same amount.

You decide which properties you want a light to inherit from a master light. 

The properties available for inheritance are:
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• Inherit Visibility
• Inherit Intensity
• Inherit Dropoff
• Inherit Color
• Inherit Attributes
• Inherit Shadow
• Inherit Glow
• Inherit Fog
• Inherit Flare
• Inherit Projection

Inherit Visibility. This setting allows the master light to control the visibil-

ity of the subscriber lights. If the master light is made invisible, then the 

subscriber light will also be invisible.

Inherit Intensity. This setting allows the master light to control the inten-

sity of the subscriber lights. If the master light’s intensity attribute is modi-

fied, then the subscriber light will also be modified.

Inherit Dropoff. This setting allows the master light to control the dropoff 

of the subscriber lights. If the dropoff of the master light is made changed, 

then the subscriber light will also be changed.

Figure 4.14 — Master Light Tab
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Inherit Color. This setting allows the master light to control the color of the 

subscriber lights. If the master light is made red, then the subscriber light 

will also be red.

Inherit Attributes. This setting allows the master light to control the light 

size and dropoff factor of the subscriber lights. If the dropoff factor or the 

size of the light is changed on the master light is made invisible, then the 

subscriber light attributes will also be changed.

If you need only the dropoff factor attribute, make sure that the light size of the 

master light is 0.0. If you need only the lightsize attribute, make sure that the 

dropoff factor is 0.0 for the master light.

Inherit Shadow. This setting allows the master light to control the shadow 

attributes of the subscriber lights.

Inherit Glow. This setting allows the master light to control the glow 

attributes of the subscriber lights. 

Inherit Fog. This setting allows the master light to control the fog attributes 

of the subscriber lights.

Inherit Flare. This setting allows the master light to control the lens flare 

attributes of the subscriber lights. 

Inherit Projection. This setting allows the master light to control the light 

projection map attributes of the subscriber lights.

Creating a Master Light

Creating a master light is different than adding or creating a master mate-

rial in a project. While master materials can be loaded from external files, 

master lights cannot. Instead, they must be created from an existing light. 
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That light is still used to add illumination to a scene, but it can also pass 

along its functions to subscriber lights. Subscriber lights can determine 

which attributes they wish to inherit from master lights.

Master light attributes that are passed to subscriber lights are light attribute data 

only. No transformations or rotations are passed within this relationship (the same 

as master materials). If you wish to pass along transformation information to sub-

scriber lights, you must use the hierarchy tools to assign that relationship.

To create a master light in a scene:

1. Open the project window (command or control “l”)
2. Pick a light to designate as a master light
3. Set the light’s attributes as desired (optional, this can be done at any 

time)
4. Name the light appropriately (such as “dining room master”)
5. Using the label function in the project window, assign a color to the 

light’s name. This and the above step will help to identify the master 
light in the various view methods of the project window

Follow the next few steps to complete the process.

Assigning a Subscriber Light to a Master Light

Once a master light is created from an existing light in the scene, you are 

able to add subscriber lights to the master light. Subscriber lights can deter-

mine which attributes they wish to inherit from master lights.

To add a subscriber light to a master light:

1. Open the project window (command or control “l”)
2. Choose the subscriber light
3. Pick the “Assign Master” icon in the project window menu bar
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4. Select the desired master light from the object list in the project win-
dow

5. Open the light info window for the subscriber light, and choose the 
master tab

6. Choose which attributes you wish to inherit from the master light

The master/subscriber relationship is established between the lights. Sub-

scriber lights can be assigned to only one master light. Master lights cannot 

be assigned to other master lights.

Viewing the Master Light Hierarchy

When you assign a master light, you will not see the relationship indicated 

in the project window, unless you have previously set the window to 

“View Master lights.” If you need to see a visual confirmation of the rela-

tionship, then use this option. Remember, the master/subscriber relation-

ship exists outside of the normal scene hierarchy, which allows you to 

parent the light to a completely different object, and still maintain the mas-

ter/subscriber relationship.
162       Electric Image Universe 3.0    



Chapter 5  Backdrops, Fog and the World Info Window — Introduction
Backdrops, Fog and the World Info Window

5.0 Introduction

Backdrops and fog help to create a variety of locations, times of day and 

weather conditions. Used in conjunction with other rendering features, 

backdrops and fog can produce striking results. Universe Animator puts 

these controls in the World object, along with background image color, 

scene ambient values, and global reflection maps. Unlike other objects in 

Universe Animator, the world object is more like a “meta object.” Rather 

than occupying a particular location, the world objects exists everywhere in 

the scene. Like other object classes in Universe Animator, the attributes in 

the world object can be animated. There are more than 100 potential anima-

tion channels for the world object, and even more when you add global 

reflections.

The world object does not officially occupy a space. It cannot be included in 

a hierarchy. It has no groups included within it. The world object is listed 

only in the Project Window.

5.1 World Info Window Overview

The World object is included in every project, and is presented at the top of 

the Project Window List. Like other objects and groups in Universe Anima-

tor, the world object has its own information window.

Figure 5.0 — The World icon in the Project window
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There are two ways to access the World Info Window: 

• Double click the World icon in the Project Window
• Select the World Icon in the Project Window and choose Object>World 

Info (Mac, command-I) (PC, Control-I)

Fog/Ambient/BG Tab

The Fog/Ambient/BG window contains three sections:

• Fog controls
• Ambient Color control
• Background Color control

Figure 5.1 — World info window
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The Fog Controls

Fog, or Fog Projection, simulates atmospheric depth cuing. Atmosphere 

has depth because of particles contained within it, which gives Fog the 

appearance of being more dense the further away it is from the Camera. 

While it can simulate distant haze or fog in a landscape, it does not induce 

atmospheric effects such as visible light shafts or shadows.

There are a number of items in the Fog Controls section:

The Enable checkbox

This checkbox enables the Fog effect. It defaults to off.

Color

Clicking this box will bring up the Universe Color Picker. There, you can 

select a color for your fog.

Mode

This menu determines the type of transition that will occur between the 

region in which the fog effect starts, and the region in which the fog reaches 

its maximum density. (The fog region starts at the center of the active cam-

Figure 5.2 — Fog control window
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era body and extends outward in all directions by the specified distance.) 

There are four choices under this menu:

• Linear
• Exponential
• Non Linear 1
• Non Linear 2

Linear. Linear gives an even increase in the density of the fog region. The 

rate in which density increase will be constant throughout the length of the 

fog region, as defined by the Radius boxes (below.)

Exponential. Exponential will calculate the density of the fog in a more 

realistic, non-linear fashion. This option renders results similar to Pixar’s 

RenderMan® fog shader. 

Non Linear 1. Non Linear 1 will calculate a gradual slope in fog density, 

topping out to a sharp curve. This choice amounts to a significant accumu-

lation of fog towards the end of the fog region.

Non Linear 2. Non Linear 2 will calculate a sharper curve flowing towards 

the top, and then flattening out (in an arc-like fashion). The change in fog 

density will be greater at the beginning of the region, and change less 

towards the end of the region to the maximum value.

Fog To

This menu determines the type of fogging technique to be used. There are 

three choices under this menu:

• Color
• Alpha
• Background
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Color. Color will calculate fog to the color specified in the Fog Color box. 

As the fog gets further and further away from the Camera, it will become 

closer and closer to the specified color. This is exactly the same as doing a 

gradient fill in a paint program, where the gradient tool is set to fade from 

transparent to a color. No matter what color you may have selected for a 

Background Color, the fog will calculate to the designated fog color.

Alpha. Alpha will calculate the fog to an alpha value of 0, which is totally 

transparent. When this is digitally composited over a background image, 

the objects enveloped by the fog will eventually fade out to the composited 

background.

Background. Background calculates the fog to the background color, as set 

in the Background Color box.

This is essentially the same as the first option, Color. The difference, how-

ever, is that while Color calculates the fog to the color designated in the fog 

color box, Background calculates the fog to the designated Background 

Color.

Radius

These edit boxes contain values that define the inner and outer fog radii of 

the camera. The first box represents the point where the fog will begin, and 

the second box designates where the fog will end. These two values are 

known respectively as the Inner Radius and Outer Radius.

The inner and outer fog radii are drawn in the world view windows as two 

discs which appear in the camera view frustrum (visible when “show 

angle” is selected for the camera). These discs are only visible if the camera 

is selected, and if Show Fog is checked in the Camera Info window.
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Amount

These boxes function in essentially the same way as the fog radius boxes. 

However, instead of determining the start and stop points of the fog radius, 

they determine the opacity value of the fog at the start and stop points. 

These values in these boxes range from 0 to 1, with 0 being 100% transpar-

ent and 1 being 100% translucent.

While it is possible for you to enter a higher value than 1, you will not ever 

get a value higher than 100%, so make sure you don’t enter a value of any-

thing other than numbers between 0 and 1 in these boxes.

The first box shows the fog opacity value between the camera and the inner 

radius. The second number designates the opacity value at the outer radius 

and beyond.

The Ambient Color Controls

The Ambient Color Controls set the color of global ambient light in a scene. 

There are two items in this section:

Enable

This checkbox enables the ambient light effect. The default is off.

Figure 5.3 — The Ambient Light Control
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Color

Clicking this box will bring up the Universe color picker. There, you can 

select a color for your ambient light.

The Background Color Controls

The Background Color Controls set the color of the background in a scene. 

When unchecked, the default black background will be rendered in your 

scene. 

Note The background color is actually colorizing the alpha channel of the image. If you 

import a 32 bit Universe Animator file into an application such as Adobe ®Photo-

shop®, the background will appear black, regardless of the color you have set. This 

occurs because Photoshop does not support colorized alpha channels. 

There are two items in this section:

Enable

This checkbox enables the background color. The default is off, which pro-

duces a background color of black.

Color

Clicking this box will bring up the Universe color picker. There, you can 

select a color for your background.

Figure 5.4 — Ground Color Controls
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Backdrop Tab

The World Info Window contains features under the backdrop tab that pro-

cedurally generate ramped color sky and ground planes. This feature can 

be used while initially setting up your project to give your test renderings a 

better sense of scale.

There are two main sections in this window:

• The Sky Controls
• The Ground Controls

Sky

The Sky Controls give you the ability to designate custom background col-

ors sky. There are four items in this window:

• The Enable Check Box 
• The Horizon Color Box
• The Zenith Color Box 
• The Transition Box 

Figure 5.5 — The Backdrop Tab
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The Enable Check Box. This check box enables the sky color effect. The 

default is off.

The Horizon Color Box. Clicking this box will being up the Universe color 

picker. There, you can select a color for the sky at the horizon line.

The Zenith Color Box. Click this box to enter a color value for the sky at 

the Zenith line.

Note The Horizon is the point at which the sky meets the ground. The Zenith is the 

upper region of the sky that is positioned directly above the camera.

The Transition Box. This value sets the midpoint of the transition between 

the Horizon Color and the Zenith Color. Higher values move the midpoint 

closer to the horizon, thus showing more of the zenith color. Lower values, 

such as the default 1, will show more of the horizon color.

  

The default sky colors The sky colors with a transition of 3

Figure 5.6 — Setting sky color transitions
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Ground 

The Ground Controls function in exactly the same manner as the Sky con-

trols do. There are four items in this window:

• The Enable Check Box 
• The Horizon Color Box 
• The Nadir Color Box 
• The Transition Box 

The Enable Check Box. This check box enables the ground color effect. The 

default is off.

The Horizon Color Box. Clicking this box will being up the Universe color 

picker. There, you can select a color for the ground at the horizon line.

The Nadir Color Box. Click this box to enter a color value for the ground at 

the Zenith line.

Note The Horizon is the point at which the ground meets the sky. The Nadir is the lower 

region of the ground that is positioned directly below the camera. The Nadir is dia-

metrically opposed to the Zenith.

The Transition Box. This functions in exactly the same manner as the sky 

transition box. Higher values move the midpoint closer to the horizon, thus 

showing more of the nadir color. Lower values, such as the default 1, will 

show more of the horizon color.
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Note When both items are enabled at the same time, the following image appears when 

rendered:

The default ground colors The ground colors with a transition of 6

Figure 5.7 — Setting Ground Color transitions

Figure 5.8 — A rendering with the default settings
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The Global Reflection Tab

The third tab contains a list of Global Reflection maps that are accessible in 

each group's material interface.

To add a reflection map to this window, click the Add button. A standard 

Open dialog will appear. Simply navigate through your computer, find the 

map you wish to add, and select Open.

When setting an object’s reflectivity value in the material editor, you will 

notice a check box called Use Global Reflections. Any object that has this 

item checked will reflect the reflection maps added to this window.

The Raytrace Tab

The raytrace tab is used to set the global refraction index for the scene. The 

global refraction index covers all space that is not assigned with a refrac-

tion index. The default is 1.0, which is the index of refraction for air on the 

earth’s surface.

The global index of refraction value is necessary when you are dealing with 

non-earth atmospheres. For example, if you are raytracing an underwater 

scene, you would want to set the global index of refraction to roughly 1.33, 

Figure 5.9 — The Global Reflection Tab
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which is the index of refraction for water (not allowing for different levels 

of seawater salinity around the world.)

The global index of refraction is used only when raytracing, and again, 

only in those volumes that do not have an index of refraction that is speci-

fied in the object’s material definition (transparency tab of the material edi-

tor.)

Figure 5.10 — The Raytrace Tab
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Rendering

6.0 Introduction

Rendering is the process in which all of the elements in a scene (models, 

lights, cameras, textures, etc.) are combined, and used to generate a final 

picture or movie. It is analogous to the photographic exposure of a scene 

recorded by the film in a camera. ElectricImage Universe is known to have 

the world’s fastest 3D rendering engine. That is not an idle boast. From 

time to time we often compare the variety of 3D software programs with 

our own, comparing features and timings. In most cases with the most pop-

ular of our competitors, ElectricImage Universe is typically 6 to 15 times 

faster to create the same image. Often our image quality is superior, as 

faster render times let us perform better anti-aliasing.

The ElectricImage Universe rendering engine, Universe Camera, was 

designed from the ground up as a motion picture production rendering 

system. It can handle an incredible amount of data (currently topping out 

at 30,000,000 polygons, although this is an artificial limit) in a very short 

amount of time. 

Universe Camera is a hybrid render/raytracer. Wherever possible, the 

standard rendering engine will be used. However, if you specify a material 

attribute that requires raytracing, and the Camera format is set to Raytrace 

(Render information window, Render tab), then raytracing will be used.

Rendering is very different from ray tracing. Rendering requires more 

hands on attention than ray tracing, especially when dealing with shad-

ows, and to a lesser degree, reflections. The approximate results that you 

achieve through these methods are good, and have been production-

proven. That said, the raytracing engine in Universe Camera is fast, and 
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generates beautiful imagery. You may find that you begin to favor ray-

traced options over time, as they are far easier to deal with. This will be 

especially true as computers improve in their processing power, and thus 

produce images more quickly.

Note Motion vector blur, also known as “2D blur” will provide inconsistent results 

when raytracing. Reflected objects in motion will not be properly motion blurred, 

for example. The best solution to this is to use the Multi-frame blur (also known as 

“3D blur”), or a combination of the two methods. Be warned, however, render 

times will be longer...

When rendering and raytracing imagery, Universe Camera transforms the 

models into optimal segments for rendering speed, caches the texture maps 

to RAM (or the hard drive), generates shadow maps and color buffers, and 

then applies the desired shading algorithm and render settings to the 

geometry in the scene. It is also during this stage that effects like anti-alias-

ing, motion blur, and glow are applied. All of these complex processes take 

place transparently to you after clicking on Go to launch the render. It is in 

the Render Information Window that the settings which control all these 

various rendering parameters are applied.

6.1 Render Information Window

In order to give the user maximum control over all aspects of the rendering 

process, the Render Information window in Universe Animator is divided 

into folder tabs. This chapter will explore each of these sections and explain 

what their functions are, as well as how these settings affect other group 

and object settings.

There are two ways to access the Render Info Window:

• Choose Render> Render Settings from the main menu bar 
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• Type command-r (PC control-r)

The Render Info Window will then appear.

This is the window where general rendering parameters are set, such as the 

global shading level, color depth, and the image format. This is also where 

global rendering flags are set, allowing the user to enable and disable spe-

cific parameters on a per-render basis. Each of these areas is explained in 

depth in this section.

6.1 The Render Tab

The render tab in the Render Information Window contains global shading 

level attributes for shading method, image quality, format, activation flags 

and gamma control.

The Camera Menu

This menu sets the maximum shading level for the rendering. The default 

is Raytrace, and this will provide the highest quality rendering. If this glo-

bal shading level is set to a lower quality than an individual group or 

Figure 6.0 — The Render Info Window
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object’s shading level, the global setting will override the objects’ setting. 

For instance, if an object is set for Phong shading and the global is set for 

Flat shading, the object will be rendered using flat shading. This allows the 

user to render an entire scene quickly using a lower quality shading level 

for motion tests and other previews. However, if the global is set to a 

higher quality shading level, individual objects in the scene can still be set 

to render at any of the other lower shading levels on a per object basis. This 

allows for a mixture of shading methods (i.e., wireframe objects with 

Phong rendered objects) in the same scene.

There are five basic shading algorithms currently available in Universe 

Animator. Listed by increasing quality and render time they are:

• Wireframe
• Flat
• Gouraud
• Phong
• Raytrace

Wireframe. Wireframe rendering is the fastest of the five rendering meth-

ods, and renders out a simple wireframe mesh image. This option will 

override any of the other shading methods set at the group/object level.   

To control line thickness enter a value in the Point/Line thickness box. 

Higher numbers result in thicker mesh lines. Here are examples of Wire-

frame shading using various Point/Line Thickness settings:
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Flat. Flat shading is fast, but lowest quality, solid rendering algorithm. 

Solid rendering allows for full hidden surface elimination, which is helpful 

for quick test renders in order to make sure objects aren’t intersecting with 

each other improperly. Flat shading, also known as constant shading, 

applies a light source to only one point on each face of a model. This can 

give a rendered image a faceted, blocky appearance. Using this global set-

ting, individual objects can use both flat, and wireframe shading, at the 

group/object level. It will however, override the shading level for any 

group/object that is set for Gouraud, Phong, or Raytracing.

Gouraud. Gouraud shading results in a higher quality solid rendering than 

Flat Shading, but is slightly slower. Rather than applying a light source to 

only one point on each face of a model, Gouraud shading calculates the 

light source based on the vertexes of the polygons that make up a face. 

These values are then interpolated to give a slightly smoother appearance 

than flat shading. The net result is that for a slight increase in render time, 

objects appear smoother and more naturally shaded than they do with Flat 

Shading. With this global setting, individual objects can use wireframe, flat, 

and Gouraud shading at the group/object level. This global setting will 

however, override the shading level for any group/object that is set for 

Phong shading and Raytracing.

Figure 6.1 — P/L Thickness    

P/L Thickness1.0 P/L Thickness 3.0 P/L Thickness 5.0 
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Phong. Phong shading uses an algorithm that creates natural, smooth 

shaded images. Phong shading calculates the light sources from multiple 

points across the surface of a model, instead of just at the vertexes of the 

component polygons. The result is more realistic specular highlights on 

surfaces as well as the most natural shadowing and light sourcing of any of 

the shading methods. This global shading level allows for all shading types 

to be active at the group/object level for the maximum amount of control.

Raytrace. Raytracing is the highest quality imaging level available in Uni-

verse. It produces accurate reflections, refractions and shadows, The ray-

tracing technology is channel-based, that is, only channels which are 

specifically assigned to raytrace will be imaged with the raytracer. In all 

other cases, the remaining channels will be imaged by the traditional ren-

dering engine. This implementation promotes the fastest speed possible for 

a final image.The ray trace engine inside of Universe Camera understands 

whether or not you are inside or outside of an object, so objects such as 

goblets etc. will render with the proper refraction effects out-of-the-box, 

with no need for special tricks (such as “air volumes” in other packages).

Selecting this option will raytrace every object that is set to raytrace in its 

group properties. If no objects use raytrace properties, then the scene will 

not be raytraced.

The Image Menu

The Image popup menu determines the final bit depth of the rendered 

image. Bit depth represents the number of colors used in the palette of an 

image. Black and white images are 1-bit (black or white), 256 Color and 

grayscale images are 8-bit, thousands of colors are 16-bit, millions are 24-

bit, and millions + alpha are 32-bit. These color depths are all processed as a 

post-rendering effect, as all Universe rendering algorithms are initially 
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computed in 64-bit color and then down-converted to the selected image 

format, which is typically 32-bit (Millions+Alpha). It is important to note 

that there will be NO savings in render time or speed by rendering in less 

than 24-bit color. It may actually take longer to render in one of the other 

modes, as there is an extra step which takes place after the render is com-

plete. 

The options for this pop-up are:

• BW Lines
• BW Filled
• BW Dithered
• BW Summation
• 256 Shades
• 256 Colors
• Thousands
• Millions
• Millions + Alpha

BW Lines. Renders an image with lines only, in black and white only.

BW Filled. Renders an image with filled polygons, in black and white 

mode, similar to flat shading. 

BW Dithered. Simulates a smooth shaded image using a fixed dither pat-

tern, in black and white.

BW Summation. Renders a black and white image using summation dith-

ering, a higher quality dithering. This dither uses randomly placed dots to 

make the image appear to be more smoothly shaded. From a distance, the 

image appears as a continuous tone.
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256 Shades. This option converts the image to 256 shades of gray (8-bit). 

No histogramming is required for 256 Shades as it is converted directly to 

gray scale from the original 32-bit palette. Therefore, there is no rendering 

time penalty for this option.

256 Colors. This option coverts the image to an optimized 8-bit color pal-

ette. 256 Color animation’s are histogrammed from the original 64-bit 

image file, resulting in a consistent frame-to-frame color palette. This 

means that a 256 color animation will maintain the same color palette 

throughout the entire animation. There will be a time penalty for the histo-

gram process to occur, and the amount of time required is directly related 

to the amount of frames in the movie file.

Thousands. This option converts the image to a 16-bit color palette (32,768 

colors) after rendering. As noted above, this does not speed up render time 

as the image is initially created in 64-bit.

Millions. This option renders the image in 64-bit color, adds noise and dis-

cards the alpha channel, resulting in a final 24-bit image.

Millions +Alpha. This option renders the image in 64-bit color, and adds 

noise, creating a 24-bit RGB image with an embedded 8-bit alpha channel.

The Format Menu

The Format pop-up menu determines the file format for the final, rendered 

image. The menu items are:

• Image
• Quicktime
• PICT
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Image. The original file format, used since the origin of ElectricImage. The 

Image format is a robust, 32-bit color format. It is natively supported by 

many other, high-end graphics packages such as Adobe Photoshop® and 

After Effects®. Files stored in the Image format can be displayed within 

Universe Animator choosing File>View Image.

QuickTime. QuickTime™ is a digital movie format that has become a stan-

dard across multiple platforms. Choosing the QuickTime format brings up 

a dialogue that offers the choice of any installed hardware or software com-

pression CODEC’s.

Note Settings made in the CODEC window will override both the frames per second, 

and the Image Depth, settings in the Render window. For instance, even if you set 

the Image Depth to Millions+Alpha in the Render window, if you choose millions 

only in a QuickTime CODEC the image will be stored in millions of colors, WITH-

OUT the alpha channel. Also note that any slave machines used for rendering 

must have the same QuickTime CODEC installed as selected on the host machine.

PICT. PICT format is used for single frame images, rather than animations. 

If PICT is chosen for a multi-frame render, a series of sequentially num-

bered PICT files will be saved. PICT files have the same CODEC options as 

a QuickTime movie.

Render Flags

Render flags are check boxes that are used to turn on and off various effects 

for rendering. Any box that is checked enables that function. This has no 

effect on the settings of a given group or object, but simply turns off that 

function temporarily during the render. Any objects that use these effects 

(i.e., reflections or shadows) will still maintain their settings, and will ren-

der properly when the appropriate flag is re-enabled. This allows the user 
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to enable and disable specific effects and functions on a global, per render 

basis. For instance, while doing a test render it might not be necessary to 

calculate shadows, so the Shadows box can be unchecked to save time until 

a final render is needed.

At many professional effects houses a trick that is often employed is to ren-

der out the same image using multiple passes, and then compositing the 

different passes together to form the final image. One render will be made 

just for the reflections, while another will be done for the diffuse light, 

another for glows, and so on. Then, in a post-processing program these lay-

ers can be combined with the utmost accuracy and flexibility, even chang-

ing over time.

The Flags control the following functions:

Clip. This check box controls whether or not clip maps are rendered. This 

option defaults to on.

Bump Displace. This check box controls whether or not bump and dis-

placement maps will be rendered. This option defaults to on. 

Diffuse. This checkbox controls whether or not the Diffuse channel will be 

used during rendering. This option defaults to on. 

Specular. This check box controls whether or not specular maps will be 

used in the rendering process. This option defaults to on.

Transparency. This check box controls whether or not transparencies or 

transparency effects will be rendered. This option defaults to on.

Transmission. This check box controls whether or not transmission effects 

and maps will be rendered. This option defaults to on. 
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Textures. This check box controls whether or not any texture maps will be 

rendered. This option defaults to on. 

Reflections. This check box controls whether or not any reflection maps 

will be rendered. This option defaults to on. 

Shaders. This check box controls whether or not procedural shaders will be 

rendered. This option defaults to on.

Luminance. This checkbox controls whether or not Luminance effects will 

be rendered. This option defaults to on. 

Glows. This check box controls whether or not glow effects are applied to 

the render. This option defaults to on.

Outlines. This check box controls whether or not the Cel/Outline shader 

functions are enabled. It defaults to on. By enabling this check box, and by 

also activating the Cel/Outline shader options in a groups’ material win-

dow, a variety of effects can be achieved. The Cel/Outline shader allows 

for separate color and thickness to be assigned to polygons, edges, and sil-

houettes of models.

Lens Flares. This check box controls whether or not lens flare effects will be 

rendered. This option defaults to on.

Shadows. This check box controls whether or not shadows will be calcu-

lated and rendered for an image. This option defaults to on. 

Add Noise. This check box adds random noise to rendered images to 

reduce mach banding (very discernible differences in what should be 

smooth color transitions), especially prevalent in darker colors of the 32-bit 

color space. This option defaults to on.
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Raytrace Shadows. With this checkbox marked, Raytraced Shadows will 

be rendered, if there are any in the scene. If unchecked, the Raytraced Shad-

ows will not be rendered.

Raytrace Reflections. This option will render Raytraced Reflections, when 

there are any in the scene. 

Raytrace Transparency. This options will render any Raytrace Transparen-

cies in the scene.

Raytrace Recursion

This edit box controls how many bounces a raytrace solution will make. 

The more bounces the more accurate the render, but it will also take much 

longer.

Point/Line Thickness

When a scene is rendered in wireframe, the Point/Line Thickness edit box 

allows the user to specify the thickness of points and lines in pixels. The 

default is 1 pixel. Higher numbers will give the wireframe mesh thicker 

lines.

Output Gamma

Gamma is a technical term used to describe the intensity of different levels 

of gray as they appear on an output device; usually either a computer mon-

itor or video screen. Standard gamma settings range from 1.0, up to 2.2 

depending on the output device. 
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6.2 The Resolution Tab

The Resolution Settings tab is where all of the parameters for the resolution 

of the final rendered image are set. In this window there are options for set-

ting the aspect ratio, resolution, cropping, and VR rendering functions. 

The Aspect Ratio Menu

The Aspect Ratio popup menu defines the relationship between the x and y 

pixels of the image. This relationship is known in technical terms as the 

aspect ratio. This ratio is commonly stated as “x resolution in pixels: y reso-

lution in pixels”, simplified to the lowest common denominator. Therefore, 

a standard Macintosh screen with a resolution of 640 pixels horizontally (x) 

and 480 pixels vertically (y) has an aspect ratio of 4:3. Usually, when dis-

cussing film resolutions, the aspect ratio is specified as a ratio with y 

always equal to 1. For instance, IMAX film requires a very square 1.22:1 

ratio, while 70mm uses an ultra wide 2.20:1 ratio. There are a number of 

preset aspect ratios defined in Universe Animator, or the user may choose 

to enter their own Custom aspect ratio. What aspect ratio you choose 

depends solely on the final format required for output. By choosing one of 

Figure 6.2 —  The Resolution Tab
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the pre-defined aspect ratios, the rendered image will be constrained to the 

proper pixel ratio for that format.

An important consideration when using one of the preset aspect ratio’s is 

how it affects the field of view of the camera. Not only does film stock vary 

in aspect ratio, it also correspondingly varies in the amount of information 

it can record, or the Field of View. One way to consider how the field of 

view relates to the aspect ratio is to visualize a physical piece of film stock. 

When you look at it, it has a tangible measurement of x inches horizontally, 

and y inches vertically. One factor is the relationship of these two measure-

ments to each other. Those measurements will give you the aspect ratio, 

and determine how wide or square an image will appear when projected. 

The other factor is the physical size of the film stock itself. Although both 

Super 8mm film, and 35mm Full format film have the same aspect ratio 

(1.33:1), you can see a lot more on 35mm film, shooting the same subject at 

the same distance, and using the same lenses. In other words, if you put the 

exact same lenses on both cameras, say 25mm, and shoot from the exact 

same distance, the 35mm film will have a significantly wider field of view 

and you will see more information recorded on the film. Why? Because 

35mm film is physically larger and has about 4 times the surface area of 

Super 8mm film on which to record an image. So it is very important to 

remember that you are determining not only the width, or aspect ratio, of 

an image, but also it’s relative field of view. Of course, in 3D you can use 

any lens, regardless of the aspect ratio, in order to create a specific field of 

view, but the film stock is an important factor in this equation.

Note The aspect ratio is locked to the X resolution. Any number entered in the X box 

will automatically calculate the proper Y resolution based on the currently selected 

aspect ratio. However, numbers can be entered manually in the y resolution and do 

not automatically convert the x value to the correct aspect ratio. Therefore, if you 
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want the aspect ratio to be automatically calculated, always enter your resolution 

in the X edit box, and let ElectricImage Universe calculate the proper Y resolution.

The aspect ratio choices are as follows:

• Custom
• Computer
• Super 8mm
• 16mm
• Super 16mm
• 35mm Spherical
• 35mm Full
• Vista Vision
• 65mm
• IMAX
• 70mm
• Techniscope
• 6x45 (medium format)
• 6x6 (medium format)
• 6x7 (medium format)
• 6x8 (medium format)
• 6x9 (medium format)
• 6x12 (medium format)
• 4x5 (large format)
• 5x7 (large format)
• 4x10 (large format)
• 8x10 (large format)
• 1/3 In. Video Pickup
• 1/2 in. Video Pickup
• 2/3 in. Video Pickup
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Custom. This option brings up a dialogue box for entering a custom aspect 

ratio. The pop-up menu on the right allows the user to specify the measure-

ment system in millimeters, centimeters, or inches. Then, simply enter the 

specific film gauge measurements in both x and y dimensions, or enter an 

aspect ratio in the Frame Aspect edit box. 

This dialogue box is very useful for entering custom measurements when 

you are trying to match a film stock that is not one of the presets, or you 

need to match a particular aspect ratio from another 3D package, or to suit 

a specific programming need. 

Computer. This option (the default) specifies the 4:3 aspect ratio of a stan-

dard 640x480 computer screen. The horizontal field of view using a 25 mm 

lens is 3.0 degrees.

If you are doing multimedia work for a standard computer screen, this is 

the setting that you would use most often.

Super 8mm. This option specifies the 1.33:1 aspect ratio of Super 8mm film. 

The horizontal field of view using a 25 mm lens is 12.1 degrees.

16mm. This option specifies the 1:38:1 aspect ratio of standard 16mm film. 

The horizontal field of view using a 25mm lens is 23.2 degrees.

Super 16mm. This option specifies the 1.7:1 aspect ratio of Super 16mm 

film. The horizontal field of view using a 25mm lens is 28.1 degrees.

35mm Spherical. This option specifies the 1.37:1 aspect ratio of standard 

35mm film. The horizontal field of view using a 25mm lens is 47.4 degrees.

35mm Full. This option specifies the 1.33:1 aspect ratio of 35mm Full for-

mat film, also known as Academy Aperture or “four perf,” for the amount 
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of sprocket perforations used per frame as the film runs vertically through 

the camera. The horizontal field of view using a 25mm lens is 52.9 degrees.

VistaVision. This option specifies the 1.5:1 aspect ratio of VistaVision for-

mat, with 8 horizontal perforations per frame. The horizontal field of view 

using a 25mm lens is 74.1 degrees.

65mm. This option specifies the 2.28:1 aspect ratio of 65mm vertical 5 perf 

film. The horizontal field of view using a 25mm lens is 92.8 degrees.

IMAX. This option specifies the 1.22:1 aspect ratio of 65mm horizontal 15 

perf IMAX film. The horizontal field of view using a 25mm lens is 109.25 

degrees.

70mm. This option specifies the 2.20:1 aspect ratio of 70mm film running 

vertically through a motion picture camera. The horizontal field of view 

using a 25mm lens is 88.3 degrees.

TechniScope. This option specifies the 2.35:1 aspect ratio of TechniScope 

film. (TechniScope is also referred to as “two perf,” as it divides the verti-

cally oriented 4 perf standard 35 mm frame into two frames, each using 

two sprocket perforations.) The horizontal field of view using a 25mm lens 

is 88.3 degrees.

Image Resolution Menu

The Resolution popup menu determines the final number of pixels to ren-

der for an image. This resolution will be constrained by the chosen Aspect 

Ratio. 

The resolution of an image has little effect on the amount of memory 

required to render, but does increase the number of passes needed, due to 

the additional pixels, and increases render time.
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You should note that the resolution has no effect on the field of view. You 

won’t be able to see twice as much of a scene by doubling the resolution. In 

order for the camera to “see” more of a scene, it is necessary to either 

change the aspect ratio and/or the focal length of the camera. The resolu-

tion setting merely renders more or less pixels in a given image. The 

amount of information seen by the camera is the same, regardless of the 

resolution.

The choices for image resolution, based on a Computer aspect ratio of 4:3, 

are:

• 260x200
• 320x240
• 640x480
• 1024x768
• 1280x960
• 2048x2048
• 4096x4096
• Main Screen (the default): This setting uses the resolution of the pri-

mary monitor.
• NTSC: (720x486) The standard television resolution used in North 

America and Japan. Pixel ratio =.9 (See below for explanation of Pixel 
ratio)

• PAL: (768x576) The standard television resolution used in many Euro-
pean countries, including England, and Germany.

• HDTV: (1920x1280) The mythical, high definition television format that 
may appear in the United States one day, but most likely not at this res-
olution and no longer called HDTV.

• Abekas NTSC: (720x486) Resolution used by Abekas direct disk record-
ers at NTSC resolution. Pixel ratio=0.9.
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• Abekas PAL:   (720x576) Resolution used by Abekas direct disk record-
ers at PAL resolution. Pixel ratio= 1.0667.

• Trinity

X and Y Edit Boxes

These edit boxes allow the user to directly enter values for resolution rather 

than choosing from the resolution pop-up menu. The X value will automat-

ically constrain the Y value to the chosen aspect ratio, but not vice-versa. 

The maximum theoretical resolution is 32,760 pixels by 32,760 pixels.

 

Pixel Aspect Ratio

This edit box allows the user to control the aspect ratio of each rendered 

pixel. Most computer screens display square pixels, at a pixel ratio of 1.0. 

However, broadcast television signals, including NTSC, PAL, and HDTV 

do not use square pixels. Therefore, by altering the pixel aspect ratio, non-

square pixels can be rendered. The value in this box will automatically 

change when specifying a resolution in the resolution popup.

 

Rendering with rectangular pixels will tend to make images look stretched 

out when viewed on a computer screen, but after being properly processed 

and sent to video tape they should appear normal.

Figure 6.3 — The X and Y Edit Boxes

Figure 6.4 — The Pixel Ratio box
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Image Cropping

The image cropping function allows for only a portion of an image to be 

rendered. There are two ways to use the new cropping feature. First, the 

enable cropping check box must be checked in the Render window. Next, 

values from 0 to 1 can be entered directly in the text boxes in the cropping 

area, where 0 represents left/top, and 1 represents right/bottom. When the 

image is sent to render, only the area within the cropping guidelines will be 

rendered.

More usefully, the crop region can be seen and interactively set. By first 

selecting Render >Render Settings, Resolution tab, Enable Crop and sec-

ond choosing Render>Edit Cropping from the menu. A visual guide will 

appear in the camera window. This region can now be interactively resized 

by dragging the safe title edges. When the render is sent, only the area 

within the visual cropping guides will be rendered.

Rather than just a temporary selection, like the method of rendering 

Selected Size, the Crop region can be saved and easily moved and resized. 

This kind of selective rendering option can be extremely useful when you 

have a scene set up, and you need to preview specific areas of the scene, but 

don’t want to wait while the computer renders everything in the scene. 

Rather than turning a bunch of objects off and on, or setting up multiple 

cameras, you can selectively set a cropping region around the object you 

Figure 6.5 — The Image Cropping options
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wish to and render. There is also a shortcut under the preview render icon, 

Cropped Size, that allows you to instantly render the cropped selection, or 

to render a selection within the cropped area, Selected Cropped Size.

QTVR

Quicktime VR (QTVR) is a “virtual reality” format, presented via Quick-

time. It offers two different VR modes, panoramic and object. Panoramas 

are created by warping the rendered image, which places the viewer in the 

middle of the image. The image is processed by Quicktime to give the 

viewer the apparent ability to pan around an environment, looking up and 

down, and zooming in and out. 

An object is a Quicktime VR movie that tracks a single object around a 360 

degree axis. Rather than the viewer panning and tilting across a panorama, 

an object movie allows the viewer to spin and rotate a single object around 

it’s own axis. Other tricks include the ability to have portions of the object 

animate instead of a complete 360˚ spherical orbit (or as part of a complete 

360˚ orbit.)

None. This option disables the QTVR features. This is the default option.

Panoramic. This option will create a self-contained panorama, as long as 

Quicktime is installed on your computer. (This option is not available on 

Sun machines.) You can save the output of the file as a warped image for 

use with VR methods other than Quicktime, by choosing the desired for-

mat from the Format menu in the Render tab. If you choose the Quicktime 

option from that menu, you will be prompted to select a CODEC for com-

pressing the QTVR movie.
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QTVR has several rules regarding output resolutions. The X dimension 

must be evenly be divisble by 96 and the Y dimension evenly divisble by 4. 

Common output resolutions include 2496 by 768 and 1248 by 384.

Camera renders QTVR panoramas in four panes, each with a 90 degree 

horizontal field-of-view (FOV). Make sure that the horizontal FOV is set to 

90 degrees in the Camera Info window. One of these panes will be dis-

played in the Camera View window when QTVR is enabled.

During rendering, all four views will be automatically rendered, rotated 

and properly warped.

It should be noted that Universe Animator can only generate single node 

movies. You will need to obtain additional tools, either from Apple or a 

third party, in order to create multi-node, or other special QTVR movies.

Object. Place the object you want to rotate at 0,0,0 on the global axis. Then, 

select Object from the VR popup menu in the Resolution tab of the Render 

Information Window. This will bring up an additional dialog box allowing 

you to set the number and angle of Horizontal (Latitude) and Vertical (Lon-

gitude) samples needed. By default an object movie will utilize a 360 

degree axial rotation, starting at 90 degrees Latitude, 0 degrees Longitude 

and rotating to -90 degrees Latitude, and 360 degrees Longitude. To create a 

smoother object movie, more samples can be created per rotation, by enter-

ing a value in the Sample edit box.

Unlike QTVR Panoramas, QTVR Object movies do not have set require-

ments for FOV or Resolution. These are left up to the user.

For more information, please visit Apple Computer’s Quicktime VR web 

page at: www.apple.com/quicktime/qtvr/
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6.3 The Anti-Alias Tab

Anti-aliasing is the filtering process used to remove “jaggies” and moire 

patterns from rendered images. The anti-alias tab contains all of the set-

tings through which you control anti-aliasing quality.

The Anti-Aliasing Menu

The Anti-Aliasing popup menu determines the type of anti-aliasing used 

when rendering. 

The choices are:

• None
• Adaptive
• Oversample

None. This option specifies that no anti-aliasing will be used on the image. 

Edges and outlines may have a jagged, rough appearance.

Adaptive. This option specifies that adaptive anti-aliasing be performed on 

the render. This produces a softer image than None, and a sharper image 

than the Oversample. Thin, sharp lines may cause artifacting when render-

ing for video output, and using Oversampling may be more effective in 

these cases.

Figure 6.6 — The Anti-Alias tab
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Oversample. This option (the default) specifies that Oversampling be per-

formed on the render. This produces the softest images with the smoothest 

edges, and significantly reduces video artifacting caused by jagged edges.

The Anti-Aliasing Levels Menu

This menu controls the amount of sampling that will be performed on the 

image. The menu items are:

• 4x4
• 8x8
• 16x16
• 32x32
• 64x64

4x4. (The default) This setting is generally sufficient for most images. Lines 

and edges maintain a sharp, detailed appearance. High contrast vertical 

and horizontal edges can cause artifacts, and moire patterns, for which the 

8x8 setting may work better.

8x8. This setting is useful when a slightly smoother, softer look is required. 

Lines and edges will appear less crisp than when using the default, and 

may reduce moire patterns and artifacts. Be aware, however, that this set-

ting may slow down rendering time significantly over the default 4x4.

16x16 (and higher). These settings should only be used in specific instances 

where a very high level of anti-aliasing is needed. For the vast majority of 

renders, these sampling levels will produce an image that is indistinguish-

able from one rendered at a 4x4 or 8x8 level. However, rendering time goes 

up dramatically when using these levels.
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The Sampling Levels Menu

Object sampling levels are set in the group info window for each object. 

The values in the sampling level menu are used to determine the maximum 

amount of sampling allowed at render time. If some of your groups are set 

to 4x4 sampling, and the sampling menu is set to 2x2, sampling will be lim-

ited to up to 2x2 maximum as the image is rendered. The menu items are:

• 1x1
• 2x2
• 4x4
• 8x8
• 16x16
• 32x32
• 64x64

1x1. (The default) This setting is sufficient for lower detail objects, or mod-

els that appear at a moderate distance from the camera. However, when 

viewing images rendered at this setting up close, jagged edges may be 

apparent. This is also not a good setting for high resolution images.

2x2. This is a good, general setting for most objects and groups. Render 

time compared to 1x1 sampling may be only slightly higher, and the extra 

detail is generally worth the time, especially with high detail texture maps.   

This setting may also help animations that exhibit flashing, or stair step 

patterns on playback.

4x4. This setting, although slower than 2x2, is useful for objects which 

require a high amount of sampling detail. This includes objects with intri-

cate texture maps that are in close proximity to the camera, or that involve 

complex effects passes (smoke, fog, glow). Very high resolution images 

may also benefit from this sampling level.
Electric Image Universe 3.0        201



Chapter 6  Rendering — Anti-Alias Tab
16x16 (and higher). Like anti-aliasing levels, these setting should only be 

used in specific instances where a very high sampling level is required. 

Render time at these levels increases by a huge amount, and for the major-

ity of renders will show no noticeable improvement.

When rendering at any typical resolutions (720x486 and less), leave your 

anti-aliasing level at 4x4. Unless you see a problem in the render this set-

ting will be more than adequate and allow you to render as quickly as pos-

sible. For sampling levels, consider using a global maximum sampling 

level of 4x4, and individually setting the sampling levels on a per object 

basis. Therefore, if you have an object with a complex texture map very 

close to the camera you can set it’s sampling level to 4x4, while objects that 

only appear in the distance can be set for 1x1. This approach gives you the 

maximum control over the 2 major issues in a production setting; quality 

and render time.

Adaptive Sampling Threshold

The Min and Max edit boxes contain values that control the type of adap-

tive comparison filtering to be performed between adjacent pixels of differ-

ent color values. If the difference in the pixels is less than the minimum 

value, the image is sharper (less filtering, more jaggy). If the difference in 

the levels is greater than the maximum value, the image is softer (more fil-

tering, less jaggy). If the difference falls between the minimum and maxi-

mum values, adaptive anti-aliasing is performed. The higher the difference, 

the softer the image; the lower the difference, the sharper the image.

Figure 6.7 — The Sampling Threshold boxes
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6.4 The Motion Blur Tab

This section of the Render window is used to control the motion blur fea-

tures of Universe Animator. Motion blur is the simulation of the kind of 

effect that occurs when recording a moving object on film. As an object 

moves across a frame of film it naturally blurs, depending on the speed of 

the film, and the object’s velocity. These controls allow you to mimic that 

behavior in Universe Animator. Note that in order for blur effects to be ren-

dered, it is also necessary to set the blur mode for each object/group that 

you wish to blur under that object’s group info window.   

Note This setting defaults to no motion blur. You will need to change the blur mode to 

the desired setting per object blur or motion blur will not be rendered.

Shutter Angle

This edit box contains a value in degrees that represents the circular angle 

at which a camera shutter is open. A value of 360 degrees simulates a shut-

ter that is always open, whereby all moving objects leave a continuous 

streak across the frame. A value of 180 degrees (the default) simulates a 

Figure 6.8 — The Motion Blur Tab

Figure 6.9 — The Shutter Angle Box
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shutter that is open for half a frame, mimicking a motion picture camera. 

The higher the angle, the longer the shutter will stay open, creating longer 

streaks and more blur. Note that only moving objects create blur, or streaks, 

as the streak length is computed by the distance an object moves within the 

field of view from frame to frame. Hence, objects that are far away from the 

camera will streak very little regardless of their velocity, while very close 

objects will streak dramatically with very slight movement. Values higher 

than 360 ˚ will create dramatic streaking, even on slow moving objects. 

Great for that “warp speed” effect.

Blur Intensity

This edit box is used in conjunction with the Point/Line blurring technique 

(see below). This value controls the brightness of the streaks left behind by 

points and lines. A value of 0.0 (the default) imparts a constant value 

regardless of the length of the streaks. Larger values produce brighter 

streaks, while smaller values produce dimmer streaks. A separate blur 

intensity can be set for each individual object/group in that group’s info 

window. This edit box automatically appears after selecting the Point/Line 

blur mode.

Blur Noise

This edit box is used in conjunction with the Motion Vector blurring tech-

nique (see below). This value controls the number of blur samples per 

pixel. The higher the number, the less visible noise in the streak. By using a 

value of 0, Universe will automatically compute the optimal number of 

Figure 6.10 — The Blur Intensity checkbox

Figure 6.11 — The Blur Noise checkbox
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samples for a streak based on its length. A value of 4 (the default) renders 

quickly and produces high quality results. Values over 10 are unproduc-

tive, and will drastically slow the rendering process.

Blur Frames

This edit box is used in conjunction with Multi-frame motion blur (3D 

blur). This value represents the number of individual frames that are ren-

dered prior to averaging the frames together to generate a single frame. For 

instance, if this value is set to 3, for each frame of an animation, Universe 

generates 3 images, the frame ahead of the current frame, the current 

frame, and the frame behind. It then averages these images together to 

make a single frame, with blurring based on the distance moved between 

all 3 frames. If this value is set to 2, Universe calculates two frames for aver-

aging; the current frame, and one after the current frame.

Point/Line Blurring

This check box, when enabled, activates the point/line motion blur tech-

nique at the global level. Individual objects still need to be set for this type 

of blurring at the group/object level. In this mode, only points and lines 

leave streaks behind. This is most useful for the motion blur of star streaks 

and particle systems. Normal polygonal models will not streak using this 

method.

Figure 6.12 — The Point/Line Blurring checkbox
Electric Image Universe 3.0        205



Chapter 6  Rendering — Motion Blur Tab
Motion Vector

This check box, when enabled, turns on Motion Vector motion blur (2D 

blur) at the global level. Unlike the point/line method which only blurs 

points and lines, this method induces blur on all objects which have been 

set for motion vector blurring. This includes points, lines, and polygons. It 

should be noted that blurred lines are always linear, and are never curved 

when seen in a single frame. This is a fast and versatile technique which 

works for most objects.

Multi-Frame

This check box, when enabled, allows for multi-frame sampling for motion 

blur. It can be used in conjunction with the other blur techniques (point/

line or motion vector). The number of frames to be sampled is set in the 

Blur Frame check box. Strobe like effects are produced if too few sample 

frames are used with this option alone. It is best applied to a section of an 

animation where there is complex or rapid motion (like spinning fan 

blades, or the tires of a quickly moving car). Combining this technique (set 

to 2 sample frames) with Motion Vector blur produces great results for 

those times when Motion Vector isn’t quite enough.

Figure 6.13 — The Motion Vector checkbox

Figure 6.14 — The Motion Vector checkbox
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6.5 The Glow Layer Tab

Any group can be given a gaussian glow that emanates outward from that 

object. Additionally, groups of layers can be defined, each with its own 

glow radius and intensity. 

There are three sections in the glow tab:

• Glow Layer List
• Glow Layer Members List
• Configuration Section
•
Glow Layer List. A glow layer contains glow attributes which apply only 

to members of that layer. To add a glow layer:

1. Click the Add Button Next to the Glow Layer list
2. Name the layer
3. Click OK

A new glow layer is added to the list.

Figure 6.15 — The Glow Layer Window
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Glow Layer Members List. Glow layer members are selection sets. In 

order for groups to use their glow effects (applied as a material), the groups 

need to be in a selection set contained within a glow layer. To add a selec-

tion set to a glow layer:

1. Select a glow layer
2. Click the Add button next to the glow layer member list
3. Pick a selection set form the list
4. Click the Add button

The selection set is now added to the glow layer.

Glow Configuration Section. The appearance of the glow layer is a combi-

nation of the material attributes of the glow, as well as the settings in the 

Glow Radius and Glow Intensity edit boxes, shown below. 

Glow Radius. The pixel area of the glow. This is the area of the image that 

will have a glow effect applied to it. Smaller values are good for objects that 

you wish to appear brighter in a scene, while larger values are better for 

simulating effects such as glare.

Figure 6.16 — The Glow Layer Window with Glow Layers and Layer Members
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Glow Intensity. This value controls the brightness of the glow. Glows are 

added on top of the rendered scene, therefore a value of 1.0 would produce 

a glow that is twice as bright as the original image without glow.

Although glow layers and sets may seem a bit complex at first, once you 

get the hang of it you will begin to understand the potential. Rather than 

having to manually tweak settings for each separate glow effect you can 

simply define a series of standard effects and apply those to the appropri-

ate sets at render time. For instance, you could come up with a set of glow 

layers to simulate fire, candles, tv monitors, spaceship exhausts, light 

bulbs, etc. Once you have a series of defined glow layers they can easily be 

assigned to any set of objects you’ve created. Additionally, since Glow 

radius and intensity can vary by layer, a series of complex effects and lay-

ered glows can be created.

6.6 The Timing Tab

The timing tab contains start and stop information, and playback informa-

tion.

Figure 6.17 — The Timing Window
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Start and Stop Times

This edit box defines the start and end times for a project, in seconds. These 

settings are also represented visually in the project window by the green 

(start) and red (end) arrows, and can be changed by dragging them interac-

tively. Any changes made in the project window will be reflected here, and 

vice versa. These boxes define the total range of frames for a given project. 

Animation keyframes can still exist outside of the range of frames for a 

project, but will not be rendered. 

Note: It is possible to set the start time to a negative number. This can be very helpful if 

you’ve already created a complex animation starting at 0.0 seconds, and you later 

realize you need to add a sequence prior to the start of the animation. Rather than 

attempting to drag all of your keyframes to the right, simply use a negative number 

as your start time. Be aware, however that while this works in most cases, negative 

frame numbers may not work with simulation plug ins such as particle systems.

Total Frames

This edit box displays the total number of frames in an animation. This 

number is generated automatically based on multiplying the delta (differ-

ence) of the start and stop times by the number of frames per second and 

adding 1. For instance, if a project is set for 10 seconds, and the frame rate is 

30 frames per second, the total number of frames rendered will be 301. This 

extra frame is due to the fact that Universe Animator counts frame zero as 

the first frame in an animation. This number is displayed primarily for ref-

Figure 6.18 — The Start and Stop Boxes

Figure 6.19 — The Total Frames box
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erence, although by setting the Total number of frames directly in the edit 

box, the Stop Time will be updated accordingly in both the Stop edit box 

and the project window.

Nth Frame

This edit box is used to specify that an animation is only rendered out with 

every nth frame. In other words, if this box is set to 2, then every 2nd frame 

will be rendered. If the start frame is 0, the following frames will be ren-

dered: 0, 2, 4, 6, 8...etc. In order for this to work, the Enable Nth frame 

checkbox must be checked. This setting works independently of the Render 

frames pop-up. The Nth frame is always used if selected, whether an ani-

mation is rendering all frames, or a selected range of frames. For instance, if 

a render is set for a range of frames from 100 to 150, and Nth frame is set to 

3, then the following frames will be rendered: 100, 103, 106, 109...etc.

The Nth frame box is extremely useful for doing test renders. Instead of 

having to render out every single frame of an animation, it is often suffi-

cient for a rough motion test to only render out every 2nd or 3rd frame.

FPS Menu

This edit box is used to specify the number of frames per second (fps) to be 

rendered for an animation. This figure determines the total number of 

images that are drawn per second. Note that it is important to set this num-

ber prior to doing any animation in a project, as all animation keyframes 

that are created will be based on this number of frames per second. By 

changing this value later, velocities and keyframe attributes may be thrown 

off. 

Figure 6.20 — The Nth Frame box and checkbox
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The pop-up menu contains the following choices:

• Custom
• NSTC 30
• NTSC 30i
• Pal 25
• Pal 25i
• Film 24

Custom. The Custom setting allows the user to enter any number of frames 

per second, as well as choose whether or not the image will be interlaced. 

Interlaced rendering splits each frame into two fields, with the odd field 

dominant unless the Even Field check box is enabled. Interlaced fields are 

necessary for some broadcast video output cards. You should consult with 

your video output devices manuals to determine if interlaced fields are 

necessary.

NTSC: 30, 30i. This setting specifies the NTSC video standard of 30fps. 

This is what all broadcast television in the US is shown using, and consists 

of a 60Hz signal, being shown in 2 fields. Combining both fields into 1 

frame results in a frame rate of 30fps. NTSC: 30i is output as interlaced 

frames, with the odd field dominant.

PAL: 25, 25i. This setting specifies the PAL video standard of 25fps. This is 

most common for European broadcast television, and differs from the US 

in that it operates at 50Hz, shown in 2 fields. Combining both fields into 1 

frame results in a frame rate of 25fps. Pal:25i is output as interlaced frames, 

with the odd field dominant.

Film: 24. This setting specifies the motion picture standard of 24fps.
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6.7 The Render Menu

This pop-up menu is used to select the range of frames that are to be ren-

dered. The choices are:

Current Frame. This option (the default for single frame projects) causes 

only the current frame in the animation to be rendered. The current frame 

is defined as whatever frame is currently displayed in the camera window. 

This is selected by moving the time slider in the project window.

All Frames. This option (the default for multi-frame projects) causes all 

frames in an animation to be rendered. The total number of frames is 

defined by the Start and Stop times, mentioned above.

Range of Frames. This option opens a dialogue box which allows for set-

ting specific frame numbers to be rendered. Using this tab, any portion of 

an animation within the Start and Stop times can be rendered. This is very 

helpful when working in a large project, with multiple animation 

sequences. Using this setting, only a specific range of frames needs to be 

rendered. You can also use Range of Frames to render your animation in 

reverse order, by typing reverse values in the edit boxes.

Even Field. This checkbox specifies that when rendering interlaced anima-

tion files, the Even field will be rendered out as the dominant field. This 

defaults to off, because the RS-170A specification for NTSC calls for odd 

field dominance. Some video cards break this rule (programmers always 

start on even numbers, such as zero, instead of odd numbers like one) and 

this option is present for those conditions. 

Note Be warned, even if your setup is even field dominant, most production houses are 

odd field dominant — you might need to re-render!
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6.8 Network Rendering Tab

You can render to as many computers as you wish (assuming they meet mini-

mum performance requirements.) Renderama, the Universe network render-

ing application, must be available in the same folder as Universe, and 

properly configured. See “Network Rendering with Renderama” on 

page 217.

6.9 How To Render a Project

To initiate a render, make sure that all of your parameters are set the way 

you want them. You can then launch the rendering process in one of several 

ways:

• Render>Window from the main menu bar
• Render>Frame from the main menu bar
• Render>Window Selection from the main menu bar
• Render>Frame Selection from the main menu bar
• Render>Render Project... from the main menu bar
• The “Go” button from the Render Information Window

The Render>Window (and selection) and Render>Frame (and selection) 

will render the current frame only. You cannot initiate a complete project 

render from these menu items. Only Render>Project and the “Go” button 

from the main menu bar can initiate a complete project render. For more 

information on rendering single frames, please See “Render Menu” on 

page 69.

Launching a Render from the Menu Bar

The Render Project... menu option will render all frames of an entire 

project, unless you have selected otherwise, with the Render popup menu 
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in the Timing tab of the Render Information window. Once you select Ren-

der>Render Project..., a save dialog will appear, prompting you for the 

name of the image or movie that you wish to render, and for the location 

where the file is to be placed upon completion. Afterwards, a Save Project 

dialog will appear. If you choose not to save the project, all of the work that 

you had completed after your previous project save will be lost.

Launching a Render with the Go Button

To simply begin rendering a project, click the Go button. If you haven’t 

saved, you will be prompted to do so. Following that, Universe Animator 

will quit, launch the camera application, and begin rendering. 
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Network Rendering with Renderama

7.0 Introduction

Rendering is typically the longest process in computer animation produc-

tion. Even with the “world’s fastest renderer,” rendering still takes too 

long. In recent years, a method has appeared to allow the work of the ren-

dering engine to be split up into smaller tasks, and distributed over a com-

puter network of suitable machines and rendered remotely. This is called 

“network rendering.” 

Network rendering requires a robust computer network, computers with 

large hard drive capacities, generous amounts of RAM, and modern CPUs, 

such as Intel PIII or P4s, Athlons, Power PC G4s or UltraSPARC-IIIs. You 

can use older machines, but of course, your render times will be longer.

The network rendering process involves a great deal of file transferring of 

data back and forth, and any noise on the network will affect data transfer 

throughput. Mixed protocol networks can sometimes create grief, and 

older routers can often be the culprit of slow network performance. Which, 

of course, leads to poor network rendering performance. Therefore, in a 

perfect world, these are things that you should avoid.

As you can imagine, with this much data traveling back and forth across 

the network, tracking model files, texture maps, plug-ins and so on can get 

rather complicated. A management system needs to be in control of the sit-

uation in order to produce satisfactory results. Network rendering in Uni-

verse is managed by the included Renderama utility.
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Renderama

Renderama can be used to schedule batch rendering on a single computer, 

as well as to distribute renderings among many networked computers. 

Each time that you send a file to be rendered via Renderama, you are creat-

ing a rendering job. Renderama will manage each job separately for you.

Note Renderama jobs can only be distributed across TCP/IP local and wide area net-

works. No other network protocol is supported.

Renderama can distribute rendering jobs transparently among multiple 

computer platforms including Macintosh, NT, and UNIX-based computers. 

However, if you do choose to render in a multi-platform environment, it is 

a good idea to confine specific shots to a specific class of computers. This is 

due to the fact that different computer classes use different math proces-

sors. As each rendered frame is very math intensive, small differences 

maybe noticeable frame-to-frame across different CPU types. Most of the 

time, these differences are not noticeable. Sometimes, however, they are 

glaring.

Renderama acts as a middle-man in-between Universe Animator and one 

or more Universe Camera rendering engines. It coordinates all rendering 

activity, automatically distributing jobs across the network, or queuing sev-

eral jobs for subsequent batch rendering, in the case of a single machine 

configuration. 

Renderama is actually a very simple-minded program. It does not offer 

many bells and whistles. Instead, it doles out single frame renders to each 

active machine on the network, and waits to see if the machine successfully 

completed the frame. If the rendering was successful, it is sent back to the 

master machine to be stored until all of the frames in the animation have 
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been completed. Once all the frames are completed, the Renderama master 

application will stitch the frames together in the proper order.

If for some reason a machine fails to successfully complete a rendered 

frame, Renderama will remove the machine from the active list, and take it 

offline. In the status section, an error message will be displayed, and the 

word “error” will appear next to the slave’s IP address in the slave list. That 

machine will remain offline for any further rendering jobs unless you reset 

it directly at the machine itself. Resets cannot be performed remotely.

Note If a machine actually crashes, or the power goes out while a machine is rendering, 

Renderama can recover once the machine is rebooted.

7.1 Configuring Renderama

Renderama consists of two applications, Renderama and Renderama Slave. 

The Renderama application acts as a master, and directs all the Renderama 

Slaves. The Slaves then transfer the output back to Renderama, where it 

stitches them all together.

Important Universe Animator and the Renderama master application must be run 

from the same machine. The machine that is running the Renderama mas-

ter application cannot be shut down until the current rendering job is com-

pleted, or the job will be suspended. If you desire unattended network 

rendering, you will need to manually copy your Universe Animator project 

file and associated model and texture files to the master machine, launch 

Universe Animator on that machine, and follow the steps outlined in “Net-

work Rendering Job Management” on page 222.

By default Renderama will recognize the machine where it is installed as a 

possible rendering candidate, called “local”. If you have a multiple 
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machine network, and want to render on other machines, they must be 

added to the list.

Adding a slave rendering machine to Renderama:

1. Launch the Renderama application. It is located in the Universe Ani-
mator directory

2. Once Renderama starts up, the control window as shown in Figure 7.1 
will appear

3. Click the Add Slave button

Figure 7.1 — Initial Renderama Interface with Add Slave Highlighted

Add Slave
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After clicking the Add Slave button, a dialog appears to enter the 

Slave’s IP address. 

4. Enter the address and click OK

After the new IP address is added, the new slave will appear in the Ren-

derama window. The small circle icon next to the name indicates that you 

will allow this machine to be available to render.

Note A machine called “local” will always appear in the slave list. This is the machine 

that the Renderama application was launched on. You may wish not to use the local 

machine as part of network rendering.

Important The Slave machines must have a directory with Camera, Renderama Slave, 

and the EI Sockets, and EI Shader directories installed. Renderama will not 

transfer sockets or shaders, instead, it looks locally.

The Renderama Slave application must be running in order for a rendering 

machine to be accessed by the Renderama Master. Universe will not launch 

the Renderama Slave or Renderama Master applications. You must do this 

Figure 7.2 — Add Slave IP Address Dialog

Figure 7.3 — Renderama with a Slave Added
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yourself. On network rendering machines, it is a good practice to place an 

alias or shortcut of the Renderama Slave to launch when the computer 

boots. This will allow for seamless operation, as well as better error recov-

ery.

7.2 Network Rendering Job Management

Once the Renderama master application is configured, and the slave 

machines are properly installed, up and running, you can begin to use Ren-

derama for network rendering. The first thing that you must do is to set up 

your Universe Animator project for network rendering.

Creating a Renderama network rendering job:

1. Launch the Universe Animator application
2. Load the desired project into Universe Animator
3. Choose Render>Render Settings from the main menu bar
4. Select the Network tab in the Render Information Window

The network rendering tab will appear.

Figure 7.4 — Render Window with Network Tab Selected
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5. Click on the Enable Network Rendering check box
6. Enter the name of the rendering job
7. Click on the Go button

A save file dialog will appear, prompting you to choose the final ani-

mation file and the directory in which the file will be placed. Rendering 

control files will then be written from Universe Animator, and supplied 

to the Renderama application. Normal operation will then be returned 

to Universe Animator.

Once you have created a network rendering job for Renderama, you must 

then activate the job. 

Note Universe Animator will not automatically switch to Renderama for network ren-

dering. You must do that manually.

To activate a rendering job in Renderama:

1. Launch the Renderama application
2. From the job list, choose the desired job name. There may be more than 

one job name

3. Make sure that the job is active, as indicated by the shaded circle icon 
to the left of the job name. If the circle is not present, the job will not be 
processed.

4. Select the Go button at the top of the window.

Figure 7.5 — Job List in the Renderama Window
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Once you select the Go button, Renderama will begin to transfer files to 

the slave rendering nodes on the network. 

The status section at the bottom of the window will provide current Ren-

derama system information. Slave machine status will be presented to the 

right of the slave machine in the slave list. As the rendering job progresses, 

Renderama will report any necessary information in the status section.

The jobs can also be removed by highlighting them and clicking remove.

Error Recovery

In the event that one or all of the Renderama applications fail, or the ren-

dering computers fail, Renderama will pick up where it left off after every-

thing is reset.

How to Get the Best Results from Renderama

As mentioned previously, Renderama is a simple-minded application, 

intentionally so. It is designed to make good use of a multi-machine render 

farm. Under certain conditions, using Renderama can be a matter of dimin-

ishing returns. Due to some overhead operations, Renderama is less effi-

cient when you have less than three slave machines in your render farm. 

That does not mean that you shouldn’t use Renderama in render farms 

with less than three machines, but that larger jobs (longer movies) will 

show more of a benefit in using Renderama than smaller jobs will.

As Renderama requires an individual control file for every frame, the con-

trol file write process can take noticably longer in Universe Animator than 

writing out a single control file for direct rendering. To insure that a job is 

successfully completed, Renderama performs certain housekeeping rou-

tines which can also impact your overall render times. 
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7.3 Renderama Tips

• You must make sure that Renderama slaves are active in order to suc-
cessfully launch a rendering job.

• If you have installed any new shaders or plug-ins on your Renderama 
master machine, make sure that you place copies of them in the EI 
Shaders and EI Sockets folders on the Slave machines.

• Some plug-ins use supporting files, such as textures. Make sure that 
these are located inside the EI Sockets folder on the slave machines as 
well.

• If networks use substandard network cables, switches, hubs, or has a 
lot of traffic, this will impede network rendering performance, or even 
make it impossible to complete a job.
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Selection Sets

8.1 Introduction

Although this chapter is deceptively short, it discusses a seemingly simple 

part of ElectricImage Universe that grows in importance with the complex-

ity of the project: Selection. Just as image-editing and illustration applica-

tions have multiple methods of selecting elements based on their attributes, 

then acting on them in ways unique to the selection process, we have wid-

ened the scope of how selections are made in Universe Animator — of how 

they are used to organize a project, and how they can be used to create spe-

cial effects.

To move an object or access the material attributes of a group, you must 

first select the object or group. This is done by clicking once on the object, 

either in the world views or Project Window, or by dragging a rectangle 

around one or more groups. To facilitate selections which are larger in 

scope, the Select menu allows you to select models and groups by a variety 

of methods.

The Select Menu has a selection type, By Set. A set is simply a defined col-

lection of groups from within a project. The By Set menu option allows you 

to edit selection sets, or select items in the project that already belong to an 

existing set. The hierarchical menu below By Set initially contains a single 

entry, Edit Sets. As sets are created their names will appear in this space.

Selection sets are used for light inclusion/exclusion lists, glow layers and, 

of course, typical selections. Selection sets will come in very handy as you 

work with Universe Animator.
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8.2 Select by Set

Sets have four purposes in ElectricImage Universe. 

• To select groups of items within the project
• To include or exclude groups from a light’s illumination
• To control the glow radius and glow intensity for a set of models
• To control which objects receive projections from Camera Maps.

To create a selection set:

1. Choose Select>By Set>Edit.
2. The Sets window, show below in the illustration “Selection Sets Win-

dow” on page 229, opens.
3. In the Selection Sets column, click Add. When prompted, create a name 

for your set.

The name of the selection set will be appended to the Select>By Set menu.

Figure 8.0 — Select Menu
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The Selection Sets Window
Selection

Sets

The left column, Selection Sets, contains the names of all existing sets. Once 

you create your set its name will appear in this column. New sets can be 

created and old sets can be deleted using the Add and Remove buttons. 

The Sort pull down gives you the option of viewing the list of sets alpha-

betically or in their creation order.

Members The right column, Members, shows the members of the set that is high-

lighted in the left column. To add members to an existing set, go to the 

Project window and highlight the names of the groups to be added. Then 

return to the Selection Sets window. 

In the left column, highlight the set name to which you wish to add the 

objects and click on the add button on the right side of the dialog box. 

Members of sets or whole sets can be removed by highlighting the item and 

clicking on the remove button.

Figure 8.1 — Selection Sets Window
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Using and Animating Groups

9.1 Introduction

In Universe Animator, geometry that is animated and rendered are referred 

to as groups. Typically, a single group corresponds to a single layer or 

object within a model file. Groups can exist as independent entities, or 

within a hierarchy. Groups can be translated (moved, rotated and scaled), 

deformed, have its materials animated, and so on. Groups can be imported 

from other programs (into the native ElectricImage FACT format) or the 

Universe Modeler, or be created by a variety of plug-in programs. A group 

can have as many as 250 or more animation channels, many of which can 

be individually enabled or disabled (others by the class of animation chan-

nel). Each channel can be controlled independently by you. All of the chan-

nels can be placed into the function curve editor for animating, or you can 

pick individual channels.

Each group can contain an unlimited amount of points, lines and polygons 

and texture maps. There are no limits to the amount of groups that you can 

have within a project, memory permitting.

To import a FACT model into a project:

1. Choose Object>Import Object...

2. Select the Model name from the file list
3. Double click or press the Add button
4. Click the Done button when finished

The model will now appear in the world view windows, and the file name 

of the model will appear in the Model File section of the Project Window. 

The model’s groups will appear in the group section of the Project Window.
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Model formats from other programs can be imported into Universe Anima-

tor. Several popular formats are supported.

To import a foreign model format into a project:

1. Choose Object>Import Object...

2. Select the Model name from the file list
3. Double click or press the Add button
4. Click the Done button when finished

The model will now appear in the world view windows, and the file name 

of the model will appear in the Model File section of the Project Window. 

The model’s groups will appear in the group section of the Project Window.

In addition to adding and importing models into Universe Animator, you 

can also create font models from Adobe® PostScript® Type 1 fonts or 

Apple® TrueType™ fonts. The font outlines are converted into polygons, 

and depending upon your choices, extruded into 3D and even bevelled.

To add 3D text into a project:

1. Choose Object>Add 3D Text...

2. Select a Font from the file list (a font does not need to be installed in the 
system in order for it to be converted into 3D — the fonts can reside on 
any disk)

3. Type in the font letters that you desire in the text box
4. Click OK
5. Set the extrusion height and bevels and element colors (if desired)
6. Click the OK
7. Save the font model

The font model will now appear in the world view windows, and the file 

name of the model will appear in the Model File section of the Project Win-
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dow. The model’s groups will appear in the group section of the Project 

Window.

As mentioned previously, groups can exist individually, or as part of a hier-

archy. Hierarchies enable complex motions to be created, using groups 

linked in “chains” or “trees.” Hierarchies are also required if you wish to 

animate your groups with inverse kinematics.

9.2 Group Info Window

Like all other object classes in Universe Animator, groups have an informa-

tion window associated with them that allow you to control a variety of 

options. The group info window contains basic non-material attributes for 

the group (such as position, rotation, scale, and so on), as well as an access 

point to the group’s material record. The Group Info Window is divided 

into conveniently organized folder tabs, each containing the controls and 

functions indicated by the name of the tab. To access the contents of a tab, 

just click on it.

The group info window is divided into the tab section, Material ball icon, 

and configuration check boxes. The four folder tabs are:

• X-Form (Transformation)
• Shading
• Shadow
• Info
• Display
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Base Options

On the left side of the window you will see either two or four options, 

depending on what type of object it is. They are not linked under a folder 

tab, and remain visible at all times.

Show Extent Box

This check box toggles on and off the display of group bounding boxes in 

the 3D views.

Figure 9.0 — Group Info Window

Figure 9.1 — Material Ball
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The Material Ball

The material ball shows shading properties that are set for the current 

group (it is does not show texture maps or procedural shaders.)

The following two options will only appear if the group’s geometry is generated by 

an active plug-in.

The Plug in Button

When a group is comprised of data generated by a plug-in, clicking this 

button will open the plugin’s configuration window. 

Live Plug in

This checkbox toggles on and off the active recalculation of a plugin’s 

parameters when the time thumb is moved (a great time saver.) 

For example, if you have a Mr. Nitro group in your project, every time you 

move the time thumb Mr. Nitro will recalculate the position of the group’s 

fragments.   A particle system will do exactly the same thing. Unchecking 

Live Plug-in will disable this calculation, removing the need for you to type 

Alt-Period (Command-Period) to prevent recalculation.
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The X-Form Tab

The X-Form (Transformation) Tab contains spaces which contain X, Y, and 

Z values for the three geometric transform values of a group: 

• Position
• Rotation
• Scale

Position. Displays the position data at the current scene time.

Rotation. Displays the rotation data at the current scene time.

Scale. Displays the scale data at the current scene time.

In the position section, you will see a popup menu where you can select 

Implicit or Explicit keyframe interpolation. The following section will 

explain the differences in these two types of interpolation. Following this 

section we will continue with the explanation of the Group Info Window.

Figure 9.2 — X-Form Tab
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Implicit and Explicit Interpolation

All vectorized quantities in Universe Animator (position, reference, center, 

etc.) have an extra pulldown menu in their info windows. This pulldown 

controls whether the quantity is Implicitly or Explicitly translated. Explicit 

translation allows separate control in our curve editor for each of the three 

components (X,Y,Z).

To make an object’s Translation explicit:

1. Open the Group Info window for a given object. Make sure that the X-
Form window is in the foreground.

2. Change the translation of the particular Transformation characteristic 
from Implicit to Explicit.

The illustration below shows the Position translation being changed to 

Explicit.

The translation value for the object’s position is now explicit. Repeat these 

steps for any other value to change its transformation.

Figure 9.3 — Changing Implicit to Explicit
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The Shading Tab

The shading tab contains attributes which let you specify the shading 

behavior of the group. 

The Shading tab is divided into seven sections:

• Shading Pop up Menu
• Sampling Pop up Menu
• Fog Section
• Reflection Section 
• Line Section
• Blur Section
• Color Section
• Geometry Section
• Texture Section

Figure 9.4 — Shading Tab
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Shading Pop Up Menu

The Shading pop up menu allows you to set the rendering level for the 

group. The items offered in the menu are the same as the choices offered in 

the Camera pop up menu found in the Render tab of the Render Informa-

tion Window. The items offered and their definitions are covered on 

page 179.

Sampling Pop Up Menu

The Sampling pop up menu allows you to set the level of sampling, or anti-

aliasing, that the group will receive. If you choose the option labeled 

“default,” then the group will be sampled at the level set in the Anti-Alias 

tab in the Render Information Window. If you choose a sampling level 

other than “default,” the object will be sampled up to the level of sampling 

that you have selected. The actual level of sampling the object receives is 

again dependent upon the sampling level settings in the Anti-Alias tab of 

the Render Information Window. If you choose a level in the Anti-Alias tab 

that is lower than the level that you have chosen for the object, the level of 

sampling will be limited to the setting in the Render Information Window. 

If you choose a sampling level that is lower than the setting in the Render 

Information Window, then the level of sampling will not extend further 

than the sampling level set in the Shading tab of the group. For more infor-

mation and definitions of the other choices in the menu, please refer to 

page 201.
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Fog Section

Fog Enable

This check box enables the group to be affected by any of the global fog set-

tings in the World Info Window’s Fog Tab. When this box is unchecked, 

the object will not be affected.

Reflection Section

The items in this section are pertinent only when automatic reflections such 

as mirror or environment maps are used somewhere in the scene. They are 

otherwise ignored.

Cast No Reflection

Enable this check box if you don’t want the group to cast a reflection onto 

another group. 

Reflection Object Only

Checking this box will force the group to not render in the scene, but other 

objects will be able to see it in their reflections.

Line Section

The attributes in this section affect wireframe shading options only. They 

do not affect the cell/outline shader settings found in the geometry tab of 

the Material Editor. 
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Shade Lines

When a group’s shading popup is set to wireframe, this check box enables 

the material attributes assigned to the group to actually shade the wire-

frames of the group. Very cool.

Line Size (pixel)

Use this value to set the line thickness in pixels for wireframe shading. A 

value of 0.0 will use the global line thickness settings in the Render Infor-

mation Window instead.

Motion Blur Section

Blur Mode Popup

There are three options for motion blur for every group:

• None
• Point /Line
• Motion Vector

None. No blur is used for the group (default)

Point/Line. This blur option should be used if you wish to blur groups con-

taining points and lines. The line size value is also used by this option 

when active.

Motion Vector . A very high quality fast motion blur that most closely 

approximates real photographic motion blur. This setting is the best to use 

in about 90% of the cases you will come across. At times, the effect does 

break (such as a fan inside a cage). At those times, you can set the Motion 
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Vector setting at the group level, and choose both the Frame Multisample 

(set the sample value to 2 and increase as necessary) and Motion Vector set-

tings (use the default) in the Render Information Window. The combination 

of these two blurs can usually satisfy all but the most ardent critics!

Color Section

Smooth Across Faces

Enables the shading of the group to smoothly blend across the faces that 

make up the group’s shape. If you want to see the individual faces defined, 

disable this check box.

Color Blend

Blends the color of the vertexes of the group together. Typically, the ver-

texes of a group are a single color, rendering this option useless. However, 

you can create some nifty special effects if you have the ability to color indi-

vidual polygons (most modelers do) and use this feature. For example, you 

can create a tail cone of a jet with black colored polygons around the edge 

of the cone closest to the outlet, and the color the polygons around the sec-

tion closest to the body gray. Enable this checkbox and shade. See how the 

colors blend together? For added realism in this example, don’t color all of 

the polygons black around the outlet, leave some gray. It looks even better 

now. This is basically a throwback to the old CGI days, before texture map-

ping was common.

Vertex Transparency

Certain plug-ins are able to set transparency values for geometry on a poly-

gon by polygon basis. This will be very useful for plug-ins that simulate 
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fire and other such effects. This type of transparency will be used by the 

render if this is checked.

Glow Object Only

This option will not shade the group, but will allow its glow settings to be 

used by the renderer. When combined with particle systems, for example, 

what you essentially end up with are “fuzzy particles.”

Geometry Section

This section contains controls which directly affect the group’s geometry 

during the rendering process.

Cull Backfaces

Removes back facing polygons (those not seen by the camera) so that they 

are not shaded at render time. This speeds up rendering (didn’t think we 

could get any faster?) and is great for eliminating the double specular effect 

present with transparent objects.

Reverse Normals

You can reverse the normals of a group with this option enabled. Unlike 

most rendering engines, Universe Animator understands that polygons 

have two sides regardless of the normals for the polygons and will shade 

the model accordingly. You can turn the group inside out with this feature, 

or better yet, combine it with the Cull Back faces option. Try this: add a 

model (don’t use the standard shapes plug in with this feature) of a sphere 

and enable both of these features. When you render, you will see the inside 

of the back of the sphere. Combine this with edges set to transparent and 

you will have yourself the beginnings of a planet atmosphere!
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Texture

When groups contain UV information, you have the option of using that 

information to apply texture maps.

Use UV space. This check box will enable the UV space feature.

Wrap Horizontal. This option will allow the UV space to wrap in the hori-

zontal axis. This will prevent a visible seam from appearing.

Wrap Vertical. This option will allow the UV space to wrap in the vertical 

axis. This will prevent a visible seam from appearing.

Shadow Tab

The shadow tab controls the shadow casting properties of the group. There 

are five check boxes in the tab:

• Cast Shadow
• Receive Shadow
• High Precision Shadow
• Generate Shadow Mask
• Shadow Object Only

Figure 9.5 — Shadow Tab
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Cast Shadow. Enables the group to cast a shadow onto other groups. 

Defaults On.

Receive Shadow. Enables the group to receive shadows from other groups. 

Defaults On.

High Precision Shadow. Improves the quality of the shadows that fall 

upon this group. Defaults Off, because it is usually not needed. If you do 

not like the way a shadow appears as it falls upon this group, high preci-

sion shadow’s alternative filtering method might improve the look of it.

Generate Shadow Mask. Creates a “shadow cutter” using this group. The 

group effectively becomes a mask wherever a shadow from another group 

would fall upon it. The sections of the group outside of the shadow would 

be rendered with a value of zero (black) in the alpha channel of the image. 

You can use this to assist in realistic compositing of rendered objects into 

real world scenes, and so forth. Use the diffuse color channel to determine 

the color of the “shadow” that this group becomes. Defaults to Off.

Shadow Object Only. Forces the group to be rendered only during the 

shadow pass, not during the final render. With this feature you can create 

low resolution shadow casting groups to make things render even faster! 

Defaults to Off.
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The Info Tab

This tab stores information about the group’s creation date, the amount of 

points, lines and polygons in the group, and the extent of the group’s vol-

ume.

The Display Tab

This tab controls the display of the group in the 3D view windows. It is 

composed of three controls:

• Display Mode Popup Menu
• Display (limited) Polygons
• Display Texture

Display Mode Popup Menu. The Display Mode popup menu allows you 

to choose the level of shading that will be used. 

Display (limited) Polygons. The display every Nth edit box allows you to 

set an amount of polygons to display that is less than the total number of 

polygons in the group. 

Figure 9.6 — Info Tab
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Display Texture. The display texture check box will shade the group with 

the top-most diffuse map visible.

Figure 9.7 — Display Tab
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Function Curve Editor

10.0 Introduction

The Function Curve Editor is a powerful feature which lets you graphically 

create, edit and apply animation information to virtually any parameter in 

a scene. Function curve editors have formed the basis of some of the most 

powerful character animation software anywhere.

What is a Function Curve Editor?

The Function Curve Editor is a window which allows animators to graphi-

cally control animation data in the form of a curve which represents 

changes in time and data values. All animation channels can be edited with 

a function curve, with the exception of color.

The Benefits of Using the Curve Editor

The art of animation involves many subtleties. Good animators know that 

to add those subtleties can be an exercise in tedium. The function curve edi-

tor is intended to make that task easier. By being able to edit the curve as it 

enters and exits a keyframe, the animator has more control over each key-

frame, leading to more control to the overall animation and the realism of 

the shot. At the very least, using the Function Curve Editor will assist the 

animator in creating complex motion using fewer keyframes, saving time 

in the process.

Accessing the Curve Editor

There are two ways to open the Function Curve Editor:
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• Choose Animation>Function Curve Editor

• Type command or control ‘.

The Function Curve Editor opens.

10.1 The Function Curve Editor Anatomy

The Function Curve Editor is divided into three sections:

• Graph Window
• Channel List
• Tool Bar

Graph Window. The graph window contains the function curves that 

graph the actual channel data, the time line, and the data scale. The time 

line is displayed at the top of the window area. It is the same time line in 

the project window, and functions indentically. The data scale displays data 

values which change depending upon the window magnification. The 

combination of the time scale and data scale is used to plot the channel 

curves.

Channel List. To the left of the graph window is the channel list. The chan-

nel list is where all of the loaded channels are displayed. Each channel is 

represented by individual curves. The channel list is covered in detail on 

page 254.
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Tool Bar. Above the channel list and the graph window is the tool bar. The 

tool bar contains icons which are used to control the display of the function 

curve editor, the display of elements within the editor, and the loading and 

saving of channel envelopes. The Tool bar is covered in detail on page 256.

Initially, there won't be any channels loaded into the Editor. Channels are 

loaded by two methods:

• From the project window, by double-clicking on the animation channel 
names in the particular object that you want to work with.

• Using the Key Channel Loader described in the Toolbar section of this 
document.

You can load in as many channels as you like from as many different 

groups as you like. Virtually any animation channel, except RGB color, can 

be loaded into the editor.

Figure 10.1 — Function Curve Editor (with channel data)
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10.2 The Graph Window

The graph window is used as an interactive display to modify the effects 

between two or more keyframes. Through the use of the graph window, 

keyframes may be added and deleted, as well as modified. Acceleration/

Decceleration and Velocity are optionally plotted as well, depending upon 

toggles set in the tool bar. See “The Toolbar” on page 256 for more information.

The active channel curve is drawn in white. All other curves are drawn in 

the color next to the channel name. (See “To set the curve color:” on page 255.)

Time and data ranges can be selected by dragging in the areas to the right 

and bottom of the graph window. These ranges are indicated by darker 

gray regions in the graph window background. The display of these 

regions can be toggled by clicking on the time and data range icons in the 

tool bar. See “Time Range” on page 261 and “Data Range” on page 261.

There are a variety of commands and shortcuts available in the Graph Win-

dow.

Figure 10.2 — Graph Window
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The Tab Key. Can be used to restrict the axial movement of the keyframes. 

Tab once to restrict in X, tab again to restrict to Y, tab again to restrict diago-

nally, tab again to restore free movement. 

Command Clicking. Command clicking on a key will break or mend the 

control handles.

Option Clicking. Option-clicking (or option-clicking and dragging) will 

add a new key to the point on the curve on which you clicked.

Shift Clicking. Shift clicking or marquee selecting a group of keys will 

allow the keys to be dragged together.

Control-Drag. Holding down the control key as you drag a key will inter-

actively scale the curve (requires that a time range be selected first).

Keypath Drag. Drag the curve between two keys to drag both keys. This 

allows you to drag a section of the curve.

Dragging the Window. Hold the space bar down to drag the entire Graph 

Window.

Toggle Linear. Command-Control clicking on a key will toggle the linear 

buttons in the Key Channel Dialog box for that key.

Cut and Paste. Cutting and pasting sections of the curve requires that a 

time range be selected first.
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10.3 Channel List

The channel list contains all of the loaded channels in the function curve 

editor. Each curve in the graph window corresponds to one item in the 

channel list. All channels added to the list are added to the bottom. The list 

cannot be reordered. The black circle to the left of each channel name con-

trols the display of the curve for that channel. Clicking on the curve will 

change the visibility of the curve (the circle will turn transparent when the 

curve is not drawn.)

Command Click adjusts 

slope of handles

Option Click adds new 

keyframe

Shift Click selects multiple keys

Figure 10.3 — Keyboard Shortcuts
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The channel list display area can be resized by dragging the right edge next 

to the scroll bar left or right (the cursor will change as indicated below.)

Each channel in the list has a separate color to plot its curve in the graph 

window. The color swatch next to the name of the channel is used to set the 

curve color.

To set the curve color:

1. Click on the color swatch for the desired channel.
2. Choose a new color from the color picker.
3. Click the OK button to accept the new color.

The new curve color will now be set.

The selected channel will always draw its curve, regardless of the channel’s 

visibility setting in the channel list.Double clicking the channel name in the 

list will bring the Key Channel Window for that item forward. 

The loading and saving of channel envelope information is controlled by 

icons in the tool bar. 

Figure 10.4 — Channel List
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10.4 The Toolbar

To effectively edit motion and time data, some special tools are required. 

The Function Curve Editor comes with its own set of tools which are used 

to edit data splines, load motion data, and various other tools to manipu-

late the motion data. The following sections will detail the function of each 

Tool icon and it’s menu items.

Add Folder

Add Folder will create a folder in which to place your channel data. You 

can organize your data easily by using folders. 

To add a folder to the channel list:

1. Click on the Add Folder icon in the toolbar

The folder will appear at the bottom of the list.

It is typically best to name the folder the by group name, and place chan-

nels that are specific to that group in the folder, thereby drawing a logical 

connection between the two.

To rename a folder:

1. Select the folder name
2. Press the enter key

The text will change to indicate that you can now edit the text

3. Type the new name for the folder.

Figure 10.5 — Function Curve Editor Toolbar
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4. Press enter to accept the change.

You can nest folders within folders, and drag and drop the order of folders 

in the list. You can also hide or reveal folder contents with the display icon 

next to the folder.

To remove a folder from the channel list:

1. Select the folder
2. Press the delete key

Note The contents within the folder will be deleted along with the folder.

Edit Mode

Edit mode has three options:

• Edit Curve Data
• Edit Time Range
• Edit Data Range

Edit Curve Data. This is the default edit mode for the function curve edi-

tor. This mode allows the normal editing of curve data.

Edit Time Range. This mode will allow you to set the range of time in 

which you will be editing. Setting a time range makes data management 

easier. The cursor will change to indicate that you are in time edit range.

Edit Data Range. This mode will allow you to set the range of values that 

you will be editing. This helps you to control the way that data is displayed 

in the editor. The cursor will change to indicate that you are in data range 

edit mode.
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Envelope

Envelope allows you to load values into and save data out from curves 

described in the Graph Editor (See the Graph Editor section below.)   These 

curve files are called “envelopes.” Envelopes may be loaded or saved 

across the entire time range or across a selected range of time.

One of the benefits of using a computer is that it can do the repetitive work 

for you. You can easily load motion data from motion capture device data 

files, other groups or function curves from another Universe Animator 

project. By saving and loading envelopes from other channels, you can 

reuse existing motion data and customize it for your current animation 

project. This works very well when doing repetitive motion, such as ani-

mating a set of humming bird wings, a trail of ants taking over a picnic, or 

matching blinking light patterns.

Clicking on the Load icon brings up a drop down menu with four choices:

• Load to Replace All...
• Load to Insert Into Time Selection
• Save All...
• Save Within Time Selection

Load To Replace All. This menu choice will replace all of the keys with a 

previously saved channel envelope. Selecting this menu choice will present 

the standard Macintosh file open dialog from which you can select an enve-

lope file. Envelope files can be saved from other channels or motion capture 

data files. 

Load to Insert Into Time Selection. Using this option will replace the 

selected time frame with the saved data envelope. If the inserted envelope 

is larger than the selection area, keys outside the selection area are scaled to 
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allow for the inserted envelope. Inserting an envelope works as if a slice of 

time is being inserted at the selection area. If the selection area is the same 

size in time as the envelope, keys outside the selection are unaffected. If the 

envelope is smaller than the selection area, keys following the selection 

area are shifted to an earlier time in the time line.

Save All. Use the Save All function to save all keys in the selected function 

curve. This effectively saves an entire channel as an envelope which can be 

loaded at a later time

Save Within Time Selection. Using this option, you can save all keys 

located within a selected range to an envelope file.

Key Channel Loader

As its name suggests, the Key Channel Loader is used to add key channels 

into the Curve Editor. Select the object(s) in the Project Window, then use 

this tool load in all of or a selected group of animation channels. Once 

loaded, the channels are displayed in the channel list. The circles to the left 

of the channel names may be used to turn off the display of the channel in 

the graph window. Channel may be removed from the editor by selecting 

them in the channel list and hitting the delete key or by using the clear 

under the edit menu.

All. All channels for the selected object(s) are added to the key path editor. 

Depending on the selected object, there may be as few as 7 or as many as 30 

or more channels added to the editor via this option.

Custom. Loads the channel selected using the Custom... view option in the 

project window.
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Specific. Using the Specific option, you can import channels of selected 

types only. This option works well when you only need to edit a single 

attribute on many objects, such as the visibility property. Since some 

attributes have interrelated channels, those too will be loaded. For exam-

ple, loading the Material type will load as many as 22 channels, while the 

Transform type will load 9 and the visibility type only one.

Color Preferences

Use to set the default color for curves displayed in the graph window of the 

Curve Editor. Clicking on this option invokes a dialog box with editor 

attributes accompanied by a color bar for customizing the color used for 

each attribute. You may use any color combination which is comfortable for 

you, although selecting non-contrasting colors may make it difficult to dis-

tinguish between editor attributes.

Graph Display Element Control

This pulldown changes the on/off settings of the last nine controls repre-

sented in the toolbar. Since, these nine controls can be turned off or on by 

clicking on them, this particular tool is redundant and will likely be 

removed.

Grid. Displays a horizontal and vertical grid.

Ruler. Toggles the visibility of the time and range scales.

All Curves. Toggles whether the selected channel or all channels are dis-

played.

Velocity. Displays the velocity graph.

Acceleration. Displays the acceleration path.
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Snap Undo. Displays the Snap Undo path.

Current Time . Displays the current time marker.

Time Range. Displays the time ruler.

Data Range. Displays the data ruler.

Grid Options

This menu controls the grid. Both the spacing of the visual grid and the 

snapping grid are controlled here. To activate snapping, make sure that the 

caps lock key is set.

Key Channel Window

The Key Channel window is used to set the curve type for each channel, 

and the beginning. You can also manage individual keyframes through the 

key list. Get to know this window well, as it will offer you the ability to fine 

tune your function curves, and get the most out of your animation efforts.
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The Motion Type Menu

The motion type menu determines the type of spline curve used to calcu-

late the interpolation of the data in the channel. There are four different 

curve types:

• Linear
• Natural Cubic
• Hermite
• F-Curve 

Linear. Straight line between the keys, no interpolation.

Natural Cubic. B-Spline interpolation, no controls. Use where you want 

automatic smoothing.

Hermite. More versatile than Natural Cubic. The whole curve won't 

change when one key is adjusted.

Figure 10.6 — Key Channel Window
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F-Curve. Contains control handles for fine adjustment. This will give the 

best control and is similar to Bezier curves.

The Left & Right Extension Menus

The beginning and ends of function curves can have a variety of behaviors. 

This allows you to create repetitive motions quickly and easily, and has the 

added value of transmitting any changes to the carried over curve sections, 

if desired.

Hold. The hold option maintains the value of the starting or ending point 

of the curve.

Repeat. This option will cause the entire curve to repeat itself in a cycle.

Oscillate. The Oscillate option will make the curve repeat itself in a mirror-

image fashion.

The Key List Subsection

Individual channel keys are displayed in the keylist to the lower left of the 

Key Channel window. Keyframe attributes are displayed when a particular 

keyframe is selected in the list. There are several attributes that are control-

lable on a keyframe by keyframe basis:

• Time
• Value
• Spline-specific controls
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Time and Value Edit Boxes. You can change the time or value of the 

selected keyframe. Enabling the Hold Value check box will force the value 

of the slope between the selected keyframe and the next keyframe be main-

tained until the next keyframe: no interpolation will occur. This will appear 

as a flat line until just before the next keyframe in the Function Curve Edi-

tor.

Spline Specific Fields. This section displays different controls depending 

upon the spline selected in the Motion Type popup menu:

• Linear
• Natural Cubic
• Hermite
• F-Curve

Linear. There are no additional controls for the Linear Motion Type.

Natural Cubic. There are no additional controls for the Natural Cubic 

Motion Type.

Hermite. There are controls for the Tension, Bias, Continuity attributes of 

the acceleration and velocity of the curve. You can type the values in 

Figure 10.7 — Keyframe List
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directly, or hold down the T, B, or C keys (lower case is fine) and dragging. 

You will see the acceleration and velocity curves change as you adjust the 

value. You will also clearly see changes in the actual motion path drawn in 

the world view windows. You can linearize the values by checking the Lin-

ear button.

F Curve. Controls for the keyframe vectors will appear if the Motion Type 

is set to F-Curve. The keyframe vectors are the little “teeter bars” that 

appear at each keyframe. There are separate vectors for the left and right 

side of the keyframe. You can set the vector angles by clicking and drag-

ging on the vectors, or by typing values directly into the edit boxes. In 

addition, you can linearize the spline segment by enabling the Linear but-

ton. When the beginning or ending keyframes are selected, on the left or 

right vector will be displayed.

There are also two check boxes for slope control, which affect the shape of 

the curve, and how the curve is interpolated through its control points:

Continuous Slope. Causes the curve to be smoothed along both sides of 

the control point equally.

Automatic Slope. Causes the curve's adjoining slopes to be adjusted for 

smoothness.

Editor Display Scale. The Editor Display Scale box allows you to scale 

individual curves so that they can be displayed together in the Editor. For 

example, lets say you have a X motion curve that runs from 0.0 to 4444 over 

4 seconds and you also have a roll channel that goes from 0.0 to 5 degrees 

over the same 4 seconds. Using the Editor Display Scale you can set the 

scale of the X motion to 1.0 and the roll to 889. In this way, both curves will 

be visible in the Curve Editor and the same time. The Editor Display value 
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for each channel is listed as a percentage after the channel name in the 

channel list.

Snap

When a data or time range is edited within the Function Curve Editor, the 

original path becomes the Snap value. The Snap command stores the 

present position of a curve in memory. This allows you to display the origi-

nal path while you make changes to it. You can make adjustments to a 

function curve and revert back by clicking the Unsnap option or saving the 

new curve as the snap value (or new original) by clicking the Snap option.

Range

Ranges are highlighted sections of the Graph Window. The tools in this 

menu allow you to select a time or data range and to operate on sections of 

a curve within the range.

The range itself is created by dragging in the white band just below (time 

range) or just to the right (data range) of the curve editor. The Time Range 

and Enable Range buttons must be on for the range to be displayed (see 

below). 

Set Ranges… Brings up a dialog box that allows you to type in values to 

create the range instead of dragging the range at the right or bottom of the 

Graph Window.

Fit to Range. Scales the curve to fit within the selected time range.

Fit to Data Range. Scales the curve to fit within the selected data range.

Move to Beginning. Move an entire channel’s keyframes to start at the 

beginning of the project time.
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Reverse Time. Reverses the order of keyframes reversing the animation.

Reverse Data. Reverse keyframes to reverse data values

Key Time Range. Deletes keyframes outside of the selected time range.

Fit Curve To Data in Time Range. This option fits a curve to custom key-

frame data with a tolerance setting. The original custom data is deleted. 

You can use this setting to turn motion capture data into motion curves.

Grid Enable

This button toggles the display of the grid in the graph window.

Time Scale Enable

This button toggles the display of the time scale, the value scale, and the 

time thumb control. The time thumb display mode (seconds, timecode, 

frames) can be changed by option-clicking on the control.

All Paths

When this button is off, only the channel highlighted in the channel list is 

displayed in the graph window.

Velocity Display

Toggles the display of the velocity curve. The velocity curve is updated as 

you make changes to the channel curve.

Acceleration Enable

Toggles the display of the acceleration curve. The acceleration curve is 

updated as you change the channel curve.
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Current Time

Toggles the vertical time line that crosses through the editing field.

Time Range

Toggles the display of the selected time range. The Time Range is chosen by 

dragging in the white region just below the Graph Window. Copying and 

pasting takes place inside the chosen Time Range.

Data Range

Toggles the display of the selected data range. The Data Range is chosen by 

dragging in the white region just to the right of the Graph Window.

Automatic Channel Scaling

In previous versions of ElectricImage, when you added channels to the 

Function Curve Editor, you had to manually adjust the panning controls to 

see the selected curve. (Because of the differences in values, curves for dif-

ferent channels can be in drastically different positions on the graph.) Now, 

selecting a channel in the editor causes the curve to be placed within the 

center of the graph window (note that view scale is unchanged.) To change 

the behavior of this feature, you can use the “Automatically Scale Graph” 

preference in the Preference Widow: Keypath Editor > Automatically 

Scale Graph. 

Interactive View Scaling

You can interactively scale the graph window of the function curve editor 

by clicking on any zoom icon, and then dragging. The direction that you 

drag will affect the zoom. Remember that there are two zoom factors for 
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the graph editor (time and value) which can be independently controlled. 

Work with this for a couple of minutes to get the hang of it.
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Project Window

11.0 Introduction

The Project window is the heart of animating in Universe Animator. This 

single window offers the control of virtually every parameter in your 

project, in time line form or spreadsheet form. It is in this window that you 

set the animation mode in which to view and edit a project, and where you 

can observe and animate all of the attributes within the project file.

Some animators love the project window, while others loathe it. While 

there are certain operations that can only be performed in the project win-

dow, whether or not you need to use them is up to your method of work-

ing. There are definitely easier tools to use if you so prefer, such as: the 

function curve editor for animating everything in motion curve form; the 

morph editor for morphing and facial animation (the function curve editor 

works great for this as well); the time palette for setting the scene time; and 

the various menus for controlling the various attributes of an object or 

series of objects.

The project window includes many useful tools which can make the task of 

using it much easier. There are tools to limit the amount of data presented, 

so that you are not overwhelmed by larger projects. There are tools to con-

trol the way that data is listed in the window, so that you can find what you 

want to edit quickly. There are also tools which allow you to animate 

almost exclusively from the project window itself. Take some to read 

through this chapter, and learn about the tools that the project window 

offers you. Afterwards, use this chapter as a reference to keep you up to 

speed on the project window. You will find that once you get to know it, the 

project window will be a very valuable tool indeed.
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The project window is very complex, due to the fact that it is the single 

repository of all information in your project. Every project attribute is listed 

in the project window, typically in hierarchical fashion (although you can 

control this). As your animation projects get more complicated, the data 

presented in the project window will grow. Be sure to read about the useful 

tools that the project window offers to assist in handling copious amounts 

of data.

Project Concepts

The project window is an environment of its own which exists in the over-

all Universe Animator environment. As such, there are several discussions 

that this chapter will focus on:

• tools which you can animate
• tools which can help you animate
• tools to help you organize your scene
• tools which help you control your work environment

Tools Which You Can Animate

Universe Animator allows you to animate almost any attribute of any 

object in your scene. These attributes are called “animation channels.” Ani-

mation channels contain the animation data that is used to drive your ani-

mated content. Animation channels contain either keyframe and/or frame 

data, and can be viewed in time line or spreadsheet form. Individual cells 

of a spreadsheet equate to either a single frame or single field of data for an 

attribute. Sections “Animation Channels” on page 283 and “Editing Cell 

Contents” on page 297 covers what you can animate, and the methods in 

which you can edit your data.
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Tools Which Help You Animate

Universe Animator can be used to literally create a “universe.” As such, 

things can get a little busy. To help you manage this, there are several tools 

offered in the project window which allow you to hide the parts of the 

project that you aren’t’ dealing with at any given time. The sections 

“Project Window Anatomy” on page 275 and “Project Editing Modes” on 

page 288 describe the architecture of the project window, and its contents, 

as well as how to work within the various editing modes offered.

Tools to Help You Organize Your Scene

Organizing large amounts of data can always be a pain. The project win-

dow can be configured to let you navigate through your projects more eas-

ily, and to help organize and structure the files and objects that you deal 

with. Sections “Project Window Anatomy” on page 275 and “The Tool Bar” 

on page 306 offers insight into organizing your projects and managing 

scene data.

Tools Which Help You Control Your Environment

Lastly, the overall environment in which you work can be set up to allow 

you a more efficient work experience. Tool offerings let you control the 

frames per second of your project, the amount of time which your project 

represents, and the methods in which the project window displays the con-

tents of your project. The section “Project Window Anatomy” on page 275 

will help you to better work within the project window environment.

The topical sections mentioned above will cover the many functions that 

you can control with the project window. Here is a list of the topics that are 

covered in the sections:
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• Showing and hiding groups, (page 308)
• Showing and hiding animation channels, (page 283)
• Activating and deactivating animation channels, (page 284)
• Controlling the visibility of objects in the scene, (page 277)
• Locking and unlocking objects in the scene, (page 277)
• Setting the project window edit mode, (page 288)
• Editing animation and timing data, (page 286)
• Naming and renaming objects, (page 279)
• Creating and editing hierarchies, (page 279)
• Editing scene timing, (page 313)
• Setting the current scene time, (page 288)
• Setting the scene frames per second value, (page 276)
• Assigning channels to the function curve editor, (page 318)
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11.1 Project Window Anatomy

At any time, the project window can be opened by the either of the follow-

ing methods:

• From the main menu bar, choose Windows>Project Window

• command (Mac) or control (PC) “l”

Once opened, the project window will appear as illustrated in Figure 11.1.

Figure 11.1 — Project Window Anatomy (time mode displayed)
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The project window structure is divided into several areas which are used 

for controlling animation channels, setting window and time view 

attributes, and other scene properties. Those areas are:

• Frames per second (FPS) popup menu
• Value/name edit field
• Edit mode popup menu
• Tool bar
• Object/channel enable/disable flags panel
• Object/channel name panel
• Channel data panel

Frames Per Second Popup Menu

The FPS pop-up menu is used to select the number of frames per second to 

be calculated and rendered.

Along with duration, FPS determines the total number of frames for the 

animation (i.e., if the duration is 10 seconds, selecting 30 FPS calculates and 

renders 301 frames—frame 0 plus 300 frames).

The menu choices are:

Custom… This option opens a dialog box that enables you to specify a 

number other than the NTSC (30 FPS), PAL (25 FPS) or motion picture (24 

FPS) standards.

Figure 11.2 — Custom frames per second dialog box
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The frames/second edit field is where you can enter a real number (num-

bers with decimals) to specify the recording/projection speed you need to 

work in. The interlace check box will properly set up your project file for 

video interlace, allowing you to animated per field.

NTSC: 30. This option uses the NTSC video standard of 30 FPS.

NTSC: 30i. This option uses the NTSC video standard of 30 FPS, but with 

interlacing. Each frame is split into two fields, so that in Keyframe and 

Frame modes the data panel will show frames as 0a, 0b, 1a, 1b, 2a, 2b, etc.

PAL: 25. This option uses the PAL video standard of 25 FPS.

PAL: 25i. This option uses the PAL video standard of 25 FPS, but with 

interlacing. Each frame is split into two fields, so that in Keyframe and 

Frame modes the data panel will show frames as 0a, 0b, 1a, 1b, 2a, 2b, etc.

Film: 24. This option uses the motion picture standard of 24 FPS.

The Flag Panel

Located down the left side of the Project window, this panel, as shown in 

Figure 11.1, shows flags indicating the status of an object’s visibility and 

selection locking.

The status can be changed by clicking on the appropriate icon:

• Clicking the visibility control toggles the visibility of the object. Invisi-
ble objects are not rendered, but animation information will be passed 
to their children (if so hierarchically structured).

• Clicking the selection lock prevents the object from being selected in 
the World View windows. It may still be selected in the Project win-
dow, however.
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Pressing the Option key while clicking either of these controls will toggle the status 

of both the group you are clicking and any groups hierarchically linked below it.

The Object/Channel Name Panel

Located to the right of the flag panel, the Object/Channel Name panel, as 

shown in Figure 11.1, displays a list of all of the objects and channels in the 

project. The object/channel name panel can be used to perform the follow-

ing operations:

• Selecting objects in the scene
• Accessing the object’s information window
• Rename objects in the list
• Creating a hierarchy
• Breaking a hierarchy
• Show or hide children of objects
• Show or hide object data channels

The appearance of an object’s children (groups hierarchically linked below 

the parent group) in the Object Name panel can be toggled on and off by 

pressing command (Mac) or control (PC) “h”.

To select objects in the project window list. Objects can be selected by 

clicking on their icons or on their names. 

Object Info

Window

The object info window displays pertinent information about an object at 

the current scene time. It is commonly used to set, shading attributes, mate-

rial attributes, motion data, and scene display settings for the object.

To access the object’s info window. There are two ways to access an 

object’s info window from the object name panel:

• Double-click on the object
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• Select the object, and choose Object>Group Info (command or control 
“i”)

Naming objects is important to help organize your projects. Naming 

objects clearly (and concisely!) will make finding objects in the project win-

dow easier, and help other animators working with you to understand 

your scene layout more quickly.

To rename an object in the project window:

1. Click on the object’s name in the object panel.

The object is selected and the object’s name is put into the edit box, 

highlighted for editing.

2. Type a new name for the object.
3. Press Return.

The new name replaces the previous name in the object panel.

Hierarchy A hierarchy is a collection of related objects, arranged in a tree-like fashion. 

Parent objects contain children objects. Children objects can contain grand-

children objects, and so on. Hierarchy allows for very complex motion to be 

animated with relative ease, or to effectively mimic real life motions of real 

things.

To assign a hierarchy of objects:

1. Select the objects that are to be made children
2. Choose Hierarchy>Parent from the menu bar, or choose the Parent 

icon from the project window tool bar
3. Select the parent object

The resulting hierarchy will be displayed as a tree in the project window.
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To remove an object from a hierarchy:

1. Select the objects that you wish to remove from the hierarchy
2. Choose Hierarchy>Unparent from the menu bar, or choose the Unpar-

ent icon from the project window tool bar

The objects chosen to be unparented will be displayed as such in the object 

list, with no attachments.

The object/channel name panel contains a list of all of the objects in the 

project. You can control the visibility of the object’s hierarchy and anima-

tion channels in this panel. You can show or hide the hierarchy from the 

location of a specific object to the end of the tree by a single key command. 

It is necessary to understand the display of hierarchy in the project window, as ani-

mation channels are attached to objects. If an object is hidden relative to its place in 

the hierarchy, its animation channels will be hidden as well.

To hide the hierarchy of objects attached to the current object:

1. Make sure the project window is open and active
2. Select the desired object
3. Depress command (Mac) or control (PC) “h” (for “hide”)

All of the objects attached to the hierarchy from the location of the object 

downward along the tree will be hidden. A small, downward-pointing red 

arrow will be added to the object icon, indicating that there are hidden 

items attached to it.

To show a hidden hierarchy:

1. Make sure the project window is open and active
2. Locate the desired hierarchy to unhide
3. Select the object
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4. Depress command (Mac) or control (PC) “h” (for “hide”)

The attached hierarchy will be revealed, up to the point that the next hier-

archy was hidden. If nested hierarchies have been hidden, you will need to 

reveal them one at a time.

The Data Panel

Located to the right of the object panel, the channel data panel contains the 

data (attributes) for objects in the project. In all editing modes other than 

Time, the data cells in this panel can be edited.

Displaying Data Channels. When the Project window is first opened, the 

data channels are not displayed. Each object in the object panel can be 

opened up to list its data channels in much the same manner as folders in 

the Finder can be opened up to list their files.

You can also use the Open/Close pop-up menu in the Project window’s pop-up 

menu palette to open and close the display of selected attributes.

When the list becomes longer than the height of the window, you can then 

scroll the window’s contents with the window’s scroll bar.

Resizing and Scrolling the Display

All panels are resizable by moving the cursor to a vertical edge of a panel, 

clicking on it, and dragging that edge to its new location.

• If the size of the panel becomes too small, the edge will snap to the 
nearest edge of the next panel or window.

• If the size of the panel is too large, the edge stays at the outermost posi-
tion indicating the panel’s maximum size.

The following controls are also available for scrolling the display:
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• The horizontal scroll bar in the Object Name panel can be used if the 
names extend beyond the panel’s edges.

• In Frame and Keyframe modes, the horizontal scroll bar in the Object 
Data panel can be used if there are more cells to be displayed beyond 
the right edge of the window.

• In Time mode, the horizontal scroll bar is used to show more key 
frames in the time line, if any.

• All panels can be scrolled vertically with the vertical scroll bar.
• In Time mode, the zoom controls in the lower right corner of the win-

dow can be used to zoom the window. Holding down the Option key 
while clicking either zoom control centers the time display between the 
start and stop times of the project.
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11.2 Animation Channels

Animation channels are containers which hold all of the animation data in 

a project. Each object in a scene has its own unique set of animation chan-

nels. If the data in an animation channel changes over the time span of the 

project, the object is said to be animated. 

Animation channels can be:

• Displayed or hidden
• Activated or deactivated
• Selected or deselected entirely or in part
• Edited numerically

Displaying Animation Channels

Each object entry in the panel list is preceded by a “display channel” icon. 

This icon is similar to icons used by file browsers in popular operating sys-

tems. The icon appears as an arrowhead. When the arrowhead is pointing 

to the right, more data is available by turning it down. 

Channels are available regardless of whether or not they are set to be animated. 

Therefore, the display channel icon will always appear next to an object, regardless 

of the object’s animation channel settings.

To display an animation channel of an object:

1. Make sure the project window is open and active
2. Locate the desired object
3. Click on the display channel icon to show the animation channels for 

the object.
4. For hierarchically-organized channels, follow the above steps until you 

arrive at the desired channel
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Activating and Deactivating Animation Channels

Each object can have potentially hundreds of animation channels, which 

can get somewhat difficult to manage, especially if a scene has hundreds of 

objects. A solution to this problem is to limit the amount of animation chan-

nels that are active in a project.

Universe Animator defaults all animation channels to OFF. This is important, as 

you will need to activate animation channels for objects that you intend to ani-

mate. You can change this behavior to default all animation channels to ON in the 

Edit>Preferences>Keyframe tab.

Channels can be activated from the group or channel level, however, if you 

activate a particular channel without also activating the group, the anima-

tion data will be ignored. This behavior allows you to easily disable a chan-

nel while retaining the animation record for the channel.

To activate an animation channel for an object or model group:

1. Open the project window 
2. Locate the object in the name/channel panel
3. Click on the animation flag in the flag panel to the left of the name

The animation record for the object will be activated, as indicated by the 

green arrow. To disable the animation record for the object, just click on the 

animation flag again. The channel will be disabled, as indicated by the gray 

arrow.

To activate the animation record for a specific channel attribute:

1. Follow the previous instructions
2. Open the object channel by clicking on the turndown icon next to the 

object name. 
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A list of channels for the object will be displayed. Some channels will 

contain additional turndown icons. Navigate through the list until you 

arrive at the channel that you wish to animate.

3. Once the channel is located, click on the animation flag to the left of the 
channel name

The channel animation record will be activated, as indicated by the green 

arrow. To disable the animation record for the channel, just click on the ani-

mation flag again. It will turn gray to indicated that the record has been dis-

carded.

Selecting Animation Channels

Animation channels can be selected and deselected in their entirety in any 

one of the three spreadsheet-based edit modes. You would typically select 

an entire channel for the purposes of:

• Recalculating the channel data (if a numerical process was applied that 
needed replacement)

• Adding a special function to the channel data, such as a repeat or cycle 
behavior

To select an entire animation channel:

1. Make sure that the project window is open and active
2. Set the project window edit mode to keyframe
3. Select the desired object
4. Click on the display channel icon to show the animation channels
5. Located the desired channel in the list
6. Command (Mac) or control (PC) click in a cell of the animation channel
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The entire channel will be selected. You can then apply any of several func-

tions or values to the data within the channel. To deselect the channel, just 

click in another cell in the project window.

Editing Animation Channel Data

In any of the three “spreadsheet views” of the project window (keyframe, 

frame and index), you can directly edit the contents of an animation chan-

nel. This feature is included more as a “power user” feature than as a fea-

ture that you would typically need to use.

In the spreadsheet views, data is presented numerically in each cell of the 

spreadsheet. The frame number for each cell is at the top of row of the 

spreadsheet, and the current frame will be highlighted to indicate its selec-

tion.Bold text cells represent key frames, normal text cells represent frames, 

and underline text cells represent custom frames.

Direct values can be typed into the cells, and depending upon the edit 

mode that you have chosen, key frames, frames or custom frames will 

result.

To edit animation data in a spreadsheet cell:

1. Click in the data cell to be edited.

The cell is selected and the cell’s data is put into the value edit field.

2. Type a new value for the cell.
3. Press Return.

The value you typed in the value edit field replaces the previous value in 

the data cell.
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To advance to another cell in the spreadsheet:

1. Click in the data cell to be edited.

The cell is selected and the cell’s data is put into the value edit field.

2. Press the arrow key to advance one cell in that direction

The selection focus will advance to a new cell in the direction of the 

depressed arrow key. The previous cell will be deselected.

You can select a range of cells, and move the entire range focus to another 

area of the spreadsheet in a similar fashion.

To move the focus of a series of selected cells:

1. Select a series of data cells to be edited.

All of the cells are selected, and the first cell is activated for numeric 

entry. This is indicated by outlining the cell border and placing its 

value in the name/value edit field.

2. Press the arrow key to advance one cell in that direction

The selection focus will advance to a new series of cells in the direction 

of the depressed arrow key. The previous cells will be deselected. To 

continue advancing, press the arrow key again.
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11.3 Project Editing Modes

Editing modes determine how your data is presented in the project win-

dow. Three edit modes are spreadsheet-based, with a column of editable 

data for each frame in the project (Keyframe and Frame modes show all 

frames; Index mode shows only the key frames, listed in order of creation). 

The default mode is a time line style representation, which presents key 

frames as diamonds in the window data panel. Which edit mode you work 

with depends upon you, but certain functions such as numeric editing 

require a spreadsheet-based edit mode. The editing mode is selected with 

the editing mode pop-up menu, as shown in Figure 11.1.

There are four editing mode choices are:

• Time Mode 
• Keyframe Mode 
• Frame Mode 
• Index Mode 

Time Mode

The default view is Time mode. In Time mode, the Project window is used 

to set the duration of the animation and the timing of individual events. In 

Time mode, the Project window appears as in Figure 11.3. In this mode, the 

data panel represents key frames as diamonds and interpolated time (time 

between key frames) as bars. A time scale is drawn above the data panel, 

and a time slider represents the current time (or frame, depending upon 

which display option is set.)
288       Electric Image Universe 3.0    



Chapter 11  Project Window — Editing Modes
The display of the project window in time mode is unique to any other 

project window edit mode. It consists of:

• The time slider
• The time scale
• Active time range

Time Slider. The time slider is used to set the current time of the scene. To 

set the time at which events occur in the animation, drag the time slider 

across the time scale. The current time value in the readout box changes as 

the time slider is dragged.

You can change the time display of the time slider from seconds (the 

default) to SMPTE time code, or frames. You can also snap to frames or key 

frames.

Time Scale. The time scale is drawn above the data panel. It represents 

time in seconds, regardless of the display that the time slider is set to. 

Figure 11.3 — Project window in Time Mode view

Time ScaleTime Slider
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Active Time Range. The active time range is displayed in the time scale. 

The active range is bracketed by two markers, one representing the start 

time of the project, and one the end time of the project. The range between 

these markers is the range that is rendered by default when the render 

command is given. 

The start time marker (drawn in green), which appears in the time scale, 

indicates the start time of the project (it defaults to time 0). The project’s 

start time can be changed by clicking and dragging this icon to the left or 

right. The time slider will snap to the marker.

The end time marker (drawn in red), which also appears in the time scale, 

indicates the stop time, or duration, of the animation (it defaults to 10 sec-

onds). The animation’s stop time can be changed by clicking and dragging 

this icon to the left or right.

Time mode operation allows you to:

• Change the scene time
• Create key frames
• Select Key frames
• Change keyframe timing
• Change sequence timing
• Scale sequence timing

Changing the Scene Time. To change the scene time of the project in time 

mode, drag the time slider to the left (smaller time values) or to the right 

(larger time values). Use the time display icon in the project window tool 

bar to change the display of the time scale (seconds, time code, frames). The 

time slider control will display the current scene time.

Creating Key frames. Key frames are automatically created any time you 

change the current time in the Project window (by dragging the time selec-
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tor) and then set an event, such as changing the position of a model, or 

adjusting the color of a light.

Selecting Key frames. Key frames can be selected by clicking on them. You 

can press the shift key to select more than one keyframe. To select a region 

of key frames, drag a rectangle around the region. Selected key frames are 

drawn in red. Selected keyframe sequences are drawn in dark blue.

Changing Keyframe Timing. To change the time for a keyframe, click and 

drag the keyframe to the desired time. The time slider will jump to the 

selected keyframe, and display the new time for the keyframe as you drag. 

If you have a selection of key frames, you can change their location in the 

time line as well by dragging.

Changing Sequence Timing. A sequence is a series of key frames which 

are connected by a bar. To change the timing of a sequence of key frames, 

click in any portion of the bar that is connecting the key frames in the 

sequence, and drag to the desired time.

Scaling Sequence Timing. You can compress or expand the timing of a 

series of key frames or sequences by pressing the control key as you drag 

the mouse to the left or right.

Keyframe Mode

Keyframe mode displays all events occurring in the project by key frames 

and interpolated frames, as shown in Figure 11.4. Instead of a time scale, a 

frame scale is drawn above the data panel. To differentiate between the two 

types of frames, key frames are drawn in bold text, and interpolated frames 

are drawn in normal text. If animation channels are collapsed, the cell data 

is not displayed. Instead, a key symbol is drawn in the frame column to 
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represent that key frames are present for the channel. To view the keyframe 

data, use the display channel icon.

In keyframe mode, you can:

• Set the current frame
• Add new key frames
• Remove key frames
• Edit the contents of keyframe cells

Setting the Current Frame. Instead of a time scale to set the current time 

(as is the case in Time mode), you are presented with a frame scale to select 

the current frame (in Figure 11.4, frame 75 is selected). To set the current 

frame, click on the frame number in the frame list row.

Adding a Keyframe. To add a keyframe in keyframe view, click on a cell 

and enter a new value. The keyframe will be set, as indicated by the value 

in the cell being drawn in bold, and a key symbol being drawn in the root 

channel row of the animation channel record.

Figure 11.4 — Project window in Keyframe mode

Frame Scale
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Removing a Keyframe. To remove a keyframe in keyframe view, select the 

desired keyframe cell and choose Animation>Delete Keyframe. The key-

frame will be removed, and replaced by an interpolated frame. The value 

of the interpolated frame will most likely be different that the keyframe 

value that you deleted.

Editing the Contents of Keyframe Cells. To edit keyframe values in key-

frame view, click in a data cell, and then enter the new value in the edit box. 

If you make a change or addition to a channel that does not contain a key-

frame, a new keyframe is automatically added at that position.

Frame Mode

In Frame mode, the Project window displays all events occurring in the 

project as actual frame values. Unlike Keyframe mode, editing a frame’s 

data in Frame mode changes the value for that frame only—no key frames 

are created and no interpolation will occur; you would be creating data that 

deviates from the key frames you have created and the frames interpolated 

from those key frames. This feature can be thus be used to create inten-

tional “glitches” in the animation. (If you need to, you can always reinter-

polate the frame list by selecting the range of frames and choosing 

Recalculate Frames from the Keyframe menu, or Recalculate All Frames for 

all frames.)
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Changed frame values are underlined in the data cell, and the underline 

remains in the cell if you switch back to Keyframe mode.

In frame mode you can:

• Set the current frame
• Edit frame values (creating custom frames)
• Resetting a frame’s value (removing a custom frame)

Setting the Current Frame. To set the current frame, click on the desired 

frame number in the frame scale. Use the scroll bars at the bottom of the 

window to scroll beyond the frames displayed.

Editing Frame Values. Editing frame values directly will create a custom 

frame. A custom frame is a frame which was not created by interpolation of 

two key frames. A custom frame is drawn as underlined text.

Resetting a Frame’s Value. To reset a frame’s value so that it conforms to 

the interpolation curve, select the frame and choose Animation>Recalcu-

Figure 11.5 — Project window in Frame mode view
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late Frame. The frame’s value will be reset, and the frame will be drawn in 

plain text to indicate the change.

Key Index Mode

In Key Index mode, as illustrated in Figure 11.6, the Project window dis-

plays key frames only, by the order in which they were created for each 

object. 

Instead of a time scale or frame scale, a keyframe index scale is displayed 

above the data panel. This scale represents the order of creation of key 

frames for the channels only. There is no interrelationship of time between 

channels that is maintained in this view.

In key index mode, you can:

• Select the current key index
• Edit keyframe values 
• Display a keyframe in the list

Figure 11.6 — Project Window in Key Index Mode view
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Selecting the Current Key Index. The current index is set by clicking the 

appropriate value in the index scale at the top of the data panel. The time 

values for the key frames are not displayed in this mode.

Editing Keyframe Values. To edit keyframe values in the index list, select 

the keyframe. Its value will be placed in the value edit field. Enter a new 

value to override the previous value.

Displaying an Keyframe in the Index List. To display a keyframe in the 

index list, click on the desired keyframe. Only that keyframe value will be 

displayed. Keyframe values for other channels will not be in sync. It is for 

this reason that Keyframe Index mode should not be used for animating, 

but rather, just quickly checking keyframe data.
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11.4 Editing Cell Contents

From time to time, you may wish to create a particular behavior for a 

motion channel, such as an up and down value for a rotation axis that 

could be used for a wing flap. Or, you may wish to fill the contents of a cell 

over a period of time with a particular value. In fact, there are several filters 

or actions that you can apply directly to the contents of a cell:

• Fill Cell with Value 
• Blend Cell Contents
• Cycle Cell Contents

Filling Cells with Specific Values

The paint bucket icon in the project window tool bar offers a pop-up menu 

(used in Keyframe, Frame or Index modes) that fills the data cells in a range 

of selected frames with a specified constant value. It can also be used to 

invert, scale and offset the values in the selected range frames.

The following options are available under the paint bucket icon:

• Fill Selected
• Fill Constant
• Invert
• Scale
• Offset
• Randomize
• Jolt
• Spring
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Fill Selected. This option fills the selected range of frames with the data 

from the first (left-most frame) in the selection of frames. For example, 

selecting frames 1 through 5 and choosing this option would fill frames 2 

through 5 with the data from frame 1.

Fill Constant… This option opens a dialog box that enables you to specify 

a value that will fill the selected range of frames.

Invert. This option inverts the data in the selected range of frames (positive 

values become negative, and vice versa).

Scale… This option opens a dialog box that enables you to specify a factor 

by which the data in the selected range of frames will be scaled.

Offset… This option opens a dialog box that enables you to specify a value 

by which the data in the selected range of frames will be offset.

Randomize... The randomize function opens a dialog box that enables you 

to randomly change the data in an animation channel. The randomize dia-

log contains three edit items:

• Range Edit Box
• Seed Edit Box
• Relative Check Box

Figure 11.7 — Randomize dialog box
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The range edit box contains a +/- value. Therefore, 5 would yield random 

numbers between -5 and +5. These numbers are added to the current value 

of each highlighted data cell.

The seed edit box contains an initialization value for the random number 

generator. If you find patterns in the random numbers applied, you can 

alter the seed to improve the randomization.

The relative check box, when enabled, causes the Random Range value to 

become a percentage value. The current value of each highlighted data cell 

will be increased or decreased by a random percentage.

Jolt... The jolt function creates an initial shock, followed by a decay. This 

can be used to simulate a camera hitting a small bump as it rolls along the 

road, for example, or perhaps being hit by flak or debris. The jolt dialog box 

contains five edit items and a graphic display of the effect to be applied to 

the data channel:

• Amplitude
• Frequency
• Decay
• Relative
• Reverse
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The amplitude box contains a value that controls the maximum and mini-

mum points on the waveform.

The frequency edit box contains a value that controls the number of com-

plete cycles in the entire waveform.

The decay edit box contains a value that controls the slope of the entire 

waveform.

The relative check box, when enabled, allows the amplitude to be treated as 

a percentage. At the maximum point on the waveform, the value of the 

data cell will be increased by the percent entered in the Amplitude edit box.

The reverse check box, when enabled, inverts the entire waveform.

Spring... The spring function opens a dialog box which lets you imprint a 

wave form which you specify on the data in a selected series of cells.

Because this command adds and subtracts from the current value of the 

data cell, multiple applications of Spring can be used with different fre-

Figure 11.8 — Jolt dialog box
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quencies and amplitudes to create “white noise.” There are nine edit items 

in the dialog, as well as a graphic display of the result to be applied:

• Amplitude Edit Box
• Frequency Edit Box
• Phase Edit Box
• Relative Check Box
• Reverse Check Box
• Decay Edit Box
• Decay Interval Edit Box
• Attack Edit Box
• Attack Interval

Figure 11.9 — Spring dialog box
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The amplitude edit box contains a value that controls the maximum and 

minimum points on the waveform.

The frequency edit box contains a value that controls the number of com-

plete cycles in the entire waveform.

The phase edit box contains a value that shifts the starting point of the 

waveform. Phase may also be changed interactively by dragging the wave-

form in the curve window.

The relative check box, when enabled, allows the amplitude to be treated as 

a percentage. At the maximum point on the waveform, the value of the 

data cell will be increased by the percent entered in the Amplitude edit box.

The reverse check box, when enabled, inverts the entire waveform.

The decay edit box contains a value that controls the slope of the waveform 

from the Decay Interval Bar to the end of the curve.

The decay interval edit box contains a value that controls the length of the 

decay. The decay interval may also be changed interactively by dragging 

the Decay Interval Bar in the curve window.

The attack edit box contains a value that controls the slope of the waveform 

from its beginning to the Attack Interval Bar.

The attack interval edit box contains a value that controls the length of the 

attack. The attack interval may also be changed interactively by dragging 

the Attack Interval Bar in the curve window.

Blending the Contents of Cells

The gray ramp (blend) icon in the project window tool bar offers a pop-up 

menu (used in Keyframe, Frame or Index modes) that controls the blending 
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of data across a range of selected frames (page 286), in order to “smooth” 

the data values in those frames in either a linear or curved fashion. This 

operation is very useful if you wish to smooth out rough moves, or create 

some kind of transition to Project window data values.

Blended frames are custom frames, denoted in the Project window by underlined 

text. Custom frames need to be reevaluated when changed, and that recalculation 

will occur when the animation is previewed, rendered or saved (or when recalcu-

lated manually).

The two types of cell blending offered are:

• Blend Linear
• Blend Curve

Blend Linear. This option uses a linear method of interpolating the data.

Blend Curve. This option uses a curve method of interpolating the data.

Cycling the Contents of Cells

The bent arrow icon in the project window tool bar offers a pop-up menu 

(used in Keyframe, Frame or Index modes) which controls the cycling of 

data across a range of selected frames, causing a sequence to repeat cycli-

cally until the end of the animation. This operation is very useful for repet-

itive motion, such as a 5° rotation on a wheel, or the flapping wings of a 

butterfly. It can be used to increment motion as well.

Cycled frames are custom frames, denoted in the Project window by 

underlined text. Custom frames need to be reevaluated when changed, and 
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that recalculation will occur when the animation is previewed, rendered or 

saved (or when recalculated manually).

The following options are available:

• Repeat
• Oscillate
• Offset Repeat

Repeat. This option repeats the selected sequence of frames until the end of 

the animation. For example, repeating frames 1 through 5 would repeat the 

values from frames 1 through 5 starting with frame 6 and continuing until 

the end of the animation (i.e., the new sequence of frames would be 1, 2, 3, 

4, 5, 1, 2, 3, 4, 5, 1, 2, 3, 4, 5, etc.).

When repeating within a range of key frames, select all frame cells with the range 

except the very last keyframe. This will ensure a smooth transition between repeat 

cycles.

Oscillate. This option oscillates the data from the selected sequence of 

frames until the end of the animation. For example, oscillating frames 1 

through 5 would take the values from frames 1 through 5 and repeat them 

in an oscillating sequence starting with frame 6 and continuing until the 

end of the animation (i.e., the new sequence of frames would be 1, 2, 3, 4, 5, 

4, 3, 2, 1, 2, 3, 4, 5, etc.).

When oscillate repeating within a range of key frames, select all frame cells with 

the range except the very last keyframe. This will ensure a smooth transition 

between repeat cycles.
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Offset Repeat. This option repeats and incrementally adds the values from 

the selected sequence of frames until the end of the animation. For exam-

ple, offset repeating frames 1 through 5 would both repeat and add the 

incremental change in values from frames 1 through 5 starting with frame 6 

and continuing until the end of the animation (i.e., the new sequence of 

frames would be 1, 2, 3, 4, 5, 5+1, 5+2, 5+3, 5+4, 5+5, 5+5+1, 5+5+2, 5+5+3, 

5+5+4, 5+5+5, etc.).

When offset repeating within a range of key frames, select all frame cells with the 

range including the very last keyframe. This is different than the previous choices 

due to the fact that offset is always adding the value and offset to the previous 

frame.
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11.5 The Tool Bar

The project window tool bar is located at the top of the project window. It is 

actually two separate tool bars, one containing tools which control the basic 

environmental settings of the project window (plus a few cell editing tools) 

and one which contains additional tools for dealing with hierarchy and ani-

mation data.

Clicking on the icon in the palette opens a pop-up menu, and some icons 

change to indicate the particular menu choice. The pop-up menus, from left 

to right, are:

Project Window List View Control

This pop-up menu is used to control the display of objects in the project 

window. The window can be viewed in a number of ways as discussed 

below. The menu choices are:

• Flat
• Hierarchy
• By Name

View List

Snap

Time Display

Custom View

Channel Display

Cell Size

Fill Cells...

Blend Cells

Cycle Cells

Render Timing

Object Labels

Figure 11.10 — Primary tool bar
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• By Label
• By Material
• By Model File
• By Complexity
• By Master Light

Flat. This option shows a flat listing of objects in order of creation.

Hierarchy. This option (the default) shows objects in hierarchical order. 

Children are indented from the parent to show their relationship.

By Name.  This option lists all objects in the project alphabetically.

By Label. This option lists all objects in the project by the color assigned to 

them with the label tool, which also resides in the project window tool bar. 

Objects without labels will be listed at the end, in alphabetical order.

By Material. This option lists all objects children of the master materials 

that they subscribe to. Objects that do not subscribe to master materials are 

put at the end of the list in alphabetical order. 

By Model File. This option lists all objects as children of the model files to 

which they belong (model files defined as disk files in the operating sys-

tem.) All other objects not associated with disk-based model files will be 

put at the end of the list in alphabetical order.

By Complexity. This option orders the list of objects by the amount of poly-

gons stored in the file. Objects with more polygons are listed ahead of 

objects with less polygons. Objects without polygons are put at the end of 

the list, and sorted by alphabetical order.
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By Master Light. This option lists all lights as children of the master lights 

that they subscribe to. Lights that do not subscribe to master materials, as 

well as objects which cannot, are put at the end of the list in alphabetical 

order. 

Snap

This pop-up menu (valid in Time mode only) controls whether or not the 

time slider will snap to a frame or keyframe when it is dragged to a new 

position. The menu choices are:

None. This option turns off the snap to frame function.

Snap to Frame. This option (the default) causes the Time Selector to snap to 

a frame when it is dragged to a new position.

Snap to Keyframe. This option causes the Time Selector to snap to a key-

frame when it is dragged to a new position.

Custom View

This pop-up menu is used to control what data is displayed in the Project 

window. The menu choices are:

All. This option (the default) shows all data in the project file.

Custom… This option opens a dialog box, as shown in Figure 11.11, that 

enables you to specify which data for which object class to display.
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To use the custom view dialog to control channels displayed in the 

project window:

1. Choose the object type to configure from the object list.
2. Select the channels to be displayed in the channel list (shift-click to 

select more than one), or click All to select all attributes from the list 
(clicking None de-selects any selected attributes).

3. Either click OK or press Return.

Position. This option shows only data for the position of objects.

Rotation. This option shows only data for the rotation of objects.

Scale. This option shows only data for the scale of objects.

Color. This option shows only data for the color of objects.

Visibility. This option will show only the visibility channel for objects in 

the scene.

Figure 11.11 — Custom view dialog

Object list Channel List
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Transform. This option will display transformation data only (position, 

rotation, scale) for each object in the scene.

Auto frames. This option will show only the auto frame channels (attach, 

track, auto-rotate) for each object in the scene.

Channel Display

This pop-up menu is used to open or close the different levels of animation 

channel data in the Project window’s data panel. The menu choices are:

Open Root. This option opens data cells for all roots.

Open Selected Root. This option opens data cells for selected roots.

Open Animated. This option opens data cells for all animated values.

Open Selected Animated. This option opens data cells for selected ani-

mated values.

Open All. This option opens all data cells.

Open Selected All. This option opens all data cells for selected objects.

Close All. This option closes all data cells.

Close Selected All. This option closes all data cells for selected objects.

Show/Hide Children. This option toggles display of a parent object’s chil-

dren (command or control “h”, for “hide”).

Hide Selected. This option will hide the selected objects from the project 

window list. The objects will remain visible in the world views and camera 

views.
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Hide Unselected. This option will hide unselected objects in the project 

window. The objects will remain visible in the world views and camera 

views.

Hide by Type. This option will hide objects by type. These types are:

• Cameras
• Lights
• Groups
• Effectors
• Sounds
• World object
• Material objects
• Model Files
• IK Handles
• Smoke objects

Show Selected. This option will unhide previously hidden, but still 

selected, objects.

Show Unselected. This option will unhide unselected objects previously 

hidden.

Show by Type. This option will unhide objects by type that have been pre-

viously hidden. These types are:

• Cameras
• Lights
• Groups
• Effectors
• Sounds
• World object
• Material objects
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• Model Files
• IK Handles
• Smoke objects

Cell Size

This pop-up menu is used to change the size (width and height) of the key 

and frame cells. The column width edit field will set the width of all of the 

column in pixels. The row height edit field will set the height of all of the 

rows in pixels. The default button will reset the column width and row 

height to factory settings.

Fill Cells

The descriptions for the fill cells popup menu can be found in the section 

“Editing Animation Channel Data” on page 286.

Cycle Cells

The descriptions for the cycle cells popup menu can be found in the section 

“Editing Animation Channel Data” on page 286.

Figure 11.12 — Cell size dialog
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Render

This pop-up menu is used to specify the frames that are to be rendered.

The menu choices are:

• All Frames
• Range of Frames
• Current Frame
• Every Nth Frame

All Frames. This option (the default) renders all frames in the animation.

Range of Frames. This option opens a dialog box for entering the specific 

start and stop frame numbers to be rendered.

Current Frame. This option will set the rendering engine to render only the 

current frame. Previews will also show only the current frame.

Every Nth Frame… This option opens a dialog box for entering the specific 

nth frames to be rendered (i.e., every 2nd frame, every 3rd frame, etc.)

Object Labels

This tool allows you to set named, colored labels for any object listed in the 

project window object/channel panel. The edit option in the menu will 

allow you to change the name of each label. Up to nine labels can be 

applied.
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Sound

This tool plays the selected sound track object. If a portion of the sound 

track is selected, only that portion will play. 

Deformation Editor

This tool opens the deformation editor window for the selected group.

Material Editor

This tool opens the material editor window for the selected group. 

Joint Editor

This tool opens the joint editor window for the selected group. 

Figure 11.13 — Secondary tool bar
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Link to Parent

This tool allows you to choose a new parent for the currently selected 

object. If many objects are selected, the new parent will apply to all the 

selected objects. To cancel the operation, press the command-period keys.

Unlink from Parent

This tool removes parentage from all selected objects.

Look at Object

This tool forces the selected object to “look at” another object. If the selected 

object is the camera or a light, its reference point will be locked to the object 

it is looking at. If the selected object is a group, its rotation will be affected 

by the object it is looking at.

This tool creates custom frames for the selected object’s reference (or rotation) chan-

nels, denoted in the Project window by underlined text. Custom frames need to be 

reevaluated when changed, and that recalculation will occur when the animation is 

previewed, rendered or saved (or when recalculated manually).

Cancel Look at

This tool removes the Look at Object function from the selected object (but 

does not recalculate custom frames).

Attach to Object

This tool forces the selected object to maintain its position relative to the 

position of another object. As the other object changes position, the selected 

object will change position. In effect, it is a way of temporarily connecting 
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groups together, much like the hierarchy feature. The major difference is 

that the Attach to Object function is temporary and time-based, and can be 

cancelled at any point in the animation. Hierarchies, on the other hand, are 

global, and any changes made apply to the entire animation. Because of 

this, you should assign hierarchies before animating.

This tool creates custom frames for the selected object’s position and reference (or 

rotation) channels, denoted in the Project window by underlined text. Custom 

frames need to be reevaluated when changed, and that recalculation will occur 

when the animation is previewed, rendered or saved (or when recalculated manu-

ally).

Detach from Object

This tool removes the Attach to Object function from the selected object 

(but does not recalculate custom frames).

Auto Rotate Object

This tool forces the selected object to change its orientation as it follows its 

motion path, always “looking” in the direction it is going.

This tool creates custom frames for the selected object’s rotation channels, denoted 

in the Project window by underlined text. Custom frames need to be reevaluated 

when changed, and that recalculation will occur when the animation is previewed, 

rendered or saved (or when recalculated manually).

Cancel Auto Rotate

This tool removes the Auto Rotate Object function from the selected object 

(but does not recalculate custom frames).
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Subscribe to Master Material

This tool will subscribe a group to a master material that has been previ-

ously loaded into the project, or previously created from the material 

record of another group.

Cancel Master Material

This tool will remove a group from a particular master material.

Park Object Data

This tool will reset the object data channels to 0.0, without changing the 

actual object orientation, position, scale, and so forth. Use this tool when 

you need to have the object’s coordinate space set to other than the one that 

it was created with.

Subscribe to Master Light

This tool is used to form a Master Light subscription. This tool does not cre-

ate a hierarchical relationship. Use the parent tool for that operation if 

needed.

Cancel Master Light

This option will remove a subscriber light from a master light.
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11.6 Assigning Channels to the Function Curve Editor

The function curve editor is used to edit motion data in curve form. You 

will likely find that the editing methods employed by the function curve 

editor or more intuitive than the numeric data presented by the project 

window. In order to edit curves in the function curve editor, the data chan-

nels must be sent over to it. That is done in the project window.

To send motion curve data to the function curve editor from the project 

window:

1. Open the project window
2. Locate the object to be edited by the function curve editor
3. Open the display channel icons, so that the animation channels are dis-

played.
4. Double-click on the channel that you want to send to the editor.

If you choose an implicit motion channel (that is, a motion channel 

which is a composite channel of x, y and z motion attributes presented 

as a single channel), you will see the following dialog:

This dialog is used to either include or exclude velocity channels when 

sending the animation data to the function curve editor. 

Figure 11.14 — Key channel velocity dialog
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Answering “yes” will remove velocity controls for the yaw, pitch, roll 

and scale channels. Answering “no” will leave the velocity controls 

intact for those channels. A velocity channel will always be added to 

the curve editor for position.

5. Choose the dialog option that best suits your needs

To see the results, you will need to open the function curve editor.
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Materials and Texture Maps

12.1 Introduction

In this chapter we will discuss the Materials and Texture Map features in 

Universe Animator. Materials are what the rendering engine uses to give 

shading and detail to a group. Textures are a component of Materials. 

Note Procedural Shaders are also a component of Materials, but are covered in the Proce-

dural Shaders chapter.

Great effort has been spent conforming to industry standard material terms 

and behavior wherever possible. This was done to allow you to take advan-

tage of the myriads of books and publications which cover the topics of 3D 

which are now available, and to make Universe even easier to use than 

ever before.

12.2 Overview of Features

The following highlights will give you an idea of the Materials and Texture 

Map capabilities of Universe Animator. 

• Master Materials (materials that groups can subscribe to)
• Materials Can Be Saved To Disk
• Industry Standard Material Controls
• Easy to Use Interface Design
• Displacement Maps
• Clipping Maps
• Procedural Shaders
• Unlimited Texture Maps
• Precise Texture Mapping Controls
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12.3 Materials Defined

Materials are a collection of shading attributes, called channels, that you 

create and apply to a group (or groups.) Materials can also contain texture 

maps and procedural shaders. You can apply materials from saved material 

files on disk, from materials created in the Material Editor, or from Master 

Materials. 

Master Materials

Master Materials are visible in the Project Window, and can have many 

groups linked to them. Master Materials will replace all of the attributes of 

the groups linked to them (an exception to this rule applies to locked 

maps.) You will still have to tweak the texture map alignment to fit each 

particular group for the best results, unless the groups are similar in shape. 

You can have as many Master Materials as you wish in a project. To add a 

Master Material to a project, choose Material > Add Master Material. You 

will now see the Material at the top of the item list in the Project Window.

Groups must be linked to Master Materials in order to use them. You can 

link as many groups as you like to an individual Master Material. A group 

may be linked to only one Master Material in a scene.

To link a group to a master material:

1. Select the group (or groups) that you wish to link to the Master Mate-
rial.

2. Click on the Link Material icon in the Project Window tool bar.
3. Click on the desired Master Material in the Project Window List.
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The selected groups are now linked to the Master Material. You can con-

firm this by setting the Project Window display icon to “By Material.” The 

Project Window display will change to show the groups that are linked to 

the Master Materials displayed as children to the Master Material.

12.4 Accessing the Material Editor

In order to create or edit a material or Master Material, you need to get to 

the Material Editor. There are four ways to access the Material Editor:

• Select the Group, and click the Material Editor icon in the Project Win-
dow

• Command double click on a Group in any window
• With the Group Info Window open, click on the Material Ball icon
• Double click a Master Material in the Project Window

The Material Editor

There are two variants of the Material Editor, one for group materials, and 

one for Master Materials. 
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The primary difference between the Group Material Editor and the Master 

Material Editor are the material management buttons, located above the 

tab area. The following discussion applies to both window variations.

Figure 12.0 — Master Material Editor
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All of the material channels have separate tabs, with each tab containing 

the controls and functions indicated by the name of the tab. To access the 

contents of the tab, just click on it, and the tab will move forward.

Above the tabs you see the material ball icon to the left. The material name 

edit field is just to the right of that. Below are the Load and Save Material 

buttons, and below them is the Create New Master button. To the right of 

the buttons is the Material Statistics section, which illustrates the makeup 

of the material.

The material ball icon shows a live preview of the settings of the various 

material channels. To copy a material, select the Material Ball Icon and 

Figure 12.1 — Group Material Editor
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choose Copy. To paste a new material into this material record, select the 

Material ball icon, and choose paste. (You can change the background color 

of the material ball icon by option clicking in the background of the icon, 

and choosing the preferred background display pattern or color.)

Loading and Saving Materials

One of the most powerful new features is the ability to create a material 

and save it to disk to be called up any time it is needed. The material is 

saved to a directory within your Universe Animator directory called “EI 

Material.” The saved material contains the settings of the various material 

channels (diffuse, specular, etc.), as well as, external references to texture 

maps and procedural shaders.

To load a material:

1. Click the Load button
2. Choose a material from the directory
3. Double click the material or click the open button

The material is now applied to the group. Groups can only have one mate-

rial assigned to them, whether you assign a material to a specific group, or 

whether you assign a group to a master material.

To save a material:

1. Make sure that the material is named
2. Click the Save button

The material is then added to the EI Material directory. Universe Animator 

does not provide any indication that the material has been saved. To check 

this you can save it again, if you like. When you do, you will then be asked 

if you wish to replace the material (indicating that it was previously saved.)
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12.5 Creating New Master Materials

You can create new Master Materials from the Material Editor of a particu-

lar group, or you can add them to a project as described previously. Groups 

can be linked to them with a special material link command described in 

the Master Materials section.

Groups can be passively linked to a Master Material, or they can be “live 

linked.” Passively linked groups will require a manual update to receive 

any changes that are made to the Master Material they are assigned to. Live 

linked groups will be updated immediately upon any change to the Master 

Material they are assigned to.

To create a Master Material:

1. Set up your material
2. Click on the Create New Master button
3. A dialog will appear, prompting you to name the material.

A Master Material version of the material you were editing now appears in 

the Project Window item list. You will note that two new material manage-

ment buttons have now been added to your material, just below the Create 

New Master button: Reload from Master and Update Master.

Reload From Master

This button appears in groups that are passively linked, not live linked, to a 

Master Material, and reloads the material properties from the Master Mate-

Figure 12.2 — Material Management Buttons
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rial. This is useful if you are exploring a change to a material but decide 

you prefer the original.

Update Master

This button appears in groups that are passively linked, not live linked, to a 

Master Material, and replaces the Master Material with the current mate-

rial. Groups that are live linked to the master will be immediately updated.

12.6 Material Interface

The Material Editor presents all material channels in a tab context. This 

makes all of the shading attributes of Universe Animator very accessible 

and easy to use. It should not take very long to get acclimated to the new 

interface. To edit a particular channel within a material, just click on its tab. 

A material channel is a shading component, referred to as material channel. 

There are eight material channel tabs:

• Geometry
• Diffuse
• Specular
• Ambient
• Reflectivity
• Transparency
• Luminance/Glow
• Transmission

Each channel tab contains the many attributes which are controlled by the 

channel, including texture maps and procedural shaders.
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Geometry Tab

The geometry tab contains all of the material channels and attributes which 

affect the apparent geometry of a group and how it is shaded. You can add 

outlines to the group, add bump and displacement maps for more detail, or 

punch actual holes into the group with clipping maps (and shadows do see 

these holes.)

The geometry tab is organized into three basic sections:

• Cel/Outline Shader section
• Bump/Displacement Map list
• Clipping Map list

Cel/Outline Shader Section

In this section you assign color and thickness to polygon outlines, edge out-

lines and silhouette outlines. Used in conjunction with the Cartoon proce-

Figure 12.3 — Geometry Tab
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dural shader, the look of traditional 2D cel animation can be achieved. 

There are three types of line effects:

• Polygon Outlines
• Edge Outlines
• Silhouette Outlines

Polygon Outlines. Activating this setting causes all of the polygons in the 

group to receive an outline. This is similar to wireframe shading, except 

that the polygon will also be shaded.

Edge Outlines. Activating this setting will cause certain edges to be 

defined with lines. As the group or camera is in motion, the definition of 

the edges will change, similar to the effect you see in traditional 2D anima-

tion. The silhouette feature should be active with this feature.

Silhouette Outlines. This setting causes the silhouette of an object to be 

drawn in lines. On occasion, the silhouette is not clearly resolved, so it is 

best to use this feature with the Edge Outline feature enabled.

To activate the particular line effect you wish you must click in the check 

box. You can color the lines by clicking on the color swatch and choosing a 

new color from the color picker. To adjust line thickness, type in a new 

value in the edit box to the right of the line type (values are in pixels.)

Bump/Displacement Maps List

The Bump/Displacement Maps list is where you add maps of these type. 

You can add as many maps as you like to this list. Along with the standard 

bump map, displacement maps are supported. Displacement maps actu-

ally move the vertexes in the group using the map to determine how much 

displacement is applied. 
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With bump maps the illusion of depth or relief can be created such as the 

bark on a section of log. The limitation to bump mapping is that the silhou-

ette or edge of the log is perfectly smooth and the closer to the edge the 

more obvious the cheat. With a displacement map the geometry is actually 

moved, so the edge of the log shows relief as well as the center. It is impor-

tant that there be enough vertex points in the group to achieve a satisfac-

tory effect. It might be necessary to apply the Dicer plug-in to the group to 

achieve best results.

Bump maps and displacement maps can be either a grayscale bitmap 

image or movie file or a procedural shader. Any bitmaps of greater than 256 

colors will be converted to gray scale by the rendering engine to achieve 

the effect. If an alpha channel is present, it can be used to control the bump 

instead.

To add a bump or displacement map

1. Click on the add button next to the bump map list
2. Choose the Map
3. Double click on the map or click on the open button

The map will be added to the list. You can configure the map by double 

clicking on the name of the map in the map list.

Controls for the strength of the bump and displacement are found under 

the Special Tab in the Texture Info Window, and these controls can be ani-

mated. Setting Bump Factor to 0 will disable the bump calculation. Setting 

Displacement to 0 will disable the displacement calculations.

Clipping Maps List

The clipping maps list is where you add clipping maps to your group. You 

can add any amount of clipping maps or procedures to this list. Similar to 
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transparency maps, clipping maps are a quick and efficient way of cutting 

holes into a group. Unlike a transparency map, the clipped region is anti-

aliased independent of resolution. Zooming in close, the clipped object will 

still exhibit very clean edges. Clipping maps actually remove geometry, so 

they will create appropriate shadows. 

Clipping maps can be either a grayscale bitmap image or movie file or a 

procedural shader. Any bitmaps of greater than 256 colors will be con-

verted to gray scale by the rendering engine to achieve the effect. If an 

alpha channel is present, it can be used to control the clipping instead.

To add a clipping map

1. Click the Add button next to the Clipping Map list
2. Select the map or procedural from the dialog
3. Double click the map, or click the open button

The Clip factor edit box is found in the Texture Info Window under the spe-

cial tab, and controls the strength of the clipping map, where 0 is fully 

transparent and 1 is fully opaque.

Solid/Dissolved Slider

This slider is another way to control transparency.

Diffuse Tab

The diffuse tab contains all of the material channels and attributes which 

affect the diffuse channel of a group. The diffuse channel is where color is 

applied, and you will note that there is no longer a surface color attribute. 
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The diffuse tab is organized into two basic sections:

• Diffuse parameters
• Diffuse Maps list

The diffuse parameters section contains a color swatch, slider bars for con-

trolling the amount of energy transmitted by the group, the falloff of that 

energy, and the mask opacity for the group. There is also a checkbox that 

allows you to use the original polygon colors of the group (some modeling 

programs let you assign unique colors to individual polygons, which you may 

want to keep.)

Color Swatch

To choose a diffuse color, click on the swatch and pick a new color from the 

color picker. 

Figure 12.4 — The Diffuse Tab
Electric Image Universe 3.0        333



Chapter 12  Materials and Texture Maps — The Diffuse Tab
Use Polygon Color

This check box forces the renderer to use the color assigned to the individ-

ual polygons of the group when it was created. Assigning a color to the 

group with the swatch will ignore all of the polygon colors in the group. 

You can revert back to the original color of the group with this checkbox.

Amount

Use this slider to darken the group’s color. The slider bar will use the color 

in the swatch (or the polygon colors if Use Polygon Color is active) as top 

end of the range (brighter). You can also type in a value in the Amount edit 

box. The Amount slider is a nifty way of keeping your diffuse color intact 

while adjusting the brightness levels of the group. 

Falloff

Falloff was formerly called Shading Dropoff, and sets transition value from 

fully shaded to not shaded. Larger objects to have sharper falloff values 

(such as planets, where.25 is a good falloff value.) Smaller objects should 

have falloff values closer to 1.0.

Some sliders will accept values of greater than 1.0, or less than zero. You can adjust 

the value by typing in the value that you wish in the edit box to the right of the 

slider. Falloff is one of the attributes that allow this.

Mask

This slider affects the alpha channel for the group (often called a Mask or 

Matte) in the final render. This feature can be used in conjunction with a 

compositing effects. If you want the group to appear normally in the scene, 

then leave the value at 0.0 (opaque on the slider.) If you want the group to 

act as a cutter, removing its shape from the scene, then set the value of the 
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mask attribute to 1.0 (transparent on the slider). When this setting is any-

thing more than 0.0, a true hole will be left behind if the group is obscuring 

another object .

Diffuse Maps list

The diffuse maps list is where you add color maps, procedural shaders, or 

diffuse value maps. You can put as many maps as you like in this list. Maps 

can be single frames or movie files, and can be any bit depth desired.

To add a diffuse map to the list:

1. Click the Add button next to the Diffuse Map list
2. Select a map or procedural shader from the file list
3. Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click 

on the map name in the list. To reorder the map in the list, just drag it to its 

new location. 
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The Specular Tab

The specular tab contains all of the material channels and attributes which 

affect how the various specular attributes of a group will shade. The specu-

lar tab is organized into two basic sections:

• Specular Attributes
• Specular Map List

 

The Specular Attributes section contains a color swatch, slider bars for con-

trolling the amount of specularity, gloss, size and falloff, and a diffuse bias 

check box.

Color Swatch

The color swatch is used to set the color of the specular highlight. To choose 

a color, click on the swatch and pick a new color from the color picker. This 

setting is ignored if the Diffuse Bias setting is active.

Figure 12.5 — The Specular Tab
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Diffuse Bias

This check box forces the specular color to be equal to the diffuse color. The 

color of the highlight is added to the diffuse color, making the highlight 

brighter than the surrounding area. This is analogous to the way that high-

lights work in the real world, and defaults to on (which ignores the color in 

the color swatch.)

Amount

The Amount slider controls the brightness of the specular highlights that 

appear on the group. A value of 0 turns off the highlight. 

Gloss

The gloss slider adds a gloss or sheen to your group. It imitates what the 

group would look like if it were a bit reflective, removing color from the 

surface around the highlight. It can create an odd look, so you might want 

to use this sparingly.

Size

Controls the size of the highlight on the group. The smaller the number, the 

larger the highlight. Values of greater than 1.0 can be typed into the Size 

edit box.

Some sliders will accept values of greater than 1.0, or less than zero. You can adjust 

the value by typing in the value that you wish in the edit box to the right of the 

slider. Specular size is one of the attributes that allow this.
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Falloff

Controls the sharpness of the highlight. Larger numbers give a sharper, 

more abrupt transition, and smaller values produce a smoother and less 

defined highlight.

Specular Maps List

A specular map controls the area in which the specular highlight is visible 

on a group, as well as the value (brightness) of the highlight or the color of 

the highlight. Specular value maps can be either a grayscale image or 

movie file or procedural shader. Any bitmaps greater than 256 shades will 

be converted to gray scale by the renderer for specular value maps. If an 

alpha channel is present, it can be used to control the specular instead of 

the RGB channel. 

To add a specular map to the list:

1. Click the Add button next to the Specular Map list
2. Select a map or procedural shader from the file list
3. Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click 

on the map name in the list. To reorder the map in the list, just drag it to its 

new location.
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The Ambient Tab

The ambient tab contains all of the material channels and attributes which 

affect the ambient shading characteristics of the group.  Ambient is a simu-

lation of ambient fill light, and you can make the ambient take a different 

color cast than the diffuse channel.

There are two basic sections to the ambient tab:

• Ambient Attributes
• Ambient Map List

The ambient attributes section contains a color swatch and a slider bar.

Color Swatch

Controls the color cast of the ambient fill light on the group. To change the 

color, click on the color swatch and pick a new color from the color picker.

Figure 12.6 — The Ambient Tab
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Amount

Controls how the group responds to ambient light. Larger numbers will 

make the group appear to have more fill color, and be a little less defined. 

Higher fill values would be appropriate for objects in sunlight. Lower fill 

values would be more appropriate for night time or deep space shots.

Ambient Map List

Ambient maps can affect the color of the ambient effect, the value of the 

effect, and the areas of the group that receive the ambient effect. You can 

have as many ambient maps as you like in the material. An ambient map 

can be an image or movie file or a procedural shader.

To add an ambient map to the list

1. Click on the Add button next to the Ambient Map List
2. Select the map
3. Double click the map, or click the Open button

The map is now added to the list.To configure the map, double click on the 

map name in the list. To reorder the map in the list, just drag it to its new 

location.

The Reflectivity Tab

 The reflectivity tab contains all of the material channels and attributes 

which affect how and what the group will reflect. There are four main sec-

tions to the reflectivity tab:

• Reflectivity Configuration (How the Group Reflects)
• Reflection Configuration (What the Group Reflects)
• Reflectivity Map List
• Reflection Map List
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Both the Reflectivity Configuration section and the Reflection Configura-

tion section are comprised of additional subsections.

The Reflectivity section resides within the left side of the tab, and the 

Reflection section resides on the right side of the tab.

Reflectivity Configuration Section

The reflectivity configuration section contains the basic reflectivity controls 

and specialized edge attenuation controls.    

Amount

The Amount slider is used to control overall reflectivity amount of the 

material. The valid ranges are 0.0 to 1.0.

Color Swatch

The color swatch tints the group’s reflection. It is disabled if the Reflection 

Bias checkbox is enabled.

Figure 12.7 — The Reflectivity Tab
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Reflection Bias

This check box forces the reflected color to be equal to the diffuse color. The 

reflection is then added to the group by whatever percentage is set in the 

Amount attribute. This is more realistic than setting the color of the reflec-

tion manually, and defaults to on. 

Edge Control (Attenuation) Section

Edge control allows you to attenuate the reflection across the surface of the 

group (this is also called the Fresnel effect.) Objects in the real world tend to 

reflect more intensely towards the edge, and less so towards the center as 

seen from the viewer’s point of view. 

To illustrate this effect, set the reflectivity amount to.5, edge amount to 1.0 and fal-

loff amount to 1.0. Note that the center of the material ball shows no reflection, but 

the edges are quite reflective.

Amount

The amount value controls the amount of reflection along the edge of the 

group. It is factored into the overall reflection amount. This value is unused 

if the edge falloff amount is set to 0.0.

Falloff 

The Falloff value controls how the reflection will fall off towards the center 

of the group. The higher the number, the less reflection you will see at the 

center of the group. This value is not considered if the Edge Amount value 

is 0.0.

To the right of the edit boxes is a graph area, which shows the relationship 

of the Edge Amount and Falloff values. With the Edge Amount set to 1.0, 

and the Edge Falloff set to 0.0, the graph will appear as a white square (the 
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default.) This indicates that the reflection will appear evenly across the sur-

face of the group. As you adjust the relationships between the two values, 

you will see the graph change to reflect the new values.

Reflectivity Maps List

A reflectivity map controls how the group will reflect any reflection maps 

assigned to it in the Reflection Map section. It can also control what areas of 

the group receive a reflection, and how much of it. Any bitmap image, 

movie or procedural shader can be used as a reflectivity map.

To add a reflectivity map to the list:

1. Click the Add button next to the Reflectivity Map list
2. Select the map or procedural shader from the file list
3. Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click 

on the map name in the list. To reorder the map in the list, just drag it to the 

new location. 

Reflection Map Configuration Section

Reflection maps are what the group is actually reflecting. Reflection maps 

can be bitmaps, either still or movie files. Procedural shaders cannot be 

used for reflection maps. Reflection maps can also be automatically gener-

ated by Universe Animator. These are called mirror maps, which are flat, 

and environmental maps, which are cubic. The controls for the automatic 

maps are in the Environment Reflection subsection.
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In the main Reflection Map Configuration section, there are three check 

boxes:

• Use Global Maps
• Use Bitmap Reflection
• Use Environmental Reflection

Any or all of these settings can be selected at any time. Each map has an 

amount slider that allow maps to be less than full intensity. This allows 

reflections to be added together, say global maps with bitmap reflections. 

The effect is additive, which may not be desired.

Global Maps. This check box enables the reflection maps applied under 

the World Info Window located in the Project Window as a reflections for 

the group. This setting allows as many groups as you wish to use the same 

reflection. This map can also function as a “default” reflection map, remov-

ing the need to physically assign a reflection map to the group.

Bitmap Reflection. This check box enables the group to reflect maps from 

the reflection map list.

Environment Reflection. This check box enables any of the selected Envi-

ronment Reflections specified in the Environment Reflection subsection.

Environment Reflection Subsection

There are three choices in the subsection:

• None
• Mirror
• Environment

None. No map is selected. This is the default condition.
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Mirror. Mirror maps are flat, and automatically render an exact mirror 

reflection, relative to the established mirror plane. You control the mirror 

plane through the Configure… button in the subsection. It is necessary to 

establish a plane to guarantee expected results. 

Environment. Environment maps are cubic reflection maps that are auto-

matically created by the rendering engine. The rendering engine creates six 

images representing the faces of the cube. These images then form the basis 

of the reflections on the group. You can control the resolution of the envi-

ronment map with the Configure… button. The resolution settings are in 

an edit box available under the Projection tab.

Please note that environmental reflections and mirror reflections can add up ren-

dering time if you use alot of them. In that case, you are better off choosing ray-

traced reflections. 

To save render time, you can set an automatic environment map to calcu-

late its reflection only once. This setting is available through the Config-

ure… button, in the Filter tab.

Reflection Map List

The reflection map list is where you add the bitmap images or movies that 

you wish the group to reflect. 

To add a reflection map to the Reflection Map List

1. Click on the Add button next to the Reflection Map list
2. Select a map from the file list
3. Double click the map, or press the Open button.
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The reflection map is added to the list. To configure the map, double click 

on the map name in the list. To reorder the map in the list, just drag it to its 

new location. 

Use Raytrace

This option will raytrace the reflections. Raytrace reflections are much more 

accurate than those of reflection maps, but they can take longer to render.

Raytrace Occlusion

Reflection maps have been around for a long time. Used in place of ray-

traced reflections, reflection maps are much faster, but not accurate, as they 

are merely a simulation of reflectivity. Raytraced reflections are very accu-

rate, but require long render times, and filtering costs can be prohibitive. 

One method which provides the benefits of both is Reflection Map Occlu-

sion. Essentially, reflection maps show a reflection everywhere on a 

reflected object, which is not accurate. Occluded reflection maps place the 

reflected map image only where it would be physically possible to see a 

reflection in the first place. Imagine looking at the reflection of a car door. In 

the real world, you would not see a reflection of the sky where a reflection 

of the rear view mirror would be. That is the operative principle here. In 

this example, a sky reflection map would not appear where the reflection of 

the mirror would be, instead, you would see no reflection of the map at all 

in the mirror area.

This method is not as accurate as a fully raytraced reflection, but then 

again, it is not nearly as time consuming either, and produces great results.
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The Transparency Tab

The transparency tab contains all of the material settings and attributes 

which affect the transparency of the group. Several improvements and 

modifications have been incorporated in the transparency calculations 

used by the rendering engine, and industry standard presentations of the 

transparency attributes have been incorporated into the interface wherever 

possible.

Please note that the specular highlight and reflection calculations for the group are 

not affected by the transparency settings. If you wish to lessen their impact on a 

transparent group, you will need to adjust these values separately.

The transparency tab contains four sections:

• Transparency Attributes section
• Edge Characteristic section
• Transparency Map list
• Transparency Edge Map list

Figure 12.8 — The Transparency Tab
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Transparency Attributes Section

Raytrace

Transparencies can be either Raytraced or Phong based. Raytraced trans-

parencies are more accurate and show light bending through an object. For 

example a glass of water bends the light as you look through it, making 

objects look distorted when viewed through the water.

Index of Refraction

This is the amount of refraction (bending of the light) that occurs. 0.0 is con-

sidered vacuum so no light would bend. Higher numbers would create 

more distortion.

The transparency attributes section contains controls for setting the actual 

transparency of the group. The slider bar controls the amount of transpar-

ency. The three buttons to the right of the slider control the type of trans-

parency applied to the group:

• Filter
• Color Filter
• EI Filter

Filter. Filtered transparency groups are mathematically “averaged” into 

the scene, meaning that they do not change the appearance of any groups 

that fall behind them, with the exception of dimming the brightness values 

of those groups by the value set for the transparency. This effect does not 

reflect how transparent objects behave in the real world, and tends to be 

used primarily for special effects. 

Color Filter. Color filter transparencies are either subtracted from the scene 

or added to the scene, depending upon which choices you make in the fil-
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ter mode subsection. (The filter mode subsection is visible only if this option is 

selected.) 

The filter mode subsection is divided into two areas:

• Filter Mode
• Filter Color

Filter Mode. Filter Mode determines the method by which the transpar-

ency will be applied to the scene. 

Subtractive transparencies most accurately mimic the effect of transparent 

objects in the real world. Groups which pass behind a subtractively trans-

parent group will be tinted to color of the transparent group, as the color of 

the transparent group is subtracted from whatever is behind it. 

Additive transparencies are typically used for special effects purposes, 

such as glowing balls of energy and so forth. Groups which pass behind 

additive transparent groups will appear brighter, as the color of the trans-

parent group is added to whatever is behind it.

Filter Color. Filter color is used to determine the color that will be used for 

the filter effect. 

The Use Surface Color option will use the Diffuse channel and all attributes 

assigned to it for the filtering process set by the Filter Mode switch. This is 

the most realistic setting, and the default.

Figure 12.9 — Filter Mode Subsection
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The Use Custom Color option will use the color in the swatch next to the 

item as the filtering color. It will ignore all of the attributes in the Diffuse 

channel. To change the color of the swatch, click on it and pick a new color 

from the color picker.

EI Filter. This setting is included for project file compatibility with previ-

ous versions of ElectricImage. The color filter transparency method offers 

far more control and ease of use than this method. Consider ignoring this 

method when you are creating new projects from scratch.

When this option is selected, the EI Filter options subsection appears. It 

consists of two items:

• Use Surface Color
• Use Custom Color

Use Surface Color

This option will use the diffuse channel and all attributes associated with it 

as the filtering process for the transparency. 

Use Custom Color

This option will use the color in the swatch as the filter color. This is analo-

gous to the methods used by previous versions of ElectricImage. To change 

the color in the swatch, click on it and pick a new color from the color 

picker.

Figure 12.10 — EI Filter Options
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Transparency Map List

Transparency maps can be applied to modify the amount of transparency 

or to modify the color of the transparency. You can have both types of maps 

in the list. Maps can be bitmap images and movie files, or procedural shad-

ers. 

To add a transparency map to the list:

1. Click on the Add button next to the transparency map list
2. Choose a map from the file list
3. Double click on the map, or press the Open button

The map is added to the list. To configure the map, double click on the map 

name in the list. To reorder the map in the list, just drag the map to its new 

location.

Edge Characteristic Section

The items in this section control the effect of the edge of an group, regard-

less if the group is set to be transparent or opaque.   For transparent groups, 

you can adjust the opacity of the edge, and the falloff when the edge gets 

more opaque. For opaque groups, you can adjust when the edge of the 

object becomes more transparent. 

A notable difference between Universe Animator and previous versions is that the 

Edge Color value has been removed. Instead, the edge color is derived from the color 

of the diffuse channel. If a colorless transparent glass look is desired, set the trans-

parency method to color filter, select subtractive, and the custom color option. Click 

on the color swatch to set a new color, perhaps a lighter variant (close to white) of 

the diffuse color selected (remember, we are using that value to give the edge some 

color.) Because you have selected the subtractive transparency mode, the white will 
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be removed, leaving no color contamination behind, as more saturated colors will 

do. This will give a result equivalent to earlier versions of ElectricImage.

There are two sliders which affect the look of the edge:

• Amount
• Falloff

The Edge Characteristic sliders work similarly to the Edge Reflection slid-

ers.The type of effect achieved is determined by the three edge control but-

tons described following the Amount/Falloff discussion.

Amount. This slider determines the amount of edge transparency or opac-

ity applied to the group. The falloff value (described below) must be set to 

a value other than 0.0 to see the effects of this slider. The range of this slider 

is 0.0 to 1.0.

Falloff. This slider determines how the edge will intrude into the body of 

the group. The Edge Amount slider must have a value other than 0.0 to see 

the effect. This slider has an infinite upper range, however, you may find 

numbers greater than 5 of no useful effect.

Edge Graph

To the right of the sliders and edit boxes is the edge graph, which shows the 

relationship of the Amount and Falloff parameters in graphic form. It 

updates in real-time as these values are edited. You will note that the more 

white area in the graph, the more powerful the defined edge will be, as rep-

resented in the material ball. The curvature plotted in the graph represents 

the actual mathematical function plotted by the values in Amount and Fal-

loff
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Edge Control Buttons

There are three radio buttons which control the treatment of the edge of the 

group:

• Normal
• Opaque
• Transparent

Normal. No edge characteristic is applied. The transparency effect is car-

ried evenly through the group. This often yields a group with less defini-

tion, and is considered less realistic for transparencies.

Opaque. The edges of the group will be opaque, using the parameters set 

by the Amount and Falloff sliders. For transparent objects, this option 

yields the most realistic results, with the Amount and Falloff values set to 

your preference.

Transparent. The edges of the group will be transparent, using the parame-

ters set by the Amount and Falloff sliders. Opaque objects can be made to 

have clear, fluffy edges, and can be used for such things as clouds, cotton 

balls, or planet atmospheres.

Transparency Edge Map List

Transparency edge maps work the same as the transparency maps and can 

affect the value or color of the transparency at the edge of the group.

To add a transparency edge map to the list:

1. Click on the Add button next to the transparency edge map list
2. Choose a map from the file list
3. Double click on the map, or press the Open button
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The map is added to the list. To configure the map, double click on the map 

name in the list. To reorder the map in the list, just drag the map to its new 

location.
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The Luminance/Glow Tab

The luminance/glow tab contains all of the material channels and 

attributes which affect the luminosity and glow effects that a group can 

have applied to it. 

 

The luminance/glow tab is divided into four sections:

• Luminance Color
• Glow Color
• Luminance Map List
• Glow Map list

Luminance Color. The luminance value controls the group’s self illumina-

tion. (This value does not actually cause the group to emit light, but rather 

glow like an LED would glow.) The slider controls the amount of self illu-

mination of the group, using either the color in the color swatch, or the dif-

fuse shading channel of the group. Texture maps can also be used to control 

the luminescence of the group. 

Figure 12.11 — The Luminance/Glow Tab
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• Use Color Button

The use color button will cause the group to luminesce with the color in the 

color swatch. The change the color in the swatch, click on it and pick the 

color from the color picker.

• Use Shading Button

The use shading button will cause the group to luminesce with the values 

found in the diffuse channel.

Luminance Map . Luminance maps can be either value maps or color 

maps. In the case of grayscale the white areas of the map will illuminate to 

white and black areas will not illuminate. In the case of a color map the illu-

mination will possess the colors of the map.

To add a map to the luminance map list:

1. Click the Add button next to the map
2. Select a map from the file list
3. Double click the map, or press the Open button.

The map will now be added to the list. To configure the map, double click 

on the map name in the list. To reorder the map in the list, just drag the 

map to the new location. 

Glow Color. The glow effect causes groups to apparently emit a glowing 

area around the group. The glow is a compositing effect added at the end of 

each rendered frame (and as such the effects of the glow settings are not 

represented in the material ball icon.) Glowing groups will not effect the 

appearance of other groups in the scene. 
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Setting up glows properly requires the following procedure:

1. Setting the glow attribute in the group’s material
2. Assigning the group to a selection set
3. Adding a the selection set to the glow layer tab in the Render Informa-

tion Window
4. Set up the glow layer

Setting the Glow Attribute in the Group’s Material

In the Glow Color section, you can control the amount that an object will 

glow, the color or shading of the glow, and whether the group will actually 

glow, or have a glare on the brighter areas of the group (which you can con-

trol.)

Glow. The Glow radio button will use the color swatch as the glow color. 

The value of the glow is set by the Glow Amount slider. To change the color 

in the color swatch, click on the swatch and pick a color with the color 

picker. The actual area of glow is determined by the attributes of the Glow 

Layer, found in the Glow Layer tab of the Render Information Window. If 

the group is not part of a selection set contained within a Glow Layer, then 

the group will not appear to glow in the rendering.

Glare. The glare button will use the diffuse channel to create a glare around 

the group. The amount slider determines the brightness cutoff for the glare. 

Typically, a fairly subtle cutoff is desired, as glares tend to be less overpow-

ering than glow effects. 50% is a good value for the brightness cutoff to 

begin with. You can have the entire group “radiate” by setting the slider to 

0.0. This makes the group appear to be heavily over-exposed, depending 

upon the settings in the glow layer to which the group’s selection set is 

assigned.
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Any pixels which fall within the specified tolerance set by the Glow 

Amount attribute will be blurred by the amount specified in the Glow 

Radius attribute of the Glow Layer, and then added back onto the scene by 

the amount specified in the Intensity attribute of the Glow Layer to which it 

is assigned. Glow Radius values of 50 pixels or greater, plus a Glow Inten-

sity of 1.5 will give you a good starting point for a nice glare effect (as 

shown in the illustration.)

The actual area of the glare is determined by the attributes of the Glow 

Layer, found in the Glow Layer tab of the Render Information Window. If 

the group is not part of a selection set contained within a Glow Layer, then 

the group will not glare in the rendering.

To assign the Group to a Selection Set:

1. Select the group
2. Choose Select>By Set>Edit Sets

3. Click the Add button in the Selection Sets section of the window that 
appears

4. Type in the name of the set and hit return
5. Select the name of the set that now appears in the list
6. Click the Add button in the members section of the window

Figure 12.12 — Teapot without glare on the left, Teapot with glare on the right
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7. Close the window

All of the selected groups will now be part of that named selection set.

Add the Selection Set to a Glow Layer:

1. Open the Render Information Window (Render>Render Settings…)
2. Select the Glow Layer tab
3. Click the Add button in the Glow Layer Section
4. Type in Glow Layer name in the edit field and hit return
5. Select the Glow Layer in the list
6. Click the Add button in the Glow Layer Member section
7. Select the desired selection set from the list that appears, and click the 

Add button

Figure 12.13 — Edit Selection Sets Window
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The selection set is now added to the glow layer.

Set Up the Glow Layer

1. Select a Glow Layer from the Glow Layer List
2. Type in a value for the Glow Radius in pixels
3. Type in a value for Glow Intensity

The smaller the pixel number in the Glow Radius edit box, the more 

defined and brighter the glow will appear. Larger values in the Glow 

Radius edit box might require an adjustment to the Glow Intensity value to 

achieve the desired effect (larger intensity values for a stronger glow, 

smaller intensity values for a weaker glow.) Glow effects will typically be 2 

or greater in intensity, while Glare effects will probably not be brighter than 

1.5, but feel free to experiment.

The previous steps cover typical glow and glare usage.

Figure 12.14 — Glow Layer Tab of Render Information Window
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Glow Color Maps List

Glow maps can be applied to control the amount of glow, and to control the 

color of the glow. Glow maps can be a bitmap image or movie file, or a pro-

cedural shader. You can have as many glow maps as you like.

To add a map to the glow color maps list:

1. Click the Add button next to the glow color maps list
2. Select a map from the file list
3. Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click 

on the name of the map in the list. To reorder the map, just drag the name 

to the desired location in the list.
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The Transmission Tab

 The transmission tab contains all of the material channels and attributes 

which affect the transmission characteristics of the group. Some objects in 

the real world can allow light to go through them to a degree. This effect 

can be seen of you were to hold up a leaf to the sun. You would notice the 

spidery vein network as darker shapes, and the thinner parts of the leaf 

would appear brighter. The transmission channel lets you correctly repro-

duce this phenomena.

The transmission tab is divided into three sections:

• Transmission Color Section
• Transmission Edge Control Section
• Transmission Maps List
• Edge Transmission Maps List

Figure 12.15 — The Transmission Tab
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Transmission Color

This attribute determines the transmission amount and color. The best 

transmission color is white, as it will conform to the color of the group and 

any maps, plus the lightsource. 

Edge Control Subsection

Transmission edge control works the same as with edge transparency 

allowing you to build less translucent edges to curved groups the way they 

would appear in the real world.

Edge Amount

Controls the transmissiveness of the edge. The Edge Falloff slider must 

have a value other than 0.0 to see the effect.

Edge Falloff

This slider determines how the edge will intrude into the body of the 

group. The Edge Amount slider must have a value other than 0.0 to see the 

effect.

Edge Graph

To the right of the sliders and edit boxes is the edge graph, which shows the 

relationship of the Amount and Falloff parameters in graphic form. It 

updates in real-time as these values are edited.

Transmission Maps List

Transmission maps are used to control the value and color of the transmis-

sion. Transmission maps can be a bitmap image or movie file, or a proce-
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dural shader. After a map is assigned, the slider no longer has any effect as 

all the transmission information is derived from the value of the map.

The best way to achieve a natural look is to assign a standard color map 

under the Diffuse tab and then a grayscale transmission map under the 

Transmission Tab.

To add a map to the transmission map list:

1. Click the Add button next to the transmission maps list
2. Select a map from the file list
3. Double click the map, or press the Open button

The map is now added to the list. To configure the map, double click on the 

name of the map in the list. To reorder the map, select the name and drag it 

to the desired location.

Edge Transmission Map List

Edge transmission maps are used to control the value and color of the edge 

of the group. Edge transmission maps can be a bitmap image or movie file, 

or a procedural shader. After a map is assigned, the slider no longer has 

any effect, as all the transmission information is derived from the value of 

the map.

To add a map to the edge transmission map list:

1. Click the Add button next to the edge transmission maps list
2. Select a map from the file list
3. Double click the map, or press the Open button

The map is now added to the list. To configure the map, double click on the 

name of the map in the list. To reorder the map, select the name and drag it 

to the desired location.
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12.7 Using Texture Maps

Universe Animator has unlimited texture maps per group. Texture maps 

are an integral component of a material. Texture maps do different things, 

depending upon the tab and map list in which they reside. The same map 

can be used in many different channels, and each channel can have an 

unlimited amount of maps as well.

All of this power can come at a price if you are not frugal with your map manage-

ment. Be careful not to waste maps and map memory. If you just need a grayscale 

value for a bump map, then you would be wasting over 1 MB of RAM (for a typi-

cal map) if that same map also had RGB channels associated with it (and was 

unused elsewhere).

New map placement controls have been added that allow face to face preci-

sion of map placement. Multiframe maps can be easily controlled with start 

and stop times and stop ranges. Most of the map functions described in this 

section can also pertain to procedural shaders, in Universe Animator.

Map Lists

Maps are managed within map lists. Each material channel contains a map 

list where appropriate. Map lists are a jumping off point to map configura-

tion and management.

Map Order

Map order is very important, as some effects may not be obvious if maps 

are out of order. Fortunately, reordering maps within a channel is easy — 

just drag the maps to whatever order you wish.
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Map Alpha Channels

Alpha channels now take on a more specific meaning in Universe Anima-

tor, both to make the process of using texture maps easier, and to conform 

to industry standards. There are essentially three ways to use an alpha 

channel within a texture map:

• Ignored
• As Value
• As Mask

The Way Texture Maps Work

Maps add into the list from the top. Think of the list being stacked on top of 

the group. The map at the top of the list is the uppermost one, while the 

map at the bottom is innermost, nearest the actual surface of the group. The 

maps can be reordered by dragging them up or down in the list. 

The circle next to each map is a checkbox that can be used to enable or dis-

able the map. This feature is very useful while developing new materials. 

The empty space next to the circle is the map lock toggle. This can be set to 

prevent this map from being over-written by a Master Material assigned to 

the group.

Texture maps can be copied and pasted from one map list to another. To 

copy the map, highlight the map, select Copy Texture from the Edit menu. 

To paste the map, select the list you want paste it into by clicking some-

where in the list box. The list box will show that it has been selected with a 

thick black outline. Use the Paste Texture command from the Edit menu to 

complete the operation.
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To configure the texture map, double-click on the name of the map in the 

list box. The Texture Info Window will open. This window displays the 

group to be textured and the map projection (on the right) and has a series 

of tabs and buttons for controlling texture scaling, tiling, etc. (on the left).

Map Alignment Buttons

There are four map alignment buttons at the upper left of the window 

assist in map placement. These buttons are:

Figure 12.16 — Diffuse map list box

Figure 12.17 — Texture Info Window
Electric Image Universe 3.0        367



Chapter 12  Materials and Texture Maps — Using Texture Maps
• Move
• Select Polygons
• Fit to Selected
• Align Map Plane (to Polygon) 

Move. This (default) button allows you to move the map projection around 

in the window for proper placement on your model. Drag left or right at 

the edges of the projection to scale the map. Hold down the control key and 

drag to rotate the map.

Select Polygons. This button is used to select polygons by clicking on indi-

viduals or drag a rectangle for multiples. Shift click to add or remove poly-

gons within the selection.

Fit to Selected. This button sets texture projection to the extent of the poly-

gons selected with the Polygon Selection Button. 

Align Map Plane (to Polygon). This button sets map plane any polygon, 

regardless of the polygons you may have already selected with the Select 

Polygons tool. Unlike the Fit to Selected tool, the size and aspect ratio of the 

map is maintained with this tool. Align Map Plane is a very powerful fea-

ture for aligning the map projection icon to tricky curved surfaces. This fea-

ture is also available while in Move mode by Command-clicking on a 

polygon.
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Map Alignment Tab

The alignment tab contains the position and rotation information for the 

texture map. The map alignment tab is divided into three sections:

• Alignment Radio Buttons
• Position Information
• Rotation Information

The Alignment Radio Buttons 

These buttons provide a straightforward way of aligning the texture map:

• User
• Middle
• Front
• Back
• Top
• Bottom
• Left
• Right
• Polygons 

Figure 12.18 — Map Alignment Tab
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These projections will align and scale the map along the axis noted by the 

radio button. They are used to set the initial map alignment. You can use 

the map alignment buttons to more precisely locate the map to the group.

Position Information

The position information section contains X,Y, and Z readouts for map 

position, as well as a popup menu to control the motion path interpolation 

method for the map position channel. You can change the map position by 

dragging, or by typing values into the edit boxes.

Rotation Information

The rotation information section contains X,Y, and Z readouts for map rota-

tion, as well as a popup menu to control the motion path interpolation 

method for the map rotation channel. You can change the map rotation by 

rotation tools and keyboard shortcuts, or by typing values into the edit 

boxes. 

World Coordinates Checkbox

When this checkbox enabled, the map will reside in world space instead of 

local space. Effectively, the map becomes fixed in space at the coordinates 

specified (you can always animate its position, of course), and the group 

would then be perceived as moving through it’s map if the group were 

moved. 
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Map Projection Tab

The projection tab is used to determine the type of mapping primitive that 

the map will project, as well as the tiling method and map scale. There are 

four types of map tiling:

• None
• Hold
• Repeat
• Mirror

None. Disables mirroring of the map on the specified map axis. Choosing 

None for both axes will cause the map to be displayed only where you 

positioned it, nowhere else. You can choose this option along with another 

to constrain a map to hold, mirror, or repeat along a single axis.

Hold. Applies the colors found at the map edges outside of the map area. 

The map will appear once as positioned, with the border colors of the map 

extending beyond the map rectangle, covering the object.

Repeat. Repeats the map along the specified axis. Choosing Repeat for both 

axes will cause the map to repeat continuously, depending upon the scale 

of the map relative to the group.

Mirror. Mirrors the map along the specified axis. Choosing Mirror for both 

axes will cause the map to flip flop about both axes.
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Map Type Popup Menu

Map projections use simple primitives to process and align the texture map 

for rendering. There are four types of map projections:

• Flat
• Cylindrical
• Spherical
• Cubic

Pick the projection which most closely matches the shape of the group.

Flat. This option (the default) is best used for flat or flattish objects. If 

applied to a non-flat-object, the texture will streak along the sides of the 

object as it is projected onto all surfaces of the group.

The rectangle in the display represents the map and consists three arrows, 

one pointing to the top of the map (Y axis), one pointing out to the side of 

the map (X axis) and the other pointing out from the center of the map (Z 

axis.)

Figure 12.19 — Map Projection Tab
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The flat projection scale defaults to the group’s extents. The scales of the 

projection are visible in the X Scale, Y Scale, and Z Scale edit boxes and can 

be changed by typing new values into the edit boxes.

Cylindrical. This option projects a cylindrical image around the group.

A cylinder is oriented around the center of the object, with an arrow point-

ing towards the top of the cylinder, and a line indicating where the seam 

will be. This is the best mapping type to use if the object is roughly cylindri-

cal.

Cylindrical map types have three projection alignment controls, wrap 

angle, height and radius. The wrap angle controls the longitude projection, 

and the height factor controls the latitude projection of the cylinder. The 

wrap angle axis allows angles from 0˚ to 360˚. The default is 180˚. The 

height factor allows a real number factor, with 1 being the default size. The 

radius represents the radius of the cylinder, and defaults to fitting from the 

center of the group to the edge extent of the group.

Spherical. Spherical mapping warps the bitmap into a spherical shape, and 

then projects the map onto the group. A sphere primitive is centered 

around the group, with a line running along the sphere. This line is where 

the seam of the map will occur, and also points to the top of the map. An 

arrow runs from the center of the primitive to the top of the sphere. This is 

the best mapping type if the object is roughly spherical.

The spherical texture type has four separate projection alignment controls, 

wrap angle, band angle, band angle start, and radius. The wrap angle con-

trols the longitude projection, and the band angle controls the latitude pro-

jection. The wrap angle axis is a circular axis allowing angles of 0˚ to 360˚.
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The band angle axis is half circular, allowing for angles of 0˚ to 180˚. The 

band angle start determines where the band angle will begin. The band 

angle is centered on the sphere by default. The radius represents the radius 

of the sphere, and defaults to fitting from the center of the group to the 

edge extent of the group.

Cubic. The front face of the cube will have an “x” through the center, much 

like the flat type. There will also be three lines indicating the top (Y axis), 

front (Z axis) and side (X axis) of the map.

When this map is used with a cube-shaped group, all sides should project 

onto the group with minimal distortion. If this mapping type is applied to a 

curved group, the edges of the cubic map will be seen, appearing like a 

seam. Seaming also occurs when the projection is not properly aligned to a 

cube-shaped object.

The front face is the active face, which determines the overall mapping 

characteristics of the selected group. Use the active face to correctly scale 

the texture to the group, as well as to correctly orient the projection to the 

group’s coordinate space.

Map Scale Edit Boxes

The map scale edit boxes can be used to fine tune the scale and fit of the 

map on the group. There are separate values for X, Y, and Z axes.
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Image Map Tab

The image map tab contains thumbnails of the RGB and Alpha channels of 

an image map, some statistics about the map, the map cropping rectangle, 

a Replace Map button, and movie playback information for multi-frame 

map files.

RGB and Alpha Thumbnails

The RGB and Alpha thumbnails give you a quick visual reminder of the 

contents of the map channels. If you click on the thumbnail, a larger image 

will appear in the view window to the right of the tab. If you double click 

on the image in the view window, the actual image will be displayed in a 

separate image display window.

Replace Image Button

Allows you to replace the current texture file without losing the placement, 

scaling, and other settings.

Figure 12.20 — Image Map Tab
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Cropping Edit Boxes

These coordinate boxes allow you to crop the texture map to any size or 

portion of the map you wish to use. You can crop interactively by first click-

ing on the RGB or Alpha windows, to bring up the image in the texture 

window, and then drag the crawling ants border.

Map Playback Controls

These controls will appear whenever you have selected a mutli-frame map 

as a texture. You can adjust the end behavior, at what frame the movie will 

start, how many frames to play back, and the playback rate.

End Condition Popup Menu

This controls how the movie will behave when the end of the file is 

reached. There are three choices:

• Repeat
• Oscillate
• Hold

Repeat. Repeats the movie when the end of the file is reached.

Oscillate. Cycles back and forth through the movie when the end of the file 

is reached.

Figure 12.21 — Map Playback Controls
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Hold. Holds the movie at the last frame when the end of the file is reached.

• Start Frame

The first frame of the animated texture to be used. The first frame of the 

animated texture is considered frame 1 not frame 0. Choosing a value other 

than one will cause the animated texture to begin at that frame. Combined 

with the Frame Range edit box, you can choose to render just a section of 

the animated texture map.

• Frame Range

This value sets the number of frames to use for the animated texture map. 

When combined with the Start Frame value, this feature can be used to ren-

der just a section of the animated texture map. The default value is 0, which 

causes all frames in the animated texture map to be used.

• Frame Rate

Controls the number of animated texture frames to increment for every 

frame of the output animation. The default is 1.0. Smaller numbers will 

speed up the apparent playback of the texture when viewed at speed. 

Larger numbers will make the texture appear to be slower. Extremely large 

numbers will make the texture appear to be “step framed.” You can fine 

tune the playback by using real numbers (numbers with decimals.)
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Map Filter Tab

The map filter tab contains the image filtering and map strength controls 

for the texture map. This tab also is used to select how the different RGB 

and Alpha channels will be processed. The filter tab is divided into several 

sections:

• Map Filter Check Boxes
• Map Quality Edit Boxes
• Map Strength Slider
• Use Channel Popup
• RGB Channel Configuration
• Alpha Channel Configuration

Map Filter Check Boxes

These check boxes enable map filtering, and the Negative Z function. There 

are a total of three check boxes:

• Interpolate
• Anti-Alias

Figure 12.22 — Map Filter Tab
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• Negative Z
• Calculate Once (automatic reflections only)

Interpolate. Interpolation filters the map as it is applied to the model. It 

cuts down on aliasing, but can also soften the image (especially as the map 

grows larger than 1.0 in scale.) Disabling this feature will sharpen the map, 

but doing so is not recommended.

Anti-Alias. Texture anti-aliasing is another form of map filtering. With this 

option enabled, the map is effectively anti-aliased twice, first, during the 

stage in which the map is applied, then, as the entire image is anti-aliased. 

This can cause a loss of high frequency detail in the map, which some con-

sider objectionable. Disabling this feature will cause some aliasing, but the 

overall image anti-aliasing might hide the artifacts. Use at your discretion.

Negative Z. Causes the texture map to be projected along both the positive 

and negative Z axis. The map will be projected along only the positive Z 

axis if this checkbox is off. As an example, imagine a flat map placed on a 

nearly flat disk. If the Negative Z checkbox is on, the map will appear on 

both sides of the disk. If the checkbox is off it will appear only on the front 

side.

Calculate Once. Causes a mirror or environmental reflection map to be 

rendered only once in the animation. This feature can save much rendering 

time, although it must be used wisely, as the reflection will not update after 

the first frame.
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Map Quality Edit Boxes

These edit boxes offer even more control over the quality of the texture. 

There are two values to do so:

• Blur
• Samples

Blur. Allows you to degrade the map sharpness. This tool is useful for blur-

ring a bump map that is too sharp and not giving you a clean bump, or tak-

ing the edge off of a reflection that might appear too busy otherwise.

Samples. Controls the quality of the map. For the most part, 5 samples will 

yield acceptable results. If you wish to improve the quality of your maps 

even more, just increase this value. Higher values will increase rendering 

time, however.

Map Strength Slider

This slider controls the amount of affect the current texture has on the 

group. Use this slider when you have multiple texture maps on one group 

to mix together several maps. This value can be animated to cause maps to 

fade in/out over time.

Use Channel Popup Menu

This popup is used to specify what image map channels you wish to use 

and for what purpose. You can choose RGB, Alpha or both and then specify 

if you want it used as color or as value and if you want to invert it. There 

are three choices:

• RGB Only
• Alpha Only
• RGB + Alpha
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RGB Only. Uses the RGB channel only for the map. The options field 

changes when this item is selected, offering you the ability to use the map 

as a color map, or as a value map (in which case the map will be automati-

cally converted to gray scale.) There is also a button to the invert the map.

Alpha Only. Uses the alpha (mask) channel only for the map. The options 

field changes to the invert map button, allowing you to reverse the alpha 

channel.

RGB + Alpha. Uses both the RGB and Alpha channels. When this option is 

selected, the options field displays configuration sections for both the RGB 

and alpha channels, which allow you to modify the behavior of these two 

channels. These configuration sections are described in detail below.

RGB Channel Configuration

There are three items in the RGB channel configuration section:

• As Color
• As Value
• Invert

As Color. This option sets the RGB channel to be used as color only. The 

color of the map will be passed through to whatever shading channel the 

map is applied to (note that some channels, such as Bump/Displace and 

Clipping, do not use RGB colors.)

As Value. This option uses the RGB colors as values (think of it as an auto-

matic gray scale map conversion.) Effectively, the RGB channel can be used 

to drive value-based effects, such as bump and displacement maps, clip 

maps, transparency value maps, and so on.
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Invert. This option negates the colors of the RGB channel. The map can still 

be used either As Color or As Value. This option often prevents a quick trip 

to Photoshop!

Alpha Channel Configuration

There are three items in the Alpha channel configuration section:

• Ignore
• As Mask
• Invert

Ignore. Ignores the alpha channel altogether.

As Mask. This option enables the alpha channel to be used as a mask. 

Invert. This option negates the colors of the alpha channel.

Special Tab

Depending upon the type of map, this tab may be empty or may contain 

controls for bump/displacement maps, as well as controls and buttons to 

show or save procedural shaders.
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Using Effectors

13.0 Introduction

Effectors are invisible null objects that models, cameras, and lights in a 

scene can be linked to. Any transformation, rotation, scale, or deformation 

applied to the effector will be passed on to the groups that are linked to it. 

Using effectors allows you to control complex animation's by layering 

motion characteristics into separate control objects. The following chapter 

will explain the use of effectors of all kinds, and describe the layout of the 

effector window.

Adding Effectors to a Scene

1. Choose Object > Add Null. 
2. The cursor will change to an arrow with a cube next to it.
3. Click in any view window to set the effector in the scene.
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13.1 The Effector Info Window

An effector’s characteristics are controlled by the settings in the Effector 

Info Window. This window is very similar to the Group Info window for 

model geometry. It is divided into three specific sections, each marked by a 

folder tab.

• X-Form
• Special
• Bone Action

X-Form (Transformation) Tab

The X-form tab in the effector info window is similar to the x-form tab for 

other objects in a scene. There are three rows of data cells that allow the 

input of values:

• Position
• Rotation
• Scale

Figure 13.1 — The Effector Info window with the X-form tab displayed
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Position. This row of data cells allows the input of X, Y, and Z position val-

ues for the effector. The “Key” pull-down menu offers a choice of 

“Implicit” or “Explicit” keyframe recording.

Implicit. Will create a velocity curve for the key frames. 

Explicit. Will create f-curves for the key frames.

Rotation. This row of data cells allows the input of X, Y, and Z rotation val-

ues for the effector.

Scale. This row of data cells allows the input of X, Y, and Z scale values for 

the effector.

Special Tab

The Special tab contains editable fields that affect how different types of 

effectors display in a scene. This tab is used for Box Effectors, Joints, and 

Bones only.

Figure 13.2 — The Effector Info window with the Special tab displayed
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The Style pull down menu in the effector info window offers a choice of 

how you want to display an effector. The standard effector display styles 

are Cross and Box. There are also a special class of effectors called Joints 

and Bones that create pre-built hierarchies. Whichever display method is 

chosen, keep in mind that an effector represents a single point in space, and 

is transformed in relation to that point.

The Effector Style Menu

Box. Choosing Box from the style drop down menu will display a cube in 

the scene. An extra check box called Show Extent will become available 

right below the Style drop down menu.

Extents are essentially the lines that join to create the cube. They display the 

outer limits of the space occupied by the effector. Unchecking this box will 

disable the display of the cube, leaving only its center of rotation visible in 

the scene.

 

The defining characteristic of a box effector is that it can be resized. This 

makes the box effector display perfect for scaling and deformations, as well 

as surrounding groups of linked objects.

Figure 13.3 — A box effector showing extents
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Special Tab Options

Selecting Box from the style pull down in the Effector Info window will 

cause the Special tab to display two options:

• Origin 
• Size

These options only affect the way the effector displays.

Origin. The Origin defines the point in space that the boxes extents are 

drawn from. The origin displays as a small cross. In the picture below, the 

Origin is represented by the black circle and the black crossed lines at the 

center of the effector.

Size. The Size defines the size of the box effectors extents in world units. 

Don't confuse size with scale (found in the X-Form tab). If you scale a box 

effector, you will scale all objects attached to it. Changing extent size affects 

only the box display. You can, for instance, change these values to make a 

box effector larger in order to surround the groups that are linked to it.

The size and origin boxes work together to control the overall size and 

positioning of the effector in space. When a change is made to the size val-

ues, the boxes extents will change in relation to the origin point. To keep 

the origin exactly in the center of the box the values in the origin fields need 

to be a negative half of the value in the size fields.

Figure 13.4 — The Origin and Size value boxes
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For instance, if you change a boxes size from 1.0 on x, y, and z to 100 you 

would need to change the origin to -50 on x, y, and z to keep the point from 

which the box is drawn even with the boxes center point.

Cross. Choosing Cross from the style menu will display a small target 

shaped circle.

 

The defining characteristic of the cross effector display type is that it can't 

be resized. This makes the cross effector ideal for large scenes that require 

constant zooming in and out.   Regardless of how far in or out you zoom, 

the cross effector will remain the same size, and thus be easy to select and 

manipulate.

Special Tab Options

There are no editable attributes displayed in the special menu for a cross 

effector.

Joint. Choosing Joint from the style drop down menu will display a Skele-

ton Effector Joint Vector in the scene.

Figure 13.5 — A cross effector
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A joint displays as a long, toothpick shaped object, that is pointy on one 

end and round on the other. The center of a joint effector is displayed 

where the horizontal and vertical vector lines cross. Joint effectors are used 

to create skeletal hierarchies. To create a linked chain of joint effectors use 

the Character > Create Skeleton command.

Special Tab Options

Selecting the joint display method enables a row of size data cells in the 

special tab.

These values can be modified to change the length of the Joints vector. 

Because skeleton joints always orient with the Z-axis running the length of 

the vector, the only value that needs to be changed is the Z data field. 

Bone. Choosing Bone from the style drop down menu will display a Bone 

Effector Joint Vector in the scene. 

A bone displays as a long, toothpick shaped object, that is pointy on one 

end and pyramid shaped on the other. The center of a bone effector is dis-

Figure 13.6 — Joint (Skeleton) effector

Figure 13.7 — The Size boxes
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played where the horizontal and vertical vector lines cross. Bone effectors 

are used to deform object meshes. To create a bone effector chain use the 

Character > Create bones command.

When a bone display style is chosen, several new items become available in 

the effector info window.

 

Bone Color

The bone color displays the color the bone will appear in when it is dese-

lected. This color can be changed by clicking on the color tab and choosing 

a new color from the color picker.

Bone Highlight

The bone highlight color displays the color the bone will appear in when it 

is selected. This color can be changed by clicking on the color tab and 

choosing a new color from the color picker.

Set Rest

Rotating a bone into the desired position and pressing the “Set Rest” but-

ton will tell the bone what position to stay in when it is at rest.

Set Bias

Resets the current rotation values of the bone to 0,0,0. Bones have a default 

Z orientation, which can interfere with imported data, such as motion cap-

Figure 13.8 — Options in the window when Bone is selected
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ture data. This feature lets you position the bone, and then “zero it out.” 

This is similar to indexing a servo motor or motion control axis on a robotic 

camera system.

Special Tab Options

Selecting the bone display method enables several options in the special 

palette. These options are specific to how a bone deforms a mesh. 

Skeleton Joints and Bones

Skeleton Joints and Bones are a special class of effectors that can be used to 

create pre-linked hierarchies. Skeleton Joints and Bones both display simi-

larly, with a balls at the joint pivots and a pyramid “bone” in between.

Figure 13.9 — The Special Menu options for Bone

Figure 13.10 — Joint (Skeleton) effector and Bone Effector
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Skeleton joint chains can be used to create complex hierarchies that geome-

try can be linked to. By allowing an underlying hierarchy of skeleton effec-

tors to control a complex model, you gain the freedom to manipulate, or 

replace geometry without the necessity of re-defining all of your joint 

parameters.

Bone Effectors are used to create chains that can deform an objects mesh. 

They can be used to create smooth skeletal deformations in situations 

where you can’t work with a jointed model.

Adding Bones and Skeleton Joints:

1. Choose Character and pick Create Skeleton or Create Bones. Skeleton.
2. Click in any window to set the root of the chain (double click to set the 

root for a bone), 
3. Click a second time to set the length of the vector. 
4. Continue clicking in this fashion to create a linked chain of any length.
5. To end the creation of a chain type command or control “.”.

Skeleton Joint and Bone Orientation

The Z-Axis of a skeleton joint or a bone is always oriented parallel to the 

length bone vector. This has the potential to cause confusion if you don’t 

look for it.

For instance if you draw a skeleton joint in the front view window, starting 

at the top and moving to the bottom, you would expect the z-rotation tool 

to rotate the effector like the hand on a clock. However, you will find this 

isn’t the case because the Z-axis is aligned with the world's Y-axis.
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13.2 Why use an Effector?

Often times an animation requires “layering” of motion. You may need to 

translate or rotate an object in several different ways to achieve the desired 

animated results. The only problem is that an object has only one set of data 

channels. Once the rotation channels are filled, for instance, they can't be 

changed without erasing the previous values. You can, however, link to a 

second object to create a second set of rotations that will happen on top of 

the rotations that have already occurred in the local data channels. EFFEC-

TORS allow you to gain control of your animation by separating transforma-

tions into easily addressable layers.

One classic example of this is a moon orbiting a planet. You want the moon 

to rotate about its local center point, but you also want it to orbit around 

the planets center point. You create a rotation of the moon on the Y-axis so it 

spins. But now you have to give the moon a second Y-axis rotation charac-

teristic that orbits it around the planet. The only way to do this is to link the 

moon to an effector that is positioned over the center of the planet. By rotat-

ing the effector on Y you can create two y-rotations for the moon!

Another example would be creating a swarm of bees. You would want to 

individually animate each bee so it flies in a slightly different manner, but 

you would also want all the bees in the swarm moving forward at a similar 

rate. You could animate each bee's forward motion individually. Each time 

you change one bee in the swarms forward accelerations, however, you 

would have to re-animate the rest of the swarm to follow. A better way to 

control the swarm would be to link each bee in the swarm to an effector 

that pulls them forward as a group. This would allow you individual con-

trol over each bee (as long as the link type is set to free), but move them all 

forward at the same rate.
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If you're working on a complex animation task and having difficulty 

achieving the desired results, ask yourself “Could an effector help me 

here?”
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The Joint Editor

14.0 Introduction

Through the Joint Editor, you determine transformation behavior, rotation 

order, link type, rotation orientation, movement constraints, inherited 

transform behavior, and joint attributes. It is wise to take the time to work 

with these attributes to get the most from bones deformations and inverse 

kinematics.

A pivot point is the location on the group in which rotations occur. It is also 

the point of origin for scaling operations, and translation (movement). A 

pivot point is visible for each group in all of the world windows.

The pivot point and the group center are almost always located in the same 

position. The group center can be offset from the pivot point by typing in a 

new value in the Group Info Window. Doing so is ill advised, and can cause 

some unwieldy animation behavior.

The pivot point defaults to the center of the group. You can use the Joint 

Editor to place the pivot point at some other location. You can even set the 

pivot point to be well outside of the group’s extents, if need be.

There are four ways to access the Joint Editor:

• Select a group and choose the Joint Editor icon from the Tools palette
• Select a group and choose Hierarchy>Joint Editor

• Select a group and choose the Joint Editor Icon from the Project Win-
dow

• Hold down the Command & Option keys (PC -Control & Alt keys) and 
double click on a group.
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14.1 Joint Editor Anatomy

The Joint Editor can be positioned to your preference. It can also be resized 

by clicking on the lower right hand corner and dragging. It is context sensi-

tive — the contents of the window will change to reflect the currently 

selected group. It can display the linkage information for one group at a 

time. The window is divided into three sections:

• Group Preview Pane
• Pop Up Menu Section
• Tab Section

Group Preview Pane

The group preview pane allows the pivot point for an object to be interac-

tively positioned by clicking and dragging. Unlike the world windows, the 

pivot point representation in the Joint Editor is that of a large red cross hair, 

called a gnome. The gnome displays the X, Y, and Z coordinate position 

and orientation for the joint. Where these vectors meet represents the center 

of the pivot point. 

Figure 14.1 — The Joint Editor
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The detail to which an object is drawn in the group preview window is con-

trolled by the settings in the Drawing Preferences Box, under Edit>Prefer-

ences, Drawing Tab. Also, the shader ball icon can be set to control 

drawing, by holding down the option (PC- MSWindow) key and clicking 

on the icon, then choosing the desired drawing level from the pop up menu 

list.

The group preview window view can be manipulated in the same way 

world view windows are. Clicking on the zoom button will bring an object 

closer or farther from the view window. Option-clicking (PC- Alt-clicking) 

on the zoom icons will fit the group into the view. Clicking on the view 

pop-up will change the angle from which the object is viewed.

The gnome can be positioned by clicking and dragging on it in any ortho-

graphic view.   The gnome cannot be interactively dragged when the view 

is set to skew, but it can be interactively rotated.

-X +X

-Z

+Z

+Y

-Y

Pivot Point Center

Figure 14.2 — Pivot Point Gnome
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14.2 Pop Up Menu Section

The pop up menu section at the top of the Joint Editor contain settings that 

will affect joints the same way regardless of what information is entered in 

the tabs. There are three menus:

• Transform Menu
• Rotation Order Menu
• Link Type Menu

Transform Menu. Rotations are susceptible to a distortion known as 

“shearing” when non-uniform scaling is applied to groups within a hierar-

chy. The transform menu lets you choose how the phenomenon will be 

addressed, on a group by group basis (each group can have a separate set-

ting). The transform menu offers two options:

• Classic
• Standard

Standard. To avoid the shearing phenomenon, this option allows ElectricI-

mage Universe to compensate by processing scaling operations so that the 

shearing phenomenon does not occur. This is the default method.

Classic. This method bypasses any compensation for the shearing effect. 

You can use this option if you are not applying non-uniform scaling to any 

groups in the hierarchy without any ill effects. If you do notice shearing, 

switch to the Standard method. This option is called classic because other 

programs on the market use this method (even though it is less sophisti-

cated.)

Rotation Order Menu. Object rotation order determines how rotations will 

be processed. Each rotation axis is processed one at a time. Ultimately, one 
398       Electric Image Universe 3.0    



Chapter 14  The Joint Editor — Introduction
of the three axes will nullify one of the other axes. For example, a rotation 

applied to Y and Z may produce the same result, even though they are 

clearly different axes. This is called “gimbal lock.” Choosing a different 

rotation order can alleviate the problem.

The default is ZXY. This means that Z rotations will be calculated first, fol-

lowed by X, and finally by Y axis rotation calculations. For many animation 

situations the default settings will work just fine.

A good rule of thumb for assigning rotation order is to calculate the axes in 

a descending order of stability. Think about how you're object is moving, 

and decide which axis is most important to creating the desired motion. 

Which axis is second most important, and which is the least important. 

The last six choices in the Rotation Order pull-down have a fourth coordi-

nate inside parentheses. This coordinate controls the last rotation in the 

order. For instance, XYX(z) indicates an X rotation, then a Y rotation, and a 

second X rotation that is controlled by the Z coordinate channel.

Note An alternative method for dealing with gimbal lock is to assign separate effectors 

for each axis of rotation, and parenting the group to these effectors. Set up each 

effector so that it can only rotate on a single axis, which prevents gimbal lock alto-

gether.

Link Type Menu. The Link Type pull-down menu contains pre-configured 

link types that can be applied to an objects pivot point. Use this pull-down 

menu to set a basic set of position and rotation limits for a joint. The link 

type chosen will create global rotation and position limits that will override 

specific values entered in the limits sub-palette, by locking specific X, Y, 

and Z channels.
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There are eleven menu options in the Link Type Menu:

• Custom…
• Free
• Ball Planar
• Cylinder Planar
• Planar
• Socket
• Cylinder
• Universal
• Slide
• Pin
• Lock

Custom. The custom option opens a dialogue box that allows specific rota-

tion and position parameters to be locked or unlocked for a group. Parame-

ters with check marks next to them are completely disabled. For instance, a 

check mark next to Lock Y Position will disable an objects ability to move 

on the Y-axis.

The Custom link type can be used to see what kind of position and rotation 

limits are created by the other pre-defined link types. Just pick one of the 

link types, like socket, and then choose Custom. The Custom Joint dialogue 

will pop-up with the limits that a socket link uses already checked off.

Free. This link type allows an object total freedom to move and rotate on all 

axes. Free is the default link type for root objects in any chain. Because this 

joint type is free to move and rotate on all axis, the values in the limits sub-

palette will override it.

Ball Planar. This link type locks the Y position channel only.
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Cylinder Planar. This link type locks the Y position channel and the X rota-

tion channel.

Planar. This link type locks the Y position channel and the X and Z rotation 

channels.

Socket. This link type locks the X, Y, and Z position channels.

Cylinder. This link type locks the X and Y position channels and the X and 

Y Rotation Channels.

Universal. This link type locks the X, Y, and Z position channels and the X 

rotation channel.

Slide. This link type locks the X and Y position channels and the X, Y, and 

Z rotation channels.

Pin. This link type locks the X, Y, and Z position channels, and the X and Y 

rotation channels.

Lock. This link type locks all position and rotation channels.

14.3 Folder Tab Section

All of the specific local controls for a group’s pivot point can be set in the 

folder tabs of the Joint Editor. There are three folder tabs in this section:

• X-form (Transformation)
• Inherit
• Limits
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The X-Form Tab

The X-form tab controls the position and orientation of the gnome, and 

thus the pivot point for an object. Values entered in these fields will cause 

the gnome to be re-positioned in the group preview pane.

Link Alignment Position

This pull-down controls the position of the groups pivot point in relation to 

its geometric bounds. The different choices will place the gnome in that 

position relative to the group.

There are a total of seven items in this menu:

• Middle
• Front
• Back
• Top
• Bottom
• Left
• Right

Figure 14.3 — The Transformation window
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Middle. The default for all objects, positions the pivot point exactly in the 

center of the object.

Front. This option positions the pivot point with the groups front.

Back. This option positions the pivot point with the groups back.

Top. This option positions the pivot point with the groups top.

Bottom. This option positions the pivot point with the groups bottom.

Left. This option positions the pivot point with the groups left side.

Right. This option positions the pivot point with the groups right side.

Link Alignment Orientation

This pull-down controls the orientation of the groups pivot point. Chang-

ing the link alignment orientation changes the orientation of the X, Y, and Z 

axes of the pivot point. Changing the Link Alignment Orientation will 

change the direction that the object rotates.

The results of changing the Link Alignment Orientation can be seen in the 

group preview pane by watching the changes in the gnome orientation as 

different options are chosen.

There are three choices in the Link Alignment Menu:

• Z is Z
• Z is X
• Z is Y

Z is Z. The default option maintains the objects initial link coordinates.

Z is X. This option will swap the group's Z and Z coordinates so that the Z 

coordinate becomes the X coordinate.
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Z is Y. This option swaps the group's Z and Y coordinates so that the Z 

coordinate becomes the Y coordinate.

Position Section

This area contains data cells for the X, Y, and Z position of the pivot point. 

Entering values in this field will update the position of the gnome in the 

group preview window.

Rotation Section

This area contains the data cells for the X, Y, and Z rotation of the pivot 

point. Entering values in this field will update the orientation of the gnome 

in the group preview window.

Parental Offset Section

This area contains data cells for the X, Y, and Z parental offset values of the 

pivot point. The parental offset is the distance between the pivot point of 

the parent object, and the pivot point of the child object. Changing the val-

ues in the Parental Offset data cells changes the distance between the pivot 

point of the child and the pivot point of the parent, it does not change the 

position of the pivot point in relation to the object. Changing the parental 

offset value will cause an object to move closer too, or farther away from its 

parent.
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The Inherit Tab

The inherit tab controls which transformations performed on the parent 

will be passed on to the child in a hierarchy. To enable an attribute check its 

box, to disable an attribute uncheck its box.  

By default rotation and position information are passed from the parent to 

the child. When a parent object is transformed or rotated, its child will be 

transformed or rotated accordingly. If the position and rotation checkboxes 

were unchecked, the child would not react at all to the parents movements.

The default preferences for the inherit options can be changed by choosing 

Edit>Preferences, Import & Data tab. The Import & Data tab contains an 

identical set of attributes to the inherit palette. Checking attributes in the 

Import Preferences dialogue will make those settings the default for all 

newly created hierarchies.

Inherit Position

This check box option, when enabled, links the position of the child group 

to the position of its parent group. When the parent is moved in X, Y, or Z 

space, the child will be moved with it.

Figure 14.4 — The Inherit Tab
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Inherit Rotation

This check box option, when enabled, links the rotation of the child group 

to the rotation of its parent group. When the parent is rotated in X, Y, or Z 

space, the child will be rotated with it.

Inherit Scale

This check box option, when enabled, links the scale of the child group to 

the scale of its parent group. When the parent is scaled in X, Y, or Z space, 

the child will be scaled with it.

Inherit Visibility

This check box option, when enabled, links the visibility of the child to the 

visibility of its parent. When the parent's visibility is off, the child's visibil-

ity will be off.

Inherit Deformation

This checkbox option, when enabled, will include the child with a deforma-

tion applied to the parent. The deformation region for the parent must be 

adjusted to include the child object within the deformation region for this 

option to be effective. This is a very powerful feature that will allow you to 

deform an entire hierarchy as if it were one object.
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The (Joint) Limits Tab

Joint limits allow you to set up your hierarchy chains to behave in a realis-

tic manner, using a variety of natural forces and limited ranges of freedom. 

You can also create joint libraries to make the creation of complex hierarchy 

chains easier. 

The limits tab consists of the following items: 

• Rotation Tab
• Stiffness Tab
• Viscosity Tab
• Position Tab

The Rotation Sub-Tab

The rotation sub tab allows joint rotation limits to be set for X, Y, and Z 

rotation. There are four items in the tab:

• Enable Limits Check box
• Minimum Section
• Center Section
• Maximum Section

Figure 14.5 — The Limits Tab
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Minimum Section. This row of data cells contains values, in degrees, for 

the minimum angle a joint can rotate.

Center Section. This row of data cells contains the values, in degrees, for 

the angles at which the joint wants to be naturally positioned at rest. This 

value is used to help smooth the transition between the minimum and 

maximum rotation limits. Instead of rotating between the maximum and 

minimum, the joint motion curve will arc through the center limit first.

Maximum Section. This row of data cells contains values, in degrees, for 

the maximum amount a joint can rotate.

Use Current Value Arrows

Each data cell in the rotation limits sub-palette has a small arrow that, 

when clicked on, will bring up a Use current value box. Selecting this 

option will update the current rotation value of the joint into the data cell. 

This allows rotation limits to be set interactively by rotating a joint with the 

rotate tools, and transferring the value of the rotation into a limits data cell. 

The Joint Editor is non-modal, so you can easily jump back and forth 

between world view windows and the limits palette to make use of this 

feature.

Universe Animator knows to put the highest value in the maximum box, 

and the smallest value in the minimum box. This means you can click on 

Figure 14.6 — The Rotation sub-tab
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the Maximum or Minimum use current value arrow and the proper values 

will be inserted where they belong. For instance, if you try to put a negative 

X value in the maximum box, and a positive X value in the minimum box, 

ElectricImage Universe will automatically “flip-flop” the two values so the 

positive value is in the Maximum box and the negative value is in the Min-

imum box. 

There is an additional current value choice in the drop-down menu for the 

center data cells called Use center of limits. Selecting this option will divide 

between the minimum and maximum limits and enter the result in the data 

cell. Note that in some cases the center of limits may not be where you want 

the joint to be when it is at rest. In those cases manually rotate the joint into 

the resting position and select the “use current values” option.

The Stiffness Sub-Tab

The stiffness sub-tab can be used to control the amount of pull required to 

move a joint through its X, Y, and Z rotation. The higher the values in these 

fields the harder the pull required to move the joint. The end result is that 

joints with a smaller stiffness setting will move farther, faster, than joints 

with a high stiffness setting. 

An example would be a human leg. The thigh bone should move slower 

than the shin bone. Setting a higher stiffness for the thigh would mimic this 

Figure 14.7 — The Stiffness Sub-Tab
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motion. The Enable check box, when checked, makes the stiffness settings 

active.

The Viscosity Sub-Tab

The viscosity sub-tab can be used to control the viscosity, or apparent fric-

tion, of a joints X, Y, and Z rotation. The higher the values in these fields, 

the more friction the joint will appear to experience as it rotates. Very high 

values will make the joint appear to catch and release as it rotates. Click the 

Enable box to activate viscosity.

An example would be a rusty door hinge. The rust would cause more fric-

tion, and thus cause the joint to move in an un-smooth fashion. To recreate 

this you would apply a high amount of viscosity to the hinge joint.

The Position Sub-Tab

The position sub-palette allows joint position limits to be set for the X, Y, 

and Z axes. These limits control how close, or far, a group can move from 

Figure 14.8 — The Viscosity Sub-Tab
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its parent. The enable limits check box, when checked, makes the position 

limits active. 

There are two sections in the Position Sub-Tab:

• Minimum
• Maximum

Minimum. This row of data cells contains the minimum X, Y, and Z posi-

tion values for the groups joint.

Maximum. This row of data cells contains the maximum X, Y, and Z posi-

tion values for the groups joint.

Each data cell has a drop-down menu arrow that, when selected, will input 

the current position of the joint into the field.

14.4 Working in the Joint Editor

Because the Joint Editor offers a wide variety of tabs and input fields, it's 

helpful to develop a standard procedure when creating joints. Like any 

complex task, it's best to start with the basics and work your way to the 

specifics. A basic procedure might go something like this:

1. Choose a pre-defined link type from the Link Type pull-down menu.
2. Select the X-Form Palette and choose a link alignment position for the 

pivot point. (If one applies)

Figure 14.9 — The Position Sub-Tab
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3. Interactively drag the gnome into position in the group preview win-
dow. Tweak the values in the X-form palette if needed.

4. Set Joint rotation and position limits in the Rotation and Position sub-
palettes.

5. Test your joint to make sure it's working properly.
6. Set Stiffness, Viscosity, and Gravity settings only if they're needed.
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Facial Animation

15.0 Introduction to the Morph Window

One of the most powerful features for character animation is morphing. 

There are effectively two types of morphing techniques — simple target 

morphing and weighted target morphing. Universe Animator offers the 

weighted target method, as it is superior for facial animation. This chapter 

will concentrate on using the Morph Window for Facial Animation.

Morphing creates in-between models from a source model and one or more 

target models. The source model is typically a “neutral” version of the 

model, and the target models are versions of the model in various poses or 

expressions. In simple target morphing, the models may not even need to 

depict the same object. A plate could morph into an apple, for example.

Morphing requires that models contain the same number of points and 

polygons, and that they are stored in the same order. For example, the poly-

gons which make up a nose for the source model must directly map to the 

polygons which make up the nose in the target model. If these polygons do 

not correspond, very strange results will occur. 

The Morph Window is just one part of the character animation equation. In 

addition, bones, effectors, and inverse kinematics round out the tools that 

are typically used to create great character animation.

15.1 Creating Models for Morphing

It is best to start with the source model, and use it to create your target 

poses. There are a variety of ways to create both the source and target mod-

els, depending upon the modeling software that you choose to use. You can 
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even use the BONES feature in Universe Animator to create target models 

from your source model.

To create the new poses or expressions that you need, you drag the points 

of the polygons to create the new shape. This can be a tedious and labori-

ous process, but when done well, the results are worth every second. 

Note 3D animator and reviewer George Maestri has written a very thorough 

treatise on character animation, which includes a variety of illustrations 

that are typically used for facial morphing. Published by New Riders, it’s 

called, “Digital Character Animation II: Essential Techniques” (New Riders 

Publishing— ISBN: 1562059300). It retails for approximately $40.00 at Ama-

zon.com— not cheap, but it will save you an incredible amount of time and 

effort!

15.2 Using the Morph Window in Universe Animator

Once you have created the necessary target models, its then time to load 

the models into Universe Animator so that they can be morphed. Morph 

model targets are not added into an Universe Animator project as other 

models are. Instead, they are added through the Morph tool. All models in 

the project, whether or not they are used for morphing, are listed in the 

project window, above the group list (in the default project window dis-

play). Let’s load a model and have a look around the Morph Window.

To add a morph source model into Universe Animator:

1. Add the source or anchor model to the project as a normal object file.
2. Be sure that the animation channel is enabled (Animation>Enable 

Animation).
3. Select the source model.
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4. Click on the MORPH BUTTON in the Project Window. 

The following window will appear.

The name of the source model will appear in the Morph Anchor section, to 

the top left. The model that will be morphed is drawn in the view area to 

the right of the window. 

The Morph Window is divided into sections:

• Morph Anchor
• Target Match Popup Menu
• Reload Target Data Button
• Morph Group
• Morph Target
• Keyframe/Timeline Slider
• Viewing Area

Figure 15.0 — Morph Window with targets
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Morph Anchor Section

The morph anchor is the base or source model. The morphing engine will 

actually use this model to create all of the poses and expressions specified 

by you in the Morph Window. The name of the anchor file is listed here.

Target Match Popup Menu

The target match popup menu tells the morph engine how to treat the 

morph target groups. There are five menu options to choose from, depend-

ing upon the desired treatment of the targets:

• First
• Full Match
• Index Only
• Name Only
• Geometry Only

First. This option will use the first group in the target model as the mor-

phing target. If you only have single groups in your morph models, use 

this option.

Full Match. This is the default option. Group names, number of coordi-

nates and group index order must all match in order for this option to have 

expected results. Properly constructed morph targets should conform to 

this recommendation.

Index Only. Group order must match in order for the morphing to work 

properly with this option selected. In other words, given a group named 

“foo” in both the source and target models, each occurrence of group “foo” 

in the target models must match the order in which group “foo” occurs in 

the source (anchor) model. No other restrictions are active with this option 

selected.
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Name Only. This option morphs only across group names contained 

within the source (anchor) model. All other groups will be ignored.

Geometry Only. This option ignores group names, or group order, and 

addresses each polygon vertex in the order in which it is stored within the 

model file. In this case, each vertex in the source model must be in the same 

order in the target models. This should be the case in any event.

Reload Target Data Button

This button will allow you to replace morph targets while retaining the ani-

mation channel data for the target. This is useful for fine tuning poses, or 

substituting higher resolution morph targets.

Morph Group 

Morph target models are placed within morph groups. You can have as 

many morph groups as necessary. Morph groups are used to organize your 

morph targets into logical collections. As you can imagine, some morphing 

projects can get pretty complex. The morph groups will help to better man-

age the complexity.

For example, if you have many different models which describe mouth 

movement, you may wish to place all of those targets into a morph group 

called “mouth.”

To add a Morph Group:

1. Click the Add Morph Group button.
2. A dialog will appear, asking you to name the group.
3. Click OK to clear the dialog.
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The morph group is created, and added to the Current Morph Group 

popup menu. Any morph targets that you add will always be added to the 

morph group indicated by the Current Morph Group menu.

Morph Target Section

As mentioned previously, the morph target models are effectively the 

extremes of the variety of poses or expressions that you will be using in the 

morphing process. Morph targets are contained within morph groups for 

easier management of model and morph data. Morph targets are added to 

the current selection displayed in the Current Morph Group Menu.

To Add Morph Targets:

1. In the Morph Target section, click the Add button.
2. A file dialog will appear, listed model files.
3. Select and add the desired target files.
4. When complete, press the done button in the dialog.

The target files are now displayed in the morph target area. Along with the 

actual file names, slider bars, edit and check boxes are also displayed in the 

Morph Target Section. The default state of a target slider is the center of the 

slider. A morph can actually operate in the positive or negative. The check-

box to the right of the target name enables or disables the target from being 

used in the morph process.

In addition to the actual Morph targets, there are three buttons and one 

menu in the Morph Target Section:

• Add
• Del(ete)
• Add Blend To Curve Editor
• Default Morph Blend Menu
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Add . This button allows you to add morph targets to the selected Morph 

Group.

Delete. This button allows you to remove the selected morph target from 

the morph target list.

Add Blend to Curve Editor. This button will manual force an update to the 

animation of the selected morph target to the function curve editor for fine 

tuning. In addition to the manual button presented here, at the bottom of 

the Morph Target section is a checkbox that will automatically send data to 

the function curve editor, if activated.

Default Morph Blend Menu. This menu allows you to choose the interpo-

lation method for the morph targets. The interpolation method will appear 

in the function curve editor as the appropriate spline type. There are four 

options:

• Linear (Default)
• Natural Cubic
• Hermite
• F-Curve

Linear (Default). This option directly blends one morph target to another. 

This option produces rather mechanical results.

Natural Cubic. This option uses a natural spline to interpolate one morph 

target to another. Splines tend to produce a more realistic result than linear 

interpolation. This curve type offers no modification options in the func-

tion curve editor.

Hermite. This option uses hermite splines to interpolate one morph target 

to another. Hermite splines offer additional Tension, Bias, and Continuity 

control over the spline curve interpolation. These attributes can be adjusted 
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in the FUNCTION CURVE EDITOR by selecting either the T, B, or C keys and 

dragging the mouse with the KEYFRAME selected in the editor.

F-Curve. This option uses function curves to interpolate one morph target 

to another. Function curves offer a very realistic result, and additional con-

trol in the FUNCTION CURVE EDITOR.

Keyframe/Timeline Slider

This slider sets the project time, so that the morphing action desired occurs 

at the time you specify. You can either drag the slider to the desired frame 

number, or manually enter the frame number in the edit section. 

To the left of the frame display field are the playback controls. These con-

trols are illustrated in the following diagram:

Figure 15.1 — Keyframe/Time line Slider with Playback Controls

Play Backwards Play Forwards

Step Back Step Forward
Play/Pause

Figure 15.2 — Playback Controls
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Play/Pause. Starts playback of the morph animation. All of the other play-

back controls require that Play be on in order to work.

Step Forward. Will cause the animation to step forward one frame.

Step Backward. Will cause the animation to step backward one frame.

Play Forward. Will cause the animation to play forward.

Play Backward. Will cause the animation to play backward.

View Area Section

This is where you can view the results of your morphing choreography. 

The default display is wireframe for speed, however, you can also display 

this window as phong shaded, by option clicking on the SHADER BALL icon 

in the upper section of the window.

15.3 Making Morphs

We have covered the Morph Window, and the process of adding a morph 

source model and its targets in the previous sections in this chapter. Now 

we are going to concentrate on creating actual morph animations.

The Morph Window is best used as a facial morphing system (although 

you can animate anything you care to morph with it). Each morph target 

has a slider that lets you blend the target with the source. The range of each 

slider is negative target to positive target, with the center, 0, being null (the 

source would be the result if all of the sliders set to zero. Typically, your 

morph target poses (the models that you create for the pose positions) will 

be the positive end of the scroll bar (value 1.0). The negative values (value -

1.0) are the opposite of the positive poses, and are derived by determining 

the change of the target model from the source model, and then negating 
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that value. This gives you the benefit of not having to create minimum and 

maximum ranges.

Note All of the morph targets are weighted and averaged together to form the final object 

for that frame. You can change the interpolation method for the best results. See the 

section entitled “Default Morph Blend Menu” on page 419.

The mechanics of the morphing process requires that you do two basic 

things:

• Set the current frame
• Move the sliders for the desired look for that frame

Tip Regular people tend to act pretty straight forward, and are usually not 

overly dramatic. Animators learned long ago that presenting such real 

world people makes a rather mundane performance. They learned that by 

exaggerating the performance somewhat, the performance becomes much 

more interesting. The typical purpose of character animation is to entertain, 

or sell by entertaining. A few extra movements, some obvious thought 

implied to the character perhaps, can go a long way. It can also go over-

board as well, and earn the curse of being “over animated,” especially if 

true to life subjects are being presented. 

Two of the greatest tools that you can use to your success are timing and 

characterization. Timing let’s you present the character effectively, making 

the most by doing the least. Simply stated, but not simply achieved. Some 

of the world’s best comedians are also the best at timing (knowing when 

and when not to tell a joke, give a look, and so on.) Timing for an animation 

is a learned art, and it takes patience to develop the skill. 

Characterization is effectively the soul of the character that you are endeav-

oring to create. Since the characters you are animating aren’t real, it is your 
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job to impose a sense of reality to them. In this way they can seem real, or at 

least real enough, so that the audience can accept them, and enjoy the per-

formance.

Typically, this involves imparting a sense of thought to the character, giving 

its actions a sense of deliberateness. Making the character appear to think 

and ponder, as well as react and emote, are all ways of imparting a soul to 

it. Some performances might be pantomime, others might use heavy dia-

log. Some might be theatrical, others might be subtle. 

Note In addition to the Maestri book, there is another must have reference has 

been written by two of the “nine old men” from Disney’s golden age: “The 

Illusion of Life,” By Frank Thomas and Ollie Johnston. It is available 

through Amazon.com, and retails for about $60.00. This book presents a 

remarkable history of Disney’s best animation, and is an excellent treatise 

on animating characters.

15.4 Timing
Typically, animation is keyframed every 8th frame. Cycles tend to happen 

in eight frames, gross mouth positions for dialogs on eight frames, and so 

on. Essentially derived at for film speeds of 24 frames per second, eight 

frames evenly divides a second into three even chunks. Video animation is 

29.997 frames per second, but you might find that ten frames can be just a 

tad too long (its up to you.)

You should put a keyframe where ever you think necessary (some anima-

tors have keyframes on almost every frame!) but the 8 frame technique is a 

good rule of thumb.
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To set keyframes in the Morph Window:

1. Move the keyframe slider into position
2. Adjust the morph target slider bars for the proper expression

The view area will update to the new pose. Keep adding new key frames 

every 8 or so frames as needed.

To playback the animation:

1. Click the Play/Pause button
2. Click the button again to stop

15.5 Working with Sync Sound

One of the most powerful character animation tools is sound. The great 

thing about sync sound and dialog is that the timing is built in. All an ani-

mator has to do is match up lip positions (and add some emotion, of course 

— acting!)

To animate with sync sound in the Morph Window, you use the sync sound 

display in the Project Window. The Keyframe slider in the Morph Window 

will stay in sync with the overall project time slider. By positioning the 

Project and Morph Windows relative to each other so that you can see the 

full Morph Window, and the sync sound track in the Project Window, sync 

sound is very straight forward to accomplish. To check your animation, 

create a preview in Universe Animator in Quicktime format. When the 

quicktime file plays back, you will be able to immediately see the in sync 

results of your work. 
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Sync dialog is actually fairly easy to animate to, and with a little practice 

the waveforms become very easy to read. As an assistant, you can use the 

Cue feature to break up the waveforms and annotate them from the Sound 

Info Window. A few minutes of work here will make sync dialog a snap. 

Typically, creating a separate cue for every spoken word should be enough. 

You can then use the cue playback feature to get a feel for the mouth posi-

tions required to sync. Then, all you do is match the mouth positions to the 

sound. The previous illustration shows how to organize your windows so 

that you can see the waveform and morph window at the same time.

Figure 15.3 — Typical Sync Sound Window Setup
Electric Image Universe 3.0        425



Chapter 15  Facial Animation — Function Curve Editor
It’s a good idea to concentrate on matching the mouth movements in one 

pass through, and then layer in the emotional content in additional pass 

throughs. If you try to animate every aspect of the performance at once, 

things can get real confusing. Animating in passes is actually faster in the 

long run, and tends to yield better work.

15.6 Working with Morph Curves in the Function Curve Editor

The Morph Window is great for creating the expressions and emotions that 

you want to put into your character. The function curve editor is the better 

tool for tweaking timings of those expressions and emotions. Why? The 

Function Curve Editor presents morphing as curves, showing how the 

inter-relationships of the morph targets are working. Subtle changes can be 

made in the editor that would be rather tedious to try in the Morph Win-

dow. With a little practice you might even prefer to animate your morphs 

in the Function Curve Editor. It is also easy to match non-morph animation 

in your project with morph animation in the function curve editor.

note You can also adjust timings in the project window, by dragging the keyframe dia-

monds to new desired locations.

Figure 15.4 — Sound Info Window Cue List
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To copy a morph “blend” into the function curve editor, select the morph 

targets that you would like to edit, and click on the Add Blend to Function 

Curve Editor button. The blend will now be presented as a linear curve in 

the editor.

The morph target channel is presented to the left of the window. Select the 

channel, and the curve changes to white in the editor. Double click on the 

channel, and you can change the curve to any supported type. You can use 

all of the tools available in the function curve editor to tweak or enhance 

your animation.

15.7 Morphs and Materials

When rendering morph models, only the material settings in the anchor 

model will be used. Material morphing is not supported. Therefore, you 

need to assign all shading attributes to the anchor model. The groups listed 

in the project window when you select by model are the groups for the 

anchor model — the groups for the target models are not presented in the 

list. 

You can still animate the materials used in the anchor model as expected. If 

you do not want to animate your materials, disable the animation flag on 

Figure 15.5 — Function Curve Editor with Morph Blend Curves
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the material and texture channels in the project window, under the appro-

priate group name. This will prevent unwanted artifacts from occurring.
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Introduction to Shaders

Procedural shaders are little “C” language programs which Universe Cam-

era can use to shaded pixels with a variety of effects. Well written shaders 

are typically very fast and efficient.

Shaders can be added to any material channel you choose (diffuse, specu-

lar, etc.) they will affect this channel and may optionally affect several oth-

ers as well (shaders do not perform displacements at this time.) Most often, 

you will add the shader to the diffuse channel. Shaders are located in the EI 

Shaders folder, in the same directory that Universe Animator is installed.

The shaders have animation parameters. The numeric entry boxes and the 

colors can be animated to create some very striking effects. (As an example, 

add the Cammo shader to a teapot and animate the Density value over 

time). Note — Changes you make in these interfaces are made at the current 

project time. To prevent unwanted texture animation, disable the animation flag 

for the texture map item for the group in the Project Window.

A shader is added to a material channel using the add button in the Mate-

rial Info Window. Once added, you can double-click on the shader to bring 

up its Texture Info Window. Under the Special Tab you will find two new 

buttons: Procedural... and Save Procedural as... The Procedural button 

brings up the interfaces shown in the rest of this chapter. The Save Proce-

dural As button saves a copy of the procedural with the current settings as 

default. This means you can create a shader with unique set of parameters 

that you like and save it out with those parameters imbedded in it. 

Some procedural shaders are designed to work as 2D projections, others as 

3D projections. Those that work in 2D will appear to stretch along the 
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depth of the projection. Also, some shaders are not anti-aliased within the 

shader. You can increase the group sampling to 2x2 to compensate.

Working with Procedural Shaders

All of the interfaces presented for each shader are simple dialog boxes, list-

ing parameters and values, plus a shader preview area. The preview area 

fits within the face of the cubic projection that Universe Animator supplies 

for procedural shaders. Whatever you see in your preview, will be what 

you see in the area occupied by the face of the cube, with one caveat: the 

cubic projection must be equilateral, that is, the scales of the X, Y, and Z 

axes must be the same. If not, the procedural will appear distorted by the 

amount of the scale values. The position of the shader is also influenced by 

the position of the cubic projection icon. You can use this to fine tune proce-

dural placement if necessary.

You can also adjust the “lighting” in the shader preview area by clicking 

the location in the preview area that you would like to see the light shine 

on the preview (it defaults to the top right of the preview area.) This can 

help you to get a better feel for the look of the shader before you render. 

Figure 16.0 — Relationship of Preview Area to Cubic Projection Icon
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Some shaders can generate holes in surfaces. The preview area will show a 

non-rendering checkerboard in that case.

You can set color values to alpha 0.0 to use the diffuse color of the group for 

that component, instead of the color swatch. Some shaders, such as Ran-

dom Dots, do this automatically.
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Anisotropic

This shader allows you to specify a non-circular shaped highlight. It will 

even let you define different layers of highlights, so that you can easily sim-

ulate things such as a car paint finish, which is actually a color coat of paint 

(which has a grain, and therefore a highlight direction and shape that is not 

circular) underneath a clear coat (which has a more conventional high-

light.) In addition to multiple layers, you can also choose preset patterns 

which mimic that way that bare metal is finished with machine tooling. The 

results of this shader are quite stunning, and fast, too. This shader affects 

only the Specular channel.

Figure 16.1 — Anisotropic Shader Interface
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First and Second Anisotropic Layer Options

Pattern. There are several anisotropic patterns to choose from: None, Lin-

ear, Radial, Square, Scalloped, and Braided. Each of these options will show 

in the preview window of the shader interface.

Size. This is the size of the pattern. You may want to make the square, scal-

loped or braided patterns different sizes depending on the size of your 

objects.

Center. This is the center of the pattern, which can be moved to a different 

location.

Color Each layer has a separate color option. They are for the color of the 

anisotropic pattern or separate specular highlight.

Isotropic Layer

In this layer, you can choose the color of an extra specular highlights, as 

well as what kind.

Blinn. A blinn highlight is similar, except that the shape of the highlights 

take into account the light hitting the surface more accurately.

Phong. A phong highlight will look round and bright like those you might 

see on a billiard ball.
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Bricks

This 2D shader creates a brick pattern on any group it is added to. Apply 

only to the Diffuse Channel. Will affect the Diffuse, Bump, and Specular 

Channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Brick Width. The width of each brick. A value of 1.0 will yield bricks as 

wide as preview window.

Brick Height . The height of each brick. A value of 1.0 will yield bricks as 

high as preview window.

Mortar Thickness . The width and height of the mortar that separates the 

brick.

Mortar Depth. The mortar is an inset procedural bump. This controls how 

deep it is.

Figure 16.2 — Bricks Shader Interface
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Row Vary. Controls brick alignment. If set to 0.0, the alignment between 

alternate rows of bricks will be perfect.

Jagged. Larger numbers than the default will cause extreme variation of 

the height and length of the bricks in a wave like fashion.

Brick Pit Frequency. The bricks themselves have a rough surface due to a 

procedural bump. This value controls the number of pits on each brick sur-

face. Useful values are between.001 and.009.

Brick Pit Depth. Controls the depth of the pits on the surface of the bricks. 

Useful values are between.01 and.0001.

Mortar Pit Frequency. The mortar also has a rough surface due to a proce-

dural bump. Useful values are between.0001 and.0009.

Mortar Pit Depth. Controls the depth of the pits in the mortar. Useful val-

ues are between.0001 and.0009.

Brick Vary . This controls the color variation of the bricks. Useful values 

are between 0 and 1.

Brick Color. The RGB color of the bricks.

Mortar Color. The RGB color of the mortar.

Ks. The Specular value for the Bricks and Mortar. 0 is no specular, 1 is max-

imum specular.
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Bump Array

This 3D shader creates an array of dimples. Could be used for the surface of 

a golf ball or for metal floor plating. It is also useful for creating a pattern of 

round holes in an object, like the lid of the original Star Trek communicator. 

Apply the shader to the Transparency Channel with a Density of 10.0 and 

the Bump Color set to black. Will affect the channel in which it is applied 

and the Bump/Diffuse Channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Hex Grid. Realigns the bumps in a hexagonal pattern. It defaults to on.

Radius. Controls the radius of the bumps. 

Spacing. Controls the distance between each bump. This number can be set 

small to cause the bumps to overlap.

Bump Blend. Distance over which the bumps blend together. Smoothes 

over transitions when the bumps overlap.

Bump Strength. Controls the magnitude of the bump, how deep or high it 

is. Can be positive or negative.

Figure 16.3 — Bump Array Shader
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Bump Color. The RGB color of the bumped area.

Surface Color. Sets the RGB value of the surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.
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Bumpy Noise

This 3D shader creates a bumpy, noisy pattern. Could be used for alien 

flesh. Will affect the Diffuse and Bump Channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Bump Strength. Controls the magnitude of the bumps on the surface. Use-

ful range is -5.0 to 5.0

Color Threshold. Changes where the color blend begins between Bump 

Color and Surface Color. 0.5 is right in the middle of the bump, 1.0 is right 

at the top of bump.

Color Range. Controls the variation in color between the lowest and high-

est points on the surface. Useful range is between 0 and 10.

Bump Color.  The RGB color of the bumped area.

Surface Color.  Sets the RGB value of the surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 16.4 — Bump Noise Shader
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Cammo

This is a camouflage 3D shader and is loosely patterned after the standard 

US “Woodland” pattern. Will affect only the channel in which it is applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Surface Color. Sets the RGB value of the underlying surface. The three 

Cammo regions are applied on to of this surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead. There are three different regions added on top of the 

surface color. They each have the following controls.

Scale. Controls the size of the pieces that make up the region.

Level. Controls how much of the Surface color shows through the region. 

0.0 allows all of the surface color to show through. 1.0 allows none at all.

Color. RGB color of the region.

Figure 16.5 — Cammo Shader
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Cell Look

This shader is neither a 2D or 3D shader, but rather an illumination shader 

which gives a cartoon-like appearance to the groups it is applied to. The 

defaults have been picked to work well. You may wish to try it, as is, before 

changing any of the values in the interface. The shader will automatically 

pick up the diffuse color of the object. Therefore, you don’t have to change 

the color values in the shader for each object you use it with. Apply to the 

Diffuse Channel, will affect Diffuse and Specular.

Highlight. If this option is on, the highlight (specular) is operated on by the 

shader.

Specular Range Min/Max. Specular is always in the range of 0 to 1. 0 is no 

specular, 1 is 100% specular. As the object is shaded, pixels with a specular 

value below the Min get no specular highlight at all. Pixels greater than the 

Max get the color in the specular channel of the group after being pro-

cessed by the Brightness and Saturation values. Between the Min and Max, 

the color is ramped.

Figure 16.6 — Cel Shader
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Brightness. Varies the brightness of the computed highlight.

Saturation. Varies the saturation of the computed highlight.

Color. When on, the color chosen using the swatch is used instead of the 

group’s specular color.

Zones. Sets the number of different colors that will be used to shade the 

group. 

Diffuse Range Min/Max. If the brightness of the pixel being shaded falls 

into this range, the objects diffuse color is multiplied by the Brightness 

value and applied. If the brightness falls in between ranges (as in the case 

of 0.42, using the numbers in the illustration), the color is ramped.

Brightness. The factor by which the diffuse color is multiplied to yield the 

final pixel color.

Color. If the brightness of the pixel being shaded falls into Min/Max range 

for this Zone, the object’s diffuse color is replaced by this color.

Account for Light Colors. If this option is on, the highlight and the diffuse 

colors of the shader are effected by scene lighting, otherwise the colors of 

the group will match the swatches in the shader.
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Checker Board

This shader can be either 2D or 3D, and places a checkerboard pattern on 

the surface of the group. Will affect only the channel in which it is applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Color1&2. RGB color of the alternating squares.

3D Checker. Makes the procedural act as a solid shader. The checkerboard 

pattern will repeat throughout the group.

Figure 16.7 — Checker Board Shader
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Clouds

This 3D shader creates a cloud-like fractal pattern. Will affect only the chan-

nel it is applied to.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Cloud Threshold. Controls how many cloud puffs are present. Useful 

range is 2.0 to 0.0.

Cloud Range . Controls the density of the clouds. Useful range is 10.0 to 0.0

Cloud Color. RGB color of the clouds.

Sky Color. RGB color of the area not covered by clouds.

Figure 16.8 — Clouds Shader
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Color Noise

This 3D shader creates a psychedelic color pattern, similar to tye-dye. Will 

affect only the channel that it is applied to.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Figure 16.9 — Color Noise Shader
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Contour

This shader creates a grid pattern on the object. The grid lines themselves 

have explicit control for visibility. Will only affect the channel to which it is 

applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out (seeing more of the grid), smaller to zooming in 

(seeing less of the grid). The default is 1.0.

Line Thickness. Sets the thickness of the grid lines. The default is 0.2 

Smaller numbers produce thinner lines.

X,Y,Z Contours. These check boxes give you explicit controls over the visi-

bility of each of the axis lines. 

X,Y,Z. Offsets the grid pattern in the direction specified. Very useful when 

the 3D Grid check box is on as you might find the Z position of the grid 

leaves you right in the middle of a line.

Grid Color. Sets the RGB color of the lines.

Surface Color. Sets the RGB value of the underlying surface. You can set 

the alpha to 0.0 to let the object’s diffuse color, or the next texture map in 

the diffuse list, come through instead.

Figure 16.10 — Contour Shader Interface
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Crumple

This 3D shader creates a bumpy pattern on an object very similar to crum-

pled aluminum foil. Will affect the channel in which it is applied and Bump 

channels.This shader is not anti-aliased, so use additional group sampling as 

needed.

Noise Level. Controls how many iterations of noise are computed for the 

shader. Each successive iteration is half the size of the previous one. More 

Levels require more rendering time.

Noise Scale. Sets the height at which the High Color is drawn. 

Noise Factor. Each successive level of noise gets smaller by this amount.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Bump Scale. Sets the magnitude of the bump. Can be negated to invert the 

crumple effect.

Bump Factor. At each successive level of noise is computed the bumps get 

smaller by this amount.

Figure 16.11 — Crumple Shader
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Animation. Animates the noise pattern over time. A value of 1.0 moves the 

noise 1 unit of the preview square per second. This can be used to create 

animated water effects. Try doing this by animating the Z value for the 

shader applied to a flat plane.

High Color. Sets the RGB value of the surface at the top of the bumps. You 

can set the alpha to 0.0 to let the object’s diffuse color, or the next texture 

map in the diffuse list, come through instead.

Low Color. Sets the RGB value of the surface at the bottom of the bumps. 

You can set the alpha to 0.0 to let the object’s diffuse color, or the next tex-

ture map in the diffuse list, come through instead.
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Crust

This 3D shader creates a series of high, flat ledges. Will affect the channel in 

which it is applied and Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Coverage. Controls the region that the Crust Color covers. 0.0 yields no 

Crust Color. 1.0 will cause the Crust Color to cover the entire procedural.

Ledge Level. Controls how far the ledges spread out across the surface of 

the crust.

Ledge Width. Sets the widths of the ledges.

Bump Strength. Sets the magnitude of the bump for the ledges. Values can 

be either positive or negative.

Crust Color. Sets the RGB value of the ledges.

Surface Color. Sets the RGB value of the surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 16.12 — Crust Shader
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Cyclone

This 3D shader creates a vortex pattern. The effect is quite startling when 

applied to the Transparency Channel. Will only affect the channel in which 

it is applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Cyclone Radius. The radius of the main body of the swirling vortex. This 

value manages the apparent “strength” of the vortex. The default value of 

is 1.0, giving a decent looking vortex. Smaller numbers will impart less 

energy to the vortex, effectively weakening it. A value of 0.0 will look like 

smoke, rather than a cyclone. Likewise, values of over 5.0 will have a simi-

lar effect.

Eye Radius. The radius of the eye at the center of the vortex. 0.5 corre-

sponds to the width of the preview window.

Twist. Sets the number of revolutions the vortex makes within the width of 

the preview window

Figure 16.13 — Cyclone Shader
Electric Image Universe 3.0        449



Chapter 16  Shaders — Cyclone
Scale. Sets the magnitude of the amount of clouds created in the vortex. 

Small changes in this value can vary the look of the effect significantly.

Offset. Can be used to make the overall effect more misty.

Omega. Increases the choppiness of the clouds. Useful range is between 0.0 

to 1.0, with 1.0 being more choppy than 0.0.

Octaves. Controls the detail of the noise function. Useful range is 1 to 8.

Contrast. Lower numbers decrease the contrast between Color1 and 

Color2.

S Noise. A noise seed. Can be used to vary the look of the cyclone. 

D Noise. A noise seed. Can be used to vary the look of the cyclone.

Color1. Sets the RGB value of the region not part of the swirling vortex.

Color2. Sets the RGB value of the clouds in the vortex.
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Dots

This 3D shader makes a grid of dots on the surface of the object. Will only 

affect the channel in which it is applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, adding more dots, smaller to zooming in, 

removing dots. The default is 1.0.

Dot Diameter. Diameter of the dots. A diameter of 1.0 fills the preview 

window at a density of 1.0. 

Fuzzy Edge Width. Sets a region around the dot to blur slightly. Makes a 

nicer transition from the surface to the dots.

Dot Color. The RGB color of the dots.

Surface Color. Sets the RGB value of the surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 16.14 — Dots Shader
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Eroded

This 3D shader puts dents and holes in the surface of an object. (The shader 

uses a black and white checker pattern in the preview area to denote actual 

holes that will be visible through the material — the pattern does not ren-

der.) Will affect the channel in which it is applied and Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Bump Strength. The magnitude of the bump applied to the dented por-

tions of the surface. Can be a negative number.

Erode Holes. When on, holes are actually cut through the surface. When 

off, areas that represent holes are shaded with the Hole Color.

Hole Min. The surface of the object is represented by a value of 0 to 1. 

Where 0 is the bottom of the deepest hole. Hole min sets the range over 

which holes occur on the object. In the default case, holes appear between 

0.3 and 0.4

Hole Max. The surface of the object is represented by a value of 0 to 1. 

Where 1 is the top of the surface. Hole max sets the range over which holes 

occur on the object. In the default case, holes won’t appear between 0.4 and 

Figure 16.15 — Eroded Shader
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1.0. Between 0.3 and 0.4 there is a ramp wherein the surface transitions 

nicely into the hole.

Hole Color. RGB value of the color applied to the holes when the Erode 

Holes flag is off.

Surface Color. Sets the RGB value of the surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.
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Flame

This 3D shader creates a fire-like color pattern. You may want to re-align 

the cubic projection icon to bottom or top, as the preview shader is present-

ing the flames to you in that orientation. (This shader does not animate the 

flame effect.) Will only affect the channel in which it is applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Distortion. Scales the combination of all noise functions. Larger numbers 

will yield many smaller regions of flame. Useful values are in the range of 0 

to 1.

Chaos Scale. Scales the color temperature of the shader. Larger numbers 

are hotter.

Chaos Offset. Increases the color temperature of the shader (default is 0.0.) 

Larger numbers are hotter. Numbers over 1.5 tend to “burn out” the shader 

and are not very useful.

Figure 16.16 — Flame Shader
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Flame Height. If set to 0.0 (the default), this shader behaves as a 2D shader. 

If a height is provided, the colors will vary as the height of the object 

changes. Apply to the top of a cube and enter in a height value. When you 

render the side of the cube, you will see the colors creeping up.

Flame Amplitude. Scales the flame temperature based on the height.

Lacunarity. Sets the gaps (dark areas) between the regions of flame in the 

preview window. By setting the colors of the coolest regions to Alpha 0.0 in 

the color picker, you can see the group’s diffuse color through the gaps.

S Noise Scale. Acts as a noise seed to vary the look of the flame.

D Noise Scale. Acts as a noise seed to vary the look of the flame.

Octaves. Sets the fractal complexity of the shader. Useful values range 

between 1 and 7.

Colors. Sets the number of colors, from the list of colors on the left, to use 

when creating the procedural effect.
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Fractal Noise

This 3D shader creates a fractal-based noise pattern. Will affect the channel 

in which it is applied and the Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Noise Level. Controls the complexity of the noise. Useful range is 0 to 8

Noise Factor. Higher numbers produce a rougher surface, smaller number 

a smoother surface.

Bump Strength.  Sets the magnitude of the bump. Can be negated.

Bump Factor. With each successive noise level calculation, bumps get 

smaller by this factor.

Sharpen Bumps. Takes the highest point and makes it rougher, takes the 

lowest point and makes it softer. Good for making the bumps nice and 

craggy.

Color Factor. Sets the point where the shader switches from the High Color 

to the Low Color. Higher numbers will completely eliminate the Low 

Color.

Figure 16.17 — Fractal Noise Shader
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Sharpness. Larger numbers increase the contrast between the High and 

Low Colors

High Color. Sets the RGB value of the surface at the top of the bumps. You 

can set the alpha to 0.0 to let the object’s diffuse color, or the next texture 

map in the diffuse list, come through instead.

Low Color. Sets the RGB value of the surface at the bottom of the bumps. 

You can set the alpha to 0.0 to let the object’s diffuse color, or the next tex-

ture map in the diffuse list, come through instead.
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Gooch

This shader renders an object with a hue and value shift rather than tradi-

tional phong shading. This produces a more “illustration” style of shading. 

This look is very useful for technical illustrations and produces an artistic, 

rather than photo-realistic, representation of the object. The user can con-

trol the cool and warm colors of the shading, as well as how the shading 

threshold will behave. This shader affects the Diffuse, Specular and Reflec-

tivity channels.

Cool Color. The cool color of a gooch shaded model, is a color that is not 

highlighted with a specular hit or is in shadow.

Warm Color. The warm color of a gooch shaded model, is a color that is 

highlighted with a specular hit, or with bright lighting.

Alpha. Alpha is the prominence of the object color and Beta is the strength 

of the color shift.

Beta. Beta is the strength of the color shift.

Figure 16.18 — Gooch Shader
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Granite

This 3D shader creates a granite rock appearance. Apply this shader only to 

the Diffuse Channel. Will affect the Diffuse and Specular Channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.\

ks1. The Specular value for the region colored by Color1. 1.0 is max, 0.0 is 

no specular

ks2. The Specular value for the region colored by Color2. 1.0 is max, 0.0 is 

no specular

Color1. The RGB value for the underlying color of the granite rock.

Color2.  The RGB value for the colored pieces that mix in with the granite 

rock.

Figure 16.19 — Granite Shader
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Grid

This shader creates a 2D or 3D grid of lines. Will only affect the channel to 

which it is applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out (seeing more of the grid), smaller to zooming in 

(seeing less of the grid). The default is 1.0.

3D Grid. Makes the shader work in 3D space. 

X,Y,Z. Offsets the grid pattern in the direction specified. Very useful when 

the 3D Grid check box is on as you might find the Z position of the grid 

leaves you right in the middle of a line.

Line Thickness. Sets the thickness of the grid lines. The default is.2 Smaller 

numbers produce thinner lines.

Grid Color. Sets the RGB color of the lines.

Surface Color. Sets the RGB value of the underlying surface. You can set 

the alpha to 0.0 to let the object’s diffuse color, or the next texture map in 

the diffuse list, come through instead.

Figure 16.20 — Grid Shader
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Hex Tile

This 2D shader creates a hexagonal pattern of terra cotta tiles. Perfect for 

your patio or mud room. Will only affect the channel in which it is applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Tile Radius. Sets the size of the tiles. 1.0 represents one full tile in the pre-

view window.

Mortar Width. Sets the width of the mortar between the tiles. Useful range 

is 0.0 to 0.3

Tile Vary. Allows subtle variations in the color of the tiles. Useful range is 

0.0 to 1.0

Scuffing. Sets the darkness of the scuff marks on the surface of the tiles. 

Useful range is 0.0 to 5.0

Stains. Creates separate stained areas using the Scuff color. Useful range is 

0.0 to 5.0

Figure 16.21 — Hex Tile Shader
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Stain Frequency. Controls the size of the stained areas. Larger numbers 

create smaller stains.

Scuff Frequency. Controls the size of the scuff marks. Larger numbers cre-

ate smaller marks.

Tile Color. Sets the RGB value of the tiles

Mortar Color. Sets the RGB value of the mortar between the tiles.

Scuff Color. Sets the RGB value of the scuff marks on top of the tile.
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Marble

This 3D shader creates a marble-line surface for rocks, pillars, temples, etc. 

Will only affect the channel in which it is applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Frequencies. Controls the number of separate veins that appear in the mar-

ble. The default is 8 and you can see 8 distinct black veins running through 

the marble in the preview window.

Turbulence. Sets the waviness of the veins. Larger numbers yield more 

waviness.

Noise Factor. Affects the variation of the veins along their length. Useful 

values are in the range of 0.0 to 1.0

Vein Spacing. Controls the distance from one vein to the next.

Vein Sharpness. Controls the sharpness and apparent width of the veins.

Colors. Controls how many of the colors on the left side of the interface are 

used to shade the marble. (Color number 1 defaults to alpha 0.0, allowing the 

diffuse color of the group to show through.)

Figure 16.22 — Marble Shader
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Oren-Nayer

The Oren-Nayer shader is rough surface BRDF shader which more accu-

rately shades surfaces which scatter a lot of light, such as unglazed ceram-

ics fabric, terra-cotta, suede, clay, human skin and so on. It can add a 

softness and richness that typical phong shading lacks. This shader affects 

the Diffuse, Specular, and Reflection Channels only.

Roughness. This option basically sets how bumpy or porous an object is. 

For example skin, is a smooth surface but close inspection shows micro-

scopic ridges all over the surface, so it’s roughness is fairly high. On the 

other hand, a glass object, or glossy painted surface is extremely smooth, so 

it’s roughness is very low.

Specular. Like the specular section for the anisotropic shader the option for 

a Phong or Blinn type highlight can be chosen.

Figure 16.23 — Oren-Nayer Shader
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Pearl

This shader produces a “pearlescent” sheen on an object. Simulating effects 

like mother of pearl or pearl coats of paint are accomplished with this 

shader. It works by allowing the user to adjust the reflected red, green and 

blue wavelengths of light coming from an illuminated object with this 

shader applied. A noise factor can also be applied. This shader affects Dif-

fuse, Specular and Reflection channels only.

Wavelength. This shader allows you to assign Red, Green and Blue wave-

lengths to apply to the object. A very small margin of color from each of 

these wavelengths is then applied to the model.

Noise Factor. This is a control for the amount of deviation from the wave-

lengths assigned. A higher number will have a greater variety of colors.

Figure 16.24 — Pearl Shader
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Plank

This 3D shader creates a nice parquet-style wood pattern. Can be used to 

great effect on the floors of entry halls or on dance floors. Biases the specu-

lar highlight with the parquet pattern as well. Can also be used to simulate 

hardwood flooring.Apply only to the Diffuse Channel. Will affect the Dif-

fuse, Bump, and Specular channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Parquet Tile. Creates the parquet pattern of tiled wood. If off, long planks 

are created instead; perfect for hardwood floors.

Planks Per Tile. Number of individual wood slats that make up each tile.

Plank Length. Sets the length of the planks when the Parquet Tile flag is 

turned off.

Plank Width. Sets the width of the tiles when the Parquet Tile flag is on. If 

the flag is off, it sets the width of the individual planks.

Figure 16.25 — Plank Shader
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Groove Width. Sets the width of the grooves that separate the tiles from 

one another and the grooves that separate the planks within the tiles from 

one another.

Ring Scale. Larger number create more, tighter grain patterns in the 

planks.

Grain Scale. Larger number cause the grain patters to be thicker.

Plank Vary. Cause color variation in the individual planks. Useful range of 

values is 0.0 to 2.0.

Grainy. Sets the amount of grain in each plank. Larger numbers give you 

smaller grain.

Wavy. Larger numbers make the grain more wavy.

Light Wood. Sets The RGB color of the lightly colored planks.

Dark Wood. Sets The RGB color of the darkly colored planks.

Groove Color. Sets The RGB color of the grooves between the planks and 

tiles.

ks. Sets the specular for each of the areas. 0.0 is no specular. 1.0 is maxi-

mum specular.
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Random Dots

This 3D shader creates a pattern of randomly colored dots. Perfect for that 

summer dress. Will only affect the channel in which it is applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in. Defaults to 1.0.

Dot Types. This value controls which of the 10 different dots are supported 

will be used by the shader, from top to bottom of the list as presented in the 

window.

Dot Color. Sets the color of each dot

Dot Size. Sets the maximum size of each dot. There is random variation in 

the size from the maximum down. 

Figure 16.26 — Random Dots
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Rust

This 3D shader creates a rusted surface pattern. The surface appears thick 

with areas eroded down to holes. Apply only to the Diffuse Channel. Will 

affect the Diffuse and Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Paint Level. Controls how deep into the surface the paint reaches.

Paint Bump. Sets the magnitude of the bumps on the painted surface. 

Paint Color. Sets the RGB value of the surface. You can set the alpha to 0.0 

to allow the underlying color or map to come through instead.

Rust Level. Sets the amount of the surface affected by the rust. 1.0 is all 

rusty, 0.0 is no rust at all.

Rust Bumps. Sets the magnitude of the bumps on the rusty surface.

Rust Color. Sets the RGB value of the rusted area.

Hole Level. Sets the amount of the surface that becomes holes. 1.0 is all 

hole, 0.0 is no holes.

Figure 16.27 — Rust Shader
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Stucco

This 3D shader creates a stucco pattern using bumps. Great for adding a 

slight variation to interior and exterior walls. Will affect the channel in 

which it is applied and Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Sharpness. Controls the smoothness of the bumps. Smaller numbers are 

smoother, larger numbers sharper. Useful range is 0 to 10.0

Bump Strength. Sets the magnitude of the Bump. Can be positive or nega-

tive.

Color Factor. Controls the blend, and therefore the spread, of the Bump 

Color into the Surface Color. Larger numbers correspond to a larger spread.

Bump Color. Sets the RGB value of the bumps.

Surface Color. Sets the RGB value of the surface You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 16.28 — Stucco Shader
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Thin Film

The Thin Film Shader is designed to provide the effects of a film-like coat-

ing above a surface. The most obvious examples would be the soap bubble, 

or oily puddle, however some new sunglass lenses also exhibit this same 

effect. This shader effects Diffuse and Reflection channels only.

Max Thickness. This option sets the thickness of the ‘film’ simulated by the 

shader. It is measured in angstroms, which is a very small unit of measure, 

one hundred millionth of a centimeter.

Wavelengths. The options for wavelengths are Red, Green and Blue set-

tings. A small band of color will then be used from each setting of the 

wavelengths.

Refraction. This setting will allow the shader to have refraction inside its 

small space. This is different than refraction on of the object itself, as it is 

only affecting the thickness assigned to the shader.

Figure 16.29 — Thin Film Shader
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Offset. The Offset option moves the shader through 3D space. Can offset 

the pattern on the model. 

Random. The Random function sets the random variable seed that controls 

the look of the pattern
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Veins

This 3D shader creates a series of polygonal shapes separated by grooves. 

Could be used for alien skin or even the surface of a cobblestone walkway. 

Will affect the Channel in which it is applied and Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Coverage. Controls the region that the Vein colors covers. 0.0 yields no Vein 

Color. 1.0 will cause the Vein Color to cover the entire procedural.

Ledge Level. Controls the height that the shapes rise above the veins

Ledge Width. Controls the width of the shapes

Bump Strength. The magnitude of the bump. Can be negative to cause the 

veins to rise above the shapes.

Vein Color. Sets the RGB value of the veins.

Surface Color. Sets the RGB value of the surface You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 16.30 — Veins
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Waves

This 2D shader creates a pattern that can be used to simulate ripple effects. 

You can animate the waves, flowing outward at a rate controlled by the 

Wave Frequency. Affects the channel of application and Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Wave Source. Sets the number of sources that generate the waves. More 

sources give rise to complex interference patterns

Wave Range. Sets the distance between Wave Sources.

Wave Length.  Distance between the wave crests.

Wave Frequency. Number of units the rings move outward per second.

Bump Strength. The magnitude of the bump. Can be negative invert the 

wave.

Wave color. Sets the RGB value of the wave crests.

Figure 16.31 — Waves Shader
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Surface Color. Sets the RGB value of the surface You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.
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Wisp

This 3D shader creates a series of lightly drawn lines, as if a calligraphy pen 

had been used to draw on the surface. Will only affect the channel in which 

it is applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Coverage. Sets the region that the Wisp Color covers. 0.0 yields no Wisp 

Color. 1.0 will cause the Wisp Color to cover the entire procedural.

Ledge Level. Larger numbers increase the number of lines that are drawn

Ledge Width. Smaller numbers increase the thickness of each line.

Wave Color. Sets the RGB value of the lines.

Surface Color.  Sets the RGB value of the surface You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 16.32 — Wisp Shader
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Wood

This 3D shader creates a basic wood-like appearance. Will only affect the 

channel in which it is applied.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Frequencies. Controls the number of separate grains that appear in the 

wood.

Turbulence. Sets the waviness of the grain. Larger numbers yield more 

waviness.

Noise Factor. Affects the variation of the grain along their length. Useful 

values are in the range of 0.0 to 1.0

Vein Spacing. Controls the distance from one vein to the next.

Vein Min. Controls the minimum width of the veins.

Vein Max. Controls the maximum width of the veins.

Colors. Controls how many of the colors on the left side of the interface are 

used to shade the wood.

Figure 16.33 — Wood Shader
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Dicer

This plug-in increases the polygon density of any group or groups attached 

to it. That is, the number of polygons in the group is increased by dividing 

(or dicing) the group into small polygons. Dicer is therefore very useful 

when combined with Deformations, because groups that contain few poly-

gons and vertices cannot be deformed.

1. Choose Plugin>Dicer!.plm… from the main menu bar.

2. Use the controls of the dialog box to configure the operation to your 
preferences.

3. Either click OK or press Return. The Dicer effect is added to the project 
as a group.

4. Link the group(s) to be diced to the Dicer group.
5. To deform the group(s), apply the deformation to the Dicer group. 

Dicer Controls

Segment Count. This radio button option, the default setting, divides a 

group into equal length segments. The length of each segment is deter-

mined by taking the longest extent dimension (x, y or z) of the group and 

dividing it by the value in the Segment Count edit box.

Figure 17.0 — Dicer! dialog
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Segment Length. This radio button option, when selected, divides a group 

into segments whose length is determined by the value in the Segment 

Length edit box.

Triangulate All Polygons. This check box option, when enabled, uses tri-

angles only (no quadrangles). Use this option if you notice flashing poly-

gons in objects linked to Dicer.

Local Coordinates. This radio button option, the default setting, deter-

mines the length of each segment by the local coordinates of the group as 

displayed in the Group Info window.

Global Coordinates. This radio button option, when selected, determines 

the length of each segment by the global coordinates of the group. These 

can be seen by turning on the rulers in the Top, Front, or Side View win-

dows.

Dice Only While Rendering. This check box prevents dicing from occur-

ring while the object is displayed within Universe Animator. This improves 

the speed of screen redraw and display.

Auto Update. This check box sets the plugin to update all linked groups 

without having to take any other steps. (?)
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Mr. Blobby

This plug-in takes groups that are linked to it and forms spheres (or blobs). 

As multiple blobs get close together, they blend into a single blob.

1. Choose Plugin>Mr. Blobby.plm… from the main menu bar.

2. Use the controls of the dialog box to configure the operation to your 
preferences. For an explanation of these controls, refer to the section 
“Mr. Blobby Controls” (below).

3. Either click OK or press Return.
The Mr. Blobby effect is added to the project as a group.

4. Link the group(s) to be affected to the Mr. Blobby group.

Mr. Blobby Controls

Texture Map Each Blob. Allows a single texture map to be applied to every 

blob. Every blob will receive the same map.

Figure 17.1 — Mr. Blobby dialog
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Texture Map Whole Model. Allows a single texture map to be applied to 

the extent of the entire Mr. Blobby group.

Mesh With Cubes. Creates 4 sided polygons.

Mesh With Tetrahedrons. Creates 3 sided triangles. 

Interpolate Color: RGB. When working with blobs of different colors this 

setting will blend the colors based on the RGB color model. There is a direct 

blend from one color to the next with no transitional hues. A blend from 

Red to Blue would look like mixed paint creating a smooth gradation 

between the two colors.

Interpolate Color: HSV. When working with blobs of different colors this 

setting will blend the colors based on the HSV color model. This causes a 

blend from one color to the next with extra transitional hues appearing. 

The extra hues are created by interpolating through the Hue color spec-

trum when blending between a start and finish color. A blend from Red to 

Blue would look like a rainbow of Red, Orange, Yellow, Green, Cyan and 

Blue.

Generate: Sphere. This is a primitive to be used to set up a texture map. 

Select this option, then use the texture window to map the Mr. Blobby 

group. Only a spherical map will work. The map can be RGBA for bump 

mapping or transparency mapping. When done setting the map change 

Generate: Sphere to Generate: Groups Blobs, or Generate: Facet Blobs. 

When rendered each blob will appear with the texture map applied.

Generate: Torus. This setting puts Mr. Blobby into a special mode in which 

only a torus will be created. No other Mr. Blobby functions will work.
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Generate: Three Spheres. This setting puts Mr. Blobby into a special mode 

in which only three spheres will be created. No other Mr. Blobby functions 

will work.

Generate: Group Blobs. This setting will take each group linked to the 

Mr. Blobby plug-in and make it a blob. It uses the bounding box size to 

determine blob size. This option allows you to control the movement of 

each individual blob by first animating a set of placeholder groups and 

then linking them to the Mr. Blobby group. This option also allows you to 

control the size of individual blobs by letting you animate the Scale of each 

placeholder group. This option also allows you to control the color of indi-

vidual blobs by letting you animate the Color of each placeholder group.

Generate: Vertex Blobs. This setting will take each vertex of a group linked 

to the Mr. Blobby plug-in and make it a blob. If you use a model, it will 

place a blob at each vertex of the model.If you use a particle generator, it 

will place a blob at each vertex emitted by the generator.The size of each 

vertex blob is set with the Vertex Blob Size entry box.The color of the vertex 

blobs are set with the surface color settings for the particle system group. If 

you want to use the color boxes inside the particle system plug-in to 

change blob colors over time, you must use the Generate: Facet Blobs 

option.

Generate: Facet Blobs. This setting will take each polygon of a group 

linked to the Mr. Blobby plug-in and make it a blob. If you use a model, it 

will substitute a blob for each polygon of the model.If you use a particle 

generator, it will place a blob at each vertex emitted by the generator. If you 

use Mr. Nitro, it will substitute a blob for each fragment generated by 

Mr. Nitro. The size of each facet blob is based on a combination of the size 

of the facets in the model, and the setting in the Facet Blob Scale entry 

box.The color of the facet blobs are based on the original model, or set with 
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the surface color settings in the group info window, or based on colors set 

in the Mr. Nitro or Particle plug-ins, or based on a texture map applied to 

the Mr. Blobby group.

Blob Threshold. Affects how attractive the blobs are to each other. A 

higher value will cause multiple blobs to join.

Vertex Blob Size. This sets the size of the blobs using World Coordinate 

units. All vertex blobs are the same size.

Facet Blob Scale. This sets the size of the blob as a percentage of the size of 

the polygon the blob is based on. A setting of 1 will create a blob that will 

totally encompass the bounding area of the polygon. (1 is equal to 100% of 

bounding area.) A setting of.5 will create a blob half the size of the total 

bounding region. A model with facets of differing sizes will produce blobs 

of differing sizes.

Mesh Resolution: EI. This sets the resolution of the surface mesh for dis-

play within EI. A setting of 3 to 5 will create a usable mesh for setting up 

animation.Be careful to test the effects of a higher Mesh Resolution. If you 

are working to get a specific look, be aware that the shape of the surface 

will change when you render at higher resolution.

Mesh Resolution: Camera. This sets the resolution of the surface mesh for 

rendering within Camera. A setting of 15 to 20 will create a fairly tight sur-

face.

Usage Notes

• All blobs are spherical. You cannot make them ellipsoidal, and you can-
not change their region of influence on an individual basis.

• In order for blobs to react to each other they must be generated by the 
same Mr. Blobby group.
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• Mr. Blobby settings do not animate and do not set key frames.
• Blobs do not understand rotation, as such it does no good to animate 

the rotation of Group Blobs because the blob won't pick up the rotation 
angles.

• Blob size is based on the bounding box size. If you rotate a group it's 
bounding box is likely to change size resulting in a blob that grows and 
shrinks.

• Plug-ins pass their data down the project hierarchy. Try linking a stan-
dard shape to a Mr. Nitro and then link that Mr. Nitro to a Mr. Blobby 
(in Generate: Facet Blobs mode). As the standard shape explodes, Mr. 
Blobby will convert the fragments into blobs.

• The blobs are recreated at every frame. Large numbers of blobs (such as 
those created by Mr. Nitro or a Particle system) may add huge numbers 
of polygons to your project. Remember, a single facet created in a 
Mr. Nitro explosion might be turned into 200 polygons by Mr. Blobby.
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Mesh Generator

This tool adds the Mesh Generator to the project. The Mesh Generator is 

used to animate various shape transformations, primarily a plane into a 

sphere (or vice versa).

1. Choose Plugin>Mesh.plm… from the main menu bar.

2. Use the controls of the dialog box to configure the mesh to your prefer-
ences. For an explanation of these controls, refer to the section “Mesh 
Generator Controls (see below).

3. Either click OK or press Return.

Mesh Generator Controls

Mesh Type. This pop-up menu provides a choice of five different animated 

mesh objects. The menu choices are:

• Flat
• Sine Wave
• Breathing Cylinder
• Screw Thread
• Sphere Wrap

Figure 17.2 — Mesh dialog
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Flat. This option creates a flat, two-dimensional mesh grid.

Sine Wave. This option creates a mesh object containing animated circular 

waves.

Breathing Cylinder. This option creates a cylinder that expands and con-

tracts as if breathing.

Screw Thread. This option creates an object that simulates a screw thread 

which reverses its threads inwards and outwards over time.

Sphere Wrap. This option (the default) creates an object that transforms 

itself from a plane into a sphere (and back again).

U Points. This edit box contains a value for the number of horizontal grid 

segments.

V Points. This edit box contains a value for the number of vertical grid seg-

ments.

Loop Time. This edit box contains a value in seconds for the amount of 

time it will take for one complete transformation. In the case of a Sphere 

Wrap, for example, the loop time would be the amount of time it will take 

for the plane to transform into a sphere (before transforming back into a 

plane).

X, Y and Z Scale. These edit boxes contain values for the scale of the object 

along the X, Y and Z axes. For a Sine Wave object, you can use the Y Scale 

value to control the height of the waves.

Once the object is added to the project, this dialog box can be reopened to modify 

your preferences. To do so, open the Group Info window for the object and click the 

Plugin… button.
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Mr. Nitro

This tool adds the Mr. Nitro special effect to the project. Mr. Nitro is used to 

animate realistic explosions of models.

4. Choose Plugin>Mr. Nitro.plm… from the main menu bar.

5. Use the controls of the dialog box to configure the blast to your prefer-
ences. For an explanation of these controls, refer to the section “Mr. 
Nitro Controls (see below).

6. Either click OK or press Return.
7. Parent the group(s) to be exploded to the Mr. Nitro object.

Mr. Nitro Controls

Ground Zero. These edit boxes contain values for the X, Y and Z coordi-

nates of the blast’s origin, or “ground zero.” This is the point from which 

the shock wave of the blast originates, emanating in all directions. By posi-

Figure 17.3 — Mr. Nitro dialog
488       Electric Image Universe 3.0    



Chapter 17  Plug-ins — Mr. Nitro
tioning ground zero farther away from the group(s) to be exploded, you 

can create more of a “wall-shaped” shockwave.

To position and configure the blast to your requirements, you should first check the 

coordinates and size of the group(s) to be blasted in their respective Group Info 

windows. You can then set Mr. Nitro’s values accordingly.

Gravity Direction & Force. These edit boxes contain values for the direc-

tion and force of gravity which will affect the manner and speed in which 

the blast fragments fall. The ± edit boxes enable you to impart a variability 

to each value so that some fragments are more affected by gravity than oth-

ers.

Blast Time. This edit box contains a value for the time in the project at 

which the shock wave will commence. A negative value will result in the 

shock wave originating prior to the start of the animation.

You will need to use a negative blast time value when ground zero is far 

away from the group(s) to be exploded—otherwise the moment of impact 

will occur long into the animation. For the blast to occur in the first frame 

of the animation, blast time should be set according to the following for-

mula:

Blast Time = - distance from Ground Zero to group ÷ Speed

For example, if ground zero is a distance of 1000 from the group and the 

blast speed (see Speed edit box, below) is 10, blast time would be -1000 ÷ 

10, or -100 seconds.

Air Resistance. This edit box contains a value for the amount of air resis-

tance which will affect the manner in which the blast fragments fall. The 

higher the value, the more air resistance slowing the fragments.
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Dissolve. This edit box contains a value for the amount of time in seconds 

for blast fragments to dissolve after being hit by the shockwave. A value of 

0 (the default) prevents fragments from dissolving.

Outer Blast. These edit boxes control the speed, rotation, turbulence and 

force of the initial shockwave of the blast. An explosion can have two 

shockwaves, the outer blast (first) and the inner blast (second).

%. This edit box contains the percentage value for the outer blast (initial 

shockwave). It defaults to 100, so that there is only the outer blast. To create 

two shockwaves, assign a value less than 100% to the outer blast and the 

Inner Blast% edit box will be adjusted accordingly (so that they add up to 

100%).

Speed. This edit box contains a value for the speed (distance per second) of 

the shockwave. When used in conjunction with the Blast Time value (see 

above), this value can control the moment when the shockwave hits the 

group(s).

Rotation. This edit box contains a value in degrees for the maximum 

amount of rotation of the flying blast fragments. Fragments rotate around 

random axes.

Turbulence. This edit box contains a value for the amount of air turbulence 

which will affect the manner in which the blast fragments rotate. With a 

value of zero, fragments rotate around their centers. A value other than 

zero will cause fragments to rotate off-axis.

Force. This edit box contains a value for the force of the shockwave. The 

greater the force, the faster the fragment will move in the direction of the 

shockwave. A force of 1.0 will cause fragments to move at the same speed 
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as the shockwave. The ± edit boxes enable you to impart a variability to the 

value so that some fragments fly faster than others.

Fragment Size. These edit boxes contain size values for the smallest and 

largest blast fragments, relative to the size of the exploding group. To have 

all fragments of approximately the same size, enter the same value in both 

the Smallest and Largest edit boxes.

Setting a minimum size value that is too small will generate a very large number of 

fragments, which will take too long to generate and may also cause you to run out 

of memory. As a starting point for the minimum size, try using a value that is 1/10 

the longest dimension of the group; for the maximum size, use a value that is twice 

the minimum size.

Fragment Shape. These edit boxes contain values for the percentage of 

fragments that are to be triangles versus quadrangles. The default is 50% 

for each. Changing one value will adjust the other value accordingly (to 

add up to 100%).

Fragment Color. This check box, when enabled, allows you to assign a 

color to the blast fragments, overriding the surface color setting of the 

group. The color of the blast fragments can be animated over time through 

the use of the Age Color buttons, discussed below.

Age Color. These buttons invoke the Color Picker to enable you to set dif-

ferent colors for the blast fragments at different stages of the blast. The age 

values are all in seconds and can be edited.You can change the color of the 

fragments before they are hit by the shockwave by setting the first age 

value to less than zero.
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Once the Mr. Nitro object is added to the project, this dialog box can be reopened to 

modify your preferences. To do so, open the Group Info window for the Mr. Nitro 

object and click the Plugin… button.
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Power Particles Basic

This tool adds the Particle Generator to the project. The Particle Generator 

is used to animate special effects such as sparks, jets of fire, and fountains 

or streams of water.

1. Choose Plugin>PowerParticlesBasic.plm… from the main menu bar.

2. Use the controls of the dialog box to configure the particle stream to 
your preferences. For an explanation of these controls, refer to the sec-
tion “Power Particles Basic Controls (see below).

3. Either click OK or press Return.

This plugin offers previews so that you can predict how the particles will 

behave over time without having to render. Previews are in OpenGL for 

maximum speed.

Figure 17.4 — Power Particle Basic dialog
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Universe Animator Preview

Previews in Universe Animator can be viewed either as emitted particles or 

as a direction arrow. Particle previews can also be set to display a percent-

age of particles you want to see. For fast Previews in Universe Animator, 

we recommend running with 1/10th or less particles than you want to see 

in the renderings.

Interface Controls

Power Particles introduces some new and unique controls that are dis-

cussed in this section.

OpenGL Preview Buttons

Orbit. This button allows you to move the view point around the particle 

stream. Changing the view in Power Particles does not affect the camera 

position in Universe Animator.

Dolly. This lets you slide the view point closer or farther away from the 

particle system.

Orientation. This allows you to choose between Top, Side, Front or Per-

spective views. 

Note Orbit only applies to the Perspective view.

Figure 17.5 — OpenGL Preview Buttons
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Continuous/Loop. The loop button allows you to see the system from its 

start frame to its end frame. Then it starts over. (Animation of the plug-in is 

not shown). Continuous shows the system emitting its particles with no 

reference to start and end time. In other words, it just keeps going and 

going forever or until you close the interface.

Stop, Pause and Play. These work just like standard CD type controls to 

control the plug-in preview of the particle system. 

Background color . The last item is the background color setup icon. Click 

the color swatch to change the background color.

Shortcuts

• Tab/Shift-Tab: Move between virtual sliders within a tab.
• Cntrl-Z, Cntrl-X: to change the increment of a virtual slider.
• Cntrl-Q, Cntrl-W: to move to another tab.

Slider Buttons

Notice the arrows on the button. This icon indicates that the button is a new 

“Virtual Slider”. To use this function, press the button (the arrow changes 

to yellow to indicate it’s active), then click and hold the mouse button in 

the OpenGL screen and slide it right and left. Notice the values in that 

parameter change. Also note: Under the OpenGL Screen are Min, Max, and 

Inc. Min and Max show the minimum and maximum values allowed for a 

given “slideable” parameter. Inc. shows the increment used when changing 

the slider. The increment can be changed by using cntrl-Z and cntrl-X. 

Slider increments will increase or decrease by a factor of ten.

Figure 17.6 — An Interactive Slider Button
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Emitter Tab

This tab allows you to select between Point, Line, and Volume type emit-

ters.

Point. Select this option if you want objects to be emitted from a point. 

Line. Select this option if you want objects to be emitted from a line. Set 

Line Length to the length in Universe Animator world units of the emission 

line. Any number greater than or equal to 0 can be entered. A line length of 

0 has the same function as emitting from a point.

Volume. Select this option if you want objects to be emitted from a volu-

metric region. Set the X, Y and Z values to determine the volume in which 

Figure 17.7 — Emitter Tab

Figure 17.8 — Emitter Pull-down
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the particles will be emitted. Volume emission is always centered around 

the Power Particles center point locator in Universe Animator.

Start Time. Set this parameter to the time in seconds from the beginning of 

the animation that you want particles to start emitting. The frame that cor-

responds to this time will be the first frame in the animation in which parti-

cles are emitted.

End Time. Set this parameter to the time in seconds from the beginning of 

the animation that you want particles to stop emitting. This parameter only 

controls the time at which particles stop emitting; emitted particles will still 

be present in the animation until they either reach the end of their life span 

or the end of the animation, whichever occurs first. The frame that corre-

sponds to this time will be the last frame in which particles are emitted. 

When Start Time is set to the same time as End Time, particles will be emit-

ted on the one frame that corresponds to this time.

Maximum Particles. Set this parameter to the maximum number of parti-

cles you want to exist at any particular time during the animation. Power 

Particles will continue to emit the specified Rate Per Second until the maxi-

mum number of particles is reached. After this threshold is reached, new 

particles will be emitted only to replace particles whose lifetime has 

expired. The maximum number of particles also greatly influences the 

amount of memory used by the plug-in. Previews and rendering run most 

efficiently if you set Maximum Particles very close to the desired maximum 

number of particles you want in the animation.

Emission Deviation. Set this parameter to the angle in degrees that you 

want particles to deviate from their initial direction vector. Valid values are 

from 0.0 to 360.0. At 0.0, particles will all be emitted in the direction that the 

emitter arrow points in the Universe Animator user interface. At 360.0, par-
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ticles will be emitted in all directions from the direction of the emitter. Val-

ues between 0.0 and 360.0 deviate the emission direction accordingly.

Particles Tab

Initial Speed. Set this parameter to the initial speed of an emitted particle. 

If you want to vary the initial speed of emitted particles, enter a number in 

the ± edit box (or use the virtual slider). 

Maximum Speed. Set this parameter to the maximum speed for all emitted 

particles. This function is used to constrain the speed of the particles. If no 

constraint is needed the default setting will normally not interfere with 

particle speed.

Figure 17.9 — Particles Tab
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Rate Per Second. Set this parameter to the number of particles you want 

created during each second of the animation. If you want to vary the num-

ber of particles created per second, enter a number in the ± edit box. 

Lifespan. Set this parameter to the length of time in seconds you want 

emitted particles to appear in the animation. If you want to vary the life-

time of emitted particles, enter a number in the ± edit box.

Set Particle Colors. Click this button to change the colors of emitted parti-

cles.

Particle Colors

Color Bar. The color bar at the very top of the screen shows the selected 

colors as they will appear over the lifetime of the particle. It displays from 

left to right the starting color through the ending color, in sequence. The 

two down arrows indicate which of the colors are displayed in the five 

color display icons below the color bar.

Color display icons. The color display icons below the color bar show the 

five colors available. The selection indicator around a color icon indicates 

which one of the five color settings is currently selected. You modify a 

color’s settings by first selecting its color display icon and then select the 

color using the color picker. On the screen shown, color 1 is selected.

Number of colors. You are allowed between 1 and 5 colors.

Figure 17.10 — Color Bar
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Dynamics Tab

Enable Air Resistance

Check this box if you want the emitted particles to react to air resistance. 

Drag Coefficient. Air resistance corresponds to the drag coefficient of the 

particle. Since the air resistance force depends on the velocity of the parti-

cles, this parameter needs to be adjusted to match the scale of any particu-

lar animation. The faster the particles move (large Initial Speed), the 

smaller the number you want for this parameter.   Numbers between 0.0 

and 1.0 are not uncommon; it all depends on the scale of the animation in 

Universe Animator. 

Figure 17.11 — Dynamics Tab
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Enable Gravity

Set this parameter to the acceleration due to gravity you want applied to 

emitted particles. Gravity is an acceleration which is applied to particles in 

the X, Y, or Z direction. Positive values result in accelerating particles in a 

positive X, Y, or Z direction.

X Direction. Set this parameter to the acceleration due to gravity you want 

applied to emitted particles in the X direction. Positive values result in 

accelerating particles in a positive X direction.

Y Direction. Set this parameter to the acceleration due to gravity you want 

applied to emitted particles in the Y direction. Positive values result in 

accelerating particles in a positive Y direction.

Z Direction. Set this parameter to the acceleration due to gravity you want 

applied to emitted particles in the Z direction. Positive values result in 

accelerating particles in a positive Z direction.

Enable Bounce

Check this box if you want emitted particles to bounce off the Y-Plane. 

Y-Plane. Power Particles Basic offers collision with a designated altitude 

only. This is set by entering a Y value where you want the invisible Y-Plane 

to intersect the Y axis.

Elasticity. Set this parameter to the amount of bounce you want to give to 

emitted particles. Use the following values as a guide to specify bounce 

behaviors:
Electric Image Universe 3.0        501



Chapter 17  Plug-ins — Power Particles Basic
Value Behavior

0 Emitted particles stick to the Y-Plane, no bounce

<1 Emitted particles lose speed with each bounce

=1 Emitted particles maintain the same speed with each bounce

>1 Emitted particles gain speed with each successive bounce

Friction. Like elasticity this setting changes how the particles bounce. This 

setting alters the horizontal distance a particle travels after a bounce. A set-

ting of zero will give the particle no horizontal distance. A setting of one 

will give the particle its normal calculated horizontal bounce distance 

based upon the elasticity and the velocity.

Preferences Tab

Figure 17.12 — Preferences Tab
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Show Emission Direction Only. Check this button to show the initial 

speed and direction of emission. This is shown graphically with the use of 

an arrow. The length of the arrow denotes the initial velocity value and the 

direction of the arrow shows the direction the emitter is pointing. 

Show Emitted Particles. Check this button to display emitted particles. 

This is the default setting.

Limit Emission to _____% of the object. Allows you to set the percentage 

of emitted particles to be seen in the Universe Animator Interface. Camera 

will render 100% of the emitted particles.

Preview Folder. Specifies the name of the folder in which the preview files 

are stored. The preview folder is placed in the folder where Universe Ani-

mator is located. This folder must be available to Camera during rendering 

of stills. If this folder is available to Camera during rendering, the Camera 

temp file needed by Power Particles will be stored here also. Power Parti-

cles does not delete these folders. These folders can be deleted at any time 

from the Universe Animator directory. 

Disable Grid. Check this box to hide the grid from the preview screen.

Disable Axis References. Check this box to hide the Axis reference letters 

from the preview screen.
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Pixel Grains

“X-Men”, the movie, Inspired the creation of this plugin. An effect involved 

the characters of the movie planning their attack strategy and they create a 

3D grain like replica of NY City region consisting of millions of little tiny 

primitives that are rearranged based on animated height maps. The effect 

was originally created on a high end workstation. We developed the same 

sort of power available for a desktop computer. 

This model plugin uses Universe IMAGE (format) files, single or multi-

frame to generate models inside of Universe. Each pixel with non-zero gray 

level will make a primitive be created. A variety of built-in primitives are 

offered. The shape is scaled according to the gray level value of the pixel. 

Animated gray maps create animated grains of pixels, hence the name 

Pixel Grains. 

Memory Allocation

This plugin can require a lot of memory. It can handle images of size 2K by 

2K and so needs at least 60 MB (this is in addition to what Universe and 

Figure 17.13 — Pixel Grains Sample, image courtesy of Wombat Interactive
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Camera are using) just to allocate buffers. Also, depending on the number 

of actual non-zero gray pixels, and the type of primitive, more memory 

may be needed. Typically 150MB for a 256*256 map is not unusual. Both EI 

and camera will need to have additional RAM.

Pixel Element Shapes

Choose the shape of the primitive you want to be created for each pixel 

from this menu.

Plane. A flat rectangle

Cube. A 5-sided primitive (no base)

Rounded Cube. A cube with rounded edges (9 quads)

Cylinder. 6 sided cylinder with a covered top. (8 quads)

Rounded Cylinder. A cylinder with rounded top (14 quads)

Cone. A 6 sided cone 

Figure 17.14 — Pixel Grains Interface
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Custom. A group that is child of the plugin, modeled with Y-up and unit 

size in X and Z with base center at the origin. Keep in mind, the included 

primitives are severely optimized, custom objects might not be, so more 

RAM would be needed.

Scaling Factor

Each primitive is a unit size in x and z. Scaling factors in X and Z can be 

used to make the elements larger or smaller than the pixel square. This 

allows for creating overlapping or non-overlapping elements.

The above two will let you change the size of the pixel primitive itself, 

without scaling the spacing between them.

Element Scale X. Scale factor in X

Element Scale Z. Scale factor in Z

Mesh Scale X. Scale of the entire model in X

Mesh Scale Y. Scale of the entire model in Y

Mesh Scale Z. Scale of the entire model in Z

Mesh Scale is just the same as if you scaled the Pixel Grains plugin in the 

Group Info Window.

Image/Movie Filename. Name of the image/ movie file to be used. This 

file must be Universe IMAGE format file and MUST be in the EI Sockets 

folder. The Change File button lets you select a new file, and will let you 

change the folder, BUT, you must only select files from the EI Sockets 

folder. This is being done to allow for files to be found if Renderama is 

being used to render on the slave machines.
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Start At frame #. The frame index of animation at which Pixel Grains start 

to generate geometry.

Stop At Frame #. The frame index of the animation at which Pixel Grains 

stops generating geometry.

Zero Value. Typically a zero gray value is taken to be the zero height field. 

If you want to take some other gray level as the virtual zero, that gray level 

value is entered here. 
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Flag

Flag is a small plug-in that generates a rectangular flag, and deforms 

(makes it look like it’s waving) it using dynamics. This will mimic a flag in 

a windy area. There are separate controls for amount of wind, direction, 

locks.

Mesh Resolution. This determines how many polygons the constructed 

Flag geometry will have.

Count. Count controls how fast time is running in the simulation. A higher 

number means faster flag movement. If you would like the simulation to 

begin before the animation in your scene, drag Flag’s initial keyframe 

before 0.

Friction. Friction is how stiff the fabric of the flag is. A higher number 

would make it appear that the flag is made of a thicker material.

Wind X/Y/Z. This is the direction of the wind. 

Strength. Strength measure the speed of the wind. Higher numbers will 

make it appear that the wind is blowing harder.

Figure 17.15 — Flag Interface
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Locks. The locks check boxes are basically where the flag would be tied 

down. By default the top and bottom left boxes are checking, making it 

appear that the flag is attached to a pole (pole would be separate geometry) 

at the top and bottom left of the flag.
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UberShape

UberShape is a plugin that creates an enormous variety of objects. These 

objects can be used for animation, texturing, and rendering. There are 

many custom controls used for each type of shape too.

Shape Type. This pull down menu allow to choose between the different 

types of shapes each with it’s own options. The shape settings area is where 

the options for each object is selected, the shapes include:

• Plane
• Cube
• Cylinder/Disc
• Cone, Sphere
• Torus

Figure 17.16 — UberShape Interface with Plane Selected

Shape
Preview
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• Tube Ring
• Capsule
• Teapot
• Rock
• Geodesic
• Uniform Polyhedron

Auto Name. When this option is checked, a Plane will be named “Plane” in 

the project window. Similarly, a teapot will be named “Teapot” and so on. If 

you would like to instead name the objects yourself, uncheck the Auto 

name option.

Smooth. The smooth option will look smooth when rendered as Phong or 

higher. Sometimes you might want more of a faceted look, if so, uncheck 

this option.

Create UVs. UV coordinates aid in texturing. This plugin will make UV 

coordinates for the group if wanted. This can aid in texturing when apply-

ing UV maps.

Shape Preview. This box will show an example of what the object selected 

may look like when generated. This is especially useful when choosing a 

polyhedron shape.

Show Faces. The show faces check box is there primarily to uncheck if ren-

dering for only Sticks and Balls.

Sticks. Sticks colors the edges of each polygon a separate color. It can be set 

to Lines which is a separate color, or to Cylinders, which will create cylin-

ders as the polygonal edges. There is also options for divisions for Universe 

and Camera. This is for a lower resolution in the view screens than while 

rendering. The sticks option can also be turned off as it is by default.
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Balls. Balls will put a point, line or sphere at each of the vertices of the 

object created. There are several orientation options for the spheres also. 

The balls have options for divisions in both Universe and Camera.

Shape Settings

Each different type of object that UberShape has its own options. In general 

though many are used in common.

Dimension. These include, Length, Width, Height, and Radius. Each of 

these affect the dimensions of the standard shape.

Orientation. These are X, Y, and Z rotational values. These can be set here 

at the initial creation of the object, or later in the group info window’s rota-

tional values.

Divisions/Subdivisions. The density of the mesh created is controlled by 

setting the EI and Camera divisions settings. If you plan on deforming an 

object, sometimes a higher division setting is needed for a smooth result.

Cap Ends. Some of the shapes (Cylinder/Disc, Cone, Capsule) have this 

option to have its ends covered or open, or to have just one side covered.

Detail Level. Some shapes (Rock, Teapot) use detail level to affect how 

dense the mesh is created.

Random Seed. Rocks use a random seed to allow the rock to look more 

natural. If adding several rocks, changing the random seed in each, will 

make the rocks look more unique.

Buckyball. Buckyball is a geodesic made up of pentagons and hexagons. It 

was named after Buckminster Fuller who did most of the early research on 
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geodesic structures. Since Buckyballs don't have triangles, you can't gener-

ate faces. This feature is only available as part of a Geodesic.

Class 1/Class 2 Geodesic. These are slightly different variations of the 

polygon layouts. Class 2 is a denser mesh and is a little bit smoother.
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 Appendix A: Before Calling Tech Support

A.0 Introduction

We receive many, many calls during the course of the day. Some people 

have questions about making Universe work. But many of the calls we 

receive deal with customers' ability to diagnose system problems. Often, 

the only thing Technical Support can do is walk you through some basic 

Troubleshooting methods. This is the process of elimination that you 

should learn if you are going to have any success using a computer loaded 

with the power of 3D software. (You could also call it the “scientific 

method”.) This information is vital to successfully use Universe.

Do Not Wait Until the Last Minute

This is a very common scenario: A customer is on a deadline. He or she has 

a problem using the product, and spends hours upon hours of valuable 

(billable) time trying to figure what's wrong. Then, at the last minute, the 

customer calls us with this problem that needs to be solved because the 

deadline is fast approaching. By this time, the customer can often sleep-

deprived and angry.

This is a case where Tech Support personnel would rather have you call 

them earlier than later. Many times the problem can be resolved quicker 

because we tend to know where the bugs already are located and might be 

able to point you at a solution that you may have missed or a work around 

that we may have already posted.
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Unexpected Behavior: Bug or Feature?

Have you ever attempted to use a feature you were unfamiliar with and 

didn't know how to use? Perhaps you had an opinion about how a feature 

should operate? But for some reason, this feature doesn't work like you 

envisioned? In this case, it's probably best to just call us and we'll do our 

best to tell you if what you are experiencing is a bug or a feature.

A.1 Crashing, Freezing, and/or Error Messages?

The information in this section applies to the Macintosh version of ElectricImage 

Universe only.

If you experience any crashing, freezes or error messages which prevent 

program operation, we need you to help us to help you, and take steps to 

find out what the problem is before you call Tech Support. Please follow 

the suggestions outlined in the following sections, and call us with your 

results.

Zap P-RAM

Zapping the P-RAM clears system parameter memory. System parameter 

memory is used by the Macintosh to set overall operational parameters. 

Zapping P-RAM will cause you to reset certain system settings, such as 

mouse speed.

How do I do this properly?   Just restart your computer, and immediately 

hold down the following keys:    Command - Option - P - R. Keep holding 

until the machine makes the restart  noise another 3 times.)
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Rebuild the Desktop

Rebuilding the desktop cleans up the Finder directory of files and Icons 

(similar to the Windows Registry.) Sometimes, newer versions of the oper-

ating system will do this automatically. 

How  do I do this properly?  Just restart your computer, and immediately 

hold down the following keys: Command - Option. Keep holding until the 

machine asks  you if you want to rebuild the desktop for your Hard Drive. 

At this time  you can release the keys, and click OK in the dialog window. 

Note Often, this  process is best done directly after zapping P-RAM. When fin-

ished zapping P-RAM, just hold down the Command - Option keys as nor-

mal.

Run Norton Utilities Disk Doctor 

Norton Utilities Disk Doctor is a utility program offered by Symantec that 

cleans up disk errors and miscellaneous b-tree errors.  See the documenta-

tion that comes with Norton. Use the latest version please.

Restart with Minimal Extensions

Extensions are small utility programs which add functionality to the oper-

ating system. Extensions can from Apple, or third parties. Sometimes, these 

extensions can interfere with the normal operation of the Universe applica-

tions. If you are running into difficulty operating the software, it is a good 

idea to reduce the amount of extensions that you are running to an absolute 

minimum.

The Extension Manager will let you create different sets of extensions to 

use for just this purpose. When reducing your extensions, make sure that 
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you include the following extensions, as the Universe applications require 

these extensions to operate properly: 

• Carbon Lib 1.1.1 or greater
• Open GL 1.1 or greater
• Quickdraw 3D extensions (all)
• QuickTime 3.0 or greater
• QuickTime PowerPlug
• USB extension (if your Mac has a USB port)

Hardware Keys

ElectricImage Universe supports two different types of hardware keys on 

the Macintosh: one for the older ADB bus, and one for the newer USB bus. 

Universe prefers the newer USB bus, as it is more reliable and faster than 

the older ABD bus. If you decide to upgrade to a newer Macintosh that 

uses the USB bus, call the sales department to order an upgrade key.

Many customers end up collecting a rather large amount of hardware keys. 

This can sometimes cause problems with program operation. When this 

occurs, run only with the ElectricImage Universe hardware key.

If you think you may have a malfunctioning hardware key, here is a test to 

determine if that is indeed the case. Before we begin the test, run through 

the procedures listed in section the section entitled “Crashing, Freezing, 

and/or Error Messages?” on page 516. You may find that one of those pro-

cedures may work for you. If that is not the case, proceed with the follow-

ing:

• Make an alias of Universe Animator and put it in the “Startup Items” 
folder in your  “System” folder. 

• Shutdown your computer. 
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• Remove everything from your USB or ADB bus except for the Universe 
hardware key.

• Boot up your computer 

 If Universe Animator launches, then the hardware key is not the problem. 

You should try some of the other isolation techniques listed in these pages. 

If Universe Animator does NOT launch, you likely have a dead hardware 

key and should contact us immediately.

A.2 Hard Disk Drivers

ElectricImage Universe makes extensive use of disk drives, especially for 

long animations. Universe can create and copy very large files, which can 

sometimes cause difficulties when the disk drives are in less than top form. 

It is imperative that your disk drives are functioning normally. 

The primary issue for disk drives is to make certain that the drivers you are 

using are compatible with your system software. To determine this, find 

the program “Drive Setup” on your System Disk, and update Drivers just  

to make certain. Be sure to read any warnings regarding drivers vs. operat-

ing system compatibility before changing any drivers. Normally, current 

drivers are available from the manufacturers’ websites.

A.3 Viruses

Viruses are programs designed to invade and attack your computer. 

Viruses can sometimes be benign, more of a prank than anything, but often 

they are malicious, and designed to destroy. If you notice that Universe or 

other programs that you are using are not working properly, check your 

system for viruses, trojan horses, etc. Most commercial virus checking pro-
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grams should handle this just fine. Make sure you have the latest version of 

the program, and that it is compatible with your operating system version.

A.4 Corrupted Project Files

If you think that a feature is not working correctly, it's time to create a New 

file and try the feature with the barest of circumstances. Let’s look at the 

following example to see how to do that:

Let’s say that you have just added a new object file to that project that you 

have been working on for the past three days. Suddenly, the program will 

not let you add a texture map to that object. Instead of panicking, attempt 

to determine why you are having the problem. 

Create a new project with an Uber Shape and apply your texture there. If 

the texture can be added to the uberShape object, then chances are you may 

just be experiencing user error. In this case, you should go back to the 

Materials and Textures section in the Universe Animator documentation, 

and review the process of adding a texture map to an object. If that doesn’t 

work, here are a few more things to think about:

• Check to see that something else is not setup properly and is perhaps 
affecting this feature

• Be sure that you are accurately mimicking the setup that your problem 
project has.

• Your project may have become corrupted 

This is over-simplifying the case, but the point is to make your new project 

as simple as possible and isolate the feature from all the other things going 

on in your real work project. This will help you (and us) to determine 

where the problem actually lies. 
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Corrupt projects don’t happen often, but they can happen. There are too 

many outside factors on modern computers to completely guard against 

such hazards. Here are some suggestions to help prevent projects from 

becoming corrupted.

• Save project files frequently
• Backup model files and texture maps
• Backup project files at least once a day (or more, if your system seems 

unstable)
• Make sure that your disk drives are in good working order
• Make sure that you operating system is stable
• Don’t use extensions that you don’t need

If a project ever becomes corrupted, there is little that can be done to restore 

it. Therefore, it is imperative that you follow the guidelines set forth in this 

document, and keep your computer in good working order.

A.5 Missing “Resources”?

Universe applications use resources which enable the program to function. 

These resources are kept in folders called “EI Resources” for Universe Ani-

mator and “Resources” for Universe Modeler. Inside, there will be files 

called “EIASKey” and “ModelerKey” which are required, and should 

remain inside those folders. The “EI Resources” folder should reside inside 

the same folder that contains the “Universe Animator” application.

A.6 When All Else Fails

Should all of the previous actions fail to return your program to normal 

operation, try these last few recommendations (in order!):
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• Delete the preference files for both Universe Animator and Universe 
Modeler. These files are located in System: Preferences.

• Re-install Universe
• Install Universe on a different computer

Create a Minimized Project

One of the best ways to diagnose a problem is to create a minimized project 

that exhibits the problem behavior. There are two good ways to create a 

minimized project:

• Create a duplicate of the problem project, and remove items one at a 
time until you have isolated the offending element

• Create a duplicate project and turn off items one at a time, and note any 
differences in the results that you are getting

Once you have isolated the element which causes the problem, send us 

your project. We can go over it with you to determine a work around, or to 

log the problem as a bug so that it can be fixed in a follow-up version.

Some Tips on Creating that Minimized Project

Once you have created a duplicate of the project, remove any items that 

don't have any bearing on your problem. Turn off that big model with the 

100MB texture map. Does the problem occur? If yes, then you can delete 

that model from your project. If no, then leave it in. Repeat this process 

until you get your project down to the barest of circumstances that make 

the problem occur. Continue with the following procedure:

1. Once you have the problem isolated, Save the project. 
2. Choose File>Collect Files from the main menu bar and save your 

project, support models and textures to a unique folder location sepa-
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rate from the project files you have in progress. 

This is the best way of placing your support files with the project and 

quickly sending them to us. Now you are ready to compress the files to 

e-mail.

A.7 Send Us Your Project When We Request It

Be prepared to send us a project which exhibits the problem that you are 

experiencing. if you are involved in a production and cannot send us work 

product, make sure to send us a duplicate project which does not fall under 

that restriction. If you cannot, we can sign the appropriate NDAs to protect 

your work. Regardless, we cannot fix what we cannot see, so please, when 

we request you to send in your project, please do so promptly. We can only 

help you if you let us do so.

Prepping Your Files

Whatever you use for file compression, please make it a self-extracting 

archive, if possible. We may not have the application that will read your 

compressed file. And even if we do, we may not have the latest version. 

After making the self extracting archive, you should also BinHex your file, 

which is a process that converts your file to a binary file. This makes your 

file much less susceptible to corruption as it travels across the internet via 

e-mail. BinHex utilities (shareware and freeware) are available at many 

sites on the internet. Also, popular products like “Stuffit Deluxe” come 

with binhex translators.

Now, attach the compressed, and BinHexed file to your e-mail and send it 

to us at: Support@ElectricImage.com or the e-mail address we give to you 

on the phone.
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Transparency 115

Apply To menu 116



ApplyTo menu

All 116

None 116

Set list 116

Removing a map from the list 113

Roto/comp tab 95

background map list 96

Adding an image to the list 97

Removing an image to the list 97

Foreground map list 97

Adding an image to the list 98

Removing an image to the list 98

Properties tab 102

Camera view section 103

Display mode popup menu 103

Alpha Only 104

RGB + Alpha 104

RGB + Color 104

RGB Only 104

Show in camera view check box 103

Sync with camera view check box
103

Image Tiling Section 104

Anti-alias check box 105

Axis Tile menus

Hold 105

Mirror 105

None 104

Repeat 105

Blur edit box 105

Invert Alpha check box 105

Invert RGB check box 105

Opacity edit box 106

Samples edit box 105

Render roto/comp check box 96

X-form tab 100

Position edit boxes 101

Scale edit boxes 101

Align popup menu 101

Both 101

Horizontal only 102

Vertical only 102

Stereo tab 106

Convergence popup menu 108

By Channel 108

By Reference 108

In Infinity 108

Enable check box 107

Render popup menu 108

Left & Right 109

Left Only 109

Normal 109

Right Only 109

Stereo convergence edit box 108

Stereo separation edit box 107

X-form tab 83

Camera Section 84

Changing Values in Frame Mode 85

Changing Values in Index Mode 85

Changing Values in Keyframe and Time 
Modes 86

Implicit and explicit values 86

Reference Section 84

Roll Control 84

Roll, Pitch, Yaw Section 84

Looking through 80



Reference Point

Translating (moving) 80

Translating (moving and rotating) 79

Camera Anatomy 77

Camera Body 78

Reference Point 78

View Vector 78

Camera FOV Tab 87

Camera Information Window 81

Camera Display Options 82

Show Angle 82

Show Fog 83

Show Map 83

Show Roto 83

Show Stereo 83

FOV tab

Depth of Field section 91

Distance popup menu 93

By Channel 94

By Reference 94

Enable Focus check box 92

Focus distance edit box 93

f-stop edit box 92

Multi-frame pixel offset 94

Focal length section 87

Field of view edit box 88

Focal length edit box 88

Focal mode popup menu 89

Diagonal focal mode 90

Horizontal focal mode 89

Vertical focal mode 89

Shutter Angle section 90

Enable Shutter angle edit box 90

Enable Shutter check box 90

General Camera Settings 82

Projection tab 109

Map list and Controls 112

Adding a map to the list 112

Apply Map As menu 113

Ambient 114

Bump/Displace 114

Clip 114

Diffuse 114

Glow 115

Luminance 115

Reflection 115

Reflectivity 115

Specular 114

Transmission 116

Transparency 115

Apply To menu 116

All 116

None 116

Set List 116

Removing a map from the list 113

Roto/comp tab 95

Background map list 96

Adding an image to the list 97

Removing an image to the list 97

Foreground map list 97

Adding an image to the list 98

Removing an image to the list 98

Properties tab 102

Camera view section 103

Display mode popup menu 103

Alpha Only 104



RGB + Alpha 104

RGB + Color 104

RGB Only 104

Show in camera view check box 103

Sync with camera view check box 103

Image Tiling Section 104

Anti-alias check box 105

Axis Tile menus

Hold 105

Mirror 105

None 104

Repeat 105

Blur edit box 105

Invert Alpha check box 105

Invert RGB check box 105

Opacity edit box 106

Samples edit box 105

Render roto/comp check box 96

X-form tab 100

Align popup menu 101

Both 101

Horizontal only 102

Vertical only 102

Position edit boxes 101

Scale edit boxes 101

Stereo tab 106

Convergence popup menu 108

By Channel 108

By Reference 108

In Infinity 108

Enable check box 107

Render popup menu 108

Left & Right 109

Left Only 109

Normal 109

Right Only 109

Stereo convergence edit box 108

Stereo separation edit box 107

X-form tab 83

Camera Section 84

Changing Values in Frame Mode 85

Changing Values in Index Mode 85

Changing Values in Keyframe and Time 
Modes 86

Implicit and explicit values 86

Reference Section 84

Roll Control 84

Roll, Pitch, Yaw Section 84

Camera lights 129

Dropoff edit box 129

Dropoff enable check box 129

Camera X-Form Tab 85

Cast Shadow 245

Cel/Outline Shader Section 329

Cell data

Editing In Project Window 287

In Project window

Editing 287

Cell Size 312

Changing Key Frame timing 291

Changing Scene Time 290

Changing Sequence timing 291

Channel Display 310

Close All 310

Close Selected All 310

Hide By Type 311



Hide Selected 310

Hide Unselected 311

Open All 310

Open Animated 310

Open Selected Animated 310

Open Selected Root 310

Show By Type 311

Show Selected 311

Show Unselected 311

Show/Hide Children 310

Channels

see Data channels

Clipping Maps List 331

Color Section 242

Color Swatch 333

Creating Key Frames 290

Creating New Master Materials 327

Cull Backfaces 243

Cycle Cells 312

Cycling Cell Contents 303

Offset Repeat 305

Oscillate 304

Repeat 304

Cylindrical option

In Map Type pop-up menu

In Group Texture window 373

D

Data channels

Displaying in Project Window 281

Deformation Editor 314

Deformations

Applying Deformations 37

Diffuse Maps list 335

Diffuse Tab 333

Dissolve edit box

In Mr. Nitro™ dialog box 490

Duplicating lights 120

E

Edge Outlines 330

Edit Sets 227

Editing a Key Frame cell 293

Editing Cell Contents

Filling Cells with Values 297

Fill Constant... option 298

Fill Selected option 298

Invert option 298

Jolt... option 299

Offset... option 298

Randomize... option 298

Scale option 298

Spring... option 300

Editing modes

Selecting in Project window 288

Effectors 383

Bone Effectors 392

Effector Info Window 384

Effector Information Window

Special tab 385

Effector Style Menu 386

Bone 389

Bone Color 390

Bone Highlight 390

Set Bias 390

Set Rest 390



Special Tab Options 391

Box 386

Special Tab Options 387

Origin 387

Size 387

Cross 388

Special Tab Options 388

Joint 388

Special Tab Options 389

X-form Tab 384

Explicit 385

Implicit 385

Position 385

Rotation 385

Scale 385

Effector Style Menu 386

Explicit 385

Implicit 385

Origin 387

Rotation 385

Scale 385

Size 387

Skeleton Joints 392

Special Tab Options 387

X-form Tab 384

Enable Glow option

In Light Info window 150

Enable Ray option

In Light Info window 148

Enable Shadow option

In Light Info window 136

End Time marker 290

F

Falloff 334

Field of view edit box 88

Fill Cells 312

Flare Tab 132

Flat option

In Map Type pop-up menu

In Group Texture window 372

In Mesh Type pop-up menu

In Mesh Generator dialog box 487

Flat Shading 181

Focal length edit box 88

Focal mode popup menu 89

Diagonal focal mode 90

Horizontal focal mode 89

Vertical focal mode 89

Fog 165

Fog lights

Setting inside color 150

Fog Section 238

Fog To Menu 166

Fog/Ambient/BG Tab 164

Force edit box

In Mr. Nitro™ dialog box 490

Format Menu 184

Image option 185

PICT option 185

QuickTime option 185

Fragment Shape edit boxes

In Mr. Nitro™ dialog box 491

Frame mode

Editing Frame Values 294

Resetting a Frame’s Value 294



Setting the Current Frame 294

Freeze

See Park Object Data

Function Curve Editor 249

Acceleration 260

Acceleration Enable 267

All 259

All Curves 260

All Path 267

Assigning Channels from Project Window 
318

Automatic Slope 265

Channel List 250, 255

Color Preferences 260

Command Clicking 253

Continuous Slope 265

Control-Drag 253

Current Time 261, 267

curve color 255

Custom 259

Cut and Paste 253

Data Range 261, 268

Dragging the Window 253

Editor Display Scale 265

F Curve 265

F-Curve 263

Fit Curve To Data in Time Range 267

Fit to Data Range 266

Fit to Range 266

Graph Display Element Control 260

Graph Window 250, 252

Grid 260

Grid Enable 267

Grid Options 261

Hermite 262, 264

Hold 263

Implicit and Explicit Translation 249

Key Channel Loader 259

Key Channel Window 261

Key Time Range 267

Keypath Drag 253

Linear 262, 264

Load to Insert Into Time Selection 258

Load To Replace All 258

Move to Beginning 266

Natural Cubic 262, 264

Range 266

Repeat 263

Reverse Data 267

Reverse Time 267

Ruler 260

Save All 259

Save Within Time Selection 259

Set Ranges… 266

Shift Clicking 253

Snap 266

Snap Undo 261

Specific 260

Spline Specific Fields 264

Tab Key 253

The Key List Subsection 263

The Motion Type Menu 262

Time and Value Edit Boxes 264

Time Range 261, 268

Time Scale Enable 267

Toggle Linear 253



Tool Bar 251

Toolbar 256

Velocity 260

G

Generate Shadow Mask 245

Geometry Section 243

Geometry Tab 329

Global Reflection Tab 174

Glow Layer Members List 208

Glow Layer Tab 207

Glow Configuration Section 208

Glow Intensity 209

Glow Layer List 207

Glow lights

Setting inside color 150

Glow Object Only 243

Glow Radius 208

Glow Tab 143

Creating Glow Effects 146

Configuring lights 146

Light Rays 148

Volume shadows 147

Enable Glow 144

Enable Glow Blend 144

Enable Ray 144

Factor 145

Glows

Glow Tab 142

Inner and outer radius 145

Inside Glow Color 145

Intensity 145

Interpolate RGB 144

Invert Glow & Fog 144

Outside Glow Color 145

Ray Factor 145

Ray Sample 145

Smoke Selector 146

Volume falloff 144

Glows

Creating 146

Configuring lights 146

Light Rays 148

Volume shadows 147

Enable Glow 144

Enable Glow Blend 144

Enable Ray 144

Factor 145

Inner and outer radius 145

Inside Glow Color 145

Intensity 145

Interpolate RGB 144

Invert Glow & Fog 144

Outside Glow Color 145

Ray Factor 145

Ray Sample 145

Smoke Selector 146

Volume falloff 144

Gouraud Shading 181

Gravity Direction & Force edit boxes

In Mr. Nitro™ dialog box 489

Ground 172

Ground Zero edit boxes

In Mr. Nitro™ dialog box 488

Group Info Window 233

Group Information Window



Motion Blur Section 241

Shading tab

Line Section 240

X-Form tab 236

Group Linkage

See Joint Editor

Group Texture window

Map Type pop-up menu

Cylindrical option 373

Flat option 372

H

High Precision Shadow 245

horizon 171

I

Illumination lists 130

Enabling/Disabling 131

Image Menu 182

256 Colors 184

256 Shades 184

BW Dithered 183

BW Filled 183

BW Lines 183

BW Summation 183

Millions of Colors 184

Millions+Alpha 184

Thousands of Colors 184

Image Resolution Menu 193

Implicit and Explicit Interpolation 237

Importing 3D Models

adding FACT models 231

foreign model formats 232

Info Tab 246

Inner Blast edit boxes

In Mr. Nitro™ dialog box 490

Inside Color button

In Light Info window 150

J

Joint Editor 314

Group Preview Pane 396

Inherit Tab 405

Inherit Deformation 406

Inherit Position 405

Inherit Rotation 406

Inherit Scale 406

Inherit Visibility 406

Limits Tab 407

Position Sub-Tab 411

Rotation sub-tab 408

Center Section 408

Maximum Section 408

Minimum Section 408

Use Current Value Arrows 408

Stiffness Sub-Tab 409

Maximum 411

Minimum 411

Viscosity Sub-Tab 410

Link Type Menu 399

Ball Planar 400

Custom 400

Cylinder 401

Cylinder Planar 401

Free 400

Lock 401



Pin 401

Planar 401

Slide 401

Socket 401

Universal 401

Pivot Point Gnome 397

Rotation Order Menu 398

Transform Menu 398

Classic 398

Standard 398

X-form Tab 402

Link Alignment Orientation 403

Z is X 403

Z is Y 404

Z is Z 403

Link Alignment Position 402

Back 403

Bottom 403

Front 403

Left 403

Middle 403

Right 403

Top 403

Parental Offset Section 404

Position Section 404

Rotation Section 404

K

Key Index mode 295

Displaying a Key Frame 296

Editing Key Frame Values 296

Selecting the Current Key Index 296

Keyframe mode 291

Adding a Key Frame 292

Editing a Key Frame cell 293

Setting the Current Frame 292

L

Lens Flares 132

Enable Background 134

Enable Cone Obscuration 133

Enable Distance cueing 133

Enable Fog cueing 134

Enable Instensity cueing 134

Enable Object Obscuration 133

Enable Offscreen flare elements 133

Flare Selection popup menu 133

Plug-in options button 133

Light color button

In Light Info window 126

Light Display options

Show Angle 122

Show Dropoff 122

Show Flare 123

Show Flare Dropoff 123

Show Fog and Glow radius 122

Show Light Size 123

Show Volume Dropoff 123

Light Info Window 121

Light Info window

Buffer Size edit box 136

Calculate Shadow Only Once option 136

Enable Glow option 150

Enable Shadow option 136

Inside Color button 150

Light color button 126



Outside Buffer Area in Shadow option 136

Light Information Window

Anatomy 120

Light Display options 122

Show Angle 122

Show Dropoff 122

Show Flare 123

Show Flare Dropoff 123

Show Fog and Glow radius 122

Show Light Size 123

Show Volume Dropoff 123

Properties tab 126

Common attributes 126

Enable Highlight check box 128

Enable Illumination check box 128

Intensity edit box 126

light color swatch 126

Size edit box 127

Volume Dropoff edit box 127

X-form tab 123

Implicit and explicit values 125

Light Section 124

Reference Section 124

Roll Control 124

Roll, Pitch, Yaw Section 124

Values in Frame mode 125

Values in Index mode 125

Values in keyframe and Time modes 125

Fog tab 149

Enable Ray 150

Inner and outer radius 151

Intensity 151

Interpolate RGB 150

Invert Glow & Fog 150

Outside fog color 150

Ray Factor 151

Ray Sample 151

Smoke Selector 151

Volume falloff 150

Projection Map tab 152

Crop tab 157

Info tab 157

Properties tab 154

Anti-alias check box 156

Blur edit box 156

Interpolate check box 156

Invert Alpha check box 156

Invert RGB check box 156

Samples edit box 155

Tiling Popup Menus 155

Hold 155

Mirror 155

None 155

Repeat 155

X-form tab 152

Alignment menu

Fit outer cone 153

Fit within inner cone 153

Fit within outer cone 154

Fit without inner cone 154

Fit without outer cone 154

Light rays

Enable Ray option 148

Light Types 118

Ambient light 119

Camera light 118



Parallel light 118

Radial light 118

Spot light 119

Tube light 119

Light X-form tab 123

Implicit and explicit values 125

Light Section 124

Properties tab 126

Common attributes 126

Enable Highlight check box 128

Enable Illumination check box 128

Intensity edit box 126

Light color swatch 126

Size edit box 127

Volume Dropoff edit box 127

Reference Section 124

Roll Control 124

Roll, Pitch, Yaw Section 124

Values in Frame mode 125

Values in Index mode 125

Values in Keyframe and Time modes 125

Lights

Adding lights to a project 120

Duplicating lights 120

Enabling glow lights 150

Enabling shadows from 136

Fog Light

Volume Shadows 152

Fog tab 149

Enable Ray 150

Inner and outer radius 151

Intensity 151

Interpolate RGB 150

Invert Glow & Fog 150

Outside fog color 150

Ray Factor 151

Ray Sample 151

Smoke Selector 151

Volume falloff 150

Glow Tab 142

Creating Glow Effects 146

Configuring lights 146

Light Rays 148

Volume shadows 147

Enable Glow 144

Enable Glow Blend 144

Enable Ray 144

Factor 145

Inner and outer radius 145

Inside Glow Color 145

Intensity 145

Interpolate RGB 144

Invert Glow & Fog 144

Outside Glow Color 145

Ray Factor 145

Ray Sample 145

Smoke Selector 146

Volume falloff 144

Illumination Lists 130

Enabling/Disabling 131

Light Information Window

Flare tab 132

Enable Background 134

Enable Cone Obscuration 133

Enable Distance cueing 133

Enable fog cueing 134



Enable Intensity cueing 134

Enable Object Obscuration 133

Enable Offscreen flare elements 133

Flare Selection popup menu 133

Plug-in options button 133

Master Light tab 158

Inherit attributes 160

Inherit color 160

Inherit dropoff 159

Inherit flare 160

Inherit fog 160

Inherit glow 160

Inherit intensity 159

Inherit projection 160

Inherit shadow 160

Inherit visibility 159

Master Lights

adding a subscriber light 161

Creating a master light 161

viewing the master light hierarchy 162

Projection Map tab 152

Crop tab 157

Info tab 157

Properties tab 154

Anti-alias check box 156

Blur edit box 156

Interpolate check box 156

Invert Alpha check box 156

Invert RGB check box 156

Samples edit box 155

Tiling Popup Menus 155

Hold 155

Mirror 155

None 155

Repeat 155

X-form tab 152

Alignment menu

Fit outer cone 153

Fit within inner cone 153

Fit within outer cone 154

Fit without inner cone 154

Fit without outer cone 154

Projection Maps

Adding Maps 157

Adding Maps with volume shadows 158

Setting color 126

Shadows 134

Depth buffer type 134

Raytraced

Shadow tab

Soft shadow section

Optimize shadow generation 139

Raytraced Shadow tab

Enable shadow 138

Raytraced type 134, 138

Special Lighting Effects 139

Fog 140

Glows 140

Projector Light Effects 141

Smoke Effects 141

Volume Shadows 140

Link to Parent 315

Loading and Saving Materials 326

Look at Object 315

Cancel Look at 315

Luminance/Glow Tab



Glare 357

Glow Color Maps List 361

Glow Color Section 356

Luminance Color Section 355

Luminance Map List 356

Use Color Button 356

Use Shading Button 356

M

Mask 334

Master Lights 158

adding a subscriber light 161

Creating a master light 161

Master Light tab

Inherit attributes 160

Inherit color 160

Inherit dropoff 159

Inherit flare 160

Inherit fog 160

Inherit glow 160

Inherit intensity 159

Inherit projection 160

Inherit shadow 160

Inherit visibility 159

viewing the master light hierarchy 162

Master Materials 322

Material Editor 314

Mesh Generator plug-in

Mesh Generator dialog box

Mesh Type pop-up menu 486

Breathing Cylinder option 487

Flat option 487

Screw Thread option 487

Sine Wave option 487

Sphere Wrap option 487

Options 486

Selecting a breathing cylinder 487

Selecting a flat mesh grid 487

Selecting a plane-to-sphere animation 487

Selecting a screw thread animation 487

Selecting animated circular waves 487

Mesh Type pop-up menu

In Mesh Generator dialog box 486

Morph 413

Morph Window 413

Add Blend to Curve Editor 419

Add Morph Group 417

Add Morph Source 414

Add Morph Targets 418

Creating Models for Morphing 413

F-Curve 420

First 416

Full Match 416

Geometry Only 417

Hermite 419

Index Only 416

Keyframe/Timeline Slider 420

Linear (Default) 419

Making Morphs 421

Morph Anchor Section 416

Morph Group Section 417

Morph Target Section 418

Name Only 417

Natural Cubic 419

Play Backward 421

Play Forward 421



Play/Pause 421

Reload Target Data Button 417

Step Backward 421

Step Forward 421

Target Match Popup Menu 416

View Area Section 421

Working with Sync Sound 424

Motion Blur Tab 203

Blur Frames 205

Blur Intensity 204

Blur Noise 204

Motion Vector 206

Multi-Frame 206

Point/Line Blurring 205

Shutter Angle 203

Motion Vector Blur 241

Mr. Nitro™ plug-in

Mr. Nitro™ dialog box

Age color buttons 491

Dissolve edit box 490

Force edit box 490

Fragment Shape edit boxes 491

Gravity Direction & Force edit boxes 489

Ground Zero edit boxes 488

Inner Blast edit boxes 490

Rotation edit box 490

Speed edit box 490

Setting fragment color over time 491

Setting fragment dissolve time 490

Setting fragment rotation 490

Setting fragment shape 491

Setting secondary shockwave 490

Setting shockwave direction and force 489

Setting shockwave force 490

Setting shockwave origin 488

Setting shockwave speed 490

N

Nadir 172

Network Rendering Tab 214

NTSC 277

O

Object Labels 313

Open Root option

Open/Close options

In Project window 310

Open Selected All option

Open/Close options

In Project window 310

Outside Buffer Area in Shadow option

In Light Info window 136

P

PAL 277

Park Object Data 317

Phong Shading 182

Point/Line Motion Blur 241

Polygon Outlines 330

Project Editing Modes 288

Active Time Range

End Time marker 290

Start Time marker 290

Keyframe mode 291

Adding a Key Frame 292

Editing a Key Frame cell 293



Removing a Key Frame 293

Setting the Current Frame 292

Time mode 288

Active Time Range 290

Changing Key Frame timing 291

Changing Scene Time 290

Changing Sequence timing 291

Creating Key Frames 290

Scaling Sequence timing 291

Selecting Key Frames 291

Time Scale 289

Time Slider 289

Project Window

Animation Channels

Displaying an object’s channel 283

Editing Channel Data 286

Advance to another cell 287

move the focus of selected cells 287

Enabling (activating) 284

Enabling a specific record 284

Selecting Animation Channels 285

Selecting an entire channel 285

Data Panel 281

Displaying data channels 281

Scrolling and Resizing the Display 281

In Frame and Keyframe modes 282

In Time mode 282

Editing Cell Contents 297

Blending Cell Contents 302

Blend Curve 303

Blend Linear 303

Cycling Cell Contents 303

Offset Repeat 305

Oscillate 304

Repeat 304

Filling Cells with Values 297

Fill Constant... option 298

Fill Selected option 298

Invert option 298

Jolt... option 299

Offset... option 298

Randomize... option 298

Scale option 298

Spring... option 300

Editing cell data 287

Flag Panel 277

FPS menu 276

Custom… option 276

NTSC:30 option 277

NTSC:30i option 277

PAL:25i option 277

FPS pop-up menu

Film:24 option 277

PAL:25 option 277

Function Curve Editor

Assigning Channels 318

Object/Channel Name Panel 278

Accessing Object Information Window 
278

Assigning Hierarchy 279

Hide hierarchy 280

Remove hierarchy 280

Selecting objects 278

Show hierarchy 280

Pop-up menus

Rendering options



Range of Frames option 313

Project Editing Modes 288

Frame mode

Editing Frame Values 294

Resetting a Frame’s Value 294

Setting the Current Frame 294

Key Index mode 295

Displaying a Key Frame 296

Editing Key Frame Values 296

Selecting the Current Key Index 296

Keyframe mode 291

Adding a Key Frame 292

Editing a Key Frame cell 293

Removing a Key Frame 293

Setting the Current Frame 292

Time mode 288

Active Time Range 290

End Time marker 290

Start Time marker 290

Changing Key Frame timing 291

Changing Scene Time 290

Changing Sequence timing 291

Creating Key Frames 290

Scaling Sequence timing 291

Selecting Key Frames 291

Time Scale 289

Time Slider 289

Rendering options

All Frames option 313

Current Frame 313

Every Nth Frame… option 313

Selection lock 277

Tool Bar 306

Attach to Object 315

Auto Rotate Object 316

Cancel Auto Rotate 316

Cancel Look at 315

Cancel Master Light 317

Cancel Master Material 317

Cell Size 312

Channel Display 310

Close All 310

Close Selected All 310

Hide By Type 311

Hide Selected 310

Hide Unselected 311

Open All 310

Open Animated 310

Open Selected Animated 310

Open Selected Root 310

Show By Type 311

Show Selected 311

Show Unselected 311

Show/Hide Children 310

Custom View 308

All 308

Auto frames 310

Color 309

Custom... 308

Position 309

Rotation 309

Scale 309

Transform 310

Visibility 309

Cycle Cells 312

Deformation Editor 314



Detach from Object 316

Fill Cells 312

Joint Editor 314

Link to Parent 315

List View control 306

By Complexity view 307

By Label view 307

By Master Light view 308

By Material view 307

By Model File view 307

By Name view 307

Flat view 307

Hierarchy view 307

Look at Object 315

Material Editor 314

Object Labels 313

Park Object Data 317

Sound 314

Subscribe to Master Light 317

Subscribe to Master Material 317

Time Scale Snap control 308

None 308

Snap to Frame 308

Snap to Key Frame 308

Unlink from Parent 315

Visibility control 277

Project window

Editing Animation Channel data

Editing cell data 286

Editing data

Editing cell data 287

Pop-up menus

Cell size options 312

Custom view options 308

Flat/Hierarchy view options 306

Open/Close options

Open Root option 310

Open Selected All option 310

Open/close options 310

Snap to frame options 308

Selecting editing modes 288

Sound tool 314

Time Selector 289

Projection (Map) tab

Info tab 157

Properties tab 154

X-Form tab 153

Projection maps

Adding to lights 157

Adding to lights with volume shadows 158

Properties Tab 128

R

Radial lights 129

Dropoff edit box 129

Dropoff enable check box 129

Raytracing

Shadow tab 138

Enable shadow 138

Soft shadow section

Optimize shadow generation 139

Shadows 134

Receive Shadow 245

Reference Point

Camera 78

Translating (moving) 80



Reflection Map Configuration Section 343

Reflection Section 240

Reflectivity Configuration Section 341

Reflectivity Tab

Amount 341–342

Color Swatch 341

Edge Control (Attenuation) Section 342

Environment 345

Environment Reflection Subsection 344

Falloff 342

Mirror 345

None 344

Reflection Bias 342

Reflection Map List 345

Reflectivity Maps List 343

Use Bitmap Reflection 344

Use Environment Reflection 344

Use Global Maps 344

Reload From Master 327

Removing a Key Frame

Keyframe mode

Removing a Key Frame 293

Render Flags 185

Add Noise 187

Bump/Displace 186

Clip 186

Diffuse 186

Glows 187

Lens Flares 187

Luminance 187

Outlines 187

Raytrace Reflections 188

Raytrace Shadows 188

Raytrace Transparency 188

Reflections 187

Shaders 187

Shadows 187

Specular 186

Textures 187

Transmission 186

Transparency 186

Render Info Window 178

Render Information Window 178

Go button 214

Render Menu

All Frames 213

Current Frame 213

Even Field 213

Range of Frames 213

Render Tab 179

Output Gamma edit box 188

Point/Line Thickness edit box 188

Raytrace Recursion edit box 188

Rendering 177

Setting 24 FPS for film standard 277

Setting 25 FPS for PAL standard 277

Setting 30 FPS for NTSC standard 277

Setting custom FPS 276

Rendering Level 179

Raytrace 182

Wireframe 180

Resolution Tab 189

Image Cropping 196

Pixel Aspect Ratio 195

QTVR

Object 198



Panoramic 197

X and Y Edit Boxes 195

Reverse Normals 243

Rotation edit box

In Mr. Nitro™ dialog box 490

Rotoscope image display

Paint image icon 99

S

Scaling Sequence timing 291

Scene Objects

Ambient light 119

Camera

Adding to Scene 78

Camera Information Window 81

Looking through 80

Reference PointTranslating (moving) 80

Translating (moving and rotating) 79

Camera light 118

Parallel light 118

Radial light 118

Spot light 119

Tube light 119

Screw Thread option

In Mesh Type pop-up menu

In Mesh Generator dialog box 487

Select

By Set 227

Select Menu 227

Selecting Key Frames 291

Selection Sets 227

Create a Set 228

Setting the Current Frame 292

Shading Tab 238

Shadow Object Only 245

Shadow Tab 244

Shadow tab

Raytraced type 138

Shadows 134

Calculating once in scene 136

Creating automatic shadow area 136

Depth buffer type 134

Enabling for lights 136

Raytraced

Shadow tab

Soft shadow section

Optimize shadow generation 139

Raytraced Shadow tab

Enable shadow 138

Raytraced type 134

Setting buffer size 136

Silhouette Outlines 330

Sine Wave option

In Mesh Type pop-up menu

In Mesh Generator dialog box 487

Sky 170

Smooth Across Faces 242

Sound 314

Sound tool

In Project window 314

Sounds

Playing from Project window 314

Special Lighting Effects 139

Fog 140

Glows 140

Projector Light Effects 141



Smoke Effects 141
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